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Foreword

Can you believe there was a time when a major part of the web 
design world used Photoshop to design everything? A photo editor 
for design? While Adobe’s application is very powerful, you will 

probably only employ a fraction of its features for actual design work; the 
rest will quickly gather dust. So why not take something easier, something 
geared more towards UI design — something that can better respond to the 
ever-changing landscape of devices? The less you need to worry about the 
tool, the more you can focus on your ideas.

But apart from Adobe’s own Fireworks there was really no alternative until 
September 2010, when a small company in The Hague decided to redefine 
the interface design world: Sketch 1.0 was born, made by Bohemian Coding. 
Six years on, it has taken the world by storm and is the design software of 
choice for many practitioners and companies, the most prominent being 
Facebook and Google. And it keeps improving, faster than ever.
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An Introduction To Sketch

Sketch is a vector-based interface design tool, which means that 
everything built with it is infinitely scalable — a must with today’s 
vast array of devices. But it still has some essential bitmap editing 

chops, so you never need to leave its comfy environment. There’s just one 
caveat: Sketch is Mac-only — but you knew that already, right? Fortunately, 
there are a few options to make your developer friends on Windows happy, 
but more on that later.

You can download a trial version of Sketch at sketchapp.com. If you are 
ready to take the plunge (trust me, after a few pages into this book you 
will be) there’s currently an investment of US$99 to make, which includes 
one year of free updates. After that, you can either keep using Sketch as is 
or pay the same amount for another year of updates. Please note that this 
book is based on Sketch 41. 

All the Features

Sketch offers a wealth of tools and features to make it the perfect applica-
tion for today’s designer: It lets you design interfaces, websites and icons 
with ease. I have also used it with success to create logos and even print 
material. Some notable features of Sketch include:

•	 It is easy to learn. You'll get the basics very quickly, and still it offers 
enough functions for the power user.

•	 Fast and lightweight: small file sizes, fast navigation and response.

•	 Clean and uncluttered UI: everything at a glance; no complicated 
submenus or dialogs. 

http://sketchapp.com
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•	 Vector-based: resize elements without losing quality; everything 
remains sharp even if you zoom in.

•	 Pixel-perfection: get the perfect result with various pixel-based aids.

•	 Copy CSS attributes and SVG code: go from design to code in no time.

•	 Pages and artboards: organize your designs in a single file.

•	 Flexible Boolean operations: combine basic shapes to create complex 
forms that remain editable.

•	 Powerful export features: export different sizes with a single click.

•	 Symbols and shared styles: easily reuse elements and layer styles.

•	 Keyboard shortcuts: efficiency is key — almost everything can be 
achieved with a keypress.

•	 Built-in grids and layouts: set them up quickly to give your work some 
constraints.

•	 Group resizing: Adapt your designs to different sizes with ease.

•	 Sketch Mirror: Preview designs on any device.
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About This Book

Before we start, a few words about how this book works. I actively invite 
you to follow me along and create your own version of the projects. This 
is essential to learn how to use Sketch, as it shows you every aspect of it 
on the go. A centerpiece of the book is workflow efficiency: you will learn 
how to perform actions as quickly and correctly as possible, mainly with 
the help of keyboard shortcuts and the clever use of the available features. 
Every essential part is described in the necessary detail. 

The first chapters of The Sketch Handbook are targeted mainly at beginners 
— both to design apps and design in general. If this is your first time using 
Sketch you should follow closely. As the book proceeds, the more advanced 
it gets: I provide fewer and fewer instructions and rely on things already 
mentioned; keyboard shortcuts covered earlier aren’t mentioned again and 
more advanced topics come to the fore. The last few chapters in particular 
are geared more towards intermediate users, but beginners will still get 
enough information that they can follow along. Last but not least, if you 
are interested in a condensed overview of many different topics and tech-
niques, I suggest you take a look at chapter 12, Mini Projects (page 323ff.). 

Between the instructions you’ll find regular info boxes that give you a 
deeper understanding of a certain related aspect of Sketch. If you are inter-
ested in a certain topic you can always read them immediately, but I advise 
you to save them up for later and digest them once you are done with the 
basics of Sketch. In addition, there are also numerous quick tips, small 
portions of information at the right time, that you should memorize for an 
immediate productivity boost. 

For updates about this book visit sketch-handbook.com, where you can 
also subscribe to the newsletter.

http://sketch-handbook.com
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Bitmaps vs. Vectors

Before we go in-depth with Sketch, let us revisit the basics a little bit. Photo- 
editing apps like Photoshop or Pixelmator are based on bitmaps, which 
means that everything is made up of a static grid of tiny, multicolored pix-
els. If you scale these raster images, the software either needs to fill in the 
gaps, which results in a blurry image, or enlarge the pixels, so that you start 
to notice them after a certain point and get a grainy image. On the other 
hand, vector-based apps like Sketch, Illustrator or Affinity Designer use 
collections of points connected to one another with lines: vectors. Since 
these points are mathematically described they can be resized infinitely 
and everything remains sharp.

 

Fig. 1.1: Left: Raster image. Right: Vector image.
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The Interface

The main differentiator of Sketch is its uncluttered, simple interface and 
ease of use, with the canvas taking up the most space of the app on screen. 
It is infinite in nature, meaning you can place as many elements on it as 
you want. But you are still able to organize the canvas with “Artboards”, 
which give your designs defined boundaries and let you iterate quickly, or 
“Pages”, which enable you to put all your different screens into one file.

Fig. 1.2: Artboards let you iterate quickly. Here you see all the versions that led to the final app design.

Quick tip: You can have as many artboards on the canvas as you like, 
but try to separate them into pages as much as possible for perfor-
mance reasons. Read more about pages on page 121.
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All elements you put on the canvas also appear on the left in the layers list, 
where you can reorder, rename and group them. This way, you’ll always 
have an overview of what’s going on with your elements on the canvas. 
The higher up in the hierarchy the layer is, the higher it is stacked in the 
drawing area. Layer properties can be changed in the inspector on the 
right, where there are controls for size, position, colors and effects, like 
shadows and blurs.

The most important functions of Sketch can be found in the customizable 
toolbar at the top, in the form of icons; but the true power of the program 
lies in its keyboard shortcuts. Almost everything you can do in Sketch is 
accessible with a keystroke, and the things that aren’t can easily be custom-
ized. You’ll not only work faster this way, but also be more efficient — and 
efficiency is the key feature of Sketch.

Fig. 1.3: The layout of Sketch.
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When you hover with the mouse over a layer it gets a blue border: this 
helps you to identify which entry in the layers list belongs to which layer 
on the canvas and vice versa. It also indicates the selected layer to click 
on. The moment you start to organize layers into groups — and you will 
do that a lot — the importance of the Cmd key becomes apparent: holding 
it while you click on a layer on the canvas allows to select it even when 
it’s nested in a group. It wouldn’t be selectable on the canvas otherwise. 
Another key you should familiarize yourself with right from the start is 
Alt: it lets you measure distances from the selected layer to other elements, 
rulers or the grid. 

What can’t be accessed using the UI elements mentioned above is hidden 
away in the menu bar, but with a cleverly customized toolbar and by learn-
ing essential keyboard shortcuts you won’t linger here often.
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Designing An App

Enough of theory — let’s get to the meat and potatoes of Sketch with 
a typical workflow based on an app with two separate screens. To 
show some love for my homeland Austria, I have created “Visit 

Austria,” an imaginary app that lets you take a peek at the loveliest spots 
of the Central European country (and there are a lot here). It consists of 
a details screen, which we will approach first, and an overview screen, 
covered in chapter 5, Creating An Overview Page. The Sketch files for all the 
covered projects can be found at http://smashed.by/sketch-files1.6

Fig. 2.1: The iterations of the details screen.

6	 http://smashed.by/sketch-files1

http://smashed.by/sketch-files1
http://smashed.by/sketch-files1
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Fig. 2.3: Sketch offers different built-in templates.

Back at our new mobile screen, you’ll notice that the formerly white back-
ground of the canvas has changed to gray with a defined area in the middle 
— our new artboard (Fig. 2.4). With it, we now also have our first entry in 
the layers list on the left. 

To get a clean starting point, click into the input fields and enter 0 for both 
of the positions — you can use Tab to jump from one to another (and 
Shift + Tab to go back). Finally, confirm the change with Enter and press Esc 
to leave the field.

On the opposite side, in the inspector, you’ll see that it has a width of 360px 
and a height of 640px, as well as a certain X and Y position. To get a clean 
starting point, click into the input fields and enter 0 for both of the posi-
tions — you can use Tab to jump from one to another (and Shift + Tab to go 
back). Finally, confirm the change with Enter and press Esc to leave the field.

You might notice that the artboard is now a little bit off center on the 
screen. To fix this, press Cmd + 3.

Quick tip: If there are already elements on the canvas that you want 
to convert an artboard, make sure they are selected, then press A and 
click on the first option: Around Selection.

A Defined Space

After you have created a new docu-
ment(Cmd + N) and saved it on your hard 
drive (Cmd + S), create a new artboard with A. 
Now you are presented with a nice selection 
of predefined sizes in the inspector, divided 
into useful categories like iOS Devices, 
Material Design or Responsive Web 
Design. Since we will be designing a mobile 
app let’s choose a common size of 360×640 
px with Mobile Portrait from Material 
Design.

For the sake of universality I won’t adhere to 
a specific device or platform, but if you are 
designing an iOS or Android application you 
can use the built-in templates: go to File → 
New From Template and choose the type 
you need — there are many to choose 
from. If you want to go 	the opposite way 
and save something you have created as a 
template, you can go to File → Save as 
Template…

Fig. 2.2: There’s a huge selection of 
predefined artboard sizes available.
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Fig. 2.4: Our new artboard. 

Another option you’ll see in the inspector is the background color of the 
artboard, which is white by default, but only inside Sketch. If you want to 
have white or another color in your exported file you need to check this 
box and select a color, otherwise you get a transparent background, a 
common pitfall.

Quick tip: To move an artboard on the canvas, click on its title and 
drag it around.
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Designing at 1x

Although most devices today have a screen with a pixel density of 2x or 
more, it’s still a good idea to start at the basic resolution of 1x when design-
ing an app. The iPhone 5, for example, has a resolution of 320×568px, but 
with a pixel density of 2x this results in a device resolution of 640×1,136px, 
as each of the pixels is divided into four subpixels so it can display every-
thing in greater detail. If you started to design at 2x and need to go up to 
3x, you would need to multiply everything by 1.5, and your measurements 
and dimensions would result in half-pixels. By starting at 1x instead, you 
can go up to 2x or 3x with ease as you have whole multipliers, but can still 
work in some extra details if you’d like. 

 
 
Fig. 2.5: Pixel densities of a 1x, 2x 
and 3x device depicted.

This approach also has the added benefit that the file size is smaller and 
you can work on the real pixels: if you need a button to be 48px high you 
don’t need to calculate its real size for the scale of your design first. 

If you need more reasons to design at 1x, read “Design at 1x — It’s a Fact”7 
where Kurt Varner sets out some tangible benefits, a description, what 
the pixel density actually is, is given by Peter Nowell in his article “Pixel 
Density, Demystified.”8

7	 http://smashed.by/sketch-designat1x
8	 http://smashed.by/sketch-pixeldens

http://smashed.by/sketch-designat1x
http://smashed.by/sketch-pixeldens
http://smashed.by/sketch-pixeldens
http://smashed.by/sketch
http://smashed.by/sketch
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The First Layer

Since our app’s name won’t be “Mobile Portrait,” let’s rename the artboard 
to “Visit Austria Detail” by pressing Cmd + R followed by Enter. You could 
also do that with a double-click on the artboard’s name in the layers list, but 
using the keyboard is always faster and more convenient, so you should 
cultivate the habit. The first element we’ll create for our app is the title bar, 
so press R for a rectangle and draw one of any size at the top of the art-
board. By default it is created with a grey fill and a dark grey border. Since 
in future we will more likely need elements without a border than with, 
deselect the checkbox in the Borders section of the inspector and choose 
Edit → Set Styles as Default from the menu bar (Fig. 2.6). 

Fig. 2.6: Deselect the default border in the inspector and choose Set Style as Default.

What you will immediately notice when you add a shape is that Sketch 
automatically snaps to the artboard boundaries while drawing, and when 
you hit certain positions, like the center. If you add another rectangle you’ll 
see that Sketch additionally shows some red lines when you hit certain 
locations on the first shape, like its edges or center: these are smart guides, 
which make life much easier. (You can delete this second layer with Del, as 
it just acted as an example.)
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Shapes in Sketch

Sketch has a wide range of shapes available, but the most important ones 
are rectangles and ovals, since almost any shape can be constructed out of 
these basic types. The different shapes can be accessed under Insert → 
Shape in the toolbar, but a more efficient way is use the keyboard short-
cuts: R for a rectangle and O for an oval.

The less important shapes with shortcuts are L for a line and U for a 
rounded rectangle. I say less important, because the latter is just an ordi-
nary rectangle with rounded corners of 8px, and the chances are pretty 
low that you’ll need exactly this roundness. Lines, on the other hand can 
be useful since you are able to adjust their length within the inspector, but 
you get two caveats in trade: they have a weird behavior and start at odd 
dimensions sometimes; and the moment you adjust their border thickness 
you need to adjust the position anyway. I often find it more practical to use 
a thin rectangle instead, or a vector, as they’re basically the same as a line.

 

Fig. 2.7: The shapes in Sketch which have dedicated keyboard shortcuts.
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Arrows fall into the same category, as the options to change them are quite 
poor. If you want to customize them you can use the little gear icon in the 
borders section of the inspector for customization. Just be sure that the 
Ends are set to the first property. A plugin that can ease the pain a little is 
Arrowfy:9 it matches the properties of the arrowhead to the vector.

Fig. 2.8: The arrow options can be accessed with the gear icon, but they are rather limited. 

The remaining shapes, which you may use just as rarely, are: star, with cus-
tomizable radius and points; polygon, whose points can also be changed; 
and triangle. A triangle can also be created as a polygon if you set the 
number of points to three, which has the nice side effect of giving you an 
equilateral triangle if you hold Shift when you draw it.

9	 http://smashed.by/sketch-arrowfy

http://smashed.by/sketch-arrowfy
http://smashed.by/sketch
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Fig. 2.9: Triangle, polygon and star, which can be customized. 

Under Insert you also find: Vector (V), which lets you insert multiple 
points to form a custom shape; and Pencil (P), that allows you to draw a 
line which is automatically smoothed at the end (I’ve never used it).

For all closed shapes, you can hold Shift to create them equilaterally, and 
Alt to start from the center (hold down both keys to perform these actions 
simultaneously). If you are unsure about their placement, hold down 
Space at the start to move them around on the canvas. Open shapes (lines, 
vectors, arrows), on the other hand, are restricted to horizontal, vertical or 
diagonal movement with Shift. 
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Smart Guides

Whenever you add an element to the canvas or move it around, red smart 
guides are shown. They allow you to align elements to one another with 
ease, as they snap to the outer dimensions or center of layers; but they also 
show you the distance to other elements when you move them around. 
Furthermore, the smart guides can be used to align elements using equal 
spacing, as they recognize common distances and suggest them whenever 
you move an object. To trigger the smart guides by hand and show the dis-
tance to the currently selected group or layer, hold Alt and point the mouse 
to another element. When there are many elements on the canvas, smart 
guides can sometimes hinder more than they help; you can switch them 
off with View → Canvas → Show Smart Guides from the menu bar.

Fig. 2.10: Left: The smart guides show you certain positions when you add layers. Right: When you drag 
elements around, the smart guides tell you the distance and alignment to other layers. Bottom: The 
smart guides can also help to get equal spacing to other elements. 
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 Back to our first layer, the rectangle. It doesn’t matter if you didn’t catch the 
top-left corner at first or made it the correct size: it’s no problem to change 
these properties now. Jump into the X position field of the inspector with 
Alt + Tab and enter 0 for both X and Y. (Remember you can use Tab to jump 
from one field to another.) Alternatively, you can also select the shape on 
the canvas with a click and drag it to the top-left corner. 
 
For the width we will use a special 
feature of Sketch. Instead of a 
defined value you can enter a per-
centage, like 50%, to fill up half of the 
artboard, or, in our case, 100% for a 
full-width element (Fig. 2.11). This 
relative width always relates to the 
width of the parent group (the 
artboard in the absence of a group). 

This also works for the Height and the Position (X and Y), and can even 
be combined with an absolute value like “50%+10.” But for now we will 
choose a height of 48 pixels for the title bar. 

 

Fig. 2.11: You can also use relative dimensions, 
both in the Position and the Size fields.

Quick tip: To quickly jump into the X position field of the inspector 
press Alt + Tab at any time. Use Tab to navigate to the other input 
fields (or Shift + Tab to go in reverse).
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Make Mistakes!

Don’t be afraid to make an error in Sketch, as you can always undo one 
or several steps with Cmd + Z. If you overdo undoing and want to redo 
actions, press Shift + Cmd + Z. To see what you’re about to undo or redo 
this way, have a look at the top two entries of the Edit menu in the 
menu bar (Fig. 2.12). Sketch sometimes combines multiple steps into 
a single action. For example, if you add a shape and resize it several 
times, pressing Cmd + Z reverts back to the initial size of the element.

 

Fig. 2.12: Sketch shows what you are about to un- or redo in the Edit menu.
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A Colorful Life

For the fill color of the rectangle we will 
choose black, so click on the box with 
the default gray in the Fills area of the 
inspector to bring up a color dialog. To 
set black as the fill color, drag the little 
circle indicator to the bottom-left of the 
color field (Fig. 2.13). If you are more 
familiar with hexadecimal values you 
could also enter “#000” or use the HSB 
color space to define the color. To 
change to this color space click on the 
letters “RGB.” 
 
Lastly, this dialog also lets you change 
the opacity (A for alpha). Let’s enter “50” 
(for 50%) here right now (don’t forget to 
always press Enter to confirm the 
change in an input field). However, 
there’s quicker way to change the 
opacity: instead of opening the color 
dialog, you can use the numerical keys 1 
to 0 (1 = 10%, 5 = 50%, 0 = 100%, and so on). While this changes the general 
opacity of a layer, the alpha value only affects the color itself, so you should 
ideally set either one or the other.

Quick tip: Layers can have multiple fills and borders. To toggle lay-
ers use F; for borders press B.

Fig. 2.13: The color dialog gives you multi-
ple ways to pick a color. For now drag the 
circle indicator to the bottom-left to get 
black as the fill color.
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Multiple Properties

Most of the properties in the inspector, 
like fills, borders or shadows, are not 
limited to a single type, but can be applied 
in various layers and stacked on top of 
one another. It’s possible to reorder them 
by dragging them around, or to remove a 
property entirely by dragging one out 
to the left. 

A contextual menu (right-click) also 
provides this, as well as the option to 
duplicate a property. To add a new prop-
erty, simply click on the + icon; to switch 
it off temporarily deselect the checkbox in 
front of it. All disabled properties can be 
removed altogether with Layer → Styles 
→ Remove Unused Styles from the 
menu bar. 

Apart from the color, each property has a 
blending mode (more on this in chapter 7 
on page 270ff.) and an opacity setting. For 
fills, the opacity can be changed directly 
in the main hierarchy of the inspector; for 
border and shadows you need to adapt the alpha value of their color in the 
color dialog, where you can also change the blending mode.

Fig. 2.14: You can stack multiple 
borders and shadows on top of 
each other.
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The Title

As the name suggests, the title bar will mostly hold the title of the app, 
so let’s add it now. Press T for a new text layer, click anywhere within the 
title bar and enter “Vilsalpsee in Tannheim” (Vilsalpsee is the name of the 
Vilsalp lake in Tannheim). Leave the text edit mode with Cmd + Enter (or 
Esc). For the font family I chose the beautiful font Avenir Next, that comes 
bundled with your Mac. Click into the Typeface field in the inspector, 
enter “avenir n” and select it from the list with a double-click. Every font 
used in your design can be chosen here. Lastly, change the color of the text 
layer to white. Instead of using the color field, click on the last preset in the 
Global Colors area.

The font’s size should be 21px, with “Regular” as the weight. Select a 
centered Alignment using the second icon from the left. (The other icons 
here mean left-aligned, right-aligned and justified.) Finally, use the smart 
guides and drag the text layer to the horizontal and vertical center of the 

Quick tip: A quick way to change the properties of a text layer is to 
press Cmd + T, which enters the Typeface field. Enter its name (or 
portions of it) and select the font you need with the down arrow key.

Quick tip: Change the opacity of a layer with the numerical keys 1 to 
0 (1 = 10%, 5 = 50%, 0 = 100%, and so on). To set an intermediate value 
like 23%, press 2 and 3 successively.
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background. You will probably need to move it down a bit with the arrow 
keys on the keyboard afterwards, as the vertical center of text and shapes is 
mostly not the same.

 Fig. 2.16: The correct properties for the title in the title bar.

Quick tip: Like most apps, to underline text, press Cmd + U; to make 
it bold, use Cmd + B. You can also apply this styling to portions of a 
text layer: press Enter to go into the text edit mode, and select the rel-
evant part with the mouse. If you click on the gear icon at Options 
next to the text color you can also apply a double underline or strike 
the text through. It’s also possible to create a quick bulleted or num-
bered list here.
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Layer Organization

The earlier you start to organize, group and rename your layers in the lay-
ers list, the better. Trust me: you don’t want to end up with a mess of “Rect-
angle 12” and “Oval 23”, all in the main layer hierarchy. To prevent that right 
from the start, select both our existing layers: either hold Shift and click on 
both, or drag a selection around them on the canvas with the mouse. Then 
hit Cmd + G to create a new layer group, which contains these two layers.

Groups act like folders, in that they combine various layers for better 
organization. They can be nested indefinitely, which means you can put as 
many groups inside groups as you want. Apart from combining layers, 
groups also let you move and resize all of their contents at once. If you 
want to see the contained layers of a group you can expand (and collapse) it 
with the little disclosure triangle on the left. Alternatively, hold Cmd and 
click on one of its layers on the canvas. An artboard is also a group, but at 
the highest level. 

Quick tip: To select the contents of a group instead of the container 
hold Cmd while you drag a selection.

Quick tip: To ungroup a layer group, press Cmd + Shift + G.



32

Chapter 2

Use this disclosure triangle now to 
reveal the contents of the group and 
use Cmd + R to rename it to “Title bar.” 
Before you confirm the change with 
Enter, press Tab twice to jump to the 
background layer (“Rectangle”) and 
change this one to “BG.” You can rapidly 
rename multiple layers like this. Press 
Enter to finish the renaming process.

Lovely Imagery

We’ll now add a beautiful eye-catching background image, one that shows 
the scenery around the Vilsalpsee. I got it directly from Austria’s tourism 
website10, and the related image and text archive11, which lets you choose 
from thousands of pictures of Austria. If you are not attached to Austria’s 
scenery like me, you can choose other beautiful imagery at pexels.com, 
visualhunt.com or unsplash.com. 

10	 http://www.austria.info
11	 https://views.austria.info/

Fig. 2.17: The layer hierarchy in the layers 
list so far.

Quick tip: To enter the currently selected layer group and choose 
the first layer, hit Enter. In turn, Esc not only leaves it again but also 
selects the group itself. Hitting Tab lets you cycle through other 
groups in the layers list.

http://www.austria.info
http://www.austria.info
https://views.austria.info/
http://pexels.com
http://visualhunt.com
http://unsplash.com
http://www.austria.info
https://views.austria.info
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Once you have found the perfect image, 
simply drag it from the browser to Sketch 
— it’s as simple as that. Depending on 
where you were in the layers list when you 
inserted the bitmap image, it may cover 
your title bar now. It also doesn’t belong in 
the “Title bar” group, so with the mouse 
drag it out above the group itself. 

Pay attention to the level of nesting, visu-
alized by a line with a circle to the left. As 
an additional point of reference, the group 
where the dragged layer ends up if you 
release the mouse button is always high-
lighted with a blue border (Fig. 2.18). Use 
these indications to make sure the image layer is still within the artboard 
when you drag it. Rename it to “BG image” using Cmd + R.

Fig.2.18: A line with a circle on the left 
indicates the position where the layer 
ends when you finish dragging it. 
Moreover the respective layer group (or 
artboard) gets a blue border.

Quick tip: Images can be added in different ways in Sketch. The 
most straightforward way is to drag one in from another application, 
like the browser or the Finder. You can also insert one with Insert → 
Image… from the menu bar, or copy it from the source (either with 
a right-click and the appropriate command or Cmd + C) and paste it 
with Cmd + V in Sketch.
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In addition to the mouse you can use the keyboard to reorder layers 
quickly in the layers list. To move the image below the “Title bar” group, 
press Alt + Cmd + Down (Alt + Cmd + Up goes the other way). It’s often much 
easier and precise to use these combinations instead of the mouse.

Fig. 2.19: The correct position of the background image in the layers list.

What you will notice on the canvas — not only for bitmaps, but also text 
layers and shapes — is that they have small square handles (known as 
selection handles) at their edges and on each side: they allow you to resize 
the layer from the respective side or edge with the mouse (Fig. 2.20). Use 
them to change the size of the image until it fits nicely into the artboard 
and shows the essential part. You may also need to reposition it so that it 
covers the whole available space.

Quick tip: To move a layer to the absolute front (the highest possible 
position on the artboard or within a group) press Ctrl + Alt + Cmd + Up; 
for the back use Ctrl + Alt + Cmd + Down.
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Whenever you insert a bitmap its aspect ratio is automatically maintained 
when you resize it on the canvas. This is indicated by the closed lock 
symbol between the width and height fields in the inspector (Fig. 2.20). To 
change this behavior, click on the lock icon, which opens it. Now you can 
change the width and height independently of each other on the canvas. 

 

Fig. 2.20: Left: The handles, that allow you to resize layers on the canvas.  
Top-right: The lock icon, which maintains the aspect ratio of layers.

Quick tip: To reset an image to its original size, select Layer → 
Image → Set to Original Size from the menu bar. If you want to 
replace it with another image, select Replace… from this menu. 
Lastly, for quick image optimization, pick Reduce Image Size, 
which reduces both the quality and the file size to keep your doc-
ument size small. For more robust image optimization, use a dedi-
cated tool like ImageOptim.1

 https://imageoptim.com

https://imageoptim.com
https://imageoptim.com
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More Text

We’ll now add two text layers: one for the heading of the attraction, and 
another one for its description. For the heading, make sure that the back-
ground image is selected (so that the text layer is placed above it) and press 
T to insert a new text layer with a click on the canvas. Enter something like 
“On the go at the Vilsalpsee in the Tannheim Valley” with a break in the 
middle to get two-lined text, and confirm it with Cmd + Enter (or Esc).

For the heading, select “Regular” as the weight, center its Alignment, and 
increase the size with Alt + Cmd + = until you reach “24” (use Alt + Cmd + – to 
make it smaller). Drag it around until it centers horizontally and vertically 
to the artboard with the help of the smart guides, but move it a bit up after-
wards (Fig. 2.21).

Quick tip: Note that Sketch remembers the text style of previous 
text layers and automatically applies them to new ones. To manually 
transfer the style of one element to another, right-click and select 
Copy Style and Paste Style. This not only works for text layers but 
also to duplicate the properties from one shape to another.
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Fig. 2.21: The properties of the heading. Choose a color that has enough contrast to the image. 

For the description’s text layer we will 
take another approach. Instead of click-
ing after you have pressed T, you can 
also drag a text border. Start with this 
border just below the heading at the 
left edge of the artboard; go all the way 
down to the bottom-right, but make it a 
bit narrower than the artboard itself. 

Quick tip: Change the font size rapidly with the mouse by dragging 
left or right at the Size label below the input field. This also works for 
other numerical inputs. 

Fig. 2.22: You can drag the label of input 
fields to change their value.

More Text

We’ll now add two text layers: one for the heading of the attraction, and 
another one for its description. For the heading, make sure that the back-
ground image is selected (so that the text layer is placed above it) and press 
T to insert a new text layer with a click on the canvas. Enter something like 
“On the go at the Vilsalpsee in the Tannheim Valley” with a break in the 
middle to get two-lined text, and confirm it with Cmd + Enter (or Esc).

For the heading, select “Regular” as the weight, center its Alignment, and 
increase the size with Alt + Cmd + = until you reach “24” (use Alt + Cmd + – to 
make it smaller). Drag it around until it centers horizontally and vertically 
to the artboard with the help of the smart guides, but move it a bit up after-
wards (Fig. 2.21).

Quick tip: Note that Sketch remembers the text style of previous 
text layers and automatically applies them to new ones. To manually 
transfer the style of one element to another, right-click and select 
Copy Style and Paste Style. This not only works for text layers but 
also to duplicate the properties from one shape to another.



38

Chapter 2

This creates a textlayer with a fixed width, instead of one set to Auto, 
which is the default behavior. While you need to make manual line breaks 
with Enter for auto-width text layers, the text breaks automatically if you 
reach the right edge for fixed layers. You can always change between these 
behaviors at Width in the typography area of the inspector. Such a fixed 
text layer also ensures that the text is automatically cut off at the bottom, 
creating text with a defined height.

I’ve taken content some from 
another tourist website, but it’s 
up to you to find your own 
appropriate text. You could visit 
blindtextgenerator.com12 for 
dummy text. (We will look at 
some ways to insert blind copy 
right within Sketch with the 
help of plugins later). Set a font 
size of “16,” color it black, and 
move it to the center of the 
artboard (with the help of the 
smart guides). Finally, drag it below the heading in the layers list, and 
resize its text frame with the bottom handle on the canvas so that it doesn’t 
grow out of the artboard. To finish the text layers, select both of them with 
a Shift-click, create a group with Cmd + G and rename this group “Content.” 
Make sure it is below the title bar but above the image.

Quick tip: For a quick way to resize auto text on the canvas, drag its 
bottom handle. Please note that it is reset to the default line spacing 
with this action.

12	 http://www.blindtextgenerator.com/

Fig. 2.23: The properties of the text layer. Dragging 
a text border automatically sets it to Fixed, but you 
can always change the behavior with the buttons at 
Width.

http://www.blindtextgenerator.com/
http://www.blindtextgenerator.com
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Background

As you can see, this descriptive text is 
unreadable, so let’s create a solid back-
ground layer for it (please note that it is 
already present in Fig. 2.23  for reasons of 
clarity). Press R for a rectangle, start at the 
leftmost edge just below the heading, and 
drag it all the way down to the bot-
tom-right corner of the artboard. If you 
didn’t catch the left or bottom-right edge 
precisely, you can drag the layer itself or 
its handles to resize it until you have the 
required result.

Let’s change its fill color to white, but 
this time we will use the frequently used 
colors area of the color dialog (Fig. 2.24). 
You’ll see it when you click on the fill 
color in the inspector: it’s right below the 
color field at the right-hand side. This 
shows all the colors that have been used in the document so far, which can 
come in handy. Pick the white field here. Now drag this background layer 
into the “Content” group in the layers list, right below the two text layers, 
and rename it to “BG” (Fig. 2.26). 

 

Fig. 2.24: The Frequent Colors 
Used area in the color dialog.
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Fill Types, Part 1

Shapes can not only have solid fills but also a number of other fill 
types, half being gradients (more on them later). The remaining two 
modes are:

Pattern

This lets you fill a layer with a custom image, which can be a good alterna-
tive to a separate image layer. Use the drop-down to define how the fill is 
applied:

•	 Fill expands the image, so that it fully covers the layer, and thus gets 
cut off if the aspect ratio of layer and fill don’t match. It’s similar to 
the cover keyword of the background-size property in CSS.

•	 Fit always shows the whole bitmap, possibly leaving some uncov-
ered room. For that it is the same as the contain keyword of back-
ground-size.

•	 Stretch in turn covers the element in both dimensions and may dis-
tort the image if the aspect ratios are not the same.

•	 Tile in the end repeats the image at its original size and can be sized 
with the slider below, which is perfect for patterns. In each case the 
pattern fill is centered to the layer in both dimensions, with no way to 
change this alignment.

For an image fill the setting Fill is appropriate most of the times. To apply 
an image, select Choose Image…, paste or drag it from another applica-
tion into the preview area on the left, or copy it from the layers list.
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Fig. 2.25: The different types of a pattern fill: Fill, Fit, Stretch, Tile (from left to right).

Noise

This type makes otherwise solid fills more realistic and is best applied as a 
separate layer on top of others. Noises of varying colors are available here. 
Original retains the color of the layer below, but since you typically apply 
noise at a very low intensity, it doesn’t matter which type you choose in 
the end.
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From now on, when you are not within the 
“Content” group in the layers list but want 
to select one of its text layers, you need to 
hold Cmd when you click. A basic rule in 
Sketch: when you are within a layer group, 
you can select its contents with a simple 
click; but if you are in another group or on 
the artboard itself, hold Cmd before you 
make a click to select nested layers.

To prevent the background layer from being 
selected accidentally in future, we will lock 
it now. Select it with a Cmd-click and press 
Shift + Cmd + L. 

A little lock icon to the right of the layer 
name in the layers list represents this state. 
You can also hide a layer with Shift + Cmd + H 
(represented by a little eye icon). 

You won’t be able to switch to these layers 
with Tab in the layers list anymore, but need 
to select them with the mouse until you 
reset these constraints.

Fig. 2.26: The progress of our design 
so far.

Fig. 2.27: A hidden and a locked 
layer in the layer list.

Quick tip: To measure the distance between nested layers, hold Alt 
and Cmd together and point to another layer. This also works across 
different groups.
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A Proper Grid

The final element we’ll tackle for now is 
the red booking button, which lets you 
visit this lovely place and book a tour 
there. To prevent a random placement 
of the elements in the design, we will 
use an 8-pixel grid from now on. This 
means for all the dimensions and 
spacing of the layout, multiples of eight 
are used for a consistent look. A grid 
also makes sure that we get full pixels 
for all elements.

Don’t confuse this, however, with a 
traditional grid with different columns 
from UI design, as that is called layout 
in Sketch. On the contrary, a grid is just 
a series of intersecting horizontal and 
vertical lines with a defined spacing.  
Set up a grid by choosing View → Grid Settings… in the toolbar. In the 
dialog, set 8px for the Grid block size and 0 for Thick lines every … 
blocks. You can also customize the color of the lines, but the default  
setting is just fine.

Quick tip: To toggle the grid on and off, use Ctrl + G.

Fig. 2.28: Our shiny new 8-pixel 
grid, which we will use to align all 
elements to.
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Why a Grid?

Whenever you design something it’s a good idea to use some kind of grid. 
This adds some constraints to your process, and you’ll be less inclined to 
place elements at arbitrary positions. You’ll also won’t have to think about 
the dimensions of elements and their spacing, because they will always be 
multiples of each other. Furthermore, this approach helps your developers 
since they can build on a reliable design system and don’t need to think too 
hard about the dimensions, but rather can decide on them autonomously 
as all dimensions are derived from a single value.

For app design, an 8-pixel grid is particularly useful as many screens are 
based on multiples of eight; it can be easily divided and multiplied, and 
doesn’t result in uneven numbers. However, in web design a grid with big-
ger units is more useful owing to larger screen sizes. Since one 1em is 16px 
by default, it’s a good idea to start from this basic unit or use a multiple of 
it. Spec has a great article about 8-point grids13 if you need more convinc-
ing.

The Booking Button

Before you can add the button, you need to lower the text box of the 
description so there is enough free space. Select the text layer with a 
Cmd-click and drag its bottom handle upwards until you have a gap of about 
90px between it and the bottom of the artboard. Use the smart guides with 
Alt to assess this spacing.

Now to the button itself. Add a new rectangle in the space we just freed up, 
but don’t worry too much about size or placement, as we will change most 
of these properties in the inspector, often a faster and more precise way. 

13	 http://smashed.by/sketch-8ptgrid

http://smashed.by/sketch-8ptgrid
http://smashed.by/sketch
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Jump to the X position field with Alt + Tab 
and enter “24,” as it should have this 
spacing from the left edge (3 × 8).

To place it the same distance from the 
right edge, we will use the mathematical 
capabilities of Sketch: calculations can 
be made directly in the input fields. We 
have an artboard width of “360px” and want 
“24px” spacing on both sides; entering “360 
− 24 − 24” gives us a width of “312” (Fig. 
2.29). Remember, that absolute and relative 
values can also be combined, so you could 
also write “100%” instead of “360.”

For the height, insert a multiple of 8: “48.” 
Although we could also use the inspector 
to calculate the placement on the Y axis 
let’s use the grid on the canvas and drag 
the button until it snaps at three grid units 
from the bottom (24px). Choose a bright red 
as the fill color to bring all the attention to 
this button (I used “#D8202D”). Save it as a 
Document color for later reference with 
the + icon at the bottom of the color dialog 
(Fig. 2.30).

Whereas Document colors are unique to a document, Global colors are 
available in the entire application. Colors can be saved to both in the same 
way and deleted by dragging them out of the color dialog, or by selecting 
Remove after a right-click.

Fig. 2.29: You can make calculations 
right in the input fields.

Fig. 2.30: Save colors to the Docu-
ment Colors in the color dialog for 
later reference.

Why a Grid?

Whenever you design something it’s a good idea to use some kind of grid. 
This adds some constraints to your process, and you’ll be less inclined to 
place elements at arbitrary positions. You’ll also won’t have to think about 
the dimensions of elements and their spacing, because they will always be 
multiples of each other. Furthermore, this approach helps your developers 
since they can build on a reliable design system and don’t need to think too 
hard about the dimensions, but rather can decide on them autonomously 
as all dimensions are derived from a single value.

For app design, an 8-pixel grid is particularly useful as many screens are 
based on multiples of eight; it can be easily divided and multiplied, and 
doesn’t result in uneven numbers. However, in web design a grid with big-
ger units is more useful owing to larger screen sizes. Since one 1em is 16px 
by default, it’s a good idea to start from this basic unit or use a multiple of 
it. Spec has a great article about 8-point grids13 if you need more convinc-
ing.

The Booking Button

Before you can add the button, you need to lower the text box of the 
description so there is enough free space. Select the text layer with a 
Cmd-click and drag its bottom handle upwards until you have a gap of about 
90px between it and the bottom of the artboard. Use the smart guides with 
Alt to assess this spacing.

Now to the button itself. Add a new rectangle in the space we just freed up, 
but don’t worry too much about size or placement, as we will change most 
of these properties in the inspector, often a faster and more precise way. 

13	 http://smashed.by/sketch-8ptgrid

http://smashed.by/sketch-8ptgrid
http://smashed.by/sketch
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Quick tip: To resize an element from a particular side in the inspec-
tor, append the following letters to the width when you change it. 
Add c to change the size from the horizontal center and r from the 
right. For the height, you can append m (middle) to resize from the 
vertical center, and b from the bottom.

Easy Rounded Corners

Instead of a rectangle, we could have used a rounded rectangle with U 
from the start, but since we need to adapt its border radius anyway, this 
didn’t make much sense. Bring your attention to the Radius slider in the 
inspector now. Drag it all the way to the right to get fully rounded, semi-
circular edges for the button. Don’t worry that this value is larger than the 
actual size of the element: Sketch won’t display the roundness bigger than 
possible. Although the maximum size seems to be “100,” you can actually 
enter much bigger values like “500” to account for larger elements. It’s even 
possible to have different radii on each corner. To achieve that, press Enter 
while the shape is selected or double-click on it, which enters the vector 
point mode. This allows you to tweak the different points of a shape and 
also their border radius.

Have a look at the Corners field now, which is basically the same as the 
Radius input, but for individual points. Tweak it to “10” and see how the 
radius of the top-left point changes on the canvas (Fig. 2.31). When you 
leave the vector point mode by pressing Esc twice, you’ll see that the con-
tent of the radius field changed significantly to “10/100/100/100.” Just like 
the border-radius property in CSS, each value represents a corner with 
the order being top-left, top-right, bottom-right, bottom-left. With this 
little trick you don’t need to enter the vector point mode at all to change 
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the radius of individual edges — you can do it right here. Since we need an 
equal radius on each side, enter “100” again. Please note that the corners 
slider only works for Straight vector points.

 

Fig. 2.31: You can use the Corners field in the vector point mode to change the border radius of points 
individually

The Button Text

For the label of the button, add another text layer with T: type “Book a tour.” 
Choose Bold for the font weight and “21” for the size. To give it more room 
to breath, change the Character Spacing to “1,” which basically represents 
the tracking of the text. After that drag the text to the center of the but-
ton, visualized by the smart guides, but move it a few pixels down with 
the arrow keys afterwards for perfect alignment. Also make sure that the 
alignment of the text layer itself is set to Center with the second button 
at Alignment in the inspector, so that it remains centered if you need to 
change the text later. Rename the button shape to “BG” and combine it into 
a “Button” group with the button text. If it isn’t already there, drag this new 
group into the “Content” group in the layers list and make sure it is above 
the “BG” layer. Lastly, change the text color to white so that it is more visi-
ble on the red background.
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Picking Colors

A quick way to change the color of a layer is to use the color picker 
(Ctrl + C). It lets you choose a color from anywhere on the screen, even out-
side Sketch. You can not only adjust the color of shapes, but also text layers, 
borders and shadows. However, for borders and shadows the respective 
color dialog needs to be open.

Fig. 2.32: The built-in color picker (accessible with Ctrl + C) is the easiest way to set the color of an element

Although Sketch offers such a great feature, I prefer to use a separate app 
as well. One I’ve trusted for years is ColorSnapper.14 Often you’ll see on a 
website a great color or color combination that you either want to save for 
later or immediately use in Sketch. With ColorSnapper, you can define 
a key combination (like Alt + Cmd + C) to open a similar color picker to 
Sketch. With a click, the color is saved to the clipboard in the hex format 
and can be easily inserted into the hex field in the color dialog of Sketch. 
The great thing is, you get a history of all the colors saved so far. Moreover, 
it gives you a handy dialog where each color can be copied in every possi-
ble form, like RGB, HSL or even Swift’s NSColor format. 

Use the promo code “SKETCH-HANDBOOK” to get 15% off when you buy 
ColorSnapper from colorsnapper.com. Please note that the promotion is 
limited to 100 users only, on a first-come, first-served basis.

14	 http://colorsnapper.com

http://colorsnapper.com
http://colorsnapper.com
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An Arrow to the Heart

The last element for the button is a right-pointing arrow at the right side 
that will be based on a triangle shape. Go to Insert in the toolbar, select 
Triangle from Shape, draw one and change its size to 16×12px to adhere to 
our 8px-grid. To change from a up-pointing arrow to a right-pointing one, 
enter “90°” into the Rotate field in the inspector. Alternatively you can hold 
Cmd (to temporarily enter the rotate mode) and Shift (to constrain to 15° 
steps), and change the rotation with the bottom-right handle on the canvas. 
Drag it until you see “–270°” at the tool tip or in the Rotate field.

Quick tip: As soon as you rotate an element, all the changes to its 
width and height in the inspector are also mapped to this rotation. 
This becomes especially apparent if you change the angle close to 90° 
(or 270°), as you are actually altering its height instead of its width 
now (and vice versa). To return to the default behavior with the 
correct axes, you need to flatten the element with Layer → Paths → 
Flatten from the menu bar.

To create an actual arrow change from a fill to a border (deselect the check-
box for one and select it for the other): for the Position select Center, and 
the Thickness should be “4.” Change the border color to white (Fig. 2.33). 
Since the fill is deactivated, you can use the color picker with Ctrl + C right 
away and don’t need to click on the color field first. 
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As we still have one line too many to represent an arrow, we need to cut 
away the left segment. This can be achieved quite easily with the Scissors 
tool, that is either accessible in the menu bar under Layer → Paths → 
Scissors or can be added to the toolbar as an icon.

 

Fig. 2.33: The base of the arrow is a triangle with a border instead of a fill.
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Opening and Closing Shapes

Every element you add in Sketch consists of a series of points connected 
with lines — vectors. To see these individual segments, enter the vector 
point mode with a double-click on the shape or by pressing Enter. The point 
that is selected now represents the start point of the shape. If you want 
to open the path, click on Open Path in the top-right of the inspector to 
remove the segment between the start and the end point. This may be not 
immediately apparent if a fill is applied, as the shape stills seems to be 
closed, but as soon as you switch from a fill to a border you notice that this 
segment has been cut away.

 

Fig. 2.34: When you open a path/shape, the segment between the start and the end point gets removed.

To open a path at a specific point, use the scissors tool from Layer → 
Paths → Scissors in the menu bar and click on the respective segment. 
Once a shape is opened and you enter its vector point mode, the end point 
gets selected. 
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A line that extends from it to the mouse pointer indicates that you can 
continue the path now — or close it manually by clicking on the start point. 
If you are unsure about the placement of this last point you can still drag it 
before closing the path.

The scissors tool can not only cut away just one segment but also multi-
ple ones; for example, to create a semicircle from a circle (Fig. 2.35, left). 
Alternatively, you can also select individual points of the shape with the 
mouse and hit Del or Backspace to remove them. However, this doesn’t 
open the shape, but only removes the adjacent segments. Instead of using 
the mouse to select a point you can also press Tab and Shift + Tab to cycle 
through them.

 

Fig. 2.35: Open shapes to create entirely new forms.
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Select the scissors tool now and click on the left part of the triangle to cut 
away this segment and get an arrow (Fig. 2.36). Although it looks better 
now, we still don’t have the desired result, as neither the ends nor the 
tip are rounded. This becomes even more apparent when you zoom in 
to the arrow width Cmd + 2: it still has sharp edges, but we have rounded 
edges in mind.

To compensate for that we can use the borders options, accessible through 
the little gear icon in the Borders section of the inspector. Here you can 
not only change the Ends and Joins (the tip in our case), but also add start 
and end arrows and create dashed or dotted lines. Unfortunately, the arrow 
options are quite limited, so you will most likely draw your own arrows or 
import an icon. Set both the ends and joins now to rounded, represented by 
the middle icons (Fig. 2.36). The last icon for the ends lets the line jut out by 
half of its width; the last option for the joins gives you beveled edges. Leave 
both the dialog and the scissors tool by pressing Esc twice. 

 

Fig. 2.36: Cut the left segment of the triangle with the Scissors tool (left), and enter the border options 
toset both the Ends and Joins to Rounded (right).
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With these changes, the arrow is ready and you just need to align it to the 
vertical center of the background with the smart guides and move it three 
grid units (24px) in on the right-hand side. Then drag it into the “Button” 
group in the layers list and rename it to “Arrow” with Cmd + R. To see the 
full artboard again, select it in the layers list and press Cmd + 1. For a zoom 
level of 100% press Cmd + 0 subsequently.

 

Fig. 2.37: The finished button.
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Dashed and Dotted Lines

Apart from the settings already mentioned, the border options also allow 
you to create dashed or dotted lines. After you have opened the dialog with 
a click on the gear icon (see Fig. 2.36), bring your attention to the bottom 
part with the Dash and Gap fields. The dash represents the length of the 
line segments in a dashed line, the gap the spacing in between. These 
values relate directly to the border’s thickness, and are also influenced by 
its position. For a dashed line, set the dash to at least the same size as the 
border thickness. The gap should be even bigger; the larger this value, the 
larger the space in between the line segments (Fig. 2.38, top) 
 
To create a true dotted line with rounded segments, switch to a center posi-
tion for the border, change to rounded ends (the middle icon), set the dash 
to “1” and the gap higher than the border’s thickness (Fig. 2.38, middle). You 
can also combine the values and use all four input fields to create a dot-
dashed line (Fig. 2.38, bottom).

 

Fig. 2.38: The required values to set a dashed, dotted or  
dot-dashed line are based on a border thickness of “12px”.
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Adhere to the Grid

Since we always want to adhere to the grid, let’s tweak all the other ele-
ments to line up with it now. First, the background of the content, which 
should have a Y position of “344.” Select it with a Cmd-click and enter this 
value into the Y position in the inspector. Then drag the bottom handle of 
the layer on the canvas all the way down to the bottom of the artboard, so 
that it fills the available space again. After that, select the heading and have 
a look at its line spacing. With a value of “33” it almost adheres to our 8px 
grid and we just need to lower it to “32” (4 × 8px). If you ever need to go 
back to the default, delete the current value. This also goes for the charac-
ter spacing.

Now move the baseline of the second line of this heading three grid units 
(24px) up and away from the white background of the content. The easiest 
way is to use the arrow keys on the keyboard. You might want to combine 
them with Shift for 10px steps, but for the final alignment dismiss this key 
again. With the line height being a multiple of the grid you’ll see now that 
both lines sit perfectly on the grid. 

Quick tip: Use the up and down arrow keys within input fields to 
change their values quickly. Add Shift for 10px increments, hold Alt 
instead to go up or down in steps of 0.1.

Change the line spacing of the body copy to “24” and move it with the 
arrow keys until its first line sits on the fourth grid line within the white 
background . You may also need to center this text layer and make it nar-
rower, so that it doesn’t stick to the margins of the artboard. Grab the left or 
right handle, but hold down Alt as well to resize the layer from the center. 
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Make sure there is a gap of three grid units (24px) on each side. Lastly, 
change its height to “192” in the inspector and everything is perfectly 
aligned to the grid. This way you not only stop yourself from placing the 
elements arbitrarily, but also make your developers’ lives much easier.

 

Fig. 2.39: Left: The correct spacing of the remaining elements. Right: The finished details screen.
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Relative Line Spacing

By default, the line spacing of text is relative to the font size and depends 
on the font. If you resize a text layer it adapts accordingly. However, the 
moment you change the line spacing manually this relationship is gone 
and always stays the same independently from the font size. You can’t have 
a text layer with 24px type and an adapted line spacing of 1.5 (36px) that 
automatically adjusts to 28px and the same relative line spacing of 42px 
(28×1.5) if you resize it.

 

Fig. 2.40: Top: Default, unaltered line spacing. Bottom: Line spacing altered to 36. When you resize the 
text layer, it stays the same and is not relative to the font size anymore. 

A workaround to maintain this custom relationship is to use the Scale… 
dialog. Press Cmd + K to open the dialog and use the arrow keys to adjust 
the size in the Scale field. Pay attention to the Size field of the text in the 
inspector until you reach the target font size. You can also hold Shift to go 
in increments of 10. Since Sketch doesn’t allow fractional numbers here 
you might need to adjust the font size by hand afterwards. It’s not perfect 
but at least it’s a good starting point.
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Fig. 2.41: A workaround is to use the Scale dialog with Cmd + K. Now the line spacing changes accord-
ing to the font size.

Alternatively you can change the font size as usual and adapt the line 
spacing afterwards by pasting this new size into the line spacing field and 
multiplying it by the desired line height. To get a line height of 1.5 for 24px 
text, insert “28 * 1.5” into the field, which results in a value of “42.”

 
Fig. 2.42: Alternatively you can adapt the line spacing manually later with the targeted line spacing 
in mind.
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The Power Of Iterations  
And Artboards

You just completed the first iteration 
of the details screen of the app and 
already learned a ton about Sketch. 

But, as you know, a design is never finished, 
so let’s keep iterating. Sketch makes it very 
easy to iterate on a design by duplicating the 
artboard. Select it in the layers list (or with a 
click on its name in the canvas) and press 
Cmd + D, which places a copy right next to it. 
Rename it to “Visit Austria Detail Variation” 
with Cmd + R and confirm with Enter.

If you share my preference for even num-
bers you may enjoy that an offset of 100 
pixels has been used. Trust me, whenever 
you see a different spacing you will feel the 
urge to adapt it to this lovely even number. 
Alternatively you can also hold Alt and drag 
the current artboard in any direction to 
create a copy. When I duplicate artboards 
and iterate on a design I always follow this 
pattern: if I simply want to try out a new ele-
ment or slight change, I will go to the right 
with Cmd + D to create a copy. For a major 
change or different element I will duplicate 
the artboard to the bottom with an Alt-drag 
and keep iterating to the right from there.

Fig. 3.1: The variation of the details 
screen we are going to create.

                                                                                    

This way I often end up with dozens of artboards, but that’s OK as it lets 
you try out an unlimited number of ideas quickly, one of the big strengths 
of Sketch. Have a new idea? Make a new artboard! Just keep in mind that 
too many artboards on the canvas can slow down Sketch. Before things get 
out of hand consider making an entire new page and iterate from there. 
Read more about pages on page 119 in this book.

Quick tip: To prevent Sketch from adding “Copy” to the names of 
duplicated artboards and layers, go to Sketch → Preferences in 
the menu bar (or Cmd + ,), navigate to Layers and deselect Rename 
duplicated layers. I’d also advise you to do the same for Offset 
duplicated layers as it’s easier to move duplicate layers from the 
initial position than from an offset position.

Some Variation

For a variant of the “Details” page we will try out another tourist attraction 
with a different image and text to see how our design holds up (fig. 3.1). 
First hide the grid with Ctrl + G so that we have a clear view of the back-
ground image. Instead of a dedicated image layer we will take a different 
approach with a pattern fill. Select the former image in the layers list and 
delete it with Del (remember we can’t select it on the canvas as it is locked). 

Quick tip: Press Fn + Left (arrow key) to cycle through the artboards 
on the canvas. Use Fn + Right to go in reverse.

Fig. 3.2: The type of modification 
determines in which direction the 
artboard should be duplicated 
when you iterate.
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This way I often end up with dozens of artboards, but that’s OK as it lets 
you try out an unlimited number of ideas quickly, one of the big strengths 
of Sketch. Have a new idea? Make a new artboard! Just keep in mind that 
too many artboards on the canvas can slow down Sketch. Before things get 
out of hand consider making an entire new page and iterate from there. 
Read more about pages on page 119 in this book.

Quick tip: To prevent Sketch from adding “Copy” to the names of 
duplicated artboards and layers, go to Sketch → Preferences in 
the menu bar (or Cmd + ,), navigate to Layers and deselect Rename 
duplicated layers. I’d also advise you to do the same for Offset 
duplicated layers as it’s easier to move duplicate layers from the 
initial position than from an offset position.

Some Variation

For a variant of the “Details” page we will try out another tourist attraction 
with a different image and text to see how our design holds up (fig. 3.1). 
First hide the grid with Ctrl + G so that we have a clear view of the back-
ground image. Instead of a dedicated image layer we will take a different 
approach with a pattern fill. Select the former image in the layers list and 
delete it with Del (remember we can’t select it on the canvas as it is locked). 

Quick tip: Press Fn + Left (arrow key) to cycle through the artboards 
on the canvas. Use Fn + Right to go in reverse.

Fig. 3.2: The type of modification 
determines in which direction the 
artboard should be duplicated 
when you iterate.



62

Chapter 3

Then create a rectangle that spans the 
upper part of the artboard, up to the 
content area. The easiest way to move it to 
this bottom position in the layers list is to 
press Ctrl + Alt + Cmd + Down. Like before, 
name it “BG image.”

To apply the image fill, click on the fill 
color of this layer in the inspector and 
navigate to the second to last type, the pat-
tern fill (fig. 3.4). There click on Choose 
Image… to select an image on your hard 
drive. Alternatively, you can drag it from 
another application into the preview area 
on the left, or copy and paste (Cmd + C and 
Cmd + V) a layer from the layers list. Now 
change the drop-down below to Fill or Fit. 
To show the relevant part of the picture 
resize the layer and move it around until 
you are satisfied. Alternatively you can 
also set it to Tile and use the slider below 
to adapt the size.

The advantage of a pattern fill is that you 
can easily crop it by resizing the rectangle. 
However, images set up this way are 
always centered to the shape (with the Fill 
setting) or the top-left edge (with Tile), 
with no chance to change this alignment. 

Fig. 3.3: The layer for the image 
should fill the upper part of the 
artboard.

Fig. 3.4: The correct settings for the 
image fill.
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Finally, it’s quite hard to assess their original size, so there’s the possibility 
that you use them at a much bigger size, which affects the image quality. 
To circumvent that, switch to tile temporarily to see the original size.

Change the text of the title bar, heading                                                                 
and body copy to something different                                                                      
for some variation. For the heading, we’d 
better switch to Fixed text before so we don’t 
need to make a manual line break anymore.

Apart from that, everything looks fine and 
we can keep iterating, tweak the design and 
add some further elements. Select the initial 
design with the Vilsalpsee, hold Alt and drag 
it to the bottom with a spacing of 100px — 
remember? Finally, name it “Visit Austria 
Detail v2.”

 

Fig. 3.5: This is how the second 
iteration will look when we are 
finished.

Quick tip: To create a quick copy of an element hold Alt and drag it 
to any side on the canvas with the mouse. Press Cmd + D afterwards 
to create a duplicate with exactly the same spacing and direction. 
This also works multiple times.
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App v2

The first task we will take care of for our second iteration of the design is 
to adapt the title bar and add some new controls: an arrow to go back to the 
“Overview” page, and a profile image, which enables users to change their 
settings. Since we already have an arrow in our design we could go down 
the easy route and simply copy it from the button.

THE POWER OF SYMBOLS

But what if we decide that the arrow would look better with a different 
color or border width? We would need to adapt both instances for a con-
sistent look. This is no problem with just two instances, but imagine if 
you were using it on six different screens. To account for that we will use 
one of Sketch’s strongest features: symbols. Think of them as layer groups 
with superpowers. You can duplicate or insert an instance of a symbol as 
often as you want, but as soon as you change the master symbol all of its 
instances get updated immediately.
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Symbols

Symbols are the ultimate way to create reusable assets, whether small 
elements like icons or buttons, or entire page elements like footers, or even 
whole screens. As soon as the master symbol is changed, all of its instances 
get updated immediately. This affects properties like color, transformations 
or the position of nested layers.

To create such a symbol select all the layers it should consist of and click 
on Create Symbol in the toolbar. In the dialog choose a name and whether 
the master symbol should either be sent to the dedicated “Symbols” page 
(check Send Symbol to ‘Symbols’ Page), or placed right next to the last 
artboard on the current page (fig. 3.6). The advantage of the dedicated 
“Symbols” page is that all symbols are nicely arranged in a separate loca-
tion and you always have an overview of all the assets. However, this way 
they can feel a bit detached from the current design and it’s harder to 
assess how changes affect its appearance. But you can always remove the 
symbol from the dedicated page and drag it to other pages.

 

Fig. 3.6: The creation dialog of symbols.
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After you have confirmed the dialog, a little double arrow is added to the 
name in the layers list, both for the master symbol and the instance. To 
add a new instance go to Insert → Symbols in the menu bar. There’s a 
clever way to organize how symbols are listed here: If you need to select 
from two button states, selected and inactive, you can name one “button/
selected” and the other “button/inactive”; this will group the symbols 
inside a “button” subfolder. If you want to swap one state to the other later, 
use the dedicated drop-down in the inspector (fig. 3.7), or make a right-click 
and select it from the Replace With menu. This also works for switching 
symbols per se.

 

Fig. 3.7: You can organize symbols into folders. Right: Use the drop-down in the inspector to swap one state 
or symbol with another.

To alter a symbol, double-click on it to bring you to the master symbol with 
a handy Back to Instance link in the upper left corner (fig. 3.8). Everything 
that is changed here gets immediately drilled down to all of the instances.  
They can be modified in multiple ways: You could flip them, change their 
rotation, opacity or blending mode, or add shadows. Also, you can resize 
them, with multiple options available in the Resizing drop-down in the 
inspector. But more on that in chapter 8 “Going Responsive” on page 265ff.

Symbols are quite versatile, as they let you change text values and images 
separate to each instance with a dedicated Overrides input field in the 
inspector. (Fig. 3.9.) This way you can have a shared symbol for all the 
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entries in a list, but each entry can be populated with different content and 
still share the same appearance. That’s also quite handy for buttons. Sketch 
is even smart enough to respect the text length of overrides and moves 
subsequent layers if the content gets too long. 

Fig. 3.8: Return from the master symbol to the instance with the dedicated button.

Furthermore symbols can be nested, which lets you have a symbol for 
a whole screen, with a nested footer symbol, for example, that in turn 
includes the symbol of an icon. Nested symbols even have a dedicated 
Overrides field, so that you can swap one symbol of the same size with 
another. Nothing lasts forever, so if you decide that a symbol isn’t appro-
priate anymore select Layer → Remove Symbol from the menu bar; for 
individual instances, right-click and choose Detach from Symbol, which 
reverts it back to a simple layer group.

Fig. 3.9: Overrides let you adapt text values, images, and nested symbols per instance.
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To create the arrow symbol, select it within the button with a Cmd-click 
and go to Create Symbol in the toolbar. In the dialog, name it “Arrow” and 
select Send Symbol to ‘Symbols’ page so that the master symbol is sent 
to a dedicated “Symbols” page (Fig. 3.6.).

After that, go to Insert → Symbols in the menu bar and select our new 
“Arrow” symbol to insert it into the artboard. For an easier workflow with 
symbols in future, you should also add the Symbol icon to the toolbar (see 
the quick tip below). Place this new “Arrow” instance in the title bar on the 
artboard and also move it to the appropriate group in the layers list. Make 
sure that you place it above the “BG” layer.

You will notice that this symbol has a double-arrow in front of it now. This 
immediately associates it with the master symbol on the “Symbols” page. 
You can check this out if you double-click on the instance. There it’s also 
possible to customize the symbol and all changes get immediately propa-
gated to the instances. To go back to the details screen, click on the handy 
Return to Instance link (or press Cmd + Esc).

Fig. 3.10: The correct placement of the Arrow symbol. Please note that I lowered the opacity of title bar’s 
background to help visualizing the grid.
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To represent an actual back arrow, flip it horizontally with Transform 
→ Flip Horizontal from a right-click and align it to the grid horizontally 
with a left offset of 16px. Use the smart guides to align it to the center of 
the background in the vertical direction.

Fig. 3.11: The customization dialog of the toolbar.

 

Quick tip: Add more icons to the toolbar with a right-click and the 
Customize Toolbar… option (Fig. 3.11). Here you have an overview 
of all the available icons and can either drag them directly to the 
toolbar or the area at the bottom of this dialog. For better organi-
zation and categorization, insert a space or flexible space between 
them. If you’re savvy with the meaning of the icons, you can switch 
off their labels with the drop-down below, as well as change their 
size. To rearrange the icons in the toolbar you don’t need to enter 
this dialog at all: just hold Cmd and drag the icon anywhere you 
want. Some recommended additions to the toolbar are: Symbol, 
Scissors and Round To Pixel. Everything else can be accessed more 
efficiently with keyboard shortcuts. But with custom shortcuts 
(read more about them in the related info box in this chapter) in 
mind, even these three might be redundant.
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Important Settings

The second element to deal with is the profile icon. To prepare it, create 
an oval using O, with a size of “24px” and hold down Shift to get a circle. 
Place it in the upper right corner of the artboard and make sure it’s in the 
“Title bar” group, above the “BG” layer. Then offset it 16px from the right 
edge (Fig. 3.12). The grid can be a huge aid here. For more detail and greater 
control on the user icon, zoom all the way in with Cmd + 2 (Cmd + 0 brings 
the canvas back to 100% again). 

 

Fig. 3.12: The properties of the mask for the user icon. Please note that I lowered the opacity of the title 
bar’s background to help visualizing the grid.

To align it vertically with the background layer we could use the smart 
guides again, but this time let’s try something else and use the alignment 
icons at the top of the inspector (Fig. 3.13). Select both layers by holding 
Cmd (to drill into the group) + Shift (to select multiple layers) and click 
on them. Now select the second icon to the right (align vertically), which 
aligns them vertically to each other.
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Aligning Everything

It’s quite easy to align layers to one another or the artboard in Sketch with 
the alignment icons in the top area of the inspector. As the first two are 
distribute icons (more on them later in this chapter in the related info box), 
let’s start with the third from left: align left, align horizontally, align right, 
align top, align vertically, and align bottom.

 

Fig. 3.13: The alignment icons at the top of the inspector. Please note that they have a light border if only a 
single layer is selected. This way it gets aligned to the artboard.

Depending on the number of selected layers, they slightly change their 
appearance and behavior. With just a single element picked, the icons have 
a light border, which denotes that the alignment happens relative to the 
artboard. But the moment you select multiple layers, the icons change their 
appearance and loose the border (Fig. 3.14). When you click on left, right, 
top or bottom now, they are aligned to each other, specifically the layer 
that is on the farthest end of the selected alignment direction. By clicking 
on align horizontally or vertically, on the other hand, the chosen layers are 
aligned to their shared center. However, if you want a specific layer to act 
as the reference point to which the remaining layers should be aligned, 
lock this one with Shift + Cmd + L.
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Although it isn’t immediately obvious, you can also align multiple layers to 
the artboard by holding Alt before you click on one of the alignment icons. 
In this case, they gain the aforementioned border again as a visual cue.

 

Fig. 3.14: The moment multiple layers are selected, the icons change their appearance and lose the 
border. Now the selected layers are aligned to each other instead of the artboard.

The alignment icons work not only for layers, but also for vector points 
when you enter the vector point mode of a layer with Enter. Unlike for 
layers, you always need to select multiple points; the alignment is always 
related to the points and not the object or the artboard, and it’s not possible 
to lock them to change the reference point.

There’s a good chance that the alignment icons will soon become the most 
clicked area inside Sketch. To apply them, you right-click and select the 
appropriate alignment option (if multiple layers are selected). But, wouldn’t 
it be easier to just press a key? Read more about creating custom shortcuts 
on the next page.
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Custom Shortcuts

While Sketch is keyboard-accessible right from the start, there are some 
functions here and there that lack a related keyboard shortcut or simply 
don’t work for you. Luckily, OS X (or its successor macOS) provides a native 
way to define custom shortcuts for applications. Go to System Prefer-
ences (the easiest way is to press Cmd + Space to fire up the spotlight search 
and enter “pref”) and select Keyboard, followed by the Shortcuts tab. On 
the left is an entry called App Shortcuts, which lets you define custom 
shortcuts for every application on your system, including Sketch.

 

 
 
Fig. 3.15: Enter the exact menu title from Sketch and the desired keyboard shortcut once you have clicked 
on the + icon.
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After selecting this option, click on the + icon below, select Sketch from the 
drop-down and enter the exact Menu Title (Fig. 3.15). This needs to noted 
exactly like the menu bar command in Sketch. For example, if you want to 
apply a shortcut to Type → Baseline → Raise, you have to insert “Raise” 
as the menu title. Then select the Keyboard Shortcut field and press the 
keys on the keyboard you want to assign, let’s say Ctrl + Alt + Cmd + R. When 
you click on Add now, go back to Sketch, select a text portion and press 
the keys you’ve set — you’ll see that the baseline is raised. Nice! This new 
shortcut is also shown next to the appropriate command in the menu bar 
(Fig. 3.16). You can not only set new shortcuts, but also redefine existing 
functions this way.

 

Fig. 3.16: The keyboard shortcut is added to the appropriate command. 
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For some inspiration, have a look at the keys I’ve assigned in this manner:

•	 Arrange → Align Objects → Left: Ctrl + Cmd + L

•	 Arrange → Align Objects → Right: Ctrl + Cmd + R

•	 Arrange → Align Objects → Horizontally: Ctrl + Cmd + C

•	 Arrange → Align Objects → Vertically: Ctrl + Cmd + V

•	 Type → Text Transform → Uppercase: Alt + Cmd + P

•	 Type → Text Transform → Lowercase: Alt + Cmd + L

•	 Type → Bigger: Alt + Cmd + + (instead of Alt + Cmd + =)

•	 Arrange → Move to Front: Ctrl + Cmd + Up

•	 Arrange → Move to Back: Ctrl + Cmd + Down

•	 Edit → Collapse Artboards and Groups: Shift + Ctrl + Cmd + C
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The circle we just created will act as a mask for an avatar image. Good 
places to find free user photos are Random User Generator15 and uiFaces.16 
Pick one, drag it into Sketch (or save it and drag it from the Finder) and 
center it to the circle. To prevent that the circle gets moved while aligning 
lock it first, so that it acts as the key object. Now select it together with the 
image in the layers list and use the appropriate alignment icons to center 
the elements in both dimensions. Finally make sure that the image is above 
the shape, as we will set up the mask now. Select both layers and click on 
the Mask icon in the toolbar (Fig. 3.17).

 

Fig. 3.17: The image will be masked by the circle (set to red to help visualizing it) once you click on Mask 
in the toolbar. 

15	 https://randomuser.me/
16	 http://uifaces.com/

https://randomuser.me/
http://uifaces.com/
http://circle.To
https://randomuser.me
http://uifaces.com
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Masking

First the definition of a mask: it’s a layer that clips other content to its 
shape. Everything within it and above the mask in the hierarchy of the lay-
ers list is shown, everything outside is visually removed. The easiest way 
to set up a mask is to select it together with the content to be masked and 
click on the Mask icon in the toolbar (or right-click and select Mask). This 
creates a group that contains both elements and sets the lowermost layer 
as the mask. The group is especially important here, as everything within 
it gets clipped, denoted by a little arrow in front of the masked layers. Alter-
natively you can also use the keyboard shortcut Ctrl + Cmd + M, but this 
doesn’t create the group for you.

 

Fig. 3.18: A mask clips everything that is in the same group and above it. The masked content is denoted 
by an arrow.

You can still exclude layers from being masked by right-clicking and 
selecting Ignore Underlying Mask. The mask itself can be removed with 
a right-click and the option Mask. Simply hiding doesn’t disable it. Please 
note that masks don’t need to have a background color — they can also be 
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transparent so only the masked content is visible. Since masks are normal 
shapes they can still have a border or shadow.

Masking is not limited to images — every shape can mask another shape 
independent from its form. Even text can act as a mask (Fig. 3.19), but it 
needs to be converted to outlines with Layer → Convert to Outlines 
first, which creates a shape from every letter. Unfortunately, the text can’t 
be edited after that anymore, but it gives you a lot of freedom over the 
placement of the masked content. If you just want to overlay text with an 
image, you can also apply a pattern fill. Read more about this technique 
at “Creating Textured Type” on page 333.

 

 

Fig. 3.19: Masking is not limited to shapes — text can also act as a mask once it is converted to outlines.

Finally, when you set up a masked image it can easily happen that you 
catch it instead of the mask layer when you click, so it’s always a good idea 
to lock the image with Shift + Cmd + L to prevent an incorrect selection after 
you have set its final size.
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Select the photo now and resize it from the middle by holding Alt and 
using the handles on the canvas so that it fits nicely with the circle. Give 
the mask a white Outside border with a thickness of “2.” Lastly, rename its 
group to “User icon” and make sure that it is within the “Title bar” group, 
above the “BG” layer (Fig. 3.20).
 

Fig. 3.20: The finished user icon. 

As an alternative to a masked image you can also apply a pattern fill to the 
mask layer itself. A plugin that can be a huge help here is sketch-uifaces.17 
With the plugin installed, after you have selected the mask go to Plugins 
→ Sketch UIFaces, which automatically loads a random user image from 
the uiFaces website. Remember to hide the image you first loaded into 
Sketch. Read more about plugins and how to handle them in the related 
info box later in this chapter.

17	 http://smashed.by/sketch-uifacesplugin

http://smashed.by/sketch-uifacesplugin
http://smashed.by/sketch
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Zooming

There’s a good chance you won’t always work with the canvas size at 100%, 
so it might be necessary to zoom in with Cmd + + to work on some details, 
or zoom out with Cmd + – to get a broader view. Press Cmd + 0 afterwards 
to go back to 100% again, and Cmd + 1 to see an overview of all the artboards 
or elements on the canvas.

Since some work will need extra attention, occasionally zoom all the way 
in to the currently selected layer or group with Cmd + 2, and if you are not 
sure of its whereabouts press Cmd + 3 to center it to the viewport. This 
move is pretty handy if you are looking for a specific artboard: use Cmd + 1 
to zoom all the way out and then, with a click on the specific artboard, 
Cmd + 3 to center it to the canvas, and Cmd + 0 to bring it to 100%. If you are 
getting sick of the slight animations that happen as you zoom, deselect 
Animate zoom under the Canvas tab of the Preferences (Cmd + ,).

If you are currently at quite a high zooming level (Sketch has a maximum 
zoom of 6,400%!) you can always switch to 100% temporarily with $. Alter-
nate ways to zoom are: the scroll wheel of your mouse in combination with 
Cmd, the trackpad with the “pinch to zoom” gesture, or holding Z to zoom 
in with a click, and Alt + Z to zoom out (I accept no responsibility for any 
physical damage to your hand, however).

Lastly, to pan around the canvas (that is, to change the viewport) hold 
Space and drag the mouse, use the touch area of your Magic Mouse (which 
is one of the main reasons I still favor it over a more ergonomic model) or 
employ the trackpad.



The Power Of Iterations And Artboards

81

A Matter of Style

The last thing to handle for the title bar is to switch the text to a text style, 
so we can reuse it later. It also makes sure that changes in one place can be 
propagated to other instances with a simple click. Text styles are similar 
to symbols, but they only affect the styling of text layers. To convert the 
title, click on the drop-down in the inspector that says No Text Style. Pick 
Create New Text Style and name it “Title bar title” (Fig. 3.21). The icon of 
the text changes to purple in the layers list to represent it being a text style. 
Whenever you want to reuse this style anywhere else select the text and 
choose the style from this drop-down. Just like for symbols, you can also 
organize text styles into folders: just add the folder name and a slash “/” 
before the text style.

 

Fig. 3.21: Create a new text style with the respective drop-down in the inspector.

To avoid changing a text style accidentally at one of its instances, you must 
click on the round double-arrow when its style should be updated (Fig. 3.22 
on the next page). (Funny side note: it wasn’t always like this, and boy how 
often did I adapt a text style or symbol only to notice it much later when I’d 
already made a bunch of changes and screwed up all of the instances.) To 
create an entirely new element of this type, choose its entry from Insert → 
Styled Text in the menu bar.
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Fig. 3.22: Once you have changed a text layer with an applied text style you need to click on the round 
double-arrow to update all other instances of it.

Shared styles can not only be used for text 
but also for the properties of layers, like 
fills, borders, shadows and blurs. Select 
the relevant layer that should act as the 
model and choose Create New Shared 
Style from the drop-down in the inspec-
tor that says No Shared Style. Every-
thing else, like the Update icon, or the 
purple appearance in the layer list, 
works exactly as for text styles. For a 
nice overview of all the styles created so 
far, select Organize Shared Styles (or 
Organize Text Styles) from the drop-
down, where you can also rename and 
delete them (Fig 3.23).

 

Fig. 3.23: Choosing Organize Shared 
Styles (or Organize Text Styles) gives 
you an overview of all styles created so far.
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From the Past to the Future

The ability to undo and redo things with Cmd + Z and Shift + Cmd + Z is a 
great way to try things out. It even lets you copy things from the “past” 
into the “future.” Imagine you have added a text layer and tried out a few 
different colors, but decided in the end that an intermediate color was the 
best one. You can press Cmd + Z until you reach this specific point in the 
“past” again and keep working from there (Fig. 3.24).

 

Fig. 3.24: Go back to the “past” and keep working from there.

Or alternatively, to compare this specific iteration from the past with the 
latest version, copy the layer with Cmd + C, press Shift + Cmd + Z to redo all 
the steps in between and insert the change from the past with Cmd + V. 
Now you have the old version and the most recent state at the same 
time (Fig. 3.25).

 

Fig. 3.25: Compare a version from the “past” with the most recent state.
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Nice Curves!

How about making the white background of the content a little bit more 
exciting with a round shape at the top? Sounds good. Select the “BG” layer 
in the “Content” group with a Cmd-click and press Enter to go into vector 
point mode. We won’t alter the existing points but we will add a new one, 
which is just a matter of clicking on a segment of the shape. Instead of an 
arbitrary position let’s place it in the exact middle, which is possible if you 
hold down Cmd while clicking at the top side of the rectangle.

If you have a look at the inspector now you’ll see that each vector point has 
its own X and Y coordinates. To move this new point up by 8px just add 
“−8” to the Y field. We could have also used the Up arrow key to nudge it in 
this direction.

What you will notice now is that we didn’t get a curve at this new point 
but a sharp edge. To give it a pleasant roundness, double-click on the point. 
Sketch is smart enough here to adapt this curve to the rest of the shape. 
Now select the outer two points of this line: first click on the one on the 
left, hold Shift and select the point on the right. Move these two down by 
8px in turn, again either by adding “+8” to the Y field or using the arrow 
keys. Finally, press Esc twice to leave the vector point mode.
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Fig. 3.26: Add a new point in the middle of the top side of the white background and change it to a curve.

Enhance Sketch with Plugins

The third new icon for this screen is the one to make the body copy tem-
porarily smaller and see the image in its full glory. You may want to zoom 
in with Cmd + + now to have a better view. Let’s add an oval for the back-
ground of this icon: press O, hold Shift, and draw a circle with a diameter 
of 32px. Use the grid lines as an aid to get to these dimensions. Name it 
“BG.” Now change its fill to white and align the circle to the center of the 
artboard with the fourth icon from the alignment icons (align horizontally) 
in the inspector. 
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Move it vertically to the middle of the curved line we just created. The 
easiest way is to use the arrow keys, probably in combination with Shift to 
span a bigger distance. In the end it should align to the grid (Fig. 3.27). To 
give the heading above enough room to this new shape move it up by two 
grid units, so that it has an Y position of “248.” 

 

Fig. 3.27: The circular background for the new collapse icon.

Instead of creating the new collapse icon from the ground up, we will use 
our first plugin. Plugins are a great way to enhance the functionality of 
Sketch, created by the community to make up for missing features.
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Plugins

The easiest way to manage plugins is to use 
Sketch Toolbox18, a simple plugin manager 
(Fig. 3.28). After you have unpacked and 
started it, you’ll see an extensive list of 
plugins to choose from with a handy search 
option. As soon as you’ve picked a plugin you 
can install it right from Sketch Toolbox and 
it’s automatically kept up to date. It shows 
up under the Installed tab and can also be 
removed with Uninstall from there.

Natively, plugins can be handled in Sketch at 
Plugins → Manage Plugins…  in the menu 
bar, which shows you a list of all the avail-
able plugins. After selecting an entry here 
you have further options when you click on 
the gear icon at the bottom-left of the dialog. 
Show Plugins Folder points you to the 
relevant folder on your hard drive in case 
you ever need to manually install or remove 
such an add-on.

The Filter field lets you search for an 
installed plugin, a click on Get Plugins… 
leads you to the official directory of the little helpers from Bohemian 
Coding. For a list of interesting Sketch plugins, check out the section in the 
appendix. Finally, to run (or rerun) a plugin simply select it from Plugins 
in the menu bar. Most of them come with a separate submenu or have 
predefined keyboard shortcuts.

18	 http://sketchtoolbox.com/

Fig. 3.28: Sketch Toolbox is the 
best way to manage existing and 
discover new plugins.

Fig. 3.29: You can also maintain the 
plugins inside of Sketch.

http://sketchtoolbox.com/
http://sketchtoolbox.com
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The plugin we need right now is Sketch Iconfont,19 a great way to find and 
add icons to your Sketch files. After you have installed it with the help of 
Sketch Toolbox and added Font Bundle20 to your system, go to Plugins → 
Icon Font → Grid Insert → FontAwesome from the menu bar, which 
gives you a list of all icons from this icon set. Enter “arrow circle o,” press 
Enter and click on the first icon (a down-pointing arrow within a circle), 
which inserts it at the top of the artboard as a text layer. Just make sure 
that no other element is already selected.

Click on this new icon, give it a font size of “23,” a black fill color and center 
it to the circle we already created. The easiest way is to use the alignment 
icons, but lock the circle with Shift + Cmd + L first so that its position doesn’t 
change. Now create a “Collapse icon” group from them with Cmd + G and 
drag it to the very top of the “Content” group. 

Fig. 3.30: The icon in the dialog of the plugin (red border) and readily placed on the artboard (middle).

19	 http://smashed.by/sketch-iconfont
20	 http://smashed.by/sketch-fontbundle

http://smashed.by/sketch-iconfont
http://smashed.by/sketch-fontbundle
http://smashed.by/sketch
http://smashed.by/sketch
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Fig. 3.31: To keep a certain spacing from one layer to another — for example between the text layer and 
the button — hold Alt, point at the button, leave the mouse pointer where it is and move the text layer 
with the keyboard. This way the distance keeps showing.

Quick tip: Sometimes Sketch doesn’t tell you the distance to a cer-
tain layer when you show the smart guides with Alt. This is espe-
cially true if you want to keep a certain spacing in relation to another 
element or the edges of the artboard while you move a layer. There’s 
a little trick to always show you the right spacing at the right time. 
Select the element you need a certain distance for, hold Alt to trigger 
the smart guides and hover over the layer (or edge of the artboard) 
that is acting as the reference point. Now leave the mouse pointer 
where it is so that the smart guides keep showing and reposition the 
layer with the arrow keys on keyboard instead (Fig. 3.31).
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Highlights

To give the heading even more emphasis and better visibility on the dark 
background let’s add a strong black shadow. Click on the Shadows area in 
the inspector to add a shadow and change the properties to “1/1/0” (X/Y/
blur) with a black color and an opacity of “100” (the A value in the color 
dialog). See Fig. 3.32, top. Remember that you can use Tab to jump from one 
input field to the other.

Talking about emphasis and shadows: we also want to highlight the button 
even more with a shadow, to make it look as if it floats above the page. 
Select its background shape with a Cmd-click and add a shadow in the same 
way as before. Since we don’t need an offset here we leave the X and Y 
positions at zero and only alter the blur to “13.” For the color we will choose 
the red from the button with the color picker (press Ctrl + C, but click on the 
color box first) and give it an alpha value of “55” (Fig. 3.32, bottom). Finish 
the button by converting it to a symbol with the respective icon in the tool-
bar (Create Symbol). Be sure to send it to the dedicated “Symbols” page 
with the respective checkbox.

Fig. 3.32: The shadows for the heading and the button.
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The Art of Shadows and Blurs

With the current trend of making everything flat, shadows have fallen out 
of favor a bit. Yet a subtle shadow here and there can give parts of your 
design the required emphasis. Besides the X and Y values of a shadow, 
which control the offset on the respective axes (and which can also be 
negative values, see Fig. 3.33, top), and the Blur, that handles how diffuse a 
shadow is, it also has a Spread value. This last property pushes the shadow 
out and makes it bigger (Fig. 3.33, second from top). To control the opacity 
of a shadow, click on its fill color and change the A (alpha) value.

The difference between a normal shadow and an inner shadow is that 
the former is added outside of the element (Fig. 3.33, top), while the latter 
is rendered inside of it (Fig. 3.33, bottom). Shadows are not only limited 
to shapes but can also be applied to text, with the only difference that 
there is no spread option available (Fig. 3.33, second from bottom). Note: 
An element can have multiple shadows, that are stacked on top of each 
other (Fig. 3.33, bottom).

Fig. 3.33: The X and Y values can 
also have negative values (top). 
The Spread value pushes the 
shadow out and makes it bigger 
(second from top). Shadows can 
also be applied to text layers, but 
without the Spread value (second 
from bottom). Inner shadows are 
painted on the inside of the element 
(bottom).
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Somewhat related to shadows are blurs, as a shadow is nothing more than 
a (usually) blurred copy of the layer. Sketch also has you covered here with 
its four types of available blur modes.

Motion blur (Fig. 3.34, top left): Imagine taking a photo of a moving car 
with a long exposure — that’s what you get with this type of blur. You can 
control the intensity (Amount) and the direction of movement (Angle).

Zoom blur (Fig. 3.34, bottom left): This also originates in photography, as it 
can be created when you zoom while the camera shutter is open. The result 
is an object of focus with motion lines radiating from it. Here you can cus-
tomize the intensity (Amount), and where the effect has its origin.

Gaussian blur (Fig. 3.34, top right): The standard blur, which blurs the 
layer by a certain amount, is certainly the most useful kind of blur. I can 
only speak for myself, but motion and zoom blurs don’t make much sense 
in a UI design app.

Background blur (Fig. 3.34, bottom right): While the other kinds of blurs 
can be applied to any kind of layer, this one only works for shapes. It repli-
cates the effect you may know (and may already be tired of) from iOS and 
the Mac, in that the content underneath certain parts of the screen appears 
blurry. To apply it, create a shape, apply Background Blur to it and reduce 
the opacity of its fill  — you can also switch it off entirely. This type of blur 
is best used above a complex background, or else you won’t notice the 
effect.
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Please note that blurs, especially background blur, are very CPU-intensive 
and can slow down Sketch noticeably, especially if used on large areas. 

Fig. 3.34: Center: Original. Top left: Motion blur (amount: 12px; angle: 162, marked by the red arrow). 
Bottom left: Zoom blur (amount: 18px, the red cross marks the origin). Top right: Gaussian blur 
(amount: 4px). Bottom right: The image is overlaid with a rectangle that has Background blur applied 
(amount: 8px).
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Gradients

Since it’s not immediately obvious that our body copy is scrollable and can 
contain more text than what’s visible, we will add a gradient as a visual 
indicator. There are three ways to achieve that: the first is to give the text a 
gradient fill (1); the second is to overlay a layer with a gradient fill (2); and 
the third is to use a special kind of mask, an alpha mask (3). I’ll show you 
all three methods (please also refer to Fig. 3.36). You should create a new 
artboard for each approach for comparison.

Text Gradient (1)

The easiest option is to add a gradient fill to the text layer, which is quite 
unusual, as you don’t normally need a fill to set the text color. For this 
special case, however, click on the Fills area and choose a linear gradient 
instead of a solid fill (the second icon above the color field). Make sure that 
it is vertical — if not drag the first color stop to the top of the text layer, and 
the second one in the same vertical line to the bottom. Choose black and an 
alpha value (A) of “100” for both color stops.

Now insert a third stop at 80% by double-clicking anywhere on the gradi-
ent axis in the color dialog and press 8 on the keyboard to move it to this 
exact position. Then jump to the last stop with Tab and give it an alpha 
value of “0.” In case you can’t see the gradient you need to cut the content 
so that it has the same height as the text layer itself. 
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Fill Types, Part 2: Gradients

There are three types of gradients available in Sketch: linear, radial and 
angular. They basically all consist of a series of colors on a gradient 
axis. While this axis is a straight line for the first two, it forms a circle 

for the third (marked blue on Fig. 3.35). By default, every gradient has a start 
and a stop color (marked with a red and green circle on Fig. 3.35). If you want 
to add a new color stop (marked with a blue circle on Fig. 3.35) either dou-
ble-click on the gradient axis (the horizontal bar) in the color dialog, or make a 
single-click on the gradient axis on the canvas (Fig. 3.35, bottom).

After that you have a few options: place the stop on a certain location with 
1 to 0 (for example, to 30% with 3 or 80% with 8, and so on); insert it in the 
middle of the surrounding stops with =; or move it with the arrow keys or 
the mouse (both on the canvas and in the the color dialog). Once you have 
placed it, use Tab to jump conveniently from one stop to another. Instead 
of a smooth transition, you can also create hard color stops by placing two 
points on the same location on the axis. Lastly, to remove a point select it 
and press Del or Backspace.

Each of the gradients has some particulars:

Linear: The angle and size can be changed by moving the start or stop 
color around on the canvas. To flip the gradient by 90 degrees use the 
arrows below the alpha field in the color dialog.

Radial: Move the gradient on the canvas by dragging its center point with 
the mouse (Fig. 3.35, 1). If you need an oval shape instead of a circle, drag 
the white dot on the left side of the gradient’s outer circle (Fig. 3.35, 2); in 
case you want to change its size or angle, move the stop color on this circle 
at the canvas (Fig. 3.35, 3).
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Angular: This type is always centered to the layer and fills the whole ele-
ment. The start and stop color are on the same spot by default, forming a 
hard color transition.

Please note that Gradients are not limited to fills but can also be applied to 
borders.

Fig. 3.35: Left: Linear gradient. Middle: Radial gradient. Right: Angular gradient. The gradient axes and 
intermediate color stops are marked blue, the start color is marked with a red circle, the stop color with 
a green circle. Bottom: The gradient axis in the color dialog is the same for all three types. 1: Move radial 
gradient. 2: Change shape. 3: Change size or angle. 
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Overlay Gradient (2)

For the second technique, create a new rectangle above the body copy text 
layer in the “Content” group; it should have about the same width as the 
text layer and a height of “32.” Now lock the text layer with Shift + Cmd + L, 
which makes sure that it isn’t repositioned, as we have already aligned 
it perfectly.

Select both layers in the layers list and align the rectangle to the left (third 
icon) and bottom (last icon) with the alignment icons in the inspector. 
Group them into “Body copy” and enter “100%” for the width of the rectan-
gle in the inspector, which gives it the same length as the text layer (you 
can unlock it again now). Apply a gradient to the rectangle: it is basically 
the same as above, but you only need the default two color stops set to 
white, with the top one at “0” alpha and the bottom one at “100.”

Alpha Mask (3)

The third method also makes use of an additional layer, but this time it acts 
as a special kind of mask, an alpha mask. Add a rectangle in the same man-
ner as above, but this time align it to the top-left of the text layer and for 
both the width and height use 100%, which gives it the same dimensions. 
Drag the rectangle below the text layer in the layers list. 

Quick tip: Sketch typically highlights the layer in the layers list the 
moment you select it on the canvas. If that doesn’t happen or you 
scrolled to another point in the layers list, press Shift + Cmd + J to 
reveal it there.



98

Chapter 3

Assign the same linear gradient fill with black as in the “Text Gradient” 
method, but this time give the first and the second stop “100%” opacity, 
and the last “0.” If you select the rectangle now and go to Layer → Use 
as Mask and then Layer → Mask Mode → Alpha Mask you’ll see that 
you achieved the same effect as above. An alpha mask is determined by 
the opacity of its color stops: it shows the masked content where it has an 
alpha value of “100” and covers it where it has “0,” with all the nuances in 
between. However, the color of the gradient stops doesn’t matter.

 

Fig. 3.36: The gradients of the three methods for the visual indicator side by side, each with the gradient 
axis from the canvas and the color dialog. 1: Text gradient. 2: Overlay gradient. 3: Alpha mask. Please 
note that I’ve given the overlay and the mask (2 and 3) a grey border for better visualization.

Which method you choose in the end is up to you.
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Back and Forth

To make it easier for our users to explore different locations we will now 
add navigation arrows that let them go back and forth. Create a new circle 
shape at the upper part of the artboard, above the “Content” group. It 
should have a diameter of “80px.” As only one third of this navigational 
arrow should be shown (the rest moved out of the left edge of the artboard), 
we can use the mathematical capabilities of Sketch again.

In the X field of the inspector enter “80 * −1 * 0.66.” To clarify: “80” is the 
size of the circle, “−1” makes the value negative (thereby moving it to the 
left), and “0.66” hides two-thirds of the shape. As this results in a number 
with a decimal place, go back to an integer with Layer → Round to Pixel 
in the menu bar. For the Y axis use a value of “118,” which aligns the top-left 
edge to a grid line (have a look at the grid with Ctrl + G). Please see Fig. 3.37.

 

Fig. 3.37: The base circle of the navigation arrow moved out of the left edge of the artboard by 
two-thirds.
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For the arrow itself we can use our “Arrow” symbol as a base, so insert an 
instance with Insert → Symbols from the menu bar and place it over 
the circle. Since we need a different shape for the arrow we can’t use it 
as a symbol but must detach (unlink) it from the master symbol: make 
a right-click and select Detach from Symbol, which changes it back to 
a normal layer group. Also ungroup it with Shift + Cmd + G. Then flip it 
horizontally with the first icon in the Flip area of the inspector to get an 
actual back arrow.

Change the border color of the arrow to black and enter the vector point 
mode with Enter to alter its height. Zoom all the the way in to the selection 
with Cmd + 2 and select the upper point of the shape. As we need the arrow 
8px higher move this point up: the easiest way is to employ the arrow keys. 
You could have also used the Y position field in the inspector and added 
“−8” (Fig. 3.38). But be sure to leave the input field with Esc in this case to be 
ready for the following actions.

Cycle to the next point (the tip of the arrow) with Tab and move this one 
to the right by 4px to make the arrow narrower. Now select all the vector 
points of this shape with Cmd + A and distribute them vertically by clicking 
on the second alignment icon at the top of the inspector (distribute verti-
cally), and leave the vector point mode by pressing Esc twice. 

Quick tip: You can perform mathematical operations in every 
input field in Sketch. For example, triple a border’s thickness with 
“*3”; halve the width of a layer with “/2”; or increase the font size by 
12px with “+12.”
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Note: In case this whole process doesn’t work as expected, try to leave and 
re-enter the vector point mode before you start to modify the points.

 

Fig. 3.38: Move the points in the respective directions.
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Distribute Content

As well as the alignment icons at the top of the inspector there are also 
two distribute icons that allow you to spread three or more layers evenly 
among themselves (Fig. 3.39).

Fig. 3.39: The distribute icons.

In this case, the outermost layers remain where they are and the ones 
within are distributed evenly so that they gain the same space between 
one another (Fig. 3.40). In case the layers can’t be distributed to full pix-
els, Sketch asks you if they should be distributed unevenly or placed on 
sub-pixels (resulting in a decimal). Distributing doesn’t only work for 
layers but also for vector points.

Fig. 3.40: When distributing, the inner layer is moved to have equal spacing from the elements outside.
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Unfortunately, it’s not possible to set the distance elements should be 
spaced apart, but there’s way to alleviate this. Go to Arrange → Make 
Grid… in the menu bar. Based on the orientation and number of selected 
layers, pick the appropriate quantity of rows or columns (inserting “1” for 
the other value) and enter the desired margin (Fig. 3.41). Please keep in 
mind that the layers are aligned to the leftmost element if you choose col-
umns, or the top if you choose rows, after you press Arrange, so you might 
need to rearrange them subsequently.

 

Fig. 3.41: Use Make Grid… from Arrange in the menu bar to distribute elements with a defined spacing.
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The next step is to center the arrow vertically with the circle. Select both 
and use the second alignment icon from the right (align vertically). Move 
the arrow to an X position of “8” to align it to the grid. It looks good now, 
but we haven’t reached our final goal yet, as we want to cut the arrow 
away from the circle to get a hole through which you can see the back-
ground image.

We will use Boolean operations for this task, which let you combine shapes 
in different ways. A requirement, though, is that all the shapes involved 
must consist of fills instead of a border, which isn’t the case for our 
arrow, so select Layer → Convert to Outlines in the menu bar or press 
Shift + Cmd + O. When you enter the vector point mode you’ll see that the 
arrow doesn’t consist of a simple line with a border anymore, but is defined 
by a shape with numerous points.

For the Boolean operation make sure the arrow is above the circle, select 
both, and click on Subtract in the toolbar or press Alt + Cmd + S, which cuts 
the arrow away from the circle. The order matters here, since layers can 
only be subtracted from underlying ones. You should now see a circle with 
a hole in the form of an arrow (Fig. 3.42). The layers merged not only on 
the canvas but also in the layers list. There you’ll see a simplified version 
of this shape, which you can expand with the disclosure triangle to get a 
glance at the layers involved.
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Fig. 3.42: The Boolean group, that cuts away the arrow from the circle.

A big strength of Sketch is that Boolean operations remain editable, so you 
can still move the layers separately from each other, and also completely 
undo the operation by selecting Layer → Paths → Split from the menu 
bar. Finally, rename the Boolean group to “Nav arrow previous,” set the 
opacity to 80% and make sure it is right above the “Content” group in the 
layers list.
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Boolean Operations

Boolean operations let you combine shapes in different ways, affording 
countless possibilities for entirely new forms. Most of the time it’s much 
easier to build elements this way than to draw entirely new objects with 
the vector tool.

There are four types of Boolean operation (Fig. 3.43). To create one, select 
the shapes you want to combine and either click on the related icon in the 
toolbar or press the appropriate keyboard shortcut:

1.	 Union (Alt + Cmd + U): Merges two shapes into one.
2.	 Subtract (Alt + Cmd + S): Removes one shape from another.
3.	 Intersect (Alt + Cmd + I): Shows just the part where the shapes overlap.
4.	 Difference (Alt + Cmd + X): Retains the area where the shapes don’t 

meet.

Fig. 3.43: The four types of Boolean operations.
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The ones you will need the most are Union and Subtract, while the other 
two are not that common. Subtract especially can lead to some awkward 
situations, but if you keep in mind a few simple points there shouldn’t be a 
problem at all.

1.	 Order matters. Shapes on top of others are always removed from the 
ones below.

2.	 The biggest shape in the combination should be at the bottom, with 
the shapes getting smaller the higher you go in the hierarchy of the 
layers list.

3.	 Shapes that don’t interact directly and just sit on top of others should 
be set to None.

An Example

Let me give you an example using the following truck shape, which con-
sists of eight basic shapes:

Fig. 3.44: Left: The individual shapes. Right: The shapes combined to form the truck. The little icon next 
to the layer name (red border) is used to change the type of Boolean operation.
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•	 The driver’s cabin (6) and wheel cases (3) the are subtracted from the 
body (1).

•	 The load bed (2) and the bumper (5) are set to Union, so that they are 
combined with the body (1).

•	 The wheels (4) are set to None, because they don’t need to interact at 
all. Union would also be an option, but None is safer.

If you reduce things to their basic elements it becomes quite easy and 
almost any form can be created this way.

Flexibility

The best thing about Boolean operations in Sketch is that they can always 
be reversed, reordered and reapplied in different ways, either by moving 
the shape(s) out of the Boolean group and executing another Boolean oper-
ation, or by clicking on the little icon next to the related layer and changing 
the type of Boolean operation (Fig. 3.44, red border). If you want to remove 
all operations at once select the group and go to Layer → Paths → Split 
in the menu bar.

There are multiple ways to enter a Boolean group for manipulation: to access 
its individual shapes double-click it on the canvas. Use Tab or Shift + Tab in 
succession to cycle through the available layers. Not to mention that you can 
also expand it in the layers list and select a layer from there. If you press Enter 
instead while the Boolean group is selected you go straight into the com-
bined vector point mode of all involved shapes. Now Tab (and Shift + Tab) lets 
you switch through the various vector points of all layers. 



109

Infobox

In all cases Esc is used to quit the manipulations, however for the vector 
point mode it needs to be pressed two times: once to deselect the current 
point, another time to actually leave the mode. This combined vector point 
mode also applies to normal layers, that are not part of a Boolean group: 
whenever you select multiple shapes and press Enter, you access the vector 
points of all at once. 

When to Flatten

When shapes get complex, try to break the process down into different 
steps, flatten the combined form in between and then continue with other 
Boolean operations. To do so go to Layer → Paths → Flatten in the menu 
bar. This reduces the complexity and creates a single shape, that is easier to 
handle. Flattening is also a good idea if you want to export a shape as SVG. 
Just remember to keep a copy of the original for later reference.

Apart from that, keep shapes in their editable state with Boolean operations 
as long as possible, so that you are always able to change them. Remember 
that forms created with Boolean operations, that have holes (like rings or 
letters like P) can never be flattened and are always comprised of subpaths 
(Fig. 3.45). Sketch will not get tired of telling you that.

Fig. 3.45: Shapes with holes can only be flattened if their subpaths fully overlap.
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Awkward Situations

If you ever encounter a strange result after a Boolean operation, no mat-
ter how you reorder the layers or change the type of operations involved, 
it might be caused by the order of one of the layers it consists of. Every 
shape in Sketch has a certain order, which mustn’t be confused with the 
order in the layers list, but the order of its vector points. You can see it 
when you enter the vector point mode with Enter and press Tab to jump to 
the next vector point. If you try to combine shapes with different orders 
with a Boolean operation, Sketch doesn’t know exactly what to do (Fig. 
3.46). To remedy this, break the Boolean operation with Layer → Paths → 
Split from the menu bar, track down the shape with the wrong order, go 
to Layer → Paths → Reverse Order and reapply the Boolean operation. 
Now everything should be fine.

Fig. 3.46: The circle has a clockwise order, the rectangle a counter-clockwise order. If you try to combine 
these shapes it can cause problems.
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Duplicate this group and rename it to “Nav arrow next” to get the arrow 
to jump to the next tourist attraction. Move it to the right of the artboard 
with the fifth alignment icon (align right) and flip it horizontally — either 
with with the first icon at Flip in the inspector or a right-click and Trans-
form → Flip Horizontal. We only need to offset it by the same distance 
as the left icon, so that only about a third of the arrow icon can be seen. So 
check out the X position of the left icon (which should be at about “−53”) 
and keep this value in mind as the target value for the right-hand icon. 
To get to the correct placement we will use the mathematical capabilities 
again. Switch to the right navigation icon, enter the X field and add “53” 
(the target value from above) to the current X position: “280 + 53.” 

Finally, select both of the navigation arrows and combine them to a new 
“Navigation” group (Fig. 3.47). The second iteration of our “Details” page 
looks great now, with just one important fix left for branding reasons: the 
logo, but more on that later. Right now, we will have a look at how easy it is 
to create an icon in Sketch.

Fig. 3.47: The finished navigation arrows.
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Replicate the Collapse Icon

While premade icons are a great way to try out ideas quickly and iterate on 
different concepts, Sketch makes it quite easy to build them from scratch. 
That’s exactly what we will do now with the “Collapse” icon from earlier, 
which lets users hide the text and see the great view of the Vilsalpsee. In 
preparation, create a new artboard with the size of 100 × 100px: place it 
next to the current artboard and name it “Collapse icon.” Select the old 
icon with a Cmd-click (to drill into its layer group) and copy it into the new 
artboard. Zoom in with Cmd + 2 to get a better view. Drag it to the left 
while holding Alt to get a duplicate and change its color to red (or any color 
other than black) so we can overlay it with our replica and assess the vari-
ous dimensions.

Comparison

When we take a close look, we see that it’s 20px wide, so make a new circle 
at its top-left corner and give it a diameter of exactly this size. Change from 
a fill to a black (inside) border and increase its thickness until it matches 
the old icon, which should be at about 3px. Also change the opacity of 
the layer to 50% with the 5 key, so that you can still see the original icon 
behind it for comparison. When we overlay the upper part of the arrow 
with a (black) rectangle, we notice that a size of about 3×5px is needed 
(plus another pixel in the vertical dimension for some tolerance). It doesn’t 
matter at the moment that the two shapes don’t match exactly.

For the tip of the arrow we will use a triangle (Insert → Shape → Trian-
gle) of the same color and if you continue in the same manner as before 
you’ll see that it needs a size of about 9×5px (to match the other icon). Flip 
it vertically and move it to the bottom of the rectangle plus one pixel up so 
that both shapes overlap. 
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Select and align them horizontally, and combine them with a Boolean oper-
ation of Union with Alt + Cmd + U, which gives us the final arrow shape 
(Fig. 3.48). Then change it to 50% opacity and rename it to “Arrow.”

  

Fig. 3.48: Left: The original icon. Right: The original icon, overlaid with our replica. 

Sketch allows you to add arrows to lines or vectors out of the box. Unfor-
tunately, they are quite useless in practice, as their size can’t be custom-
ized. If that doesn’t put you off, you can click on the little gear icon on 
the right in the Borders area of the inspector to see the options for Start 
Arrow and End Arrow. Just be sure that the Ends are set to the first prop-
erty (see Fig. 2.8).

Quick tip: An alternate way (one I prefer) to create a triangle is 
to make a rectangle with the same size. Enter the vector point 
mode, insert a new point in the middle of the side where the arrow 
should point by holding Cmd and clicking. Then remove the outer 
two points on the same line by selecting and deleting them with 
Backspace or Del.
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If you take a closer look at the template of the icon, you’ll see it has 
rounded corners. The easiest way to set them for all corners is to flatten 
the arrow with Layer → Paths → Flatten, so that we can apply them to 
the whole shape. Enter the vector point mode and select all points with 
Cmd + A, but not the ones where the rectangle and the triangle meet: hold 
down Shift and click to deselect these points. Now use the Corners slider 
in the inspector to set a border radius — “1” would be too much, so use “0.5” 
instead (Fig. 3.39, red points). Either directly enter this value or hold Alt 
and use the Up arrow to go up in steps of 0.1 to end at “0.5.” The outermost 
points of the arrow need a radius of “1” in turn (Fig. 3.49, blue points). Leave 
the vector point mode by pressing Esc twice. You can delete the old icon in 
the back now.

Fig. 3.49: Set the border radius (Corners) to “0.5” for the red points, for the blue points use “1.” The other 
two don’t need a radius at all. 

Odd Dimensions

The arrow looks good now, but we can’t center it to the circle, which would 
result in half-pixels: the circle’s dimensions are even, but the circle’s are 
odd. To switch off this pixel-snapping we could go to the Preferences 
and uncheck Fit layers and points to pixel bounds in the General tab, 
but this should be avoided if you work on icons and want to have a pix-
el-perfect result. On the other hand, it can be quite handy when you create 
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something more complex like a logo. In turn a good idea when making an 
icon is to switch on the pixel grid with View → Canvas → Show Pixels 
Grid (or press Ctrl + X).

To solve our dilemma with the misaligned arrow we simply need to give 
the circle odd dimensions, so select it and change the width to “19.” A quick 
way to do that right on the canvas — without even needing to touch the 
mouse — is to employ the arrow keys in combination with Cmd. To make 
a layer bigger press Cmd + Right or Cmd + Down; to make it smaller use 
Cmd + Left or Cmd + Up (Fig. 3.50); add Shift to go in 10px steps. Whenever I 
need to resize a layer I do it this way as it is much more efficient and pre-
cise than using the mouse. Please note that you can also resize lines using 
the same technique. After that you can finally center the circle to the arrow 
in both dimensions.

 
Fig. 3.50: A quick way to resize layers with the keyboard is to use the arrow keys in combination with 
Cmd. Left: Make a layer smaller. Right: Make it bigger. 

Quick tip: Sketch saves your files automatically. If you want to go 
back to a previous version, select File → Revert To → Browse All 
Versions... in the menu bar. To switch off this safety net, uncheck 
Auto Save files while editing under the General tab in the Prefer-
ences.
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Finalize the Icon

For the final icon we first need to create a dedicated shape for the circle as 
we’ve used a border up until now. Select it and go to Layer → Convert to 
Outlines in the menu bar, or press Shift + Cmd + O, which creates a Boolean 
operation with two circles. Now add the arrow to the this group: simply 
drag the shape into it in the layers list. Make sure the arrow is at the very 
top and change the Boolean type to Subtract (with a click on the two 
overlapping squares next to the layer name, see Fig. 3.51). The type for the 
two circles should be None. Finally, leave the Boolean group with Esc and 
change the opacity back to 100% with 0.

Note that the Boolean operation of the ring is quite different from what 
we’ve covered so far, as the bigger circle is above the smaller circle and the 
Boolean operation isn’t set to Subtract (only for the arrow, see Fig. 3.51, 
left). This is just another way to approach this operation, which you should 
keep in mind for the future. Alternatively you could also drag the small 
circle above the bigger circle and set the Boolean type to Subtract, as well 
as changing the type of the arrow to Union (Fig. 3.51, right). Try it out with 
another copy of the icon!

Quick tip: An even simpler way to resize a line is to enter its vector 
point mode and use the arrow keys alone (without Cmd). Again, com-
bine them with Shift to span 10px at once. You can even change the 
direction from which the size is adapted with Reverse Order from 
Layer → Path in the menu bar.
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Fig. 3.51: Left: Original Boolean operation of None for the circles, and Subtract for the arrow (red bor-
der). Right: Alternative approach, where the positions of the ovals are swapped and the type is changed 
to Subtract. The Boolean type of the Arrow needs to be set to Union here.

To assess the quality of our new icon we can press Ctrl + P to Show pixels, 
which gives us a preview of how the icon would look outside of a vec-
tor-based environment (a browser, for example). If you compare it with the 
old icon, you’ll see that the new version looks much better, as we adhered 
to the pixel grid wherever possible.

The icon is ready to use in our design now. If you’d like, you can copy it 
there to replace the old one. But don’t forget to switch off the pixel preview 
again to avoid confusion. With this newly acquired knowledge we can 
move on to the logo of our project.

 
Fig. 3.52: The old icon (left) and new icon (right) in the pixel mode. As you can see the new version looks 
much better, with more lines being on full pixels. 
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Pixel Precision

While everything you build in Sketch is based on vectors and, there-
fore, infinitely scalable, many things you export still need to be in a bit-
map-based format like PNG or JPG, or at least adhere to a pixel-grid so that 
they look sharp in the browser. It’s also a good idea to check the pixels of 
you work on a high-density display and assess how it could look on a stan-
dard display. The most important tool here is to Show Pixels with Cmd + P, 
which gives you such a preview once you start to zoom in to the canvas 
(Fig. 3.53, left). It’s not completely accurate but a good start. You can also 
display a pixel grid with Cmd + X, which is shown as soon as you surpass 
600% when zooming (Fig. 3.53, right).

 

Fig. 3.53: The arrow icon, zoomed in. Left: Original vector display. Middle: Pixel mode from Show 
Pixels. Right: Pixel grid switched on additionally. 

To prevent half-pixels being created in the first place, you should always 
switch on Pixel Fitting in the General tab of the Preferences. There is 
also a related option you should consider when you are in the vector point 
mode of a layer: make sure that Round to full pixel edges is selected in 
the drop-down in the inspector (below the Corners slider, see Fig. 3.54, 
top).
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But that doesn’t mean that you always need to force yourself to the pixel 
grid — some elements can or should not be aligned pixel-perfectly; for 
example, when you work on a complex object like a logo, full pixels would 
hinder more than help. For more freedom with the placement and move-
ment of vector points you can always choose Round to half pixels (Fig. 
3.54, middle) or Don’t round to nearest pixels (Fig. 3.54, bottom). Even if 
you created a fractional number by mistake, in either its X or Y position 
or the width or height, you can always go back to full pixels with Layer → 
Round to Pixel from the menu bar.

 

Fig. 3.54: Top: Vector points snap to full pixels. Middle: Vector points snap to half pixels. Bottom: Vector 
points don’t snap at all (free placement).
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Especially when you work on mobile designs, a good place to start is at 1x, 
because if you want to go up to 2x or 3x you just have to double or triple 
your assets, whereas 2x as a starting point would always force you to use 
a factor of 1.5 if you go to 3x, thereby producing fractions of pixels. Read 
more about this topic in the info box “Designing at 1x” on page 17.

Last but not least, when you resize an element it’s always a good idea to 
use the Scale… option from Edit in the menu bar, as it gives you a clean 
dialog and a predictable outcome with full pixels. Read more about scaling 
elements in the info box Scale vs. Scale vs. Scale in the next chapter.
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Creating A Logo

Sketch is not only great for icon design but can also be used for logos. 
And we still need one for our app! Since we want these processes to 
be distinct, let’s make a new page, which is ideal for this separation. 

This way you also increase the performance of Sketch, as too many art-
boards on one page can slow down Sketch significantly.

Fig. 4.1: The finished logo. Assign a background color to the artboard (right). 

Organize Your Content with Pages

Pages can be managed right above the layers list and they are collapsed by 
default. Expand them with a click on the icon in the top-right corner of the 
layers list (Fig. 4.2, left): this not only gives us an Add icon but also a list 
of the pages created so far (Fig 4.2, right). Although we haven’t created one 
yet, we still see two entries here: “Page 1,” where we’ve worked so far; and 
“Symbols,” which was added automatically when we set up our “Arrow” 
symbol earlier. Whenever you add another symbol you can find it here — if 
you selected Send Symbol to “Symbols” Page at its creation.
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Fig. 4.2: Left: Click on the icon at the top-right of the layers list to reveal the list of pages. Right: Add new 
pages with the + icon. You can resize the pages area at the bottom. 

Rename the currently active page to “Details” with a double-click and add 
a new page by clicking on the + symbol in the top-right. Name it “Logo” 
and drag it above the “Symbols” page. (You can resize the pages area at the 
bottom, see Fig. 4.2, right) To delete or duplicate a page, right-click on its 
entry and select the corresponding function. If you want to collapse the 
list of pages again, click on the icon right next to the current page’s name, 
above the layers list.

With our “Logo” page selected, create a new artboard with the same name 
and change its X and Y positions to “0” in the inspector. Also alter both the 
width and height to “500,” so that we have enough space to work on the 
asset. As I mentioned earlier, you could also work directly on the canvas, 

Quick tip: You can copy elements from one page to another, or drag 
them to another page from the layers list.

Quick tip: Use Ctrl + Up and Ctrl + Down or the Page Up and 
Page Down keys to switch between pages.
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but as our logo will be white we need a different-colored background to 
distinguish it. The easiest way is to use the background color of the art-
board. Set it to the blue from the Global Colors of the color dialog, for 
example, but make it darker, to have enough contrast (see Fig. 4.1, right).

Inspiration

It can be quite hard to come up with an idea for a logo, so let’s embrace 
the web with its endless possibilities and go to the Noun Project,21 which 
is perfect inspiration for icons and logos. They even have a dedicated 
Mac app that lets you drag icons right into Sketch to be used there as 
vectors. As a special deal you can get three free months of their Pro 
plan if you use the promo code “coolicons” when creating the account 
at smashed.by/sketch-npsignup.

With the name of our app being “Visit Austria” it’s definitely a good idea to 
search for “visit” first. When scouring the search results, you’ll come across 
a certain icon again and again: the pin. Why not take this route? Save a few 
of the related icons to your hard drive as reference material and drag them 

21	 https://thenounproject.com

Quick tip: You can always start to work directly on the canvas if you 
are unsure about the dimensions of a project. Sometimes a fixed 
canvas would be needlessly limiting. To create an artboard from all 
the content on the canvas later, you need only to drag the artboard 
around it once you have selected the dedicated tool with A. Every-
thing within is automatically added to the new artboard. Alterna-
tively, you can also select the entire contents of the canvas with 
Cmd + A and pick Around Selection once you have pressed A.

https://thenounproject.com
http://smashed.by/sketch-npsignup
https://thenounproject.com
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into Sketch from the Finder. What else comes into your mind when you 
think about Austria, or a country in general? Its shape on the map? Per-
haps, but not good enough. What about its flag? Bingo! If you start another 
search for this term, a wafting flag catches the attention, so we will take 
that for inspiration as well.

Fig. 4.3: You can get some inspiration for the logo from The Noun Project. Search for “visit”, “pin” or 
“flag” for example.

The Pin, or How to Control Vector Points

After we have generated some ideas, let’s start with the pin. The basis for 
it is a simple white circle, so add one with a diameter of about 40px in the 
lower half of the artboard. Be sure to hold Shift to get a circle, which also 
locks the dimensions in the inspector. Zoom in to this new shape with 
Cmd + 2 and duplicate it with Cmd + D for the hole. Drag its corners on the 
canvas, but hold down Alt to resize it from the center to 32px. Now select 
both circles and make a Subtract Boolean operation to cut out the hole; 
make sure that the smaller circle is above the bigger one (see Fig. 4.4 for the 
correct Boolean operation). We’re keeping this hole rather big to provide a 
sense of openness or hospitality.

https://thenounproject.com
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Types of Vector Points

For the actual pin shape, press Enter to go into the vector point mode of the 
Boolean group: the lowermost point of the outer circle should be selected 
now. Move it down by about 8 pixels: either add “+8” to the Y value of this 
point or use the Down arrow key for this purpose (Fig. 4.4).

Using the mouse to drag the point on the canvas isn’t the best idea at 
the moment as it doesn’t snap to full pixels and most likely results in 
a double-digit decimal number. However, you can cater for that if you 
change the drop-down in the inspector which says Round: None to 
Round to full pixel edges. Read more about this option in the info box 
“Pixel Precision” on page 116. Be sure to hold Shift when you move the point 
with the mouse, as it locks the movement to the horizontal or vertical 
direction. Alternatively you can also embrace the smart guides to stay on 
the same line.

Quick tip: Hold down Alt when dragging the handles of a layer on 
the canvas to resize it from the center.
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Fig. 4.4: The base of the pin shape, created with a Subtract Boolean operation.

STRAIGHT AND MIRRORED

After you have moved the point down, the icon already starts to resemble 
a pin, but the lower point still needs some hard edges for the perfect look. 
That’s when the different point types in the inspector come into play. But 
first some theory. Every curved line in Sketch is represented by a vector 
point and two handles — the vector control points — that extend from each 
side and control the roundness of the curve. To distinguish between them 
better, the point itself is round while the handles are square (Fig. 4.5, left). 
By default these handles are the same distance away from the vector point, 
which results in an evenly rounded curve — a Mirrored vector point. 

Quick tip: To go the opposite way and switch the smart guides 
off temporarily when you move a vector point with the mouse, 
hold Cmd.
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If you move one of these handle control points, the other moves by the 
same distance and at the same angle (Fig. 4.5, middle).

 

Fig. 4.5: Left: Every curved line consists of a vector point (red) and two control points (blue). Middle: The 
control points of a Mirrored vector point have the same distance. Right: A Straight point doesn’t have 
handles at all. See Fig. 4.7 for the remaining point types

For our pin, when one of the control points is moved towards the lower 
vector point, the other moves in the opposite direction and the curve 
becomes smaller and smaller, until it totally vanishes and the vector point 
becomes a Straight point, with no handles and thus a hard edge: exactly 
what we need (Fig. 4.5, right)! To change quickly between these two point 
types, double-click on the vector point. Sketch is smart enough here to 
adapt the curve in the mirrored mode based on the surrounding points.

Quick tip: To change between the different point types in the 
vector point mode, use 1 to 4, with the order being Straight, Mir-
rored, Disconnected and Asymmetric. Another way to go to a 
Disconnected point is to hold Cmd after you have started to drag a 
vector control point.
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DISCONNECTED

Depending on the type of pin you have in mind, you could also change 
this lower point to Disconnected, but first make a copy of the pin shape 
so that we can compare the different versions: press Esc until the Boolean 
group is selected again, and hit Cmd + D to create a duplicate, that you 
move to the right.

After you have entered the vector point mode and selected the lowermost 
point of the outer shape again, double-click on it to get the handles back. 
Now change to a Disconnected point type with either 3 on the keyboard 
or the dedicated button in the inspector. This type lets you control the han-
dles’ distance and angle individually (Fig. 4.7, middle).

If you move both points up, but leave the angle between the lines that 
extend to the vector point rather big, you create a somewhat bellied form; 
keep this angle rather small and get a more pointed form. While the smart 
guides help you bring these two handles to the same height, it can still be 
quite hard to maintain the same distance or angle for both of them. That’s 
why it is of particular importance that not only every vector point has its 
dedicated X and Y coordinates, but also each handle point (Fig. 4.6). If you 
move the points independently, it’s still easy to bring them to certain spots 
or have certain distances between them.
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Fig. 4.6: Each vector control point has a dedicated X and Y position, that can be controlled in the inspec-
tor. This also applies to the vector point itself.

Let’s say we want the pointed shape for the bottom of our pin. Select the 
left handle point and move it 6 pixels up (add “−6” to Y and press Enter), 
and 8 pixels in (“+8” at X); and the same for the right point: first, 6 pixels 
up (“−6” at Y), then 8 pixels in, but symmetrically, so add “−8” to the X 
axis. Make sure that you only use integers, or the calculations won’t work. 
Alternatively, you can also use the arrow keys on the keyboard to move the 
points the same distances.

ASYMMETRIC

Let’s make another copy of the pin and take a look at the final type of point 
you can choose: asymmetric. Here the two handle points are still on the 
same line, but their distance can be controlled individually, which results 
in different curves on each side of the vector point. This could come in 
handy at the sides of the pin (after we have changed the bottom point to 
Straight again with two double-clicks) and want to make the lower part 
of the pin a little bit more bellied. Select either the left or the right vector 
point of the pin, switch to Asymmetric and drag the lower handle point 
down — about 8px for example. Repeat the same for the opposite point and 
remember that you can copy its Y position to get the same distance.
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 Fig. 4.7: Left: Every curved line consists of a vector point (red) and two control points (blue). Middle: A 
Disconnected point lets you edit the control points of the curve individually from each other. Right: The 
control points of an Asymmetric point are on the same line, but can have a different distance. See Fig. 4.5 
for the remaining point types. 

To my liking, however, the first variant with the Straight lower point (Fig. 
4.5, right) is ideal for our purpose, so let’s take this as the basis for the next 
steps. First zoom out to 100% with Cmd + 0 and press Esc until the Boolean 
group is selected again. Then hold Alt and drag this first shape to the upper 
half of the artboard to create a quick copy for the next course of action. 
Name it “Pin shape” and move it to the uppermost position in the layers list 
with Ctrl + Alt + Cmd + Up. 

The Flag

The next element we want to tackle is the Austrian flag. This consists of 
three equal rectangles in the colors red, white, and red with additional 
points. We could also draw the shapes by hand with a vector, but most of 
the time it’s much easier to take a basic shape and modify its vector points 
or add extra points. I’ll show you both approaches. First, the ideal workflow.
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AN IDEAL WORLD

For the top red bar create a rectangle with the dimensions of 40 × 7 pixels 
next to the pin. Remember that it’s much easier to start with an arbitrary 
size and change the dimensions afterwards in the inspector. Zoom in again 
with Cmd + 2 to make working on the shape more convenient. For the fill 
color use the red from the button within our “Details” page — we have it 
saved as a document color.

Now for the fun part. Enter the vector point mode and add a first point at 
about the first third of the upper segment with a click; do the same at the 
lower segment. Now select both of these points by dragging a selection 
and bring them to the same vertical line with the Left alignment icon 
(third from the left). Repeat that with two additional points in the last third 
of the segments, which you also align to each other (Fig. 4.8).

After that, grab both of the points we added first and move them up with 
the keyboard two or three pixels. Do the same for the last two points, but 
move them down by the same amount. Now double-click on each of the 
points to change them to mirrored. You can tweak the handles now if you 
like, but Sketch actually did quite a good job at adapting the curves to the 
surrounding points.

Fig. 4.8: The upper bar of the flag with the four additional points. Note: I’ve changed the background of the 
screenshot to white for better contrast.  
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THE HARD WAY

Instead of modifying a rectangle, you can also take another approach and 
draw a vector from scratch. Start below the wavy shape we just created so 
you have some reference. Press V to enter the Vector tool and click to add 
the first leftmost point, which results in a straight point. Go right and up 
slightly and click again, but this time drag to the bottom-right, creating a 
curve with two symmetrical handle control points and a mirrored point. 
Please take Fig. 4.9 as a reference.

Go to the right once more, at about the height of the first point, and drag 
to the top-right again to make a mirrored point. The last point at the far 
right should be a straight point at the height of the second, so simply 
click. We’ve just created the upper segment of the shape. Now add another 
straight point below in the same vertical axis, but this time hold Shift, 
which constrains the movement to the vertical, horizontal or diagonal axes. 
Go left and create the remaining points in the same manner as at the top 
segment, but in the inverse order. When you have reached the left edge, 
click on the first point again to close the vector path (you could also click 
on Close Path in the upper right of the inspector).

As it was impossible to align the points to one another while drawing the 
shape, you might want to handle that now in case you are not satisfied 
with the result. Enter the vector point mode again and select all the points 
that need to be at the same vertical or horizontal height: align them with 
the alignment icons in the inspector. To pick multiple points either hold 
Shift and click on the points, or drag a selection. After that you may also 
need to reposition some points individually, or smooth the curves again 
with two double-clicks (one to go to a Straight point; another one to get 
back to a Mirrored point). 
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Moreover it might be necessary to change some points to Asymmetric 
or Disconnected, so that you are able to adapt the vector control points 
independently of each other. Finally change from the default grey border 
to the red fill.

 

Fig. 4.9: Draw a vector from scratch and start at the top-left point. Follow the red arrows for this pur-
pose: when at the blue points, drag in the direction of the blue arrows to get a respective curve.

Quick tip: To join two vectors select them and choose Layer → 
Paths → Join from the menu bar.

As you can see, this whole process can become quite tedious. Often the best 
way is to start from a simple shape and either combine it with other shapes 
with a Boolean operation, or add additional points. Possibly the only excep-
tions are when you want to replicate and trace another shape, like we did 
before with the arrow icon, or you want to create a drawing.
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COMBINING THE PARTS

After our diversion into vector land, let’s continue with the flag. Move 
aside the vector shape we just created (or delete it, as we don’t need it any-
more). Select the red shape from before and duplicate it: hold Alt and drag it 
down until its top side fully overlaps the bottom side of the original. Press 
Cmd + D to create another copy with the exact same offset. Changing the 
fill color of the middle shape to white makes it finally represent the waft-
ing Austrian flag we had in mind.

Group all three bars into a “Flag” group and move it to the hole of the pin, 
so that it sits in the center. You may need to use the arrow keys here for 
some fine-tuning. Make sure the pin is below the flag in the layers list. 
Since the flag shouldn’t be visible outside of the pin, we need to create a 
mask for it. Go into the Boolean group of the pin with a double-click on 
the canvas, click to select the hole in the layers list, hold Alt and drag a 
copy of it into the “Flag” group. Be sure it resides at the lowest position 
(press Ctrl + Alt + Cmd + Down to move it there). Now remove the fill of 
this circle with F, right-click on it in the layers list and select Mask or 
press Ctrl + Cmd + M, which hides all the unnecessary parts of the flag 
(Fig. 4.10, left).

The last thing we need is a nice shadow for the hole, that gives the whole 
pin some depth. Duplicate the circle again, name it “Shadow,” but this time 
move it to the highest position in the layer group (Ctrl + Alt + Cmd + Up). 
Click on Inner Shadows in the inspector and set the properties to “0/0/3/1,” 
with the color being black with 20% opacity (Fig. 4.10, right). Finally, com-
bine the “Flag” group with the pin into the “Pin” group. This part is now 
complete; we only need to add the text to finish the logo.
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Fig. 4.10: Finish the flag, move it to the hole of the pin, create a mask for it and add a shape on top with 
an inner shadow. Please note that I have removed some properties in the inspector to show the relevant 
parts only.

THE WORDMARK

Create a new text layer with T with “Visit Austria” as the content next to 
the pin. The base font should be Avenir Next again with a size of “36,” a 
weight of “Bold” and a white text color. For the Alignment choose Left (the 
first icon). Separate the words into two lines with a line break, and set the 
Line Spacing to “27” so that the letters V and A come very close together. 
You’ll see that these two characters aren’t aligned properly to each other 
(Fig. 4.11, red circle) and the kerning in general needs some work.

For the alignment problem, add a space right before the V, select this space 
and decrease the Character Spacing in the inspector until the letters are 
perfectly aligned (Fig. 4.11, bottom), which should be between “−7” and “−8.” 
Use the Down arrow key in the input field in combination with the Shift key 
to go in steps of 1 instead of 0.1. 
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Fig. 4.11: By default, the letters V and the A 
aren’t aligned properly (top). Create a space in 
front of the V, select it and decrease the Char-
acter Spacing in the inspector until the two 
letters are perfectly aligned (bottom).

Then select the A of “Austria” and decrease the character spacing to 
bring the u closer to it. Do the same for the u itself and the i (to reduce 
the spacing to the s and last a), and the first i and s in “Visit” (to bring 
these three characters a little bit closer together). Please see Fig. 4.12 for 
some reference.

Fig. 4.12: Adapt the Character Spacing 
between some letters for a perfect kerning.
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Quick tip: Use the Character Spacing in the inspector to change 
the tracking or kerning of text. For tracking, select the whole text 
layer; for kerning, pick individual letters. A quick way is to use the 
arrow keys, which changes the value in steps of “0.1.” Combine that 
with Shift for intervals of “1”, or hold Alt to go in “0.01” steps. Learn 
more about this topic in the info box Tracking, Kerning and Ligatures in 
chapter 7.

Now that the kerning looks good we need to convert the text into outlines, 
which is always a good idea for a logo (please have a look at the following 
Quick tip) and also lets us remove the tittle (the dot) of the i in “Austria” to 
replace it with the pin. After you have left the text edit mode with 
Cmd + Enter make a copy of the text layer so you have a backup if you need 
to amend something later. Now go to Layer → Convert to Outlines or 
press Shift + Cmd + O. Access the newly created Boolean group with a 
double-click on the tittle — which should be selected now — and delete this 
shape.

Drag the pin over to the text on the canvas and align it until it sits perfectly 
on the top of the i — about three pixels away vertically. Finally, combine the 
text layer and “Pin” group into a new “Logo” group — and we’ve created our 
first logo (Fig. 4.13).
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Fig. 4.13: All parts combined: the 
final logo.

 

THE CORRECT SIZE

Whenever you need to resize the logo, your first instinct might be to do 
that with the handles on the canvas — which is not a good idea at all. 
Sketch tries to set all the dimensions to full pixels when Pixel Fitting is 
switched on in Preferences (Cmd +,), which can ruin all the hard work 
you’ve put into kerning and alignment. You’ll get better results with this 
option switched off, but shadow sizes and border thicknesses, for example, 
are still not accounted for and remain at their original sizes.

A far superior approach is the Scale option, which resizes everything pro-
portionally. Another advantage of this is that you can set a relative percent-
age value. Access this feature either in the toolbar or by pressing Cmd + K

Quick tip: Whenever you design a logo, be sure to convert all text 
layers within it to outlines in the last step. This ensures that every 
computer, even without the fonts installed, can open the logo — 
especially important if you pass it on for printing. Read more about 
printing in chapter 6, Exporting.
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Scale vs. Scale

When you need to resize an element, your first thought might be to do it 
right on the canvas using the selection handles. While this isn’t much of a 
problem with simple shapes, you should reconsider when you change the 
size of a complex element like an icon or logo, especially if it consists of 
multiple layers that have borders or shadows applied — these properties 
won’t get resized proportionally. If you have a layer with a border thickness 
of 2px, it will have the same width after reducing its size by half on the 
canvas, instead of being 1px (Fig. 4.14). This becomes even more evident for 
text layers, as they don’t get resized at all, which is due to the “Group Resiz-
ing” feature — read more about it in chapter 8 on page 265ff. Text layers 
only change their size with the rest of the elements if they are converted to 
outlines in advance.

Moreover, using the selection handles can lead to unwanted results if 
Pixel Fitting is switched on in the Preferences (read more about this 
setting in the info box Pixel Precision on page 116), as both the spacing and 
dimensions of nested layers get re-calculated to have full-pixel dimensions. 

Fig. 4.14: If you resize layers with a border on the canvas or in the inspector, the border keeps the same 
thickness and isn’t changed in relation to the element’s size.
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This problem can be avoided if you use the Size fields in the inspector to 
resize layers (but remember to lock its aspect ratio beforehand with the 
lock icon, see Fig. 2.20). However, using the Scale option from the toolbar 
(Cmd + K) is still be most ideal way to resize elements: it will not only give 
you relative sizes for the layer properties (like borders, see Fig. 4.15) and 
resize text proportionally, but also a preview right on the canvas, to assess 
the potential result. As an added bonus the dialog lets you set the size in 
percentages, but you can still use good old pixel dimensions. 

By default, the origin of the change is the center of the element, but you 
can adapt this behavior in the bottom-left corner of the dialog (Fig. 4.15, red 
border). There's a small caveat to the Scale option, however: mathematical 
operations don't work here, and you can't use fractions.

 

Fig. 4.15: The Scale option also takes the border thickness (and other layer properties) into account 
when resizing. 
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Everything Comes Together

Since we want to have a little bit of brand-
ing in the details screen, we’ll copy the 
“Pin” group there now. Navigate to the 
“Details” page and paste it right above the 
“Navigation” group in the layers list. Align 
it to the horizontal center of the artboard 
and two grid units (16px) away vertically 
from the title bar. With this final step we 
have finished the second iteration of the 
details screen (Fig. 4.16). 

You have learned how easy it is to employ 
artboards to evolve a design and try out 
different ideas. Be sure make to constant 
use of them! I hope you are also fond of 
some of the advanced techniques in Sketch 
that can make your life as a designer much 
easier. With this knowledge it’s time to 
create an entirely new design in the next 
chapter: the overview screen containing a 
list of all the available tourist sites.

Fig. 4.16: The finished details screen. 
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Layer Management in the Layers List

By now we have a wealth of different layers in the layers list, so it gets 
harder and harder to keep track of everything, especially if many of the 
groups are expanded. To collapse all of them at once go to View → Layers 
List → Collapse Artboards and Groups (Fig. 4.17), which you should 
assign to a keyboard short (see more at the info box Custom Shortcuts on 
page 71).

An alternate way to collapse or expand an artboard and its nested groups 
and layers is to hold Alt and click on the disclosure triangle in front of the 
artboard in the layers list (Fig. 4.17, red border), which shows you the full 
hierarchy. With another Alt-click, the artboard is folded up again, and with 
it all the nested content. If you expand the artboard now (without hold-
ing Alt), just the main groups are shown. Please note that this works for 
groups alike.

Fig. 4.17: Use Collapse Artboards and Groups (from View → Layers List in the menu bar) or hold 
Alt and click on the disclosure triangle to fold up artboards (or groups) and all of its contents. Expand-
ing the artboard now (without holding Alt) just shows the main groups. 
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If you are looking for a specific layer or group and know its name or at 
least part of it, the search function at the bottom of the layers list can come 
in handy (Fig. 4.18). It is accessible with Cmd + F and highlights the Filter 
input field. Matching elements are shown as you type.

 

This way you can also easily reorder elements in the layers list. Say you 
have several elements scattered around on the canvas, that you want to 
bring to the same location (Fig. 4.19, left). Enter parts of the name that these 
elements have in common in the Filter field, select all of them in the layers 
list (by clicking on the first, holding Shift and clicking on the last) and drag 
them to the top until you see the insert line with the circle on the left (Fig 
4.19, middle. Additionally see Fig. 2.18 for the depiction of the insert line). 
Now when you empty the Filter field you’ll see that all of the elements 
have been moved together and placed on top of the other layers (Fig. 4.19, 
right). Use this approach in the same way to group specific layers, rename 
them quickly, or move them altogether on the canvas. 

 

Fig. 4.18: Employ the Filter option at the bottom of the 
layers list to search for specific layers.

Layer Management in the Layers List

By now we have a wealth of different layers in the layers list, so it gets 
harder and harder to keep track of everything, especially if many of the 
groups are expanded. To collapse all of them at once go to View → Layers 
List → Collapse Artboards and Groups (Fig. 4.17), which you should 
assign to a keyboard short (see more at the info box Custom Shortcuts on 
page 71).

An alternate way to collapse or expand an artboard and its nested groups 
and layers is to hold Alt and click on the disclosure triangle in front of the 
artboard in the layers list (Fig. 4.17, red border), which shows you the full 
hierarchy. With another Alt-click, the artboard is folded up again, and with 
it all the nested content. If you expand the artboard now (without hold-
ing Alt), just the main groups are shown. Please note that this works for 
groups alike.

Fig. 4.17: Use Collapse Artboards and Groups (from View → Layers List in the menu bar) or hold 
Alt and click on the disclosure triangle to fold up artboards (or groups) and all of its contents. Expand-
ing the artboard now (without holding Alt) just shows the main groups. 
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Fig. 4.19: Left: You want to bring all the “Entry” groups together at the top of the layers list. Middle: 
Use the Filter option and enter “Entry,” select all of the found elements and drag them to the top of the 
layers list. Right: Now all the “Entry” elements are at the same location. 

Selecting and moving multiple elements to reorder them also works for 
groups and layers. You don’t even need to use the search function to gather 
scattered layers: just select all the elements you want to bring together in 
the layers list and drag them to the preferred location there.
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Creating An Overview Page

Now that we’ve finished the details screen and learned a great 
deal of Sketch’s functions, our next task is the “Overview” page 
containing a list of all the available tourist sites of Austria. It not 

only features a sortable catalog with all the points of interest, but also a 
slightly modified title bar and an options bar to adjust the display of the 
list (Fig. 5.1).

 
 

Fig. 5.1: The list view (left) and the card view (right) of the “Overview” page we are going to create in 
this chapter.
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Set Things Up

Since we want to keep things separate and organized let’s first create an 
“Overview” page to hold the design and all the iterations we might come 
up with. Since the pages area above the layers list should still be visible, 
click on the + icon on the top-right and name the page appropriately. 
Then drag it just below its “Details” counterpart. There are a few different 
approaches to how we could carry over the necessary parts from there. The 
first approach would be to copy the “Details” artboard, insert it on the new 
page and delete all the unnecessary items.

Another way (that I prefer slightly) is to begin with a clean slate, as it forces 
you start from zero and lets you reconsider your workflow. We don’t need a 
lot from the details screen anyway. Take a deep breath and create a new art-
board based on the Mobile Portrait preset with “Visit Austria List View” 
as the name. Be sure to move it to the “0/0” position again. 
 
To make it easier to pull in the only required part, the title bar, head over to 
the “Details” page with Ctrl + Up. In the latest iteration of the design select 
the related group in the layers list and create a symbol from it by clicking 
on Create Symbol icon in the toolbar. Name it “Title bar” and be sure to 
check Send Symbol to “Symbols” page. Although it will have a slightly 
different look than the “Details” page, we can clear the way to use it on 
future artboards with this step. And it’s never a bad idea to have all your 
assets lined up nicely on the “Symbols” page for reference.
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Adaptations

Go back to the new “Overview” page with Ctrl + Down and insert the new 
symbol into our artboard with Insert → Symbols from the menu bar (or 
the appropriate Symbol icon in the toolbar). Align it to the top-left corner. 
Since these two instances of the symbol are now linked, we need to detach 
it with a right-click so we can edit it individually. 

The first adaptation to make is to delete the back arrow: since users will 
be on the “Overview” page at this point, they can’t go back anywhere. The 
profile icon to update the user’s settings should still be present, however. 
Next, change the background color of the bar to the red we defined earlier: 
make another Cmd-click on the title bar to select the “BG” layer and choose 
this color from the Document Colors in the color dialog; in contrast to the 
“Details” page it should have 100% opacity. Finally, edit the text layer of the 
title to “Discover Austria” (Fig 5.2) and create a new “Title bar overview” 
symbol for good measure.

 

Fig. 5.2: The adapted title bar.

Quick tip: Instead of performing a Cmd-click on a group to access 
one of its nested layers, you can also right-click and select Pick 
Layer. This gives you a list of all the layers at the position of the 
mouse cursor, including the full layer hierarchy.
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The New Options Bar

Right below the title bar we will introduce a new options bar that not 
only lets the user change the entries from a list to a card view, but also 
has a search field and filter button to narrow down the displayed tourist 
attractions (Fig. 5.3). The first step is to insert a new rectangle for the back-
ground, named “BG” with 100% width and a height of 32px to adhere to our 
grid. Speaking of grids: they are not automatically applied to all artboards, 
so we need to set up our 8px grid again with a click on View → Grid Set-
tings in the toolbar. To ensure we don’t need to define it again for future 
artboards, make it the default. 

Fig. 5.3: This is how the options bar will look when we are ready.

Zoom in to the artboard and select a white fill color for the background of 
the options bar. Remember that you don’t need to enter the color dialog 
but can use the color picker with Ctrl + C for a quick change. Since a white 
fill on a white artboard background doesn’t make much sense, adapt it to 
“#D2D0D0”: click on the artboard’s title on the canvas, check Background 
Color in the inspector and insert this hex value. I’ve mixed a little bit of 
red into the grey so that it doesn’t look too dull. This should be considered 
for large areas. 
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Black Is Never Black

When you see a dark tone in nature it often seems as if it is a pure shade 
without any color. But don’t let your eyes fool you. Even the darkest black 
mostly has a little bit of color sprinkled in. This is due to lighting and the 
surrounding colors, and also goes for any other shade of grey or white. 
Don’t believe me? Take a photo, pull it into Sketch and measure any part 
with the color picker (Fig. 5.4). You will be amazed that almost every spot 
has some kind of saturation. Ian Storm Taylor’s article “Design Tip: Never 
Use Black”22 explores this idea more closely. 

 

Fig. 5.4: The lovely city of Grado in Italy. Every spot that doesn’t seem to have actual color in nature does 
have some saturation actually (the HSB format is used for every color).

22	 http://smashed.by/sketch-black

http://smashed.by/sketch-black
http://smashed.by/sketch-black
http://smashed.by/sketch
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Bear that in mind when you define the colors for your next UI. The darker 
the shade, the more color you need to mix in (Fig. 5.5). For colors close 
to black, you may need to drag the saturation far to the right in Sketch, 
but for lighter grays only a small amount of color is needed. Generally 
you shouldn’t use pure black at all. With this little trick, designs feel 
much more natural and less dull. But take care not to overdo it, as things 
can swing the other way pretty fast and look very odd, as though some-
body spilled a paint bucket over your design! That’s also why I often 
use an unsaturated tone for text colors, as everything else appears to be 
quite strange.

 

Fig. 5.5: The darker the shade, the more color (saturation) you need to mix in. 
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The Cards Icon

Creating icons is one of my favorite parts of UI design as it not only gives 
me a welcome break from the usual design work, but also lets me discover 
and master a design application like Sketch much more deeply. Although 
it’s always a good idea to gain some inspiration beforehand (remember we 
used The Noun Project23 for this before), in this case there’s not much to 
think about, as a cards icon turns out to be a rather simple icon type: four 
squares, split up into two rows (see Fig. 5.6 for the finished icon)

Since the grid would hinder more than help, hide it and create a rectangle 
with a side length of 7px (hold Shift to get a square) on top of the “BG” 
layer. Don’t worry that it’s off the 8px grid, as this isn’t a sacred rule we 
are never allowed to break, but rather a helpful guide. Zoom in to the new 
shape so that we can better work on this icon (remember, Cmd + 2). Soften 
the square a little with rounded corners of 1px, duplicate and move it to 
the right with a spacing of 2px (Alt + drag is best for that). Select both of 
the elements and duplicate them again, this time to the bottom with the 
same spacing.

Already this looks like the icon we imagined, so select all four of the 
squares and create a Union Boolean operation (Alt + Cmd + U). Finally, 
choose black for the fill color and tone it down to 20% opacity (hit 2). This 
marks it as being unselected, as we are currently on the other view of the 
page, the list view. To reuse this unselected state at a later point we will 
now create our first shared style. With the list icon still selected, click into 
the familiar drop-down in the inspector that says No Shared Style. Pick 
Create New Shared Style and name it “Options bar inactive state.” Now 
on to the icon for the other view of the list. 

23	 https://thenounproject.com

https://thenounproject.com
https://thenounproject.com
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The List Icon

The list view icon is also a bunch of rectangles, but in a slightly different 
arrangement (see Fig. 5.6 for finished icon). Create another square, this 
time with a side length of just 4 pixels, but also a border radius of 1px. 
Duplicate it, unlock its aspect ratio with the little lock icon in the inspector 
(Fig 2.20) and move it to the right with a spacing of 1px. Change its width 
by holding Cmd and using the right arrow key until you reach 11px. Keep an 
eye on the width field in the inspector to get there.

Select both of these rectangles with Shift and drag them down with a 
spacing of 2px, but hold Alt to get a duplicate. This also has the helpful 
side effect of displaying the smart guides for the spacing. Hit Cmd + D 
now, which duplicates the elements again with the exact same distance. 
Achievement unlocked! Pick all the six newly added shapes and create 
another Boolean operation of the Union type. Use black as the fill color 
again, but mitigate it with an opacity of 70% (press 7) so that the color isn’t 
so hard on the eyes.

In addition to the inactive state we also want to prepare this active state 
to be reused at a later point. Like before create a new shared style, but this 
time choose “Options bar active state” for its name. 

Tidy House, Tidy Mind

Time to bring some order to the layers list for the icons. Pick the card icon 
and rename it to “Icon cards”; do the same for the list icon with a name of 
“Icon list.” Select both icons and create an “Icons” group from them; be sure 
it’s within the “Options bar” group. Now add the background layer to the 
selection with Shift, and center all of these elements vertically with the sec-
ond alignment icon from the right in the inspector (align vertically). You 
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can use the grid for some aid to align the icons: space them apart by 16px 
with the same amount from the left edge of the artboard.

Fig. 5.6: The completed cards and list icon.

In Search of Some Sights

On to some new challenges with the search field (have a look at Fig. 5.11 
for the end result). But fear not: its layout is rather simple, though it still 
has a few unique qualities. First, center the canvas to the options bar with 
Cmd + 3, as this will be the location for the field. You might also need to 
zoom out a bit. With the right view, create a new rectangle that has a size 
of 140 × 22px and a border radius of 2px; name it “BG.”I’ve made the back-
ground color a little bit more natural again by mixing some red into the 
base color of black. First I dragged the color to black, pulled the Hue slider 
all the way right to red, increased the saturation to 30 and the brightness to 
20 (Fig. 5.7). 
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This brought me to a color value of 
“#332424”, that I saved for later refer-
ence in the Document Colors of the 
color dialog (Fig. 5.7, bottom). Finally I 
changed the opacity of the layer to 10%.

With “Search sights,” add some place-
holder text to tell the user what this field 
is supposed to do and set its properties 
to Avenir Next with a regular weight, a 
size of 14px and the trusted color of 
black. However, change the opacity to 
50%, so that it actually looks like a 
placeholder, and center it both horizon-
tally and vertically to the background of 
the input field for now. I hope you’re not 
yet tired of icons as we still have two 
more to go for the options bar.

IN SEARCH OF AN ICON

Time to create the typical and widely recognized search icon, the magni-
fying glass (see Fig. 5.11 for the finished icon). It consists of a circle with a 
diameter of 9px, no fill color and an inside border of 2px thickness. Create 
it close to the left edge of the search field. For the handle we will employ 
our old friend the rectangle again (remember to hit R to access this shape 
quickly). Draw one with the size of 3 × 5px and 1px rounded corners. Leave 
the grid switched off to ease the creation of these shapes.

But we don’t need rounded corners on all four sides — just on the bottom 
ones. We could either enter the vector point mode, drag a selection with 

Fig. 5.7: Start from black and mix some red 
into it. Then save it as a Document Color 
(bottom).
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the mouse and change the corners; or, for a quicker method, enter “0/0/1/1” 
in the Radius field of the inspector. Remember you can use the quick top-
left/top-right/bottom-right/bottom-left notation here. Align the two shapes 
to their horizontal center and move the handle down to the bottom of the 
circle, but let them overlap by one pixel.

Before we can combine the two shapes with a Boolean operation we need 
to create a dedicated shape for the circle, as it consists of a border rather 
than a fill: hit Shift + Cmd + O for that and name it “Icon.” Drag the handle 
of the magnifying glass into this new Boolean group in the layers list, to its 
uppermost position. Change the type for the handle to Union, and the type 
for the remaining two circles to None. Like the collapse icon for the details 
screen we recreated earlier, the Boolean operation is quite different to what 
you may try at first (see Fig. 5.11 for the correct Boolean operation). The tra-
ditional approach would be to move the smaller circle above the bigger one, 
set the Boolean operation to Subtract and the one for the handle to Union 
or None. Just keep this alternate approach in mind.

Search icons of this type are typically tilted. Although this isn’t a big task 
we could go down two routes. The first, which I’ve already shown you, is 
to hold Cmd to temporarily switch to rotate mode. This allows you to rotate 
the object with its selection handles at the corners.

However, you are missing an important detail this way. Each element in 
Sketch has a rotation origin around which it can be rotated — but you 
only see this point when you click on Rotate in the toolbar. This point is 
depicted by a little crosshair at the center of the object (Fig. 5.8). You can 
move it to any location you want to place the rotation origin. Unfortu-
nately, this point isn’t saved with the object and neither is it applied when 
you rotate it with the input field in the inspector.
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Fig. 5.8: Every object in Sketch has a rotation point, depicted by a little crosshair, but only if you use the 
Rotate icon in the toolbar.

Either way, turn the magnifying glass by 45 degrees counter-clockwise 
(−45°), change the fill to black, and give the whole element an opacity of 
50%. Remember you can hold Shift to rotate in 15-degree steps.

Quick tip: One specialty of Sketch is that rotations of groups alter 
the axes of contained elements, no matter if you resize them with the 
selections handles or the keyboard (Cmd + arrow keys). This tilted state 
is even represented by the smart guides and if you add new objects 
to the group. Modifications to vector points however are not affected 
by this behavior, but you can always move the element out of the 
group, adapt its points, and put it back in. Removing the group with 
Shift + Cmd + G applies the rotation to its elements.
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Please note that most of these concepts don’t apply to Boolean groups, but 
you can still see the altered axes in action if you enter the Boolean group of 
the search icon and resize the handle with the mouse (Fig. 5.9). 

Fig. 5.9: Modifications to children of rotated groups happen at the same angle as the rotation  
of the parent. 
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Transformations

Besides rotations, Sketch also allows us to transform elements using the 
Transform icon in the toolbar. Move the corner handles (Fig. 5.10, red) to 
distort the object and hold Cmd to apply the transform only from one side. 
The selection handles on the sides of the element let you skew the object 
(Fig. 5.10, blue). Transformations are especially handy to create 3D effects 
or to bring some perspective into them. There’s even a plugin called Magic 
Mirror24 that lets you automate this process and modify the content even 
when it’s already been transformed (which isn’t possible by default).

Fig. 5.10: Use the Transform tool from the toolbar to distort a layer (with the red handles), or to tilt it 
(with the blue handles).

24	 http://magicmirror.design

http://magicmirror.design
http://magicmirror.design
http://magicmirror.design
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FINAL MOVE

Back to our search field. Move the placeholder text 22px away from the 
left edge of the background to leave some room for the icon, which we 
will place here. It should sit neatly in the middle of this cleared space and 
also be centered vertically to the background. Lastly, select all the ele-
ments from the search field in the layers list, create a “Search field” group 
and align the whole bunch to the vertical and horizontal center of the 
options bar’s background using the alignment icons (fourth from the left 
and second from the right). Make sure that it is also within the “Options 
bar” group and above the “BG” layer. We’ve now finished the search 
field (see Fig. 5.11) and can approach the last element in the options bar: 
the filter button.

 

Fig. 5.11: The finished search field with the correct layer hierarchy.
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A Filter Button

When I prepared to create the filter icon I realized there wasn’t a single 
icon that represents this type of function, but I quickly narrowed it down 
to two: range sliders, and funnel. Let’s start with the sliders, but also cre-
ate the funnel for the card view of the “Overview” page later, to have an 
alterative. It’s straightforward again, as the sliders icon consists of just a 
rectangle and a circle, both duplicated and mirrored (take a look at this icon 
in Fig. 5.13). Move your viewport to the right edge of the options bar and 
start there.

The rectangle should be 12×2px with rounded corners of 2px; the circle 
should have a diameter of 5px. Instead of a rectangle we could also draw 
a line with L, hold Shift to constrain the movement to the horizontal axis, 
change its length to 10px, the border thickness to 2px and the ends to 
rounded with the middle icon at Ends in the border options (which can be 
shown with a click on the little gear icon). But the moment you inspect the 
properties of the line in the inspector, you’d see the inherent problem of 
this type of shape: it’s always placed on half-pixels, even when you create 
outlines. That’s why I rely on rectangles whenever possible.

Owing to the difference between the rectangle and the circle — one has 
even dimensions, one uneven — they can’t be centered vertically. This 
becomes apparent as soon as we try. For once, we won’t care about half-pix-
els and we’ll move the circle down by 0.5px. The easiest way is to enter 
the Y field in the inspector, hold down Alt and use the arrow keys to go in 
0.1px steps. Also move the circle 2px away from the right edge of rectangle, 
select both shapes, duplicate them and move them down with a spacing of 
1px between.
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For this second row the circle should be 2px away from the left side of 
rectangle. As a little trick, select it, hold down Alt, point to the rectangle 
with the mouse, leave it at this position, and move the circle with the arrow 
keys to see the distance. Select all four shapes and apply a Union Boolean 
operation. Now we can employ the shared style we set up earlier on the 
list icon. Click on the respective icon in the drop-down again and select the 
style “Options bar active state” (Fig. 5.12). This takes the styling properties 
over to the filter icon: a color of black with an opacity of 70%. Whenever 
you want to have another color for both of the icons you just need to adapt 
it and click on the round arrow next to the drop-down (see also Fig. 3.22 on 
page 80), which automatically changes it for all instances of this shared 
style. Nice! For the name of the Boolean group, use “Icon filter.”

 

Fig. 5.12: Take over the styling from the list icon with the shared style. 

Finally, add the “Filter” label with the same color properties, a font size of 
12px and a regular weight. The rest is just some naming and positioning: 
move the text 4px away from the icon, align them vertically to each other, 
create a “Filter” group, and move it away by 16px from the right artboard 
edge to adhere to the grid. Place it into the “Options bar” group in the 
layers list and center the filter group to it vertically. We just finished the 
options bar. Well done!
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Fig. 5.13: The filter icon is ready.

A List of Tourist Sites

The list view of the overview screen consists of eight identically structured 
entries with different content (see Fig 5.1, left), so we only need to create 
the first line and use it as a model for the other seven (Fig. 5.15). There are 
multiple approaches to achieve this goal in Sketch. I will show you each of 
them, but first let’s create our initial entry.

THE MODEL

Make use of the grid again and draw a white rectangle with a height of 
64px, equally 8px (one grid unit) away from the left and right edges of the 
artboard and from the options bar. Give it 4px rounded corners followed 
by a nice black shadow with the properties of “0/2/0/0,” and 10% alpha to 
add some depth. Name this element “BG” in the fashion of other back-
ground layers.
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Let’s move on to the content. For the image of the attraction create a circle 
with “56 × 56” and pull in a photo of your liking — I’ve used one from 
unsplash.com to speed up the process. Make sure that it is above the circle, 
both in the layers list and on the canvas. Select both, the image and the 
mask, and click on Mask in the toolbar to restrict the photo to the shape of 
the circle. You might need to adjust the size and placing of the photo now, 
so that the relevant parts are visible. It’s also a good idea to lock it with 
Shift + Cmd + L to avoid an unintended selection. Align this mask group to 
the vertical center of the background, move it away 8px from the left edge 
and name it “Image.” For the title of the tourist site add a bold black, left-
aligned text layer outside of this group with a size of 22px. 

There should be gap of about 10px to the top of the background and it 
should sit nicely on a grid line. The content doesn’t matter, as it will be 
replaced shortly, but use “Title” for now.

The next element is the location, comprising the state, city and a pin icon. 
For the icon we can benefit from knowledge we gained creating the logo 
(you might want to have a look at Fig. 4.5 for some reference), so add the 
outer circle with a diameter of 8px first. Hide the grid now as it doesn’t 
help much at the moment, but zoom to about 800%. Duplicate the circle, 
hold Alt to resize it from the center — together with Shift to constrain 
the ratio — and drag it to a size of 4px. Select both to create a Boolean 
operation of Subtract, but make sure that the smaller circle is above the 
larger. Now enter the vector point mode of the Boolean group with Enter, 
and move the bottom point of the outer circle — which should already be 
selected — down by 2px with the arrow key. Finally, change the point mode 
to Straight, give the element a color of 40% black, and rename it to “Pin,” 
which completes the icon.

http://unsplash.com
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The text for the location should have a regular weight and a size of 12px, 
toned down to 60% black. Its content is “Location.” Align it vertically with 
the pin, group them to “Location” and set a distance of 4px between the 
elements. Position this group below the title, so that it also aligns to a grid 
line. Make sure that both the title and the location are also left-aligned to 
the grid horizontally with a distance of 16px to the image.

The last element for our model of the entries is a text layer with the dis-
tance from the user’s current location to the tourist site. Enter “100 km” for 
now and use the same properties as for the location but with a size of 14px. 
Place it one grid unit from the right of the entry’s background and at the 
same height as the title of the entry. The alignment icons don’t work here, 
as both of these text layers have a different line height. 

You could use the smart guides instead, but if you have a whole lot of other 
elements on the artboard, this can become quite fiddly.

Let’s try out something new and employ the custom guides of Sketch for 
the first time to act as a guide for the alignment of the text layers. Before 
you can add a new guide you need to show the rulers with Ctrl + R. Hover 
over the left bar of the rulers to show a preview of the guide and click at 
the position where it aligns to the baseline of the entry’s title. After that, 
move the distance text layer to the same line with the arrow keys. You can 
hide the rulers again now.

Quick tip: Use Alt + Cmd + = or Alt + Cmd + – to increase or decrease 
the font size of a text layer after you have added it. By default, it is 
resized from the top this way, but if you have previously altered its 
line height, the resizing happens from the baseline.
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Fig. 5.14: Show the rulers with Cmd + R and set a custom guide to align the title and the distance to each 
other. Click on the leftside ruler to add the guide.

The final thing to do for this layer is to decrease the font size of the “km” 
unit to emphasize the number itself a bit more. First, change the Align-
ment of this layer to Right in the inspector (third icon), since we’ve already 
aligned it and a change of the text size would reposition it. Then start to 
edit the text layer with a double-click, select “km” and press Alt + Cmd + – until 
it reaches a size of 8px. Confirm the action with Cmd + Enter. Complete the 
first entry of the sights by selecting all of the belonging elements, group-
ing them as “List entry” and moving them to the bottom of the artboard 
with Ctrl + Alt + Cmd + Down.

 

Fig. 5.15: The completed model of the list entries.
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Rulers and Guides

Individually, rulers are not particularly useful, but they enable you to add 
custom guides to align elements or act as reference points. You can show 
them with Ctrl + R. Add a vertical guide with a click on the top ruler (Fig. 
5.16, top); a horizontal guide is placed with a click on the ruler on the left of 
the canvas (Fig. 5.16, left). After that you can drag them to any other posi-
tion. If you drag the ruler instead you are changing its zero point. To make 
it easier to place a guide, select a layer first and let the guide snap to its 
boundaries when you hover over the ruler.

 

Fig. 5.16: Click on the top ruler to add a horizontal guide and on left ruler for a vertical guide.
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To delete a guide, simply drag it out of the canvas or right-click on the ruler 
and select Remove Guide, or Remove All Guides to clear them all at once. 
Most of the time, you don’t even need to add a custom guide to align layers: 
hover over the relevant ruler to see a preview of the guide, leave the mouse 
pointer where it is and use the arrow keys on the keyboard to move and 
align the currently selected layer to this guide (Fig. 5.17).

 

Fig. 5.17: Hover over the ruler to show a preview of the guide and align the layer to it with the arrow keys.
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Other Entries

As this first entry of the tourist attractions is supposed to act as a model for 
the other entries, it should be as reusable as possible. What better than a 
symbol for this task? Let’s do it. Select the layer group and create a symbol 
with the appropriate icon in the toolbar. Leave the name as “List entry” but 
don’t check the Send symbol to “Symbols” page checkbox yet: we want 
to have the master symbol beside the list itself to see possible adaptations 
right away. We can move it to the dedicated “Symbols” page later.

As I’ve mentioned before, there are several ways to get to the other entries 
of the list. The first one, which you have already learned, is to drag an ele-
ment with the mouse while holding Alt to create a copy. Pressing Cmd + D 
subsequently creates various copies with the same spacing. Do this with 
the new symbol, but be sure to zoom to 200% first to catch the correct 
spacing of 8px. Duplicate the element six times until you reach the bottom 
of the artboard.

A slightly easier and yet underused method is to employ the Make Grid… 
feature of Sketch, which can be found under Arrange in the menu bar. It 
gives you a handy overlay that lets you decide in how many rows and col-
umns you want to lay out the selected element. Furthermore, the margin 
between the copies can be defined. To make use of this method, delete all 
the copies we’ve recently created by pressing Cmd + Z until you reach the 
initial state with just one entry again. In the Make Grid… overlay, enter 8 
rows with a margin of 8px; for the columns select “1,” which automatically 
grays out the respective Margin field (Fig. 5.18). With a click on Make 
Grid you see the same result as before.
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Fig. 5.18: Use Make Grid… from Arrange in the menu bar to create the other entries.

You can use this feature not only to duplicate a single element, but also 
to rearrange existing elements. Say we want to have a spacing of 16px 
between the entries instead: select all of them, call Make Grid… again, 
set all the input fields as above, but this time pick a margin of 16px. A click 
on Arrange adapts the spacing to this new value. But go back to the result 
with 8px spacing. As soon as you have multiple layers selected, you see the 
Duplicate layers to missing cells checkbox, which makes sure that the 
exact number of rows or columns is met, even if fewer layers were selected 
on the canvas. New copies are created in this case.

No matter which method you chose, the list looks pretty dull now with all 
the entries the same, so let’s unleash the full power of symbols with their 
overrides. If you click on one of the entries, you see the Overrides area 
in the inspector, where each of the text layers has a dedicated input field, 
which enables you to change the content of each instance individually (Fig. 
5.19). What you might notice now is that the image has no dedicated over-
ride, which can be traced back to the fact that we locked the image earlier 
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to prevent an unintended selection. This also removed it from having an 
override function, so you need to select and unlock it in the master symbol 
with Shift + Cmd + L now.

 
Fig. 5.19: You can adapt the content of each entry with the Overrides fields of the symbol in the inspector. 
Images can be directly pasted after clicking on the thumbnail (red border).

Back at the instances, enter different values for each text field and image 
at Overrides to populate the list with varying data. Just as before, you can 
directly paste a bitmap from another application after you have clicked 
on the thumbnail in the inspector (Fig. 5.19, red border). Although each 
entry looks different now, it is still based on the same symbol. The reason 
we didn’t send it to the “Symbols” page is that we can edit it in context 
when it’s placed next to the relevant artboard. If you decide that a smaller 
image would look better, the pin icon isn’t appropriate anymore, or the title 
should have another color, you can change it here and immediately see 
how these changes look in the real thing. To create some order again, put 
all the symbols into a new “Entries” group.
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Pasting

Even seemingly simple tasks like pasting have different layers of function-
ality in Sketch. By default, elements you paste into Sketch from another 
application with Cmd + V are placed at the center of the currently selected 
artboard (the image in Fig. 5.20). If you copy something from one artboard 
to another, the original position is preserved. However, the location in 
the layers list stays the same in both circumstances: it’s always above the 
currently selected layer, or, if no layer is selected, at the top of the artboard. 
There’s only one exception to this rule: if the currently selected layer isn’t 
in view on the canvas, the pasted element gets inserted at the center of the 
canvas itself, above everything else.

Pasting can be quite a challenge and depends on different factors. That 
said, there are a few options to insert content at exactly the place you want. 
Use Shift + Cmd + V instead to always paste elements above the top-left 
corner of the formerly selected layer. This even works if multiple layers are 
inserted, in that the original positions of the elements in relation to one 
another are preserved. A very similar option is to right-click and pick Paste 
Here (Fig. 5.20): this inserts content at the current position of the mouse 
cursor, above the currently selected layer in the layers list.

Fig. 5.20: By default, content that 
you paste into Sketch from another 
application is placed at the center of 
the currently selected artboard (or 
the original position, if you copy it 
from another artboard). To place the 
content at a certain position make 
a right-click and select Paste Here, 
or pick another layer first and press 
Shift + Cmd + V to insert the new 
content at its top-left corner.
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While it’s usually ideal to employ symbols for similar elements, you could 
also use their little brother, shared styles, to quickly pass the properties 
from one element to another and keep them in sync. Either way, try to 
create reusable components as often as possible to make sure everything 
within your designs has a consistent look. This is also important for style 
guides or whole design systems like atomic design.25

Designing with Real Data

When you changed the text layers and images of all the instances, you 
might have thought to yourself that this is pretty tedious, there must be a 
better way. There is, my friend; not natively in Sketch, but with the help of 
plugins. They not only let you fill your designs with dummy content, but 
also enable you to pull in real data from various sources, or even use your 
own content in the form of JSON files. Some of them even let you lay out 
elements in the same manner as Make Grid… and at the same time popu-
late them with real data.

This is not only faster, but also means you can assess how your designs 
adapt to real content, and how they hold up against some unexpected vari-
ations you might not have considered. In short, it forces you to think in a 
different way, to see things from a more practical perspective.

Let me give you an overview of these content generators, with a brief 
description of each. Take a look at their websites or GitHub pages for more 
information and detailed instructions.

•	 Craft26 by InVision27: For me this is one of the best plugins available. 
It combines different helpers to duplicate elements and fill them with 
content. You can either choose from predefined data, open a website 

25	 http://smashed.by/sketch-atomicdesign
26	 http://smashed.by/sketch-craft
27	 http://www.invisionapp.com/

http://smashed.by/sketch-atomicdesign
http://smashed.by/sketch-craft
http://www.invisionapp.com/
http://smashed.by/sketch
http://smashed.by/sketch
http://www.invisionapp.com
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to select text and images, or pull in JSON content. The plugin can 
even create a style guide automatically for you, and allows you to 
share design assets with your team.

•	 Sketch Data Populator28: This falls into the same category as Craft, but 
you can also employ placeholders in your layers that are later popu-
lated with content from a JSON file. Like Craft, it lets you duplicate 
elements with varying data easily.

•	 Content Generator:29 This one provides predefined data like city 
names or email addresses, but also lets you add relevant random 
numbers to fit a data pattern. You can also pull images from Flickr 
or create avatar images, but generating text is certainly the strongest 
feature of this plugin.

•	 Day Player:30 A collection of images from various sources. The major 
differences from the other plugins are that you can specify the dimen-
sions of the images, and they are inserted as separate layers instead of 
fills, which is much more flexible — as you already know.

CRAFT MORE ENTRIES

Since you have already learned two methods to create the other tourist 
attraction entries from the base element, let’s take a look at a third that 
employs the Craft plugin. You can duplicate the sights easily, and automat-
ically populate them with different content at the same time.

28	 http://smashed.by/sketch-datapopulator
29	 http://smashed.by/sketch-contentgenerator
30	 http://smashed.by/sketch-dayplayer

http://smashed.by/sketch-datapopulator
http://smashed.by/sketch-contentgenerator
http://smashed.by/sketch-dayplayer
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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With the plugin downloaded and installed, we need to prepare the art-
board. First, duplicate it so that we have the different methods side by side; 
name it “Visit Austria List View Craft.” Do the same with the master sym-
bol of the entry and give it a new name like “List entry Craft.” Now connect 
these two: select the symbol of the first entry in the new artboard and swap 
it with the drop-down in the inspector that still says “List entry” (Fig. 5.21). 
The remaining entries can be deleted. The same goes for the override value 
of the title. 

 

Fig. 5.21: Duplicate the symbol of the list entry and link it to the new artboard. You can delete all the 
other entries and the values of the Overrides.

Finally, you need to change the image from a dedicated layer to a pattern 
fill: go to the master symbol, pick the image layer, delete it and select the 
layer that acted as the mask before. To populate it with a bitmap fill, click 
on the third icon in Craft’s toolbar (show it with Craft → Toggle Panel 
from the menu bar if it’s not already there) and from the Custom tab select 
Photos. Now hit the Unsplash button. After you have selected the cate-
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gory from the drop-down — Landscape or Scenery should be appropriate 
for our purpose — a click on Place Photos gives us the actual image (Fig. 
5.22, left). If you aren’t satisfied with the photo, repeat the process.

You should also fill the text layers in this way, as it allows us to use Craft 
as much as possible in what follows. Instead of Photos click on Type. For 
the title, pick the Cities category, for example (Fig. 5.22, right); the location 
could be populated with Countries.

 

Fig. 5.22: Left: Change the mask to a pattern fill and populate it with an image, using the Craft plugin. 
Right: For the title pick Cities from Type.

Now that we’ve taken care of the content, we can employ Craft one last 
time for the remaining entries. Return to the instance of the symbol in 
the list view, go to the Craft panel again, but this time select the last icon 
(Duplicate). Like Make Grid… you can define the number of duplicates 
and the spacing in between. Since we want to lay out the entries vertically, 
enter “8” for the Count and “8” for the Gutter like before. A click on Dupli-
cate Content not only creates the remaining entries but also varies the 
content (Fig. 5.23). Sweet!
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And it doesn’t stop there: you can adapt the spacing on the fly with the 
slider or the input field after you have selected the “Duplicate content” 
layer, and also create more items by just enlarging the size of this layer 
on the canvas (Fig. 5.23, left). Awesome! The only thing that needs to be 
changed manually is the distance: select each entry and use the overrides 
in the inspector to create individual values for each line.

 

 
Fig. 5.23: Create the remaining entries with Craft’s Duplicate panel. Left: You can adapt the spacing 
and count of entries on the fly after selecting the “Duplicate content” layer in the layers list.

The Card View

The overview screen not only consists of a list view, but can also be 
switched to a card view with a different layout and larger images to whet 
the user’s appetite for the different sights (see Fig. 5.1, right). We’ll cre-
ate a single card first and convert it to a symbol later to get to the rest of 
the items.
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THE BASICS

First, duplicate the latest artboard of the list, but this time hold Alt and drag 
it to the bottom, as it represents a totally new state and not an iteration. 
Rename it to “Visit Austria Card View.” Delete all the entries except the first, 
which we will adapt now and use as the model for the other entries. Unlink 
it with Detach from symbol after a right-click so that we don’t alter the list 
view. Afterward, rename it to “Card entry,” ungroup the parent “Group” that 
has been created by Craft and delete the “Duplicate content” layer below.

To start with the adaptations, select the background with a Cmd-click and 
change its size: it should fill half of the artboard and be 16px away from its 
sibling in the same row and the edge of the artboard. Let’s use the mathe-
matical capabilities of Sketch again to calculate the required width: divide 
the width of the artboard by two, subtract the distance to the left edge 
(16px), as well as half the width to the other entry (16/2), which leads us to 
“360/2 − 16 − 16/2” and the final size of 156px. For the height, choose 176px 
for now.

NUDG(E) IT

Since all of our spacings are based on an 8px 
grid, we could show it again and realign this 
layer using the mouse. However, Sketch also 
allows us to change the distance layers are 
moved with the arrow keys. The easiest way 
to alter this value is to use the little com-
panion app Nudg.it31 that gives you a handy 
dialog for this purpose. 

31	 http://www.nudg.it

Fig. 5.24: Use the companion app 
Nudg.it to set the distance layers are 
moved with the arrow keys.

http://www.nudg.it
http://Nudg.it
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Use it to set the Big nudge from 10px to 8px (Fig. 5.24), which changes the 
behavior of the arrow keys in combination with Shift. To try out the new 
nudge distance, press Shift + Right to move the “Card entry” group 8px to 
the right, followed by Shift + Down to the final position. The last thing to 
change for the background is the shadow: give it the properties “0/3/8/0.”

A NEW ARRANGEMENT

Now to the content itself. The title is much too long for the card view, so 
let’s resize it to 16px. We also need to shrink the “Distance” text layer to 
12px (including the unit), change its Alignment to left, move it below the 
location, and left-align it. Select all of these layers (title, location, distance) 
and group them to “Text.” Move this group to the bottom-left edge of the 
card for now.

For a distinct look, the image should get a different appearance: delete the 
old “Image” group and add a rectangle at the same place in the layers list, at 
the top-left of the card; that acts as the container. Change its width in the 
inspector to “100%,” the height to “54.5%” (96px) and the name to “Image.” 
For the actual image, use the Craft plugin again. You might notice now that 
we lost the rounded corners from the background at the top of the bitmap. 
To bring them back we need to select the “BG” layer so we can change it to 
a mask with Ctrl + Cmd + M. Voilà! The rounded corners are back.

The last action to perform for the card is to align the “Text” group to the 
grid again. Use Shift + Right to nudge it in by 8px from the left edge of the 
card. Make sure that all of the text layers sit on a grid line vertically and 
have enough spacing from the image and each other.
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Fig. 5.25: The new card entry.

USING THE SYMBOLS

The card looks great so we can again 
convert the “Card entry” group to 
a symbol with the same name. As 
before, don’t send it to the “Symbols” 
page yet — it’s easier to alter it and 
see changes right on the artboard. If 
you can’t find the new symbol any-
more, it may have been added next to 
the rightmost artboard on the canvas. 
Move it back to the correct position 
next to the “Card view.”

Fig. 5.26: Use the Duplicate function of 
Craft again to create the remaining entries 
of the card view — this time lay it out in 
both axes.
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Now everything is ready for us to use Craft again to create the rest of the 
entries. With the symbol selected on the artboard, click on the last icon 
in the panel of the plugin (Duplicate). This time we want to lay out the 
element both vertically and horizontally (a Count of “3” vertically and “2” 
horizontally), to give us a total of six cards. The gutter should be 16px for 
both axes. A click on Duplicate Content almost brings us to the final state 
of the card view: you just need to change the distance — again — for each 
entry with the overrides.

TWO MORE ICONS

These changes brought us a big step closer to the finished card view, but 
there are still two things to deal with: first, change the icon in the options 
bar to indicate that the card view is active; and second, create an alterna-
tive of the filter icon (a funnel, Fig. 5.28) so we have two versions to choose 
from. The former is quite easy to handle: just swap the shared styles we 
created earlier between the icons (Fig. 5.27).

 

Fig. 5.27: Swap the layer styles of the two icons.

The second task represents a more difficult endeavor, but with our past 
experience at creating icons it shouldn’t be too hard. First, zoom in to the 
original filter icon with Cmd + 2, but hide it so we can replace it with a tri-
angle for the bowl of the funnel. Instead of using the most obvious shape 



Creating An Overview Page

181

for this, try a rectangle; create one with the size of “11 × 5.” Enter the vector 
point mode and insert a new point in the exact middle of the lower side 
with a Cmd-click. Now select the outer points on this line and delete them. I 
prefer this approach over a using a triangle as it has no dedicated keyboard 
shortcut and is always pointing upwards. Another reason for a rectangle is 
that we can set the radius, which we will do right now with a value of “2”; 
right after we have left the vector point mode by pressing Esc twice.

Next we need another rectangle, this time with dimensions of “3 × 8.” Align 
its top side to the bottom of the triangle, but move it one pixel up, so that 
the shapes overlap. Center them horizontally. Make a short trip into the 
vector point mode of the second rectangle for some more rounded corners: 
Tab to the bottom-right point and set the Corners to “1”; press Esc to leave 
the input field and Tab another time to get to the bottom-left point, which 
should have a value of “0.5.” Move this point the same distance up as the 
shape’s width (3px) with the arrow key to get a 45-degree angle for the 
bottom line.

To finish the icon, select both shapes, create a Union Boolean operation, 
apply the shared style “Options bar active state” and rename it to “Icon fil-
ter.” Center it vertically to the “Filter” label with a spacing of 3px between, 
but lock the label with Shift + Alt + L first, as it already has the correct 
position. Finally make sure the icon is in the existing “Filter” group. Which 
icon you choose in the end is up to you — I’d go for the little sliders.
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Fig. 5.28: The new filter button with the funnel icon.

ACTIVE STATE

Do you remember what I told you about symbols earlier, that you should 
employ them as often as possible to create reusable components? Right, so 
let's do this with the options bar in the card view. Select its group, click on 
the familiar Create symbol icon in the toolbar, but this time send the sym-
bol to the “Symbols” page, as there’s no need to have it besides the artboard. 
Now, go to the list view and insert the newly created symbol at the same 
position as the “Options bar” group, which you can delete now. Wait! We 
are on the list view, but in the symbol, the icon for the card view is active.

Because we can’t have two different states in the same symbol, let’s employ 
a little trick. Enter the symbol with a double-click and change both of the 
icons to the “Options bar active state” shared style (Fig. 5.29, top). Return to 
the instance with the appropriate link, where you create a new rectangle 
that covers the icon for the card view, and name it “Inactive state.” Change 
the fill color to white with an opacity of “70%,” which is just about the same 
as if we had set the icon itself to “20%.” Now we have our deactivated style 
again. Do the same for the list icon, but in the card view. 



Creating An Overview Page

183

To go one step further with the active state of the view icons, we could 
even make a nested symbol for each of them. Enter the “Options bar” sym-
bol with a double-click, select the icon of the card view (“Icon cards”) and 
create a nested symbol and name it “Icon cards” so that it has the same 
name as the layer. 

Now click on this new symbol in the layers’ list and duplicate it with 
Cmd + D. Rename it to “Icon cards deselected” and set the layer itself 
(not the symbol) to “20%” opacity with 2. Do the same for the icon of the 
list view: select it (“Icon list”), create a same-named symbol, duplicate it, 
rename it to “Icon list deselected,” and set its layer to 20%.

Now you have four symbols, one for each state of the icon (Fig. 5.29, 
bottom). Select the original “Options bar” symbol and return to the 
“Overview” page with the Return to Instance link.

Fig. 5.29: Top: Enter the symbol of the options bar and set both icons to the “Options bar active state” 
shared style. Bottom: We have one symbol for each state of the view icons. Return to Instance link.

Quick tip: To create some quick color variations, overlay a vibrant 
color with a white or black layer, and reduce the opacity. Read more 
about this technique in the next info box.
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Back at this view, you can conveniently change from one state of the icon 
to the other with the drop-down fields at the Overrides in the inspector 
(Fig. 5.30). Since we are currently at the list view, select "Icon cards dese-
lected" for the Icon cards override. You just have to delete the redundant 
“Inactive state” layer first, that we used for the overlay.

On the artboard for the card view, do the same, but for the Icon list over-
ride: select "Icon list deselected" there. The similar dimensions of the icons 
even allows to swap their positions with the Overrides, and for example 
set the one for the list to the left.

Fig. 5.30: Back at the list view, you can conveniently change between the symbols for the active states of the 
icon: “Options bar list view” and “Options bar card view.” The same goes for the card view.

Because the options bar itself is based on a symbol, every change to it is 
automatically transferred to all other instances. If you decide that the other 
filter icon looks better, you can swap it there and see how this change 
affects all appropriate symbols. You could even use a nested symbol for the 
filter icons, too. They just need to have the same dimensions.

With this final step, we’ve finished the overview screen and at the same 
time the app, for now. Designing it in Sketch was a breeze so far, but what 
good is the best design application if you can’t get the various parts out of 
it and into a website or app? Luckily, Sketch also excels in this regard, so 
stay tuned for the next chapter, where I will show you how to export all of 
the necessary assets.
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Create Color Variations

A neat trick I learned from bjango32 is to overlay a vibrant color with black, 
white or another light color to create some quick variations of the same 
color or an entire color palette. On a new “Color variations” page, add a 
rectangle with the size of 120 × 120, named “Base color.” Fill it with the 
color you want to vary, for example “#4A86E2.” Now, create another rect-
angle, named “Lighten,” with the same width on top but a height of just 
40 pixels. Align it to the top of the colored rectangle, and set its fill color 
to 20% white. Hold Alt and drag it to the bottom of the colored rectangle to 
duplicate it, but give it a background of 20% black. Name this one “Darken.” 
This alone will give you a lighter tint and a darker shade of the same hue to 
choose from (Fig 5.31, left).

Fig. 5.31: Left: Create a colored rectangle and overlay it with two other rectangles: one with 20% white 
(top), one with 20% black (bottom). This alone gives you two variations of the same color. Middle: 
Create another two rectangles on top, but make them upright. Change the blending mode to “Overlay” 
for both; give one 80% opacity (right column), one 40% (middle column). Right: To create variations of 
another color, duplicate all of the layers created so far and change the base color

But it doesn’t need to stop here. For even more variation, add another rect-
angle on top of the other layers with a bright color like yellow (#F8E71C), 
but this time make it upright (40 × 120) and name it “Variation 1.” Move 
this rectangle to the right edge of the colored base. Give it an alpha value 
of “80” and a blending mode of Overlay, which will mix it with the under-

32	 http://smashed.by/sketch-bjango

http://smashed.by/sketch-bjango
http://smashed.by/sketch
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lying colors. Duplicate it to the left in the same manner as above, name it 
“Variation 2,” but modify the alpha value to “40,” with the same blending. 
Now you have a base color (the one in the middle of the left column) and 
eight variations, which should give you more than enough choices for your 
next interface design (Fig 5.31, middle). In the end, you can lock all layers 
except the base color so that you are able to change just this one.

If you want to vary another base color, just select all of the layers from above, 
add them to a “Color 1” group and duplicate it to the right. Afterward, rename 
this new group to “Color 2” and adapt the base color to your liking (Fig. 5.31, 
right). Try it out with “#63D321” and “#B313FE”, for example.
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Exporting Assets

One of the strongest selling points of Sketch is its powerful yet 
simple exporting capability — no intricate or complex dialogs 
with a bunch of different options, just a relatively small area in the 

inspector. The most obvious choice during the design phase is probably to 
export whole screens, or artboards, to show them to your peers and clients 
or simply to assess how they look on your mobile device.

To mark an artboard for exporting, select it first, then click on Make 
Exportable in the bottom-right of the inspector. This will give you various 
options for the file to be created.

 

Fig. 6.1: Select an artboard and mark it for exporting with the Make Exportable button in the bottom- 
right of the inspector (1), which gives you various options (2). You can also set a background color for the 
exported asset (3).



188

Chapter 6

Size

Size lets you define the resolution or pixel density of your asset export. 
So, if we take one of our screens, at “1x” the design would come out at its 
original size of “360 × 640,” and at “2x” these dimensions would be doubled 
to “720 × 1280,” to be viewed on a high-density device. You can not only 
choose a predefined option but also enter custom values, like “2.5x.”

Besides a resolution, it’s also possible to define explicit dimensions here. 
So, if you know that you want to preview the artboard on an iPhone 6, 
with its native, high-resolution resolution width of 750 pixels, you can 
enter “750w” as the Size. The important part is the addition of the letter 
“w,” which stands for the “width” and which can be swapped for “h” to set 
an intrinsic height. This definition works for all file formats except SVG, 
which is a real pity because sometimes you’ll even need to set explicit 
dimensions here.

Suffix

The next input field, Suffix, allows you to extend any sequence of letters 
to the file name. In the early days of the iPhone 4, it was common to export 
assets in two versions: at their original size and at double resolution, with 
“@2x” appended to the file name. That’s exactly what the Suffix lets you do 
if you enter “@2x” here.

File Formats

Besides the bitmap-based formats PNG, JPG, TIFF, and WebP,  you can 
choose the vector-based formats PDF, EPS and most notably SVG. PNG is 
the format of choice most of the time because it keeps everything and also 
supports transparency. 
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One of the most popular tools to optimize PNGs is TinyPNG,33 a web-
based lossy image compression tool that combines similar colors. If you're 
exporting photos though, export as JPG will work best in most cases, and 
you can set level of quality, too (see Fig. 6.2). However, transparency is not 
supported and you may want to double-check for artifacts. TIFF is mainly 
used in print. It supports transparency but the exported files are huge. No 
matter which format you choose, be sure to use optimized images to save 
bandwidth and loading time. Your website visitors will thank you! For 
maximal efficiency use an external tool such as ImageOptim,34 but there 
are also the official plugins SVGO Compressor35 and Sketch Image Com-
pressor,36 that do all the work for you. 

 

Fig. 6.2: JPGs let you choose the quality level, among other options.

33	 https://tinypng.com/
34	 https://imageoptim.com
35	 http://smashed.by/sketch-compress1
36	 http://smashed.by/sketch-compress2

https://tinypng.com/
https://imageoptim.com
http://smashed.by/sketch-compress1
http://smashed.by/sketch-compress2
http://smashed.by/sketch-compress2
https://tinypng.com
https://imageoptim.com
http://smashed.by/sketch
http://smashed.by/sketch
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Among vector formats, PDF is perfect for print, saving branding assets like 
logos, and exchanging assets. Instead of exporting each artboard individu-
ally, Sketch lets you create a multi-page file with File → Export Artboards 
to PDF from the menu bar. The settings can be defined at Artboard 
Export under the General tab of the Preferences. 

EPS, on the other hand, is a rather dying format, so basically you have no 
reason to use it at all. SVG is the web format. Whether you want to show a 
simple icon or a complex illustration, SVG can handle it all. It is infinitely 
scalable, which is very important in an ever-changing landscape of devices 
and resolutions. Just keep an eye on the exported file because it could hap-
pen that some parts aren’t replicated in the same way as in Sketch. In this 
case, try to simplify the structure or flatten the respective areas. 

Export it

After you have defined all parameters, click on the Export… button at the 
bottom (Fig. 6.1, 2, bottom), which opens the save dialog. The name of the 
exported file depends on the title of the artboard. This is important when 
you mark multiple artboards for exporting, because you can’t change their 
file names in the save dialog and will need to rely on their naming in the 
layers list.

Not immediately obvious, but each bitmap format has some additional 
options here. All of them (except WebP) let you define Save for Web, 
which discards “color profile and EXIF metadata” and is important if 
consistent colors are needed. JPGs and WEBP images have a Quality slider 
(Fig. 6.2), which massively influences the file size and quality of the file. 
For maximum quality, choose “100%,” especially if large colored areas are 
present. Progressive should always be checked for JPGs if the file will be 
used on the web because it further saves a few bytes.
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Supported File Types

Just as Sketch can export the abovementioned file formats, it can also 
import them. It even supports PSD and AI files, but only in a flattened 
state. However I wouldn’t rely on its importing skills for PDF and EPS files 
because it doesn’t support some of their concepts and often screws them 
up. To avoid that, select Insert PDF and EPS files as bitmap layers in the 
General tab of the Preferences (Fig. 6.3), which flattens the files automati-
cally when they are imported.

 
Fig. 6.3: Set Insert PDF and EPS files as bitmap layers in the Preferences 

to keep Sketch from screwing them up.
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Putting Images on a Diet

Since the beginnings of the web, the load of an average website has been 
increased year by year,37 making websites slower to load. That is a particu-
larly painful experience for users who rely on mobile connectivity, causing 
more than 50% of them to abandon a site that doesn't start loading within 
three seconds.38 To improve the loading speed of a web page, it is there-
fore mandatory to optimize all your images. One possible way of doing 
so is exporting JPGs at a very low quality (ca. 30%) but at twice the size of 
the final image dimensions (Fig. 6.4). This even works for high-resolution 
devices, without a noticeable impact on quality. Alternatively, you can save 
it at a higher quality, but just 1.2, 1.3 or 1.5 times the size, which also doesn’t 
influence the quality negatively. Read more about these techniques on 
Netvlies’ blog39 and on A List Apart,40 where Dave Rupert talks about the 
possibilities for keeping the image file size of your websites low.

Fig. 6.4: Left: JPG, saved at double size but with very low quality (30%). Right: Used at the original size, 
the reduced quality can’t be noticed anymore.

37	 http://smashed.by/pageload
38	 http://smashed.by/webobesity
39	 http://smashed.by/sketch-netvlies
40	 http://smashed.by/sketch-ala

http://smashed.by/sketch-netvlies
http://smashed.by/sketch-ala
http://smashed.by/pageload
http://smashed.by/webobesity
http://smashed.by/sketch
http://smashed.by/sketch
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The export area also lets you share the asset in various ways with the but-
ton on the bottom-right; for example, if you want to mail it to your team-
mate effortlessly (Fig. 6.1, 2, bottom right).

 

Fig. 6.5: Drag assets from the layers list to the desktop (or any application) to export them quickly.

Quick tip: A quick method to export an element is to drag it from 
the layers list to the desktop (or any application), which gives you a 
PNG version at a “1x” resolution by default (Fig 6.5). Hold Alt while 
dragging to get a PDF version instead. The settings you made after 
clicking on Make Exportable will directly influence the exported 
file.
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Before you export an artboard, have a look at the Background Color and 
Include in Export checkboxes in the upper half of the inspector (Fig 6.1, 
right middle), because artboards have a transparent background by default. 
This is a common pitfall when you open artboards in the Preview app, for 
example, which shows a nasty gray background in this case. To account for 
this, Sketch displays a checkered pattern for areas in artboards that have no 
defined background color (Fig 6.8, 2, bottom).

Multiple Export

Sketch’s export function isn’t limited to artboards but can also be employed 
for layers and whole groups. Just like for artboards, click on Make Export-
able in the inspector after you have selected the respective element in the 
layers list. If you look there now, you will see that a little knife icon has 
been added to the element’s name (Fig 6.6, 1). This symbol shows you at a 
glance that an element is marked for exporting.

The real power of exporting manifests the moment you click repeatedly 
on the title of the Export area (or the + icon, see Fig. 6.6, 2), which lets you 
export multiple versions of the same asset at once. For example, if you 
need to export an icon for the various required sizes on Android, you can 
set one version for each resolution: “1x” as the Size for “mdpi,” “1.5x” for 
“hdpi,” 2x for “xhdpi,” “3x” for “xxhdpi” and finally “4x” for “xxxhdpi” (see 
Fig 6.8, where all of these sizes have been added). Just be sure to empty the 
Suffix values, respectively. To delete a line, click on the x icon at the end of 
it (Fig. 6.6, 3).

The workflow for iOS sizes is similar: If you still support the iPhone 3G, 
with its low-resolution screen, use “1x” for the size of this one, “2x” for the 
iPhone 4, 5 and 6, and “3x” for the iPhone 6 Plus. 
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Here also the Suffix input field comes in handy because it lets you define 
the corresponding “@2x” and “@3x” indications for the latter two (see Fig 
6.6. bottom right, where multiple sizes have been added).

Fig. 6.6: 1: The moment you mark an element for exporting, a little knife icon is added to its name in the 
layers list. 2: To export a layer in various sizes or formats, click on the title of the export area (or the + icon). 
3: Delete an export option with the x button. 

The moment you click on the Export… button at the bottom, all of the 
defined sizes are exported to the selected folder on your hard drive. As 
for artboards, the name of the layer or group in the layers list is the base 
for the filename of the selected assets. If you want to export to a specific 
subdirectory of the selected folder, you can prepend it to the layer name, 
followed by a forward slash (/). For example, to save the “arrow” layer to the 
“symbols” subdirectory of “images,” name it “images/symbols/arrow” in the 
layers list. By default, everything will get exported to the same directory. 
Unfortunately, this doesn’t work for Android because it needs different 
folders for each asset size. No problem: Slices can help.
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Slices

Slices are a special kind of layer that serve two purposes: to export a spe-
cific area of the canvas or artboard instead of a single layer, and to define 
multiple versions of the same element. The latter comes in handy for the 
required Android sizes because we need a separate folder for each reso-
lution, defined by a dedicated slice that includes the name of the folder 
followed by a “/.” To add such a slice, press S for the appropriate tool and 
click on the element on the canvas. Just like before, you can hold Cmd to 
drill into layer groups. This adds a new entry to the layers list, depicted 
by a dashed border with the familiar knife icon (Fig 6.7, 1). The slice is also 
shown with the same dashed border on the canvas (Fig 6.7, 2).

Like before, the slice’s name is derived from the layer name. So, if we want 
to set up the “xxhdpi” version of the asset for Android now, which needs to 
reside in the “drawable-xxhdpi” folder, we prepend the layer’s name with 
“drawable-xxhdpi/.” In the export area of the inspector, define “3x” for the 
Size of this slice. Repeat this for all of the different sizes with a separate 
slice and Size setting (Fig 6.8). An alternate way to create a slice is to click 
on the little knife icon in the export area of the inspector once you have 
defined it for exporting (Fig 6.7, 3).

A slice is treated like a normal layer on the canvas, which also allows you to 
move or resize it there. For example, if you need to have padding around an 
asset once it is exported, add the slice as described above, but then resize 
it on each side to add the spacing (Fig 6.7, 2, the space around the button). 
Instead of converting a slice from a layer, you can also drag a rectangle 
of any size once you have entered the slice tool with S. This allows you to 
export parts of your design that don’t belong to a coherent group.
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Because the layers list can get pretty crowded with all of these slices 
defined, you can disable them with the icon on the bottom-right here (Fig 
6.7, 4). This also hides the dashed lines on the canvas. To go the opposite 
way and only make the slices selectable on the canvas click on the icon 
left to it.

 

Fig. 6.7: 1 and 2: Slices have a dashed border, both in the layers list and on the canvas. 3: After you have 
set a layer for exporting, you can convert it to a slice. 4: Hide the slices on the canvas temporarily.

MORE OPTIONS

Compared to normal layers, slices have two additional options in the 
inspector. Export Group Contents Only just works if the slice resides 
within a group. As the name suggests, it makes sure that only content 
within this group gets exported. Everything outside or behind it is omitted 
and exported as transparent pixels (Fig. 6.8, 1 and 2).

If you want to remove this transparent area and only export the content 
itself, add Trim transparent pixels (Fig. 6.8, 3). For example, if you have 
set up a slice for a group containing a button but the slice is bigger then 
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the group, the exported file will have just the size of the icon and not the 
whole slice, with everything around it being transparent. Please note that 
this option is not meant to be used alone; otherwise, it only works correctly 
if no other layers are behind the slice and the artboard has no background 
color defined.

Finally, you are also able to set a background color for the slice. With 
these options available, it can be hard to tell sometimes what exactly gets 
exported in the end. Therefore, always have a look at the preview, which 
shows the expected output (Fig 6.8, 2, bottom). As with artboards, areas 
that end up transparent in the exported file are displayed with a check-
ered pattern.

Fig. 6.8: 1 and 2: When the slice resides in a group and Export group contents only is set, only the content 
of the group is considered. The remaining space around the slice is exported as transparent pixels, 
which can be seen in the preview in the inspector (2, bottom). 3: When Trim transparent pixels is set 
additionally, even the transparent pixels get cut and only the content itself remains. 

All at Once



Exporting Assets

199

The more elements you define for exporting, the harder it is to stay on 
top of things. It would also be too cumbersome to click on the Export… 
button for every single element. Luckily, there’s a separate dialog that 
shows you all exportable elements at a glance (Fig. 6.9). Open it by pressing 
Shift + Cmd + E (or by clicking on the Export icon the toolbar). This dialog 
gives you a handy overview, lets you disable certain assets and also warns 
you if there will be a conflict with overlapping file names. If you haven’t 
defined anything for exporting yet, Sketch will assume that you want to 
export all available artboards in this dialog.

 

Fig. 6.9: The export dialog, accessible with Shift + Cmd + E, shows all assets that have been set for 
exporting. Conflicting file names are marked with a warning.
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Fig. 6.10: Show multiple artboards in one screen with a big overarching artboard in the back, which 
you export. 

Quick tip: Instead of exporting individual artboards, you can create 
a big overarching artboard in the back that spans all of the relevant 
artboards and export this single big one instead (Fig. 6.10). This is 
great for presentations where you want to show a number of differ-
ent options at once. Be sure to set a white background color.
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An Example

With all of these options available, let’s get back to the Details screen of our 
app and have a look at a practical example. We want to export the arrow of 
the button to all required sizes for Android and iOS: Either select it on the 
initial version of the screen or enter the symbol. As preparation, put the 
“arrow” layer in a same-named group so that we can use the option Export 
Group Contents Only. With this new group selected, click on Make 
Exportable in the bottom-right of the inspector and then two more times 
on the +. This automatically sets up all of the required options we need for 
iOS, from “1x” to “3x” (Fig. 6.6, bottom right). That was easy!

Things prove to be more difficult for Android, because subfolders are 
needed for the various sizes. Let’s start with “mdpi”: Select the arrow itself, 
not the group, press S for the slice tool and click on this layer on the canvas 
to add a new slice. As mentioned, the group makes sure that we can select 
Export Group Contents Only. Otherwise, the background of the button 
will also be exported.

The default exporting options for this slice are correct, but its name needs 
to be prepended with “drawable-mdpi/” so that the icon is placed in the cor-
responding subfolder of the selected directory in the save dialog later. Now, 
duplicate the slice with Cmd + D, change the name to “drawable-hdpi/” and 
set the Size to “1.5x” in the export options. Do the same with “xhdpi” (2x) 
and “xxhdpi” (3x) until you get to “4x” and “xxxhdpi” (Fig. 6.11). Make sure 
that “copy” wasn’t added to any of the slice’s names.
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Fig. 6.11: A slice has been added for every size needed for Android. 

Now, press Shift + Cmd + E to enter the Export dialog, where you should see 

all different assets listed (Fig. 6.9). After clicking on Export and selecting 

the appropriate folder, the defined file names and folder structure will be 

created (Fig. 6.12). 

Fig. 6.12: All assets have been created correctly.
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Setting up all of that for multiple assets can be quite cumbersome, but a 
plugin provides a remedy: Sketch Export Assets.41 After you selected the 
element to export, choose the target platform in the appropriate menu 
from Plugins in the menu bar, which asks you where the assets should be 
created on the hard drive.

Real Devices

Seeing a design in Sketch is good and all, but to assess the true quality, 
you need to experience it on a real device. An easy way would be to export 
the artboard and open it on the device from something like Dropbox. To 
do this, select the artboard and define the various resolutions you want to 
target. Say we’d like to preview the card view of the Overview screen on 
an iPhone 6 and an Nexus 6 device. Select the artboard, click on Export in 
the inspector again, and define each size with the “w” suffix in the Size, 
multiplied by the pixel density, to get a sharp output.

For the iPhone 6, with its native screen width of 375 DP and pixel density 
of “2x,” this would be “750w” (375 × 2). Also enter something like “-iphone6” 
as the Suffix to be able to distinguish between the different screenshots. 
The format can be left as the default PNG option. The Nexus 6 has a 411 DP 
width and a density of “3.5x,” so we need to set up a second export option 
with a Size of “1439w” (411 × 3.5 rounded) and a Suffix of “-nexus6.” When 
you go to the Export dialog with Shift + Cmd + E now, you will see not only 
the variations of the arrow we set up for exporting earlier, but also the new 
artboard, which you may need to select (or simply check Export all).

41	 http://smashed.by/sketch-exportassets

http://smashed.by/sketch-exportassets
http://smashed.by/sketch
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DIRECT PREVIEW

But wouldn’t it be easier to preview a design right from within Sketch, on 
an actual device? That’s exactly what Mirror does: It sets up a web server 
and a dedicated URL that can be opened on any device, whether desktop, 
mobile, tablet or TV, as long as it has a web browser. You can access it from 
the same-named icon in the toolbar, which sends you the browser and 
gives you an overview of all of the pages and artboards. It even auto-up-
dates the view as soon as you change something in Sketch, giving you an 
instantaneous preview. Please note that you still need to make sure that 
the artboard’s size matches the device you want to preview on (including 
the pixel density) in order to get a sharp result.

 

Fig. 6.13: Mirror opens a preview of all of the artboards of your design in the browser. You can access it 

from the toolbar in Sketch.

One extension that not only runs locally but can be accessed from any-
where in the world is Cloud. After you have selected Upload and share 
from the respective icon in the menu bar, your design will get transferred 
to a server, and you will be provided with a link that lets you preview your 
creation in the browser, just like with Mirror. 
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A similar alternative to the local browser 
preview that runs directly on your iOS 
devices is the app Sketch Mirror,42 which 
also connects through the Mirror icon in 
the toolbar (Fig. 6.14). You just need to be 
on the same Wi-Fi network as your Mac. 
Alternatively, you can connect via USB. 
The app is a bit more reliable than the 
browser version and also smart enough to 
match the pixel ratio to the device you are 
viewing on. So, even if you design in 1x in 
Sketch, you will get a sharp result on a 
high-density device like an iPhone 6. On 
the device itself, you will get a list of pages 
with their artboards, each of which you can 
swipe through. Unfortunately, there’s no 
Android version yet, but have a look at 
Mira43 and Crystal,44 for a glimpse.

ALTERNATIVES

For the full package, iOS and Android, have a look at the Skala Preview bun-
dle from Bjango, which consists of a Mac application and companion apps 
for both mobile platforms. That alone would make it a serious contender. 
Unfortunately, it doesn’t work from inside Sketch, but it’s free, so you’ve 
got nothing to lose. Once opened on both devices (desktop and mobile) 
and connected to the same Wi-Fi network, it lets you drag screenshots to 
the Mac application, and the screenshots are then displayed on the mobile 
app. Furthermore, it has some useful features such as a filter to simulate 
various types of color blindness and a few predefined zooming levels.

42	 http://smashed.by/sketch-mirror
43	 http://mirapp.io/
44	 http://smashed.by/sketch-crystal

Fig. 6.14: Mirror is also available as a 
dedicated iOS app (iPhone 6s depicted).

http://smashed.by/sketch-mirror
http://mirapp.io/
http://smashed.by/sketch-crystal
http://smashed.by/sketch-skala
http://smashed.by/sketch
http://mirapp.io
http://smashed.by/sketch
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Fig. 6.15: The Skala Preview bundle consists of a Mac application and companion apps for iOS and 
Android.

A Sketch plugin that can be of massive assistance here is Sketch Preview,45 
which automatically sends the selected artboard to Skala View on your 
mobile device and lets you select the output size.

The Achilles Heel?

Probably the biggest downside of Sketch is its absence on Windows. While 
the Mac seems to be the preferred environment for many designers, the 
majority of developers still trust Microsoft’s operating system. This might 
be not an issue in the design phase, but once you need to hand off the 
different screens for development, there’s no official way to provide the 
Sketch file to your mates on Windows.

45	 http://smashed.by/sketch-preview

http://smashed.by/sketch-preview
http://smashed.by/sketch
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Of course, you could do it the hard way and export all elements separately 
and allocate the necessary information (like colors, measurements and 
sizes) by hand, but that’s not exactly efficient. Luckily, some clever people 
have taken care of this issue with Avocode,46 Zeplin,47 and Sympli.48 Zeplin 
and Symbli offer free plans to get started right away.

 

Fig. 6.16: Top: Avocode, Zeplin. Bottom: Sympli, Markly (from left to right). They all let you inspect and 
share your design in one or another way.

Basically, these services let you inspect Sketch files in a read-only format 
to gather all of the required information, to export assets, to add notes and 
to create a style guide all at once. Even the critical CSS code is provided 
automatically. This is helpful not only for making a design available to the 
developers, but also for sharing it across your design team. Sketch plugins 
make sure that everything is kept up to date once a file changes.

46	 https://avocode.com
47	 https://zeplin.io
48	 https://sympli.io/

https://avocode.com
https://zeplin.io
https://sympli.io/
https://avocode.com
https://zeplin.io
https://sympli.io
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Speaking of plugins, if you don’t need all of these fancy bells and whistles, 
check out the free Marketch,49 which gives you a rather basic version of 
the functionality described above but still has everything you need to code 
your designs. Sketch Measure50 does the same except that you can add 
measurements, dimensions, color codes and more as separate layer groups 
directly in Sketch.

Finally, a different approach is taken by Markly App,51 which specializes 
in design specifications exclusively and lets you read all of the required 
measurements, colors and sizes.

Quick tip: If all you need is to check out the CSS attributes of an 
element, right-click and select Copy CSS Attributes. Depending 
on the element, this will give you CSS properties such as border-ra-
dius, font-size and color and background-image, ready to be used in 
your style sheets. Available from the same menu, Copy SVG Code 
provides you with all of the code required to quickly create an SVG 
file inside your text editor.

If you are not afraid of running Mac OS X (or its successor macOS) on your 
Windows machine, you could also take the plunge and set up a virtual 
machine, which enables you to run Sketch in your trusted environment. 
Martijn Schoenmaker talks about this approach on Medium.52

49	 http://smashed.by/sketch-marketch
50	 http://utom.design/measure/
51	 http://marklyapp.com
52	 http://smashed.by/sketch-windows

http://smashed.by/sketch-marketch
http://smashed.by/sketch-windows
http://smashed.by/sketch
http://utom.design/measure
http://marklyapp.com
http://smashed.by/sketch
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Infobox

Discount Time!

As a convenience to you, I’ve collected discount codes for all of the specifi-
cation tools mentioned:

•	 Avocode: With the promo code “sketchbookpromo”, you get three free 
months.

•	 Zeplin: Use the promo code “ZeplinLovesSketchHandbook” and be 
one of the first 100 to get 25% off for three months.

•	 Sympli: The discount code “SMASHINGMAGAZINE” gives you 15% 
off for the first six months.

•	 Markly: Use this link to get 30% off the app:  
smashed.by/sketch-markly

http://smashed.by/sketch-markly
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Printing

While Sketch offers an option to print artboards (or slices, if no artboard 
is present) in the File menu, this clearly isn’t one of its strongest points. 
Given its quirky behavior, you are often better served by exporting art-
boards or elements as a PDF and using a more suitable application for 
printing, even if it’s just the native Preview application on your Mac.

Speaking of printing, while Sketch is clearly targeted at digital design, it 
can be used surprisingly well to create print material such as posters, sta-
tionery and brochures. A few caveats: Sketch has only pixel measurements; 
there is no option to set a bleed or margins; and RGB is the only color space 
available. Also, be prepared to use a separate application such as Adobe 
Illustrator or Affinity Designer to make the document print-ready.

PAPER SIZES

The first restriction, pixel-only measurements, can be circumvented rel-
atively easily with a bit of math. If you look at the built-in artboard sizes, 
you’ll see that A4 from Paper Sizes results in the dimensions “595 × 842” 
pixels. If you convert that to the A4 size in millimeters, 210 × 297, you’ll get 
about 2.83 pixels per millimeter or 28.3 pixels per centimeter (Fig. 6.17, red). 
Not exactly easy to calculate with, but a good start. To fully embrace this 
ratio, you should switch off Pixel Fitting under General in the Prefer-
ences (Cmd + ,). Full pixels are of no use here.
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Things are quite easier with US measurement in inches. One inch directly 
relates to 72 pixels (Fig. 6.17, blue). This means “612 × 792” pixels for the 
official “Letter” size of 8.5 × 11 inches.

Fig. 6.17: The artboard presets are the base for the calculations of the measurements. Red: 
A4. Blue: Letter.

BLEED

Because print shops don’t guarantee cutting that is 100% accurate, your 
designs need a safe zone on all sides. All elements that should touch the 
outer edges on the printout need to extend into this space. Sketch doesn’t 
offer a dedicated option to add this extra space, but you can use custom 
guides for this purpose. After you have created the artboard in the size you 
need (without bleed, see Fig. 618, left), add a full-sized rectangle (position: 
0/0, width: 100%, height: 100%), and change from the fill to a border. Now 
hold Alt to resize the artboard from the center on the canvas, and bring it 
to the new dimensions, including the bleed: 9 pixels (= ⅛ inch bleed) or 12 
pixels (= 4 mm bleed) on each side.
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After that, show the rulers with Ctrl + R, select the rectangle, and drag 
out a guide for each side from the left and top rulers, letting them snap 
to the dimensions of the rectangle (Fig. 6.18, middle). You can delete this 
shape later. The space inside the rulers represents your initial document 
dimensions; the area outside is the bleed. Now you can enlarge all required 
elements so that they extend into this area (Fig. 6.18, right).

 

Fig. 6.18: Left: Create the artboard in the required size (without the bleed). Middle: Add a rectangle with 
a border, resize the artboard to include the bleed, and add guides to the dimensions of this rectangle. 
Right: Create your design and make sure that all of the required elements extend into this area.

OTHER OPTIMIZATIONS

After you have finished your design, you will need to manage another 
important task: converting all text layers to outlines. This ensures that all 
other computers can handle your text, regardless of whether it has the 
fonts installed, and makes everything look exactly the way you intended. 
To do so, select the respective layers and press Shift + Cmd + O. This creates 
a dedicated shape for every part of the text layer. Be warned: If your docu-
ment contains many text layers, you are better off delaying this task.

Now you can set up your artboard for exporting by clicking on Make 
Exportable at the bottom of the inspector. PDF is the preferred format 
(Fig. 6.19, top export format), but if your design is image-heavy, consider 
saving it as a PNG with a very high resolution instead. To go from the 
default 72 DPI to the printer-friendly 300 DPI, you’ll need to export it at 
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a size of “4.17x” (300 DPI / 72 DPI) (see Fig. 6.19, bottom export format). In 
both cases, make sure that the images in your Sketch document are at least 
4.2 times the size of the final format to get a sharp output. Finish this task 
by clicking on the Export button.

 

Fig. 6.19: Export your design as a PDF, or a PNG with a high resolution. 

RGB TO CMYK

Sketch can’t help you here because you are only able to use RGB colors; for 
print, you need CMYK colors. This requires you to involve another print-
friendly application, such as Adobe Illustrator or Affinity Designer. First, 
convert the entire document to the CMYK color space. In Illustrator, you 
can do that in File → Document Color Mode → CMYK Color in the 
menu bar. Affinity Designer enables you to make this change in Docu-
ment Setup → Colour → Colour Format.

Now is also the time to convert all text layers to outlines, in case you post-
poned that earlier. In Illustrator, you can use Shift + Cmd + O, like in Sketch. 
Affinity Designer lets you perform this conversion with Cmd + Enter.
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If you are satisfied with the conversion or exported a PNG, you can stop 
here; otherwise, you need to find a good alternative for each important 
color. I won’t go into detail here. Please consult the respective manual for 
the exact process of how to select and change colors.

CUTTING EDGE

You may want to define crop marks before saving the final PDF. The 
bulletproof way is to set them directly in Sketch before exporting. Draw 
some ordinary lines at the positions of the custom guides for the bleed in 
each corner (Fig. 6.20). You can also add them right in Illustrator, but this 
requires you to bring the document to the original dimensions again there 
(without the bleed). After that, use the Marks and Bleeds tab in the Save 
As dialog to define these settings.

 

Fig. 6.20: The bulletproof way is to add the crop marks right in Sketch. Just draw a few lines in the 
corners at the positions of the custom guides.
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Unfortunately, Affinity Designer doesn’t let you set automatic crop marks, 
but you can define the bleed without having to bring it back to the original 
dimensions first. Like before, go to the Document Setup and define the 
relevant settings in the Bleed tab.

After you have handled all of these preparations, save your document 
with something like a “-print” suffix in the file name to denote the fin-
ished version.

OFF TO THE PRESS

As you can see, Sketch is absolutely capable of handling a print project. 
While it won’t allow you to manage it from start to finish, the design app 
can get you a long way. Only after using other applications such as Illus-
trator do you realize how easy Sketch actually is and how little effort is 
required to design something that looks great. I’d like to mention Peter 
Nowell’s article on Medium53 in particular, because it was a very helpful 
resource when I tackled my first print project.

Alternatives

Sketch is not the only player in the field of vector-based design apps, but 
it is, unfortunately, the only one that is Mac-exclusive. Only time will tell 
if this is a recipe for success or a pitfall. All of the applications described 
below have a Windows equivalent. While some of them seem to have been 
around forever, such as Adobe Photoshop and Illustrator, others such as 
Figma and Adobe XD are on the rise and challenging Sketch in every possi-
ble way. Let me give you a short overview of the alternatives.

53	 http://smashed.by/sketch-print

http://smashed.by/sketch-print
http://smashed.by/sketch-print
http://smashed.by/sketch
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ADOBE PHOTOSHOP54

The top dog, still favored by many designers around the world because 
it lets you basically do anything you can imagine, all in one application. 
Although it’s mainly bitmap-based, you also have the necessary vector tools 
to remain resolution-independent.

Photoshop grew into such a behemoth over time that Adobe almost lost 
sight of basic user tasks, like creating an interface with as little effort 
as possible. To compensate for this, Added recently added a slew of new 
features (some clearly “inspired” by Sketch), but for many designers it was 
already too late. In search of an alternative, they found a new home in 
Sketch, some never to return.

ADOBE EXPERIENCE DESIGN CC55

This is Adobe’s answer to Sketch, called XD for short. Although it is still 
far away from Sketch’s feature set, it has an ace up its sleeve: native proto-
typing, right in the app. However, this might not be a strong selling point 
anymore, because the Craft56 plugin mentioned a few times earlier brings 
all of the features that otherwise set XD apart.

If you are already subscribed to Creative Cloud, this might be a worth-
while option. Moreover, the XD team moves fast and adds features reg-
ularly, so it’s just a matter of time before it reaches feature parity with 
Sketch or starts to add totally new functions. A Windows version has been 
announced, but no word on the release date yet.

54	 http://smashed.by/sketch-photoshop
55	 http://smashed.by/sketch-xd
56	 http://smashed.by/sketch-craft

http://smashed.by/sketch-photoshop
http://smashed.by/sketch-xd
http://smashed.by/sketch-craft
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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ADOBE ILLUSTRATOR57

Illustrator is probably the closest competitor from Adobe’s huge pool of 
applications in terms of icon and logo design. It offers many of the features 
you know and love from Sketch, but in a less intuitive way. Illustrator is 
clearly the better choice if you mainly do illustrations and create branding 
assets, but its massive set of features and options makes it so much more 
complicated and intimidating than Sketch. I tried it but felt lucky that I 
could go back to Bohemian Coding’s counterpart.

AFFINITY DESIGNER58

This is actually more of a competitor to Illustrator, because it offers many 
of Adobe’s powerful features but also enables you to design interfaces 
relatively effortlessly. It lacks some of Sketch’s features and can’t compete 
with its ease of use and focus on interface design, but keep an eye on it 
because it allows you to combine vector and bitmap tools for some amaz-
ing effects, ones that Sketch will probably never get. A Windows version 
was released lately.

FIGMA59

Figma could finally provide a way to directly open and edit Sketch files on 
Windows. With its feature set similar to Sketch, and Figma team’s pas-
sion for innovation it has the most potential to become a serious threat to 
Sketch. Most importantly, Figma isn’t limited to one platform; it runs in 
the browser and can be used from anywhere in the world. You can share 
your designs, make comments, and even simultaneous edits. A desktop app 
is available for Windows and MacOSX, too.

57	 http://smashed.by/sketch-illustrator
58	 http://smashed.by/sketch-affinity
59	 http://figma.com

http://smashed.by/sketch-illustrator
http://smashed.by/sketch-affinity
http://smashed.by/sketch
http://smashed.by/sketch
http://figma.com
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GRAVIT60

Another browser-based design tool that’s improving at a crazy-fast rate. 
You are free to sign up and try out all of its features. Its functionality is 
very similar to Sketch’s, but Gravit also offers some unique tools and a slew 
of filters. Moreover, it features a market with a large set of premade tem-
plates, icons and components ready to be used in the app. A strong focus is 
also made on collaboration: You can share your designs with other people 
and even work on them together.

 

Fig. 6.21: Some competitors of Sketch. Top: Photoshop, Affinity Designer. Bottom: Figma, Gravit (from 
left to right).

60	 https://gravit.io

https://gravit.io
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Prototyping

Probably the most requested feature of Sketch is prototyping. Bohemian 
Coding might have had many chances to introduce this feature, but it has 
always focused on its core competence: making Sketch the best design 
application available. And it is filling this role very well so far. Luckily, 
dozens of applications out there have jumped in to offer prototyping 
capabilities. Below is a brief overview of the options that either work with 
Sketch in some way (mainly in the form of plugins) or are very similar to 
it as applications. Most of them even let you experience prototypes on a 
real device once you are finished. Please visit the respective websites for 
more information.

CRAFT PROTOTYPE61

This is probably the hottest contender to the throne of prototyping tools, 
not because it’s the best, but because it’s built right into Sketch and pro-
vides a seamless experience. Formerly know as Silver Prototype, it was 
integrated into the Craft suite lately, along with other useful helpers that I 
have already mentioned throughout the book.

PRINCIPLE62

Although not related in any way, this is the app that comes closest to feel-
ing like Sketch. You have your layers list and inspector on the left, and a 
canvas where elements are added. From there, you define how they inter-
act with each other. Once you are finished, you can also export the proto-
type as a video or animated GIF.

61	 http://smashed.by/sketch-craft
62	 http://principleformac.com

http://smashed.by/sketch-craft
http://smashed.by/sketch
http://principleformac.com
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INVISION63 AND MARVEL64

These are very similar, in that they give you a web interface where you 
basically link your screens to each other. Moreover, they offer several tran-
sitions for fixed elements. In contrast to most of the other options, these 
web applications are free as long you don’t need more than one project or 
prototype (Marvel: two).

PROTO.IO65 AND FLINTO66

These are supercharged versions of the tools above because they allow you 
not only to set up simple prototypes, but also to add advanced interactions 
and functionality. Both offer a (toned-down) web interface and a dedicated 
Mac app for you to build ideas. Use the link smashed.by/sketch-protoiotrial 
to get an extended trial period of 60 days (instead of 15 days) for Proto.io.

FRAMER67

In contrast to the other applications, Framer is built entirely on code. You 
also get a visual editor where you can change elements directly, but every-
thing is immediately translated into the code editor and can be tweaked 
there. This approach allows you to explore many different ideas without 
being limited to predefined patterns. Use the promo code “FRMR-SKETCH-
HANDBOOK-2016-CK” when buying the app to get 20% off.

63	 http://smashed.by/sketch-invision
64	 http://smashed.by/sketch-marvel
65	 http://smashed.by/sketch-protoio
66	 http://smashed.by/sketch-flinto
67	 http://smashed.by/sketch-framerjs

http://smashed.by/sketch-invision
http://smashed.by/sketch-marvel
http://smashed.by/sketch-protoio
http://smashed.by/sketch-flinto
http://smashed.by/sketch-protoiotrial
http://Proto.io
http://smashed.by/sketch-framerjs
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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KEYNOTE68

This is probably the easiest option on this list because it lets you copy 
elements directly from Sketch in the vector format, even entire artboards. 
Then, you can use the “Magic Move” transition to move from one slide 
(artboard) to another. This is the perfect way to visualize an idea quickly. 
But it doesn’t need to stop there: Either keep tweaking the presentation 
on Keynote for iOS or send a link to an Android device so that you can 
also experience it there. Because Keynote comes free with every Mac, this 
approach won’t cost you a penny.

BUILD THE REAL THING

The biggest downside of all of these applications is that you have to go 
through three stages to get to the result: design, prototype, development. 
Why not skip the middle step and go right into code? Either with HTML, 
CSS and JavaScript or with Xcode or with Android Studio. It might be 
harder to show off something in the first place, but once you are finished 
with the first prototype, you will be much closer to the final product. 
Something to think about.

68	 http://smashed.by/sketch-keynote

http://smashed.by/sketch-keynote
http://smashed.by/sketch
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Designing An Article Page

Mobile is growing like crazy, but it's not the only way to con-
sume content. There are still a myriad of other devices with 
larger screens, so we should also take a look at how to display 

information there. For this purpose, I have chosen to present a tourist site 
in full detail in the form of a comprehensive article (Fig. 7.1). Because it 
contains much more information than the mobile version, let's think of it 
as an iteration, a way to try out new ideas and display formats. 

 

Fig. 7.1: The full-length article. Note: Its length made it necessary for me to split it into three columns for 
the screenshot. 

For a clear separation to everything we have created so far, add a new page 
called “Article,” which will house all of the different screen sizes of the arti-
cle. In the fashion of mobile-first, let’s start small and work our way up to 
the bigger variants. This is also a perfect opportunity to use a grid, because 
it gives some constraints to the structure of the design and makes sure that 
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the responsive versions can adapt in a predictable way. For a good starting 
point, choose the artboard preset Tablet Portrait from the Responsive 
Web Design category. However, the default height of “1024px” gives us 
way too little room, so set it to about “4500” for now. Don’t forget to rename 
it to something like “Article Small” and set the origin to “0/0.”

Grids or Layouts?

Sketch makes it very easy to build a grid, because this functionality is 
an integral part of the application. No need for add-ons or quirky tem-
plates. However, the term “grid” is used quite ambiguously here, because 
it describes the mesh of intersecting vertical and horizontal lines we’ve 
already used to lay out the elements in the mobile screens in the form of 
an 8-pixel grid. In turn, the traditional grid with different columns that 
you might know from web or print design goes by the name of “layout.” To 
prevent confusion, the latter will be mainly called “layout grid” or “column 
grid” in the course of this book.

Quick tip: Setting up new artboard presets is a snap: Press A for 
the artboard tool, and click on the + icon at the bottom-right of the 
inspector. After you have added a new size this way, you can find it 
under the Custom tab at the very bottom of the list of presets.
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DEFINING A COLUMN GRID

To set up such a column-based layout grid, click on View in the toolbar and 
select Layout Settings…, which will open a massive dialog with various 
settings. Be sure that the artboard is selected before; otherwise, you would 
be setting up a general layout grid. Going forward, we will not only create 
a grid of Columns but also define a baseline grid (Rows). This further sim-
plifies the placement of elements and prevents arbitrary spacing.

Let’s begin with the Column grid (for the final settings, see page 225, Fig. 
7.3.). The starting point is the Total Width because it sets how much space 
should be available for the different columns. To have some kind of safety 
zone, I always set my content to about 94% of the page’s total width, which 
gives us a value of "722px" for the first input field. Feel free to let Sketch do 
the math and enter “768 × 0.94.” Offset is useful when you want to create 
a left-aligned design that occupies only some of the available space but still 
has defined spacing from the left. However, we are aiming for a centered 
layout grid, so we let the Center button align the design to the middle of 
the artboard.

 The second determining factor for a layout grid is the Number of Col-
umns. To have enough options for the placement of elements, I have 
chosen “12” here.

Based on the type of gutters you want to use in the development phase, 
you need to set Gutter on outside (Fig 7.2, top). Select the checkbox if this 
spacing should be evenly distributed before and after each column. Boot-
strap, for example, handles it like this. In case the gutters should be before 
(or after) the columns as a whole and removed at the first (or last) column, 
leave this setting switched off. This is also the approach we will be taking. 
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After we have defined the  available space for the layout grid, we will set 
how it should be distributed across gutters and columns now. These values 
are directly related; one changes when you adapt the other. My preferred 
setting for a layout grid is to have gutters that are about one third the size 
of the columns. Unfortunately, Sketch lets you set neither relative percent-
age values here nor the Total Width, so we have to do the math ourselves. 
Because we have about 60 pixels available per column (722 ÷ 12), we just 
need to divide this by 4 (3 parts for the columns, 1 part for the gutters), 
which gives us a Gutter Width of “15px.” The rest of about “46px” remains 
for the Columns Width. Please note that this is just an approximation; 
Sketch will distribute the available space slightly different.

 
Fig. 7.2: Top: If you set Gutter on 
outside, then the gutter (light red) 
will be evenly distributed left and 
right of each column. Bottom: Or 
else, the gutter will be added after the 
column but removed at the last one.

Quick tip: Layouts and grids are individual to each artboard. To set 
the same grid for all the artboards in a page, open the Grid Settings 
or Layout Settings dialog without selecting an artboard first. A click 
on Make Default, in turn, will apply the settings provided to all new 
files from now on.
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SETTING UP A BASELINE GRID

With the Column grid set, let’s move on to the Rows, or baseline grid. 
Select this checkbox now. Things might seem a bit more unclear here, so let 
me give you a short introduction. The defining value is the Gutter Height, 
because the rows are just multiples of it. The bigger the Row Height, the 
larger the individual “blocks” you will get, each with the Gutter Height 
in between. The best way to visualize the individual rows and gutters is 
to check Draw all horizontal lines, which will show all individual rows 
independent of the different blocks. However, if you just need the blocks, 
don’t check this setting.

For a simple baseline grid, leave the Row Height at “1” and let the Gutter 
Height define the baseline. This is exactly what I did with a value “12px” 
here, because it leads to a nice line height of “1.5,” based on the targeted 
font size of “16px” (12px × 2 = 24px ÷ 16px = 1.5). I chose this value because 
it represents the default font size in browsers and leads to an ideal read-
ing experience and line length for the present screen width of 768 pixels. 
Furthermore, it fits perfectly in the typographic scale that I’ll use later to 
determine all of the different font sizes for the other elements.

Finally, choose a red with “20%” opacity for the Light color of our grid. If 
you prefer to show the grid lines only, without solid fills for the columns, 
select Stroke Outline, whose color can be defined with the Dark color. A 
click on Make Default takes these settings for all future artboards.

While it might not be practical to execute a baseline throughout the whole 
development phase, it can be a huge aid in the design stage, because you 
will always have predefined positions where you can place elements at.
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Fig. 7.3: The final settings for our layout and baseline grid.

The Header

After you confirm the settings with OK, you will see the grid in its full 
beauty. We can finally use it to lay out elements on it. Let’s bring our 
attention to the header for this purpose. It is similar to the mobile design, 
with a back link, the logo, the title and the “hero,” a huge image to whet the 
viewer’s appetite for the sight. You can copy it directly from the “Details” 
page (the locked “BG image” layer) if the size is big enough. Check it out 
with Image → Set to Original Size from the menu bar. Otherwise, bring 
in another suitable image. Now, we need a rectangle in the top-left corner, 
behind the image, with the dimensions of “768” (“100%”) by “432” to clip the 
image with a mask: Select both and click on Mask in the toolbar. As a last 
step, resize and reposition the image so that it shows a reasonable section, 
and lock it (Shift + Cmd + L).
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The dimensions of the mask haven’t been chosen randomly. They represent 
the ratio of 16:9, which most displays use nowadays. This creates a nice cor-
relation and prevents an arbitrary size. It also aligns nicely to the baseline 
grid. To calculate the height, we could have also used the mathematical 
capabilities of Sketch again, with “768 / (16/9)” in the height field.

As an alternative to a mask, you could also use the image as a pattern fill for 
the rectangle (Fig. 7.4). To do so, simply select the masked image in the lay-
ers list and copy it. Enter the fill settings of the rectangle, select the second 
icon from the right (Pattern Fill), click on the default checked pattern, and 
press Cmd + V to insert the exact clipping that you defined with the mask. 
Be sure that Fill is selected in the drop-down to the right. This pattern fill 
is also the approach we will take for the “Article” page, so you can delete 
the image in the layers list again, rename the former mask to “Image” and 
uncheck Mask with a right-click. The group is not needed anymore.

 

Fig. 7.4: Set up a rectangle with a pattern fill for the hero image.
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LOGO AND BACK LINK

For the logo, go to the “Logo” page, where you should define it as a symbol, 
so that it’s easier to reuse on the “Article” page. Make sure to check Send 
Symbol to “Symbols” page upon setting it. Of course, you could also sim-
ply copy it, but it doesn’t hurt to line up all of our important assets nicely in 
one place (in our case, the “Symbols” page).

You can also add other elements here, even if they don’t exist as symbols 
(yet), such as text elements and color swatches. This enables us to see 
all “components” of the design, all its important parts, at a glance. At the 
same time, it prevents similar elements from being created. The more 
you can reuse, the easier it will be to see what’s available, and the bet-
ter off you’ll be.

Insert the newly created logo symbol in the top-right corner of the “Article” 
page. Align it to the right edge of the layout grid horizontally; move it about 
one row unit vertically from the top. Now, go to the top-left corner, where 
you should add the background of the back link (see Fig. 7.5 for the finished 
back link), a rectangle with fully rounded edges that has a background 
color of 30% black; like always, name it “BG.” Insert the “Arrow” symbol, but 
detach it, so that you can change its width to “10px” with the Scale function 
(Cmd + K). This ensures that the border thickness is scaled proportionally. 
Flip it with a right-click and Transform → Flip Horizontal so that it 
points in the proper direction for a back arrow.

Now add the white “All destinations” text, with a spacing of about “10px” 
on the arrow. I have chosen “Avenir Next Bold” for this label, with a size of 
“18px.” Select both and align them vertically to the rectangle. With all of the 
relevant parts added, resize the background layer so that there is enough 
padding on the other elements: about “19px” left and right, about “9px” on 
the text top and bottom. Combine the three elements as a group, named 
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“Back,” center it vertically to the logo (and lock it, so that its position isn’t 
altered, or else use the smart guides), and align it to the left edge of the 
layout grid (which should be at an X position of “23”).

Fig. 7.5: The finished back link.

THE TITLE

Another important element of the header is the huge title. For a contrast 
to the straight “Avenir Next” font, I’ve chosen the playful “Playfair Display” 
from Google Fonts69, which is even lovelier when set in its italic styles.

Use the “Bold Italic” weight for the title, with a font size of “48” and a color 
of white. For the text, choose the same as on the Details screen. The line 
spacing should be at “60,” so that it aligns perfectly to our baseline grid (5 × 
12). Change the Alignment to Center (second icon), as well as center it on 
the page. Now hold Alt and drag one of its handles on the sides until it fills 
10 grid columns. 

Manage Your Fonts

69	 http://smashed.by/sketch-playfair

http://smashed.by/sketch-playfair
http://smashed.by/sketch
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An app I’ve trusted for a long time now to maintain all the fonts on my 
system is RightFont.70 It lets you organize your fonts into lists, with pre-
defined ones for Google Fonts and Typekit, allows you to install and deac-
tivate fonts quickly, gives you a quick preview with custom sample text, 
and easily syncs with Dropbox or Google Drive, so that you have the same 
selection available on all computers.

 

Fig. 7.6: RightFont lets you easily manage, find and install fonts (and much more).

RightFont even features a huge set of icons to choose from and lets you 
assign fonts directly to a text layer in Sketch, once you have found the per-
fect match for your design. To help with that, you can categorize the fonts 
into Sans, Sans Serif and Script, for example, or set filters for the Weight 
and Width. Use the link smashed.by/sketch-rightfont to get 30% off.

Place the text layer about 6 row units (72 pixels) away from the bottom of 

70	 http://rightfontapp.com

http://rightfontapp.com
http://smashed.by/sketch-rightfont
http://rightfontapp.com
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the image, so that its baseline (the bottom of the letters in the second line) 
sits nicely on a grid line. Lastly, give it a “50% black” shadow, with the prop-
erties “1/1/0/0,” so that it can be clearly seen against the background image.

Fig. 7.7: Resize the title to 10 grid columns, and place it 6 row units away from the bottom of the hero 
image. Note: I’ve temporarily reduced the opacity of the hero image to highlight the layout grid.

CATEGORY ICON

The last element for the header is a colored line at the bottom, as well as 
an icon, which will represent the type of sight being profiled (Fig. 7.9). Four 
different categories are available: “seaside,” “mountainside,” “cityscape” 
and “countryside,” for each of which I’ve designed an icon. I will guide you 
through the creation process later and show you the best way to export 
them to be used as SVGs. For now, either grab the finished icon from the 
book’s resources or simply make a white circle 64 pixels in diameter over 
the image. In both cases, add an outline border 8 pixels thick.

Text and Borders
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Sketch allows you to set borders not only for shapes, but also for text 
layers. Unfortunately, it is limited to the Center position, which makes it 
useful to a certain degree — about 4 pixels, no matter how big the font size 
is. If you need a bigger outline or a border on the outside, you will have to 
resort to another solution. Duplicate the respective text layer and move it 
to the back with Alt + Cmd + down arrow. Now, set the actual border on this 
duplicate. Because it’s in the back, it won’t interfere with the shape of the 
text and can take any size.

 

 

Fig. 7.8: Create a copy of the text layer in the back, where you will set the actual border. Both layers 
overlaid result in the final text. 

In case you need an inside border instead, you can fall back on an inner 
shadow. Set X, Y and Blur all to “0,” but use the Spread to control the bor-
der width. Like a normal border, its application is pretty limited but better 
than nothing.
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The color is up to you, but be sure to pick a bright hue that stands out from 
the rest of the page and the image. I chose a bright blue with a bit of green 
mixed in (#55BFE1), which I also added to the Document Colors in the 
color dialog, with a click of the + icon. This way, I can easily pick it later 
when the icons need to be created. You may want to disable the layout grid 
for now with Ctrl + L, which will make the following elements easier to 
create. For the line, either add a 100% wide rectangle with a height of “8” or 
add a line shape with the same border thickness. Hold Shift for the latter 
to constrain it to the horizontal axis when drawing it. Either way, name it 
“Line,” assign it the same color as the icon’s border, and move it below the 
icon in the layers list.

The icon consists not only of the pictogram, but also a white circle in the 
back, which makes it stand out from the image. As described above, the 
icon itself is set at a size of “64 × 64,” with an “8px” outside border; the 
white circle should be “32px” bigger in diameter, to form a white ring of 
“8px.” This gives us a size of “96px.” Align them vertically and horizontally 
to each other and the line. Name the white circle “Mask,” and include it 
in a group named “Category” together with the icon and the line. Lastly, 
align this group to the left side of the artboard, and reposition it until its 
vertical center is at the bottom line of the image. The smart guides should 
help here.

To stay organized in the layers list, add all layers and groups created so far 
to a new “Header” group. With this last action, we have finished the header, 
which leads us to the actual content of the article.
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Fig. 7.9: After we have finished the category of the sight — consisting of an icon and a line — the 
header is complete.

The Content

Real content should be the foundation of every design, and all decisions 
should derive directly from it. However, very often that’s simply not the 
reality, and you are left with a couple of sentences or images from the 
client, if anything. Finding suitable content can be quite a challenge, so let 
the aforementioned content generators come to the rescue.

THE HEADLINE

The one-size-fits-all approach is definitely represented by the Craft71 plugin 
from InVision, which not only provides diverse content, but also lets you 
distribute and align elements, create placeholder images, and set up a style 
guide or library of design assets for your team. And it’s free — who knows 
for how much longer? The part we are in desperate need of at the moment 
is the type generator, which we will employ first and foremost for the title 
of the article. But first, let’s take care of the title’s styling.

71	 http://smashed.by/sketch-craft

http://smashed.by/sketch-craft
http://smashed.by/sketch
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Create a new text layer with our trusted “Avenir Next Regular” font, below 
the header. For optimal readability, I’ve picked a slightly toned-down shade 
of black, “#1A1A1A”, because true black is never a good idea on a white back-
ground for big text blocks. Be sure to save this color as a Document Color. 
Leave the content of the text layer with the default value for now, but move 
it to the left edge of the grid, and resize it with the right handle on the can-
vas until it fills the full width of the layout grid. This changes the Width to 
Fixed in the inspector and ensures that the text layer always breaks at the 
right edge, regardless of its content. 

Finally, change the Alignment of the title to Left with the first icon in the 
inspector, and align its baseline to the baseline grid (which you can show 
with Cmd + L again), so that the text layer is about 6 row units away from 
the header. A Line Spacing of “48” (4 × 12) adapts this alignment for subse-
quent lines later on.
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Choosing Font Sizes

Whenever I need to set the size of text layers, I rely on the classic typo-
graphic scale.72 It ensures optimal contrast among the different sizes, with 
its harmonious steps. The setting of “16px” makes it ideal for typesetting 
even in web projects because this is the base font size of browsers, and 
there are many other useful size options above and below this grade. This 
is also useful in a responsive context because you can easily go from a base 
font size of 16 pixels to 18 or 21 pixels for larger screens, which all lie on the 
typographic scale. Although the scale has some options for bigger text, like 
headlines, it may lack some variation here, so feel free to add more sizes, 
ideally in increments of 4.

 

Fig. 7.10: The values of the typographic scale are ideal for choosing font sizes.

To go one step further, you could also employ a so-called modular scale 
(read more about it in the article above), which calculates font sizes based 
on a “prearranged set of harmonious proportions,” like the “golden ratio” 
(1:1.618), the “perfect fourth” (3/4) or the “perfect fifth” (2:3). However, their 
application and calculation can become quite tedious, so I mostly stick to 
the classic typographic scale.

72	 http://smashed.by/sketch-scale

http://smashed.by/sketch-scale
http://smashed.by/sketch-scale
http://smashed.by/sketch
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Now it’s time to give some form to this headline with the Craft plugin. The 
panel should still be open from earlier, so click on the second icon from the 
bottom. In the Custom tab, select Type, pick Headlines, and for a com-
mon theme select the Travel category (Fig. 7.13). That was easy! 

To make it easier to align items from now on, we will add some custom 
guides to the outer limits of the layout grid. This way, it doesn’t need to be 
shown all the time (otherwise, we might get distracted from the content 
sometimes). First, show the rulers with Ctrl + R, which enables you to add a 
guide at the outer-left edge of the layout grid by clicking on this position in 
the top ruler. Do the same for the right edge of the layout grid.

Highs and Lows

The headline is already quite attractive, but to give it even more impact, 
we will set it to uppercase letters. To do so, go to Type → Text Transform 
→ Uppercase in the menu bar, because no keyboard shortcut is available 
by default. As mentioned in Custom Shortcuts on page 71, you could easily 
assign Alt + Cmd + P to this command (Alt + Cmd + U is already reserved for 
the Union Boolean operation) and assign Alt + Cmd + L to the lowercase.

Unfortunately, the popular “Capitalize” setting, which changes every first 
letter in a word to capitals, entirely misses here. But there’s an alternate 
way to make such typographic changes. Go into text-edit mode by hitting 
Enter while the text layer is selected, and right-click, which opens a wealth 

Quick tip: A quick way to disable the Smart Guides is to right-click 
on the rulers and select Show Alignment Guides.



Designing An Article Page

239

of options for you to discover (Fig. 7.11). The Capitalize option is hidden in 
Transformations. Another setting to note here can be found at Font → 
Show Fonts; it is an extended version of the text options in the inspector. 
A handy plugin that sets up keyboard shortcuts for the most important 
features from here on is Comma.

 

Fig. 7.11: When in text-edit mode, a right-click gives you many type-related options.

Quick tip: To control the OpenType features of a font, such as small 
caps, old-style figures, stylistic alternatives and ligatures, go into the 
text-edit mode of a text layer with Enter, right-click and select Font 
→ Show Fonts. In this dialog, click on the gear icon in the top-left 
corner, where Typography… will give you access to all of the Open-
Type features.

The change to uppercase letters gives the title quite a dark typographic 
“color,” adding to the already dense look of the “Regular” style of the font. 
To mitigate this, let’s change the Character Spacing to “3.75” (Fig. 7.12), 
which restores the lighter, more relaxed feeling.

http://smashed.by/sketch-comma
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Tracking, Kerning and Ligatures

The Character input field in Spacing in the inspector serves two pur-
poses. First, it lets you change the tracking — i.e. the overall spacing 
between letters — to give the text a looser or denser feel. It also lets you 
change the kerning — i.e. the spacing between individual letters — for 
example, to move letter combinations like “Wa” and “AV” closer together, 
which would otherwise be too widely spaced. This is usually handled quite 
well by the font, but there will be occasions when you want to fine-tune it.

To change the tracking, select the text layer or portions thereof and adapt 
the value in the Character field. For the kerning, just select the first letter 
of the pair you want to kern. A quick way is to use the arrow keys up and 
down to increase or decrease the value in this field. Combine them with 
Shift to change in intervals of 1; and hold Alt to change the spacing in inter-
vals of 0.01.

Fig. 7.12: To change the tracking — the general spacing between letters — select the whole word (top) and 
adapt the value in the Character field. To adapt the kerning — the spacing between two letters that 
would be too far apart by default — select the first of the pair of letters (bottom).
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The tracking can also be tightened with Ctrl + Alt + T; to loosen it, press 
Ctrl + Alt + L. To switch the kerning off entirely, select Type → Kern → 
Use None from the menu bar; for the default value, select Use Default, or 
delete the value from the input field. Please mind that these shortcuts only 
work when you are in text-edit mode.

Closely related to the kerning are ligatures, special alternatives to letter pairs 
such as “ff” and “fi,” which would look strange if set too close together. You 
can select Use None, Use All or Use Default from Type → Ligatures in the 
menu bar. Learn more about ligatures in Butterick’s Practical Typography, 
which is also a great resource for other type-related topics. 

The Optimal Reading Experience

To ensure optimal readability for your text, always aim for a certain line 
length — i.e. the number of letters (including spaces and punctuation) on 
a single line (also called measure). The more letters a line contains, the 
harder it gets for the human eye to jump to the next line after finishing the 
previous one. Usually, the sweet spot lies between 45 and 85 characters per 
line, but for short text passages, you don’t need to be so strict. Sketch can’t 
help you to figure out this length, but there are numerous online aids for 
this task, such as www.charactercountonline.com.

 

Fig. 7.13: The optimal line line length lies between 45 and 85 characters (middle). Left is too short, right 
is too long.

http://smashed.by/sketch-butterick
http://www.charactercountonline.com
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Whenever you notice a paragraph with an excessive line length, either 
narrow the column or make the font size bigger. If neither is feasible, you 
could try breaking the text after a certain distance so that it doesn’t fill the 
available space.

Another factor that plays into readability is line height, or leading, the ver-
tical space between lines in a paragraph. It should ideally be between 133% 
and 150%. For a font size of 16 pixels, you would need line spacing in the 
range of about 21 (16 × 1.33) to 24 (16 × 1.5). For narrow text blocks, reducing 
the line height is OK, but the wider a column, the more you’ll need.

As with line length, it gets hard to distinguish between lines if the line 
height is too small. But don’t overdo it, because the lines will start to drift 
apart if the setting is too high. For more information, read this article on 
Smashing Magazine73, in which Laura Franz talks about the correlation 
between line length and font size.

 

 
Fig. 7.14: For line height, the optimal value is between 133 and 150% (middle). Left is too low, right is 
too high.

73	 http://smashed.by/sketch-linelength

http://smashed.by/sketch-linelength
http://smashed.by/sketch-linelength
http://smashed.by/sketch
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The Introduction

Let’s tackle the introductory section of the article now, which is slightly 
bigger than the body copy. Add another text layer by dragging a frame 
that has the full width of the layout grid. Give it a size of “18” (part of our 
typographic scale), a line spacing of “30” and the same color as the title. 
Also, reset the character spacing to auto by deleting the value in the input 
field, because it got adopted from the title. From now on, make sure that 
all text layers have the full width of the column grid and are aligned to the 
baseline grid.

For the content, we’ll make use of Craft again. But this time, choose Travel 
from the Article category (Fig. 7.15). Repeat it until you get some text to 
your liking, and remove parts of it so that three lines are filled. Because 
Craft tends to add much more text than required, you will also need to 
reset the height of the text layer: Simply drag the lower handle of the text 
layer up a bit; it will automatically snap to the height of the content. This 
text layer should be four row units away from the title.

 

Fig. 7.15: The finished title and introduction. We have used the Craft plugin to fill them with content. 
For the title, we picked the Travel category from the Headlines category; for the introduction, we used 
some content from Article (right below Headlines). 
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Craft lets you not only use predefined content, but also select real text 
from any website. So, the next time you are tasked to redesign a website, 
you can choose the Web tab instead of the Custom tab, navigate to the 
relevant web page, and apply the text from there to the selected text layer 
with a simple click. To follow a link, click while holding Alt instead.

You may be wondering why we have set the line spacing to “30” — that isn’t 
exactly according to our baseline grid, and it only aligns on every second 
line. For one, not every text layer needs to employ this grid to the fullest 
degree; some font sizes would even look awkward if forced to this align-
ment. It’s OK to deviate from the rules in some circumstances.

The Body Copy

Now for the body copy. Drag the introductory section down while holding 
Alt to make a copy and leave three rows in between. Choose the base font 
size of “16px,” set the line spacing to “24px” to get a nice line height of 1.5, 
and add some filler content with Craft (again, Travel from Article). Delete 
until you have about six lines of text, or drag the bottom handle of the text 
layer up to get this amount of content.

The chosen font size of 16 pixels ensures that the line length — the number 
of characters in a line — is not too long. Ideally, lines should be between 45 
and 85 characters. This ensures optimal reading flow, because the eye can 
easily find the beginning of the next line.
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DROP A CAP

It looks nice already, but for some typographic gimmickry, I’ve decided to 
add a drop cap — a differently styled and enlarged variant of the first letter 
of a paragraph. Unfortunately, adding it directly in Sketch is not possible, 
so we need to use a workaround and create two additional text layers.

Start by entering text-edit mode for the existing paragraph, cut the first 
letter and create a new layer with it below. Enlarge this single letter until it 
fills three grid rows, which should happen at a font size of about 48 pixels. 
For even more variation, choose “Playfair Display Bold” as the typeface, and 
change the color to that of the category icon below the hero image. Be sure 
to align the drop cap to the left edge of the layout grid.

After that, drag a new text layer next to it, expanding it to the right edge of 
the layout grid. Fill it entirely with two lines of text from the other para-
graph (and removing this portion in that other paragraph). The spacing in 
the drop cap should be about “8px.” Align the two paragraphs below each 
other, on the baseline grid, so that they look as if they are a single text layer, 
like before. Lastly, put all of the elements we’ve just used in a “drop cap” 
group, and leave three rows for the introduction.
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Fig. 7.16: The part with the drop cap consists of three text layers. The two paragraphs are put below each 
other so that they look as though they are one.

Alternatively, we could keep everything except the drop cap on the same 
layer, but use the right amount of space for the indentation of the first two 
lines, to give the drop cap the room it needs. This would require you to 
make a hard break with Enter after the first line, so that you can also indent 
the second line with the same amount of space or tabs. Sketch doesn’t 
allow you to do that without a manual break. Both methods are not ideal, 
but the look of the drop cap makes up for the effort.

Break It Up

After so much text, it’s time for some relaxation with a nice full-width 
image. For this, create a new rectangle the full width of the layout grid. 
Don’t choose the height arbitrarily; set it according to the hero image, with 
its ratio of 16:9. This leads to a value of 406 pixels (“722/(16/9),” rounded). 
Also, move it three grid rows away from the preceding paragraph, and 
name it “Image.”
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Time to use the Craft plugin again to fill this placeholder with some 
content. Click on the second icon from the bottom in the panel, and select 
Photos → Unsplash → Travel from the Custom tab. We might want to 
reuse this type of image later on, so favorite it by clicking on the dotted 
box, give it an appropriate name and setting the other properties as above. 

Fig. 7.17: The first image in the content area of the article. Use Craft to insert it.

A minor downside of Craft is that images are always added as a pattern 
fill instead of a dedicated layer. In this way, the bitmap is tied to the 
size of the shape, so you can’t enlarge the placeholder without a loss of 
quality. To avoid this restriction, always insert the placeholder shape at 
a much bigger size, add the image fill, and then shrink it down to the 
required dimensions.

Craft lets you add placeholder images not only from Unsplash, but also 
from a local folder or Dropbox. Moreover, you can visit a website in the 
integrated browser in the Web tab and choose an image from there (just 
like with text, as described above). Lastly, you can pull in a JSON file in the 
relevant tab and select values from there.
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Image Manipulation

In Sketch, you can change the appearance of an image with Color Adjust 
in the inspector (more on that later), and also manipulate it with a dou-
ble-click. There, you can either drag a rectangular selection or use the 
Magic Wand tool to select similar-colored areas. In both cases it is possible 
to add areas by holding Shift or to remove parts with Alt.

As soon as a selection is made, more options become available: You can 
invert it (Fig. 7.18, 1), crop the image to the selected area (Fig. 7.18, 2), fill 
it with a color (Fig. 7.18, 3) or vectorize it (Fig. 7.18, 4). The latter sounds 
interesting at first, but is rather limited due to the restricted options of the 
Magic Wand.

It is also possible to remove the selected part of the image with Delete or 
backspace, and you can copy and paste the selection with Cmd + C and 
Cmd + V. Keep in mind that all of these manipulations, except the last, are 
final and cannot be undone with Cmd + Z later.

Also, these manipulations only work for dedicated image layers that you 
either drag in from other applications or insert with Insert → Image 
… from the menu bar. To convert a layer with a pattern fill, as Craft uses 
it, select it and choose Layer → Flatten Selection to Bitmap from the 
menu bar.

Fig. 7.18: You can manipulate images 
with a double-click. After you have 
made a selection, more options 
become available: 1: Invert it. 2: Crop 
the image to it. 3: Fill it with a solid 
color. 4: Vectorize it. 
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Connect the Text

Before moving on to the next paragraph, we will create a text style that 
ensures the text remains reusable and changes can easily be applied to 
all other parts of the same type. To do so, select the two paragraphs by 
the drop cap, click on the drop-down that says No Text Style (Fig. 3.21) in 
the inspector, and select Create New Text Style. Name it something like 
“Article paragraph.” Also do this for the title and the introductory text, with 
appropriate names, and later on for all of the other text elements. To see a 
nice overview of all of the different styles used so far, create a new artboard 
named “Text” on the “Symbols” page, and add a new text layer for every 
text style.

Now, add another text layer with a couple of lines below the image. The 
easiest way is to select the one above and drag it down while holding Alt, 
but then move it out of the “Drop cap” group. It should be three rows away 
from the image. Use Craft to apply some new content. Break the text into 
two separate paragraphs, but instead of using multiple line breaks, just 
make a single one and employ the Paragraph field at Spacing to control 
the distance in between (Fig 7.19). Match the value to the line spacing (24 
pixels), so that there are three rows between the two paragraphs.

 
Fig. 7.19: Use the Paragraph field to control the distance between two paragraphs that are separated with 
a line break.
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Whenever we decide that another typeface or color would be more 
appropriate for these paragraphs, we can propagate the changes to other 
instance of the text style easily. Just click on the round arrow in the appro-
priate drop-down (see Fig. 3.22 on page 80).

My Favorite Quote

Too many paragraphs on one row would make the article look dull, so let’s 
create another element to break the flow a little. The element of choice is 
differently styled quotation marks, which will fill a couple of grid columns.

Copy a short piece of text from one of the paragraphs for this purpose. 
Then insert a new text layer containing it. For the typeface, select “Playfair 
Display” again, but this time the “Regular” weight. Because we’ve already 
used this font, we can simply pick it from the beginning of the Typeface 
drop-down. Select “24” as its size, another grade from the typographic 
scale. A line spacing of “36” aligns it to the baseline. Move it to the begin-
ning of the third grid column, and resize it so that there is a gap of two grid 
columns at the end, giving it an even more distinct look.

For the quotation marks, create another text layer with the same typeface, 
but an “Italic” weight, a size of “84” and a color of black with “20%” opacity. 
The sole content should be the opening quotation mark (“). Align it to the 
left of the text, with a gutter in between (15px). Drag it to the bottom-right 
of the quotation mark, while holding Alt, and change the content to the 
closing quotation mark (”). Place it next to the last word, with another 
gutter in between.

Now, select both of these layers and convert them to outlines with 
Shift + Cmd + O. This will change them to a shape, making them easier to 
handle later on. Add all three elements to a “Quote” group. 
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Lastly, place it on a grid row line, so that it is about three row units away 
from the preceding (and, later, subsequent) content (Fig 7.20, top).

More Text

Add another text layer in the same way as above, also separated into two 
paragraphs. With so much text on the page, we should break it up into 
chunks with subheadings. To prepare for this, add a text layer with “Ave-
nir Next Regular” and a size of “24.” Just like for the page title, add some 
placeholder text from the Travel category of Headlines from Craft. This 
text would also benefit from a looser feel, so apply a bit of Character 
Spacing. I have chosen a value of “2” here. Place it four row units away 
from the preceding paragraph, at the left edge of the layout grid, as always 
(Fig. 7.20, bottom).

Fig. 7.20: The quotation (top) and the first subheading (bottom).

Like for the other text elements on the page, create a new Text Style for it 
that you also add to the “Symbols” page with an exemplary element. This 
will give you a good overview of all of the elements that have been used 
throughout the design so far. 



252

Chapter 7

Whenever you create a new element, have a look here first to see if there 
is some potential to reuse a component. Back on the “Article” page, add 
another text paragraph after the subheading, with a spacing of two 
row units.

To the Max

Time for another image to break up the article. Like before, add a place-
holder rectangle, but this time full width for a slightly different look. 
Instead of a ratio of 16:9, I chose another movie format, 2.35:1, to differenti-
ate it even more. Based on the width of 768 pixels, this results in a height of 
326 pixels (“768/2.35,” rounded down). 

Before adding the image itself, you should prepare it for the bigger screen 
widths so that it doesn’t lose details when enlarged. For this reason, lock 
the ratio of the placeholder shape first (with the lock symbol between the 
width and height in the inspector), and then double the width by adding 
“*2” to the field in the inspector. Now, add the image itself in the same 
manner as before with the Craft plugin. After this action, change the width 
back to “768px.”

Quick tip: To make superscript text — for example, for dates (2nd) 
or the square root of a number (12²) — go to Type → Superscript 
in the menu bar. Here, you can also find the reverse with Subscript 
(for example for H2O). To change the baseline of text, manually select 
Raise or Lower from this menu. Please note that all of these com-
mands require you to select a portion of a text layer. Use default at 
the end lets you go back to the standard alignment.
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Maximize the Available Space

Although the interface elements of Sketch are rather minimal, the time 
will come when you long for more space on the canvas, especially with 
big-scale images. To fill this need, you can temporarily hide the layers 
list with Alt + Cmd + 1, the inspector with Alt + Cmd + 2 or both at once 
with Alt + Cmd + 3. For some more vertical space, remove the toolbar with 
Alt + Cmd + T (Fig. 7.21).

Fig. 7.21: There are numerous ways to enhance the available space on the canvas.

The last grain of space can be squeezed out of Sketch by entering full-
screen mode with Ctrl + Cmd + F. Lastly, all of the available control elements 
can be hidden at once in presentation mode. Enter it with Cmd + .. Keep 
distractions to a minimum here by deselecting Show Selection Handles 
and Show Layer Highlight from View → Canvas in the menu bar.
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In contrast to the first image we added to the article, the current one not 
only has a different ratio, but also has a caption. It is on a “Regular” text 
layer, with a size of “12px,” 50% opaque black and a centered Alignment. 
Copy a few words from a paragraph, place it on a grid line below the image, 
and center the text to the artboard. Put both of them in a group named 
“Big image.” The spacing from the preceding text layer should be three 
row units.

The third difference relates to the style of the image. When you look at 
figure 7.22, you’ll notice it is in black and white. However, I didn’t insert it 
like this; I changed the style right in Sketch. To accomplish this, we need to 
convert the pattern fill to a dedicated image. Be sure to create a duplicate 
first, and hide it and rename it to “Big image backup.” Now you can select 
the original image by holding Cmd and clicking it, and you can convert it 
by selecting Layer → Flatten Selection to Bitmap from the toolbar. This 
enables us to click on Color Adjust in the inspector, which shows various 
options for manipulating the appearance of the image.

Fig. 7.22: Sketch allows you to make color adjustments directly within the app. In the screenshot, you can 
also see the second image of the article in its finished state. 
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For the black and white style, simply drag the Saturation slider to “0.” 
Furthermore, you can adapt the hue, brightness and contrast of the image 
here. So, if the image is too dark in this desaturated state, drag the Bright-
ness to the right a bit. Return to the original state by clicking on the round 
arrow. Just mind that these manipulations lower the image quality, so 
they are rather for demo purposes. In case you want to reuse an image 
with such a change later, you might need to recreate it in another graph-
ics application.
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Blending Modes

A non-destructive method to create a grayscale image that doesn’t alter the 
quality of the image is to use blending modes. You might already know 
them from Photoshop or other graphics applications. They allow two layers 
to interact in a certain way. Delete the current “Big image”  group first, but 
dig up the backup we created earlier. Now, duplicate the image layer, give it 
a white fill (or any other color with “0” saturation), and change the Blend-
ing to Color. Name it “Black/white.” 

The image may be too dark now; to soften the effect, create another white 
layer on top, but with a Soft Light blend mode, named “Brightness.” 
Instead of a dedicated layer for each blending mode, you could also add a 
fill. However, you couldn't change the opacity with the slider or numerical 
keys anymore if the effect is too strong.

 

Fig. 7.23: Blending modes are a great way to alter the appearance of an image — for example, to make it 
black and white. Apply them either as fills or as separate layers (not depicted). 
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You should also try out other blending modes, because they often create 
very special effects for bitmaps. I mostly use Overlay, Multiply or Color 
to overlay a colored layer to an image. Have a look at the mini project 
“Creating Textured Type” on page 333 to see them in action. It would go 
way beyond the scope of this book to describe all of the available blending 
modes, because there is some serious math involved. However, if you want 
to learn more about them, there’s a very in-depth article at PhotoBlogStop. 
It’s about Photoshop but applies to Sketch.

Please note that every layer has a general blending mode that defines how 
it interacts with the layer below it; however, each property, such as the fill 
or border color, also has a blending mode available that sets how it reacts 
to other properties of the same type. As of late, blending modes can also be 
replicated with pure CSS. Like always, Chris Coyer from CSS-Tricks74 has 
you covered.

74	 http://smashed.by/sketch-csstricks

http://smashed.by/sketch-blending
http://smashed.by/sketch-csstricks
http://smashed.by/sketch
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The last text elements for the article are another two text paragraphs, bro-
ken up by a subheading. Apply the same spacing and text styles as for the 
other text elements; the spacing of the image caption should be three rows.

Book a Tour

Like on the “Details” page, we also want a button for visitors to book a tour 
of the featured sight. Luckily, we set up a symbol earlier, so it’s just a matter 
of choosing it from the list of available symbols. We don’t even need to 
detach it, because all of the properties fit the “Article” page perfectly. Just 
make sure that it is centered on the page and four row units away from the 
paragraph before.

Add it to a new group named “Content,” which we will also take as an 
opportunity to bring some order to the layers list again. Move all of the 
content elements of the article — headings, text paragraphs and image — 
into this new group. I say “image” because I want you to add only the first 
image to this group. The second full-width image with the caption should 
remain in the main hierarchy of the layers list for now. This also goes for 
the “Header” group, which you can place at the very top.

 

 

Fig. 7.24: The remaining text layers and the booking button. On the left is the full layer hierarchy of the 
content elements.



Designing An Article Page

259

A Matter of Taste

Our article has already reached quite a length, but we are not finished yet. 
We need to take care of one last element: a list of destinations similar to 
our sight (“You might also like”). The list should give the user some choices 
after they have finished reading the article.

First and foremost, this area will consist of a full-width rectangular back-
ground, which we’ll add with a height of about 800 pixels for now. For the 
fill color, choose the one we used for the background of the search field of 
the “Overview” screen (#332424), but with an opacity of “80%.” Good thing 
we saved it to the Document Colors of the color dialog. Name it “BG” in 
the layers list, and move it four grid rows from the button.

For the title, “You might also like,” the beautiful Playfair Display is applied 
again at a size of “28px,” a “Regular” weight and default character spacing 
(just delete the value). It’s OK that we haven’t taken a value from the typo-
graphic scale this time. The sizes from there aren’t always appropriate, so 
don’t be afraid to break the rules. The text Alignment should be changed to 
Center, with Cmd + |; for the color, choose a pure white. Place this headline 
on a grid line, three rows units away from the top of the dark background; 
also, center it to the artboard.

Quick tip: A quick way to change the Alignment of text layers is to 
use the keyboard shortcuts Cmd + { (left), Cmd + | (center) and Cmd + } 
(right).
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The main players in this block are the sights themselves, but because they 
are very similar, we only need to create one and duplicate the other five. It’s 
not even necessary to adapt the content. All of that is handled for us by our 
darling, the Craft plugin.

For the model of these sights, create a new rectangle, which will be the 
placeholder for the image. It should be five layout grid units wide (“292px”) 
and, according to the tried and trusted ratio of 16:9, “164px” high (“292/
(16/9),” rounded). To prepare it for the other screen widths, proceed as we 
did for the full-width image before: Lock the ratio, double the width, and 
only insert the Unsplash image at this enlarged state. After that, bring it 
down to the intended size (add “/2” to the width in the inspector).

Move it horizontally one grid column away from the left edge of the layout 
grid. Vertically, space it three row units from the title. Name it “Image.” 
The title of the sight should be “Bold” and “18px,” set in “Avenir Next.” For 
the location below, use “Regular” and “12px.” Set both to white, center them 
in the image, place the title on the baseline grid beneath, with reasonable 
spacing, and the location slightly below. Finally, change their text Align-
ment to Center with Cmd + |.

 

Fig. 7.25: The model for similar destinations.
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A prerequisite for Craft not only duplicating the elements but also adapt-
ing the content automatically is that you define it with the help of the 
plugin. For the title, choose some content from the Cities category, for 
example, and for the location, some placeholder text from Countries.

The last element for the template of the sight — a line that marks the cate-
gory it belongs to — should be placed over the image, at its bottom. Create 
a new rectangle for it, with the width of the element and a height of “2.” If 
you put them in the same group as the image, you can use “100%” for its 
width. Give the line the same color as the icon in the header of the article 
(get the color from Document Colors), name it “Category,” and the group 
“Sight.” Also, put the title and location in it. Now, create a symbol from the 
group of this model, which ensures that we can adapt it easily for the other 
screen widths, once we have duplicated it multiple times. Don’t send it to 
the “Symbols” page, but let it be added next to the current artboard. From 
there, move it down, below the artboard, so that we have it close to the area 
of application.

Power Duplicate

With all elements in place, we can make use of the powerful duplication 
capabilities of the Craft plugin. You could use the Make Grid… feature 
of Sketch that we learned about earlier, but it wouldn’t adapt the content 
(image, title and location) automatically for each entry. Craft also makes it 
much easier to adjust the spacing afterwards. To get the duplication pro-
cess up and running, choose the “Sight” symbol in the artboard, and click 
on the Duplicate icon in Craft’s panel (last one).

We want to have a grid of two sights horizontally, and three on the vertical 
axis. The spacing of the latter should be “30”; for the horizontal spacing, 
choose the gutter width of the grid, about “15.” After you click on Duplicate 
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Content, the plugin will not only fetch all of the required content but also 
add the other entries of the sights. Furthermore, it will create a “Duplicate 
control” layer that lets you add or remove elements simply by resizing it. 
In case the elements don’t align to the baseline, you can select this control 
layer and change the Vertical spacing with the slider or the input field in 
the Craft dialog until you get perfect alignment. You can also easily adapt 
the number of elements here. There should be about two to three rows 
between the sights. Finally, rename the group that Craft created to “Sights.”

 

Fig. 7.26: Craft added the remaining elements for us and also adapted the content of each automatically.
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Category Colors

The only thing we need to change manually still is the color of the category 
lines at the bottom of the images. Because we have used a symbol, we can’t 
adapt the line without affecting the other instances. But what we can do is 
to use a nested symbol and swap the colors with the Overrides. For this, 
go to the “Sight” master symbol we placed below the artboard and select 
the line (named “Category”). Create an eponymous symbol from it. Select 
this new symbol (with a click on the title at the canvas) and rename it to 
“Category color 1”

Make three more copies, naming them “2” up to “4,” and assign differ-
ent colors for the lines (Fig. 7.27, bottom). Besides the blue, I have chosen 
orange (#F5A623), purple (#E01081) and green (#79C03D), which I also 
added to the Document Colors of the color dialog. We will need them 
later. Also, add them to our “style guide” on the “Symbols” page, so that you 
have an overview of the colors used so far.

The swatch for each color should consist of a circle with a diameter of 
about 100 pixels, which you should fill with the relevant color, and two text 
layers: a bold one for the name of the color, followed by one for its HEX 
value right below. Name the group of all of these elements, respectively, to 
the first text layer, and group everything again in a “Colors” group. If you’d 
like, you can also make a new artboard for these swatches. Whenever you 
introduce a new color to your design, you should add it not only to Docu-
ment Colors but also here. This will ensure that you reuse colors as often 
as possible for a consistent look. 
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Back on the “Article” page, we can assign a different category color to the 
symbol of each sight for some variation. Select one sight and change the 
“Category” drop-down at the symbol’s Overrides in the inspector to a dif-
ferent color (Fig. 7.27). This allows us to have different lines for each sight, 
but they are still all based on the same symbol, which makes modifications 
much easier. You can also move the five symbols below the artboard to the 
“Symbols” page now, because we don’t need them here anymore; select all 
of them with a Shift-click on the title, and drag them from the layers list to 
the respective page.

Fig. 7.27: Assign a different category color to each sight at the Overrides in the inspector.  
Bottom: The symbol for the sights besides the nested symbols for the category colors.

For a nice finish, add the list of sights, together with the background and 
the title, to a new “You might also like” group, and send it to the back of 
the layers list with Ctrl + Alt + Cmd + down arrow. Also, make sure there is a 
gap of three rows between the last line of sights and the background, and 
adapt the height of the artboard so that it matches the whole content of the 
“Article” page. You can use the Resize to Fit button in the inspector after 
selecting the artboard.
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A Word About Layer Order

The number of elements has grown not only the length of the article, but 
also the numbers of layers and groups in the layers list. Although we’ve 
done our best to keep things organized, we might still have a mess of 
collapsed and expanded groups. I have already shown you a few tricks in 
the info box Layer Management in the Layers List on page 140 on how to avoid 
chaos in the layers list.

However, I want to say a few words about the way layers are ordered in the 
layers list. Sketch tends to place elements that you duplicate or copy above 
the source in the layers list. This seems logical because the old element 
shouldn’t cover the new. But it goes against my natural habit to put ele-
ments in the same order as they appear on the canvas. Content that is up 
in the artboard should also be up in the layers list; from there, the layers 
should be placed in the same order in both. This way, it is easier to under-
stand the hierarchy and where to find individual elements later on.

The same goes for artboards. Sketch always places them on top after the 
duplication, which may seem more logical because new content should 
also be further up in the layers list. However, for me it makes more sense 
to go for the typical left-to-right arrangement. Content that is on the left 
should be on top in the layers list, and the further right you go, the further 
you go down the list. Think about it the next time you add and order con-
tent — just some food for thought.

According to this principle, I placed the header of the article on top in the 
layers list, followed by the big image and the content group. There, I started 
with the title, continued with the intro, the paragraph with the drop cap, 
the image and so on. The end of this group is marked by the button. In the 
main hierarchy of the layers list, I ended with the “You might also like” 
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area. You may want to follow this order now if you share my view. The 
easiest way to do it is to use the keyboard shortcuts Alt + Cmd + up arrow 
to move a layer up in the layers list, and Alt + Cmd + down arrow to move 
in the opposite direction. Of course, you can also drag them to the pre-
ferred location.

One relevant plugin is Sort me,75 which allows you to arrange layers alpha-
betically or numerically in the layers list in the reverse order.

75	 http://smashed.by/sketch-sortlayers

http://smashed.by/sketch-sortlayers
http://smashed.by/sketch
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Going Responsive

A              modern website doesn’t consist of a single width alone. With     
responsive web design in mind, you need to create multiple break 
points at which the layout can adapt to different screen widths. 

While it’s not feasible to set up a separate artboard for each responsive 
breakpoint in Sketch, you might still want to see how the adaptations will 
look like at a few different sizes. To understand this workflow, we will cre-
ate two more artboards: one for a width of 1024 pixels, one for 1920 pixels.

Designing With Constraints

Let’s start with the first one. Duplicate the current artboard, resize it to a 
width of “1024” in the inspector, and rename it to something like “Article 
Medium.” We also need to update the layout grid (View → Layout Set-
tings… in the menu bar) to reflect this new size. Like before, it should take 
up 94% of the available width, be centered with no gutter on the outside, 
and have 12 columns; also, the gutters should be about one third of the col-
umns. This gives us a Total Width of 962px (“1024 × 0.94” rounded down), 
a Gutter Width of “21px” (962 / 12 ≈ 80. 80 / 4 = 20) and columns with a 
size of “61px” (≈ 80 − 20). Also, click on Center at the end.

Now we can use this new layout grid to adapt all of the elements of the 
design to the expanded room with the “Group Resizing” settings. Not too 
long ago, you needed a plugin for this functionality, but as of late Sketch 
allows you to define how elements react when you resize their parent 
group (or symbol). It’s not perfect but can still be a huge time-saver.

If you select a layer or group, you’ll notice the Resizing drop-down 
in the inspector. Basically, it can be broken down to how the dimen-
sions (width and height) and the placement (X and Y position) adapt to 
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changes: whether they are fluid, in that they change proportionally to the 
parent group or symbol, or fixed, which means that the original values 
are retained.

There are four values you can set at Resizing (the respective shortcut is 
mentioned in parentheses):

1.	 Stretch, the default option, means that the element changes its 
width or height proportionally to the size of the group it is located in. 
This includes spacing. Both the dimensions and placement are fluid 
(Ctrl + 1). 

2.	 Pin to corner fixes the layer at the current position — the closest 
corner, to be precise. It is not resized, nor is its spacing adapted. Both 
the dimensions and placement are fixed. This option can be used to 
keep an element centered if it has the same distance from both sides 
(Ctrl + 2). 

3.	 Resize object is similar to Stretch in that it resizes the element 
proportionally, but the exact spacing is retained. The dimensions are 
fluid, and the placement is fixed. Please note that the behavior chan-
ges if the element touches three sides of the parent: In this case, the 
size is maintained on the axis where one side touches (but only if it is 
less than half the size of the parent); on the other axis, it takes on the 
size of the parent. (Ctrl + 3). 

4.	 Float in place is the total opposite, in that the measurements of the 
element are maintained, but the spacing changes relative to its cont-
ainer. The dimensions are fixed, and the placement is fluid. It can also 
be used to center an element (Ctrl + 4).
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Fig. 8.1: The different Resizing options. 1: Stretch. 2: Pin to corner. 3: Resize object. 4: Float in place.

As a bonus, Sketch is smart enough to memorize the “corner” where the 
element was before. So, if it was at the right edge of the parent, and you 
resize this parent container from the right, the element will stick to this 
side. This also goes for centered elements and is applied on the vertical axis 
alike. Unfortunately, there are some limitations: You can neither change 
the origin of this pinning nor set a different behavior for each axis.

A Responsive Grid

Possibly the biggest restriction with layout grids is that they don’t react to 
the size of the artboard; you have to set one up for each width individually. 
However, there’s a trick to creating a responsive version: Instead of using 
Sketch’s built-in layout grid, add your own grid overlay. To make it easier to 
set it up, select all groups in the main hierarchy of the layers list, and hide 
them temporarily.
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Start with the left margin of the responsive grid. Create a rectangle atop all 
of the other content, representing the left area outside of the grid. For the 
width, orient yourself in the normal layout grid. Make it 100% high, give it 
a bright color (green, for example), name it “Left margin,” and create a new 
“Grid” group with it. Now on to the first column. Add another full-height 
rectangle, with a width of one column. Duplicate it for the gutter, put it 
next to the column and shrink its size to the width of the gutter. Assign a 
similar color for both, like a dark and a light red, and add them to a “Col-
umn” group, which you should put in the “Grid” in turn.

After that, use the Make Grid… function from the Arrange menu to get 
the remaining 11 columns (rows: 1; columns: 12; margin: 0px). Put all of 
these “Column” groups into a new “Inner” group, but delete the gutter of 
the last column. You will notice that these columns don’t match the layout 
grid exactly, but that doesn’t matter much at the moment. Finally, duplicate 
the layer of the left margin for its pendant on the right side, place it on the 
right edge of the last column, and rename it to “Right margin.”

 

Fig. 8.2: The fluid grid: You can easily adjust it for different screen widths.
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When you grab the “Grid” group now and change its width on the can-
vas, you will see how the columns and gutters respond to the new width, 
thanks to the default Stretch behavior of all layers. To use it to align other 
layers to it, set the opacity to 30% and lock it. However, this approach has 
two disadvantages. First, elements of your design can’t snap so easily to 
it like with a normal layout grid. Secondly, you can’t switch it off with a 
keystroke, but rather need to hide the “Grid” group in the layers list. In 
turn, you will get a fluid grid that you can easily adapt to the width of your 
artboard. Thanks to Anthony Collurafici76 for his idea about this respon-
sive approach.

The Header

No matter which grid type you choose in the end, you can start to adapt 
the elements to the artboard’s new width now, after you have shown all of 
the groups again. Begin with the back link and the logo in the header. They 
should be pinned to their respective edges, but the spacing should still 
adapt to the layout grid’s new width, which is 94% of the artboard. For this 
to happen, we need to create a new group from these elements that can be 
left at the default Stretch value in Resizing; name it “Inner.” The individ-
ual elements, the “Back” group and the logo, however, are set to Pinned to 
corner so that they stick to this relative width of the container.

If you try to resize the “Header” group to the full width with the handles 
on the canvas, you will see that this gives us the desired result, and both 
elements have been moved to the outer edges of the layout grid. But for 
now, go back to the original width with Cmd + Z, because we still have to fix 
a few other elements.

76	 http://smashed.by/sketch-grid

http://smashed.by/sketch-grid
http://smashed.by/sketch
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Because we can’t set different behaviors for the X and Y axis, we will con-
centrate on the horizontal dimension for now, and take care of the verti-
cal position of the elements later. First, the title and its width. Because it 
should be sized proportionally to the artboard, the default value of Stretch 
is OK. In turn, the category icon should remain at the center, which also 
goes for the white mask in the back. Select both, the “Icon” group and the 
“Mask” layer, and set them to Pin to corner. The line itself doesn’t need to 
be changed.

If you adapt the Width of the “Header” group in the inspector to “100%” 
again, you will see that all of the elements behave exactly as intended: 
The icon and the logo move to the outer edges of the layout grid, the title 
adopts the correct position and width of the grid columns, and the cate-
gory icon and the mask remain at the center. All of this mostly happens 
due to the fact that we calculated the layout grid and its columns relative to 
the artboard’s width. You will see that this is an advantage not only in the 
design phase, but also in the development phase.

One thing we still have to fix is the vertical position of the elements. Go 
back to the original width of the header, with Shift + Cmd + Z, lock the ratio 
of its group in the inspector, and make it full width again. The result looks 
quite good, but we still have to make a few modifications, mostly to the 
elements at the top of the header.

Because the “Inner” group, which contains the back link and the logo, is set 
to Stretch, its placement has changed relative to the height of the header. 
What we really want is a pinned behavior, so that the position remains 
constant. Unfortunately, you can’t set a different Resizing behavior for 
each axis; therefore, we need to fix this by hand and bring the “Inner” 
group back to the old position, so that the logo is one grid row away from 
the top of the artboard, which is at a Y position of “12.”
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For the category, the Stretch value works perfectly, ensuring that it 
remains at the bottom of the background image. The same goes for the 
background image: It stretched correctly to the new dimensions of the 
header. Unfortunately, it might look a bit blurred now, so you might want 
to optimize it in the same way as we did for the full-width image in the 
content: lock its ratio, double the width, insert the image fill again, and 
bring it back to the original width. This way, we have also prepared it for 
the next screen width of 1920 pixels. But more on that later.

    

   
 

Fig. 8.3: The correct resizing settings for each element in the header.

The last element in the header that needs a new vertical position is the 
title. But let’s delay this task until we have made a small but important 
change to the baseline grid.
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Hide and Seek

The change of the header’s height has made it cover some of the content 
below, which is less than ideal. Instead of moving all of the elements in this 
area individually down now, combine them into a new “Container” group. 
It should include the “Content,” the “Big image” and the “You might also 
like” groups.

This way, it’s easier to move everything at once, and we will also need this 
group to set the correct resizing behavior. Now, hold Shift (to constrain 
the movement to a straight line), and drag this group down until it’s fully 
visible again; don’t worry about the row grid at the moment.

After that, we can finally embrace the additional space of the enlarged art-
board and adapt the content to it. For example, for the header, enter “100%” 
for the width of the new “Container” group and watch the magic unfold. 
This will not only adapt the spacing to the new layout grid automatically, 
but will make all of the children full width. However, it also makes one 
issue immediately apparent: With the increased width, the line length of 
the text gets way too long, which would lower the reading experience. Let’s 
take another approach. Return to the original width (with Cmd + Z).

A New Base

The easiest way to bring the text back to an optimal width is to increase 
the font size. But instead of doing that for each layer individually, we will 
increase the base font size of the whole design, to which every text element 
will adapt. With it, we will also increase the baseline grid so that the line 
height is brought back to an ideal value, too.
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To do that, enter the Layout Settings from View in the toolbar again, with 
the artboard selected. Instead of the old base font size of 16 pixels, which 
was derived from the size of the body copy, we will choose 18 pixels now, 
giving us a ratio of 18 ÷ 16 = 1.125. This is our “golden value” from now 
on and should be reflected not only in the baseline grid but in each text 
element of the design. If we take the old value of “12px” of the baseline grid 
from the Gutter Height and multiply it by this new ratio, we get “13.5px” 
(12 × 1.125). Unfortunately, Sketch can’t handle decimals here, so this gets 
rounded to “14px,” which is also fine. The rest can be confirmed with OK.

It would be quite tedious to adapt all text layers to this new ratio manually. 
Instead, we will use a trick and use the Scale… dialog to adapt the whole 
“Container” group at once: Select it and press Cmd + K. Bring your attention 
to the Scale field, which allows us to resize the group proportionally. If we 
apply our “golden value” from above, we get a value of “112.5%” (100 × 1.125). 
Unfortunately, Sketch doesn’t allow decimals here either (nor calculations), 
so let’s take the next best value, “113%” (Fig. 8.4, 1). Furthermore, change the 
origin of the resizing from Center to the top-left corner (Fig. 8.4, 2). Press-
ing OK brings us a huge step closer to the correct size of the text elements.

Fig. 8.4: Instead of enlarging all elements individually, we resize the whole “Container” group with the 
“golden ratio” of 1.125 in mind, giving us a Scale value (1) of 113% (100% × 1.125 rounded). Be sure to set the 
origin of the resizing to top left (2).
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Slow and Steady

Before we dare to bring the content to full width again, we need to adapt 
two other elements from the screen slightly: the red button and the “You 
might also like” area at the bottom (in particular, its “Sights” group). Set 
both to Float in place, so that they remain centered. That will suffice for 
now; we will tackle the rest later.

We will also take a chance and adapt all of the elements of the header to 
the new baseline grid now. First, the logo: The size is fine, but move it a bit 
down, so that its top is aligned to the bottom of the first baseline row. Next, 
the back link. Instead of enlarging all of the elements separately, we’ll 
use the Scale function in the same fashion as before and resize it to “113%” 
(100 × 1.125, rounded) to respect the “golden value” from above. The origin 
should be Scale from left (the middle point in the first column).

The title in the header needs not only a new font size but also a new posi-
tion. (Remember we had postponed that?) If we embrace our “golden value” 
here and multiply the font size by “1.125,” we get “54px.” Secondly, change 
the line spacing to “70” (14 × 5) to reflect the new baseline grid, and move it 
down so that there’s a gap of about four row units from the category icon. 
You could also use the Scale dialog again to adapt both the size and line 
height at the same time. 

Now for the big moment: Select the “Container” group and set its width to 
“100%” in the inspector. This almost gives us the desired result: Not only 
do we have an ideal line length again, but all of the content elements have 
adapted to the boundaries of the new layout grid. Good thing we set its 
width relative to the artboard.
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The Content Area

Now for the “fun” part: adapting all of the text layers in the content area 
to the new baseline grid. We could also be meticulous with the font sizes, 
because the value of “113%” from Scale was just an approximation. But 
most of the sizes are so close to the correct size and just a few percent off 
that this extra work wouldn’t be worth the hassle. It should be enough to 
give the golden ratio to the developer and tell them that all measurements 
should adapt to it.

But the alignment to the baseline grid is still required. First, move the 
whole “Container” group until there is a gap of about four row units 
between the category indicator and the title, and it sits on the baseline grid. 
The position and line spacing of the intro should already be almost good; 
you might just need to adapt both by a few pixels. From now on, align all 
text layers to the baseline grid, as we did with the initial artboard size of 
the article. Also, adapt the custom guides at the outside of the layout grid 
to the new boundaries, so that there is no need for the grid to be visible all 
the time. The easiest way is to select the “Content” group and let the guides 
snap it as you move them.

That was a piece of cake. Luckily, we can continue in the same fashion with 
the body copy. Select all of the paragraphs in the content area and slightly 
increase the line spacing to “28” (14 × 2). Also, set up a new text style to 
keep everything in sync. Name it “Article paragraph Medium.” Be sure 
to create new text styles for the other types of text layers, to make future 
modifications easier.
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The Drop Cap

With the new font size, the upper part with the drop cap needs a small 
modification: Just move the nearby text a bit closer, so that the spacing 
of 10 pixels in between is retained. Align all of the paragraphs here to the 
baseline again, and copy some content from the lower one to the upper one 
so that it is fully filled again. Lastly, make sure that there is a spacing of 
three rows from the introductory paragraph above.

Floated

One downside of the group-resizing feature is that images don’t retain 
their ratio when the parent group is resized, even when the ratio is locked. 
But let’s take this as an opportunity to give the image a totally new appear-
ance. Instead of just fixing the height to bring it back to the original 16:9 
ratio, give it a totally new alignment to the layout grid so that it fills only 
the first six columns.

To achieve this, drag the right handle until this width is met at 470 pixels, 
unlock the ratio in case this setting was defined before, and enter “470/
(16/9)” for the height. This brings back our beloved 16:9 ratio. Make sure it’s 
three rows away from the preceding paragraph, as on the previous screen.

The rest of the workflow is similar to the initial creation of the drop cap: 
Copy a few lines from the following paragraph, then drag a text layer next 
to the image, with the size of the remaining columns and the same height. 
Fill it with the copied text until the whole space is occupied, align it to the 
baseline grid, and apply the new “Article paragraph Medium” text style. 
Remove this portion from the initial text layer; it might take a couple of 
tries to get the right amount of text. In case you don’t have enough text for 
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this action, employ the Craft plugin. Finally, move the rest of the paragraph 
up until it also sits nicely on the grid below the image, and put everything 
in an “Image” group.

Fig. 8.5: Adapt the first image of the article so that it fills only six grid columns now and the text floats 
around it. 

The Quote

The modifications required for the quote are rather minimal, because the 
default Stretch value gives us an almost perfect result. We just need to 
handle two things: update the line spacing to “42” (14 × 3) and move the 
right quotation mark to the end of the text again, with a spacing of 21 pix-
els (the gutter width). Lastly, grab the whole group so that you can align it 
to the baseline, with a spacing of three units from the text above.
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The Remaining Elements

Modification of the remaining elements in the content area is just a matter 
of changing their position and alignment to the baseline grid. Use the 
mouse to drag them on the canvas for bigger distances, holding Shift (to 
constrain the movement to one axis); for smaller increments, press the 
arrow keys on the keyboard to get more precision, also holding Shift (to go 
in 10-pixel increments).

The paragraph after the quote needs to be moved up and aligned to the 
baseline grid again until it has a spacing of three rows. In case you used 
the Paragraph field for the spacing in between, you need to match it to the 
line height of “28” now. Continue with the subheading, moving it up until 
it is four rows from the preceding text, and the following paragraph, until 
it is two units away. 

We still need to update the height of the big image to the correct ratio of 
2.35:1 again. For this, select the image, including the adjustment layers, and 
enter “1024/2.35b” in the Height field, being sure to unlock its ratio first. 

The “b” suffix is especially important, because it resizes the image from the 
bottom and retains the correct distance from the caption. However, you’ll 
still need to move the group three rows away from the preceding para-
graph and align it back to the baseline grid, together with the caption.
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The Remaining Elements

Modification of the remaining elements in the content area is just a matter 
of changing their position and alignment to the baseline grid. Use the 
mouse to drag them on the canvas for bigger distances, holding Shift (to 
constrain the movement to one axis); for smaller increments, press the 
arrow keys on the keyboard to get more precision, also holding Shift (to go 
in 10-pixel increments).

The paragraph after the quote needs to be moved up and aligned to the 
baseline grid again until it has a spacing of three rows. In case you used 
the Paragraph field for the spacing in between, you need to match it to the 
line height of “28” now. Continue with the subheading, moving it up until 
it is four rows from the preceding text, and the following paragraph, until 
it is two units away. 

We still need to update the height of the big image to the correct ratio of 
2.35:1 again. For this, select the image, including the adjustment layers, and 
enter “1024/2.35b” in the Height field, being sure to unlock its ratio first. 

The “b” suffix is especially important, because it resizes the image from the 
bottom and retains the correct distance from the caption. However, you’ll 
still need to move the group three rows away from the preceding para-
graph and align it back to the baseline grid, together with the caption.

 

Fig. 8.6: The adjusted text layers between the two images. 

The remaining text layers should be positioned as follows: three units 
between the caption and paragraph, followed by the second subheading 
with a spacing of four units, which itself should have a gap of two rows 
from the last paragraph in the article.

The last element in the content area, the button, needs a distance of four 
rows from the last paragraph. One’s instinct would be to use the Scale 
function again to resize the symbol to the “golden ratio” of “1.125”; unfor-
tunately, this doesn’t work with symbols yet. Resizing it on the canvas also 
wouldn’t yield the expected outcome, because neither the font size nor the 
border width of the arrow would adapt proportionally. Therefore, we need 
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to detach the symbol with a right-click in order to use this option: Press 
Cmd + K and enter a Scale of “113%” (100% × 1.125, rounded). For the origin, 
select Scale From Top (the middle dot in the top row).

Do You Also Like?

We have made some good progress with the responsive version of the 
article so far, but there is still one element to address to finish it up: The 
“You might also like” area. Our previous modifications have lightened the 
workload, but there are still a few things to take care of. First, move this 
block up, so that it is four rows from the button; then, align the title to the 
baseline grid again, with a spacing of three rows before and after (Fig. 8.7).

Continue with the list of sights. Not only do we need to update the dimen-
sions of the sights and the spacing in between to reflect the new layout 
grid’s dimensions, but we also want two rows with three columns each to 
take advantage of the increased space of the artboard. Thanks to the use of 
symbols and the group-resizing capabilities of Sketch, the modifications 
required are rather minor.

However, Craft can’t handle the resizing of the sights that happened in 
between very well, so we need to start afresh. Delete all of the “Sights” 
symbols except the first, and change its width to “306” in the inspector, the 
size of four columns. Ensure that the ratio is locked to get a proportional 
height. The text layers may be a bit off the baseline grid now, but we’ll 
gladly accept that because the rest of the element adapts perfectly. Also, 
remove the redundant “Duplicate content” layer. 

Now, enter the Duplicate panel of Craft again and create the rest of the 
elements with the following properties: In the vertical direction, use a 
Count of “2” and a Gutter of about “46”; horizontally, we need “3” elements 



Going Responsive

283

now, but with a spacing of “21” to respect the new gutters of the layout grid. 
With a click on Duplicate Content, you’ll get the remaining sights back. 
In case the second row doesn’t sit on the baseline, adapt the vertical spac-
ing until you get perfect alignment, with three rows in between. It may 
also have happened that some of the titles became double-spaced; in this 
case, enter the master symbol, select the title, hold Alt and drag the right 
handle until the text layer is full-width. The only thing left is to move the 
“Sights” group to the left edge of the grid. You’ll see that all elements align 
perfectly to the grid columns now.

Fig. 8.7: The adapted “You might also like” area, with the new layout of three columns and two rows.

For a finishing touch, resize the dark background until there is gap of 
about three rows from the bottom of the second row of sights, and match 
the height of the artboard to this position. You might also want to change 
the categories of the symbols in the drop-down in the inspector to have 
some variation for the category lines. With this last action, we have com-
pleted the second responsive breakpoint of the article. For the third and 
final one, we will look at how the article would look on a display that is 
1920 pixels wide.
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The Final Breakpoint:  
Desktop Widescreen

Even with rise of handheld devices, desktop computers will probably 
not go away anytime soon. Having started small and determined the 
appearance on the typical tablet resolutions of 768 and 1024 pixels, 

let’s look at a typical desktop computer, 1920 pixels width. As before, the 
first task is to duplicate the current artboard and change its width to 1920 
pixels; the height should be about 5000 pixels for now. Choose something 
like “Article Large” for the name of the new artboard. Again, the base for all 
new modifications is the vertical baseline grid and the horizontal column 
grid, so let’s change them to the new requirements in the Layout Settings.

With the artboard at 1920 pixels, the column grid would be far too wide if 
we set it to 94% of the available size like before, so I’ve decided to cap the 
article’s content to a maximum width of “1280px.” This gives us a Total 
Width of “1202px” (“1280 × 0.94,” rounded to an even number). The rest is 
the same as for the other breakpoints: The layout grid should be centered, 
there should be no margins on the outside, and the Gutter Width should 
be one third of the column width. This leads to “26px” for the former, 
“76px” for the latter. In case you have been using the responsive grid so far, 
the adaptations are even easier: unlock the “Grid” group, change the width 
to “1280,” center it to the artboard, and lock it again. That’s it!
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Fig. 9.1: The required layout settings for the final breakpoint.

For a pleasant reading experience, we’ll enlarge the base font size again. 
We started with 16 pixels for a width of 768 pixels, 18 pixels for 1024, 
and we’ll end at 21 pixels for this breakpoint. By the way, this represents 
another value of the typographic scale. Based on the initial size of 16 pixels, 
this gives us a new ratio of 21 ÷ 16 = 1.3125. This is our new “golden value” 
now, by which all possible elements in the article should be increased 
relative to the initial breakpoint of 768 pixels. For the baseline grid and its 
Gutter Height, we derive a value of “16px” (the initial baseline grid of “12” 
multiplied by the ratio “1.3125” = 15.75, rounded up). For an easier calcula-
tion, we could also take the 1024-pixel breakpoint as a base for all of the 
elements, which would lead to a ratio of 21 ÷ 18 = 1.167.
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The Header

This new column grid forces us to make some changes to the elements of 
the article again. For a good base, center both groups — the “Header” and 
the “Container” — to the layout grid. Be sure to hold Alt when you use the 
alignment icons, so that they get centered to the artboard instead of to 
themselves.

The first step is to adapt the header: Grab the whole group and enter 
“1280c” for the width in the inspector. This will enlarge the element from 
the center and give us a good start, because all elements will take on the 
correct horizontal position: The back link and logo will move to the outer 
edges of the layout grid, the title will adapt to 10 grid columns, and the cat-
egory icon will remain centered. But we won’t stop here because both the 
category and the background image should take on the whole artboard’s 
width. So, grab them, the “Image” layer, as well as the “Category” group, 
and set the width to “1920c.”

The horizontal axis is OK now, but the height of the image doesn’t match 
the ratio of 16:9 anymore. This doesn’t matter so much because it would 
make the header far too high anyway, so let’s take a chance and use 2.35:1 
instead: Select the “Image” layer to enter “1920/2.35” as the height. With 
this, we are also forced to move the category down: Either drag it to the 
correct place or calculate the new Y position in the inspector with “100% − 
(96/2).” Let’s break this down: “100%” would move the element to the bottom 
of the header, and “96/2” would bring it up again by half the height of the 
category element.

Now for the remaining elements. First, move the logo up so that it is one 
grid row away from the top again. After that, bring the back link to the new 
base size; press Cmd + K and enter “117%” (100 × 1.167, rounded) in the Scale 
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field. Use Scale from left for the origin (the middle point in the left col-
umn). Enlarge the title with the same ratio, but go to the inspector instead 
and enter “54 * 1.167” for the size. For the line spacing, choose “80” (16 × 5). 
You could also make the title span the full width of the grid, to better uti-
lize the screen. In this case, change the Width from Auto to Fixed in the 
inspector, remove the line break, and enter “1202c” (the grid’s width) for the 
width. Finish the header by moving the text element down so that it has a 
spacing of three rows from the category again.

 
Fig. 9.2: The adjusted header for the 1920 breakpoint.

The Content

While parts of the header should span the entire width of the artboard, the 
content area is supposed to be capped to the layout grid’s width of “1202px” 
and centered horizontally. Let’s employ the trick from the former artboard 
and adapt the whole “Container” group at once to the new base font size: 
Press Cmd + K and enter “117%” (100% × 1.167) in the Scale field, with the 
origin set to Scale from top (the middle point in the top row). 

Now, move the whole group down until the page title is four rows away 
from the category icon and sits on the baseline grid.
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With all the excess space available at 1920 pixels, I chose to adapt a few 
parts of the article. First, the body copy itself. If we applied it to the full 
width of the layout grid, the line length would be too long, so I decided 
to move it one grid column in on each side, which gives us an appropri-
ate width again. The same goes for the main title of the article and the 
subheadings. The easiest way is to drag the whole “Content” group to the 
beginning of the second grid column while holding Shift (to keep the hor-
izontal position) and resize it to “996px,” the width of 10 columns. You can 
also drag the right handle of the group to match this number of columns.

The remaining changes for the text elements are the same as before: Set up 
new text styles for each type and align them to the baseline grid with the 
same spacing as for the other breakpoints. A quick reminder: The font size 
of the body copy needs to be 21 pixels now (our new base size) and have a 
line spacing of “32” (16 × 2). The same goes for the rest of the modifications 
to the artboard: I won’t go into detail but will only mention the most nota-
ble changes, because you should already be familiar with the procedure.

The only paragraph that should stick out from the body copy left and right 
and still span the full layout grid’s width is the intro: Either enter “1202c” 
for the width or hold Alt and resize it from the center with either handle at 
the side of the element. With the updated font size, the line length is a bit 
too wide, though; but for short text blocks like this, it doesn’t matter that 
much. Just be sure that it is four rows away from the title, like before. 

The following element with the drop cap should already look quite good; 
you might only need to match the contents of the two paragraphs and 
the spacing to the drop cap itself. For a distinct look, I also used the outer 
layout grid’s line to align both of the images. The first image should still 
already fill five grid columns but be moved to the left, including the adja-
cent paragraph. 
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This requires you to bring the latter back to the width of six grid columns, 
so that it ends at the same line with the other text. The second full-width 
image should look good already.

The remaining element, the quote, should fill eight grid columns, like 
before. After you have dragged the whole group to the left, so that the text 
starts at the beginning of the third grid column, resize the text layer to be 
eight columns wide. Update the line height to “48” (16 × 3) and realign the 
quotation marks so that they are one layout grid gutter (26 pixels) away 
from the text. For the spacing, use the same values as before: three units 
from both the preceding and following paragraphs.

 

Fig. 9.3: The new arrangement of the content elements.

The button at the end of the article got squished a bit with the content, so 
bring it back to the original width of 412 pixels, and center it to the art-
board. Also, make sure that it is spaced four rows from the last paragraph.
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All the Sights

The last element to take care of for the current breakpoint size is the list 
of related sights at the bottom. First, reposition the whole block so that it 
is four rows away from the button. Next, grab the dark background with a 
Cmd-click: Bring it to full width by entering “1920c” in the width field. The 
“c” suffix will resize it from the center. The size of the title is OK; you’ll only 
need to change the spacing so that it is three rows away from the top. The 
sights that follow should also have this distance.

Speaking of the sights, let’s make use of the available space to arrange 
them in a single full-width column, instead of two rows (Fig. 9.4). Like 
before, we need to start from the first element and delete all others, along-
side the “Duplicate control” layer. Bring it to a width of 281px, three grid 
columns, and use Craft to create the remaining five sights: For the vertical 
count, choose “1,” because we only need one row, but in the horizontal 
direction enter “6” with a spacing of “26” (the gutter of the layout grid). 
After that, center the “Sights” group to the artboard again, but add 13px to 
the X position, because Craft will append a gutter width at the end.

To finish this block, drag the bottom handle of the dark background up 
until there’s a spacing of about three grid rows, and assign a different cate-
gory to each “Sight” symbol for some variation. Also, resize the artboard so 
that it ends at the block, to give it a clean look.
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With this last action, we’ve finished the three different breakpoints of the 
article. It was quite some work, but now it will be much easier to estimate 
how everything will look for the development phase. There are still some 
decisions to be made in the code, but most of the groundwork is laid.

Fig. 9.4: The sights are arranged in a single row now. 

Adapt the App

Now that we have learned how the group-resizing feature of Sketch can 
help us make the article responsive, let’s apply this knowledge to the app 
we designed earlier. Remember that we set up a symbol for the title bar, 
which enables us to reuse this element on different screens. If you slightly 
change some of its parts, it can be adapted easily to different screen widths.

For this, go to the “Details” page and double-click on the “Title bar” symbol 
to jump to it on the “Symbols” page. Select the arrow group, and set its 
Resizing to Pin to corner. The same goes for the “User icon” group of the 
avatar icon on the right. In contrast, the title should be changed to Float in 
place so that it keeps its centered position.

To try out these new settings, go back with the Return to Instance link, 
select the artboard itself, and make it wider. Nothing will happen, but if 
you select the “Title bar” symbol again to adjust its width or set it to “100%” 
in the inspector, you’ll notice that all of the elements adapt accordingly to 
the new width. Just be sure that the ratio of the symbol isn’t locked. But go 
back to the original width for now.



292

Chapter 9

With a few extra settings, you can also make the remaining elements of 
this screen responsive, so that you can reuse it for the different widths 
of all iPhone models and Android devices (Fig. 9.5). To do so, first create a 
group from all elements in the artboard, which not only is the prerequisite 
for this feature to work, but also lets you resize everything at once. Name 
it “Container.”

The first element to adapt is the pin from the logo. Select its group and set 
the Resizing drop-down to Float in place, which will keep it centered. Do 
the same for the “Collapse icon” group within the “Content.” Now, select 
the title text layer, the body copy and the button symbol, so that you can 
change them to Resize object all at once. This setting makes sure that the 
spacing of the elements stays the same but that the width adapts according 
to the parent group.

For the navigation to work correctly, we need to set up a mask for each 
arrow. This ensures that these elements are capped at the outer limits of 
the artboard and don’t disrupt the correct resizing. Create a rectangle for 
the mask of the left arrow that fully covers it and that starts at the left edge 
of the artboard. Switch off the fill of the mask, move it below the arrow, 
select both, and click on the Mask icon in the toolbar. Change the resizing 
to Pin to corner for this new group, so that it stays at the left edge of the 
artboard. Proceed in the exactly the same manner for the right arrow.

The background image also needs a mask, but this one must have the 
full width and height of the artboard. Set it up in the same way as above. 
Unfortunately, there’s currently no other way than to let the image stretch. 
Every other setting produces a poor result. As an alternative, you could 
change to a pattern fill, but make sure to use it at a sufficient size to main-
tain a sharp image when it gets enlarged.
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Before we can try out the new settings, we 
also need to change the elements of the 
button so that they respond to its width. 
Enter the symbol with a double-click, set 
the text to Float in place and the arrow to 
Pin to corner. Back at the artboard, enlarge 
it to give room for the adaptation of the 
“Container” group. The moment you adjust 
its width, all other elements will change 
accordingly. Good work!

After so much resizing, adapting and 
adjusting, we will do something completely 
different in the next chapter. Let’s design 
some icons!

Fig. 9.5: The correct resizing proper-
ties for the details screen. They make 
sure that the   elements can adapt to 
multiple screen widths. 
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Designing Category Icons

Do you remember the icon from the header of the responsive article 
that represents the type of sight? And remember that a sight can fall 
into one of four categories, each with its own icon? Time to create 

these icons. The idea for all of them is to use basic shapes as often as possi-
ble, instead of custom vectors. While it might seem like a restriction at first, 
shapes are much easier to set up and modify, and you are still able to com-
bine them into complex forms with the Boolean operations. Furthermore, we 
will use keyboard shortcuts as often as possible for maximum efficiency.

Fig. 10.1: The category icons we are going to create.

First, add a new page to house all four icons. Name it “Icons.” Each of 
the icons should be “64 × 64” pixels and be on its own artboard. Add 
the first one and change both the X and Y position to “0” for a clearly 
defined starting point.

The Seaside Category

Let’s start with the first icon, the one for the “Seaside” category. Be sure to 
use this name for the artboard. Change the background color to the blue 
(#55BFE1) from the category icon of the responsive article, but switch off 
Include in Export. Good that we saved it to the Document Colors earlier.
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The first element for each icon is a white circle, the size of the artboard, 
which will also define its boundaries and act as a mask (Fig 10.2, left). Draw 
one after you have pressed O, and hold Shift to lock the ratio. The circle 
should start in the top-left corner. Name it “Mask.” Although the icons 
have an “8px” border in the article, let’s leave it out for the moment. We 
can add it later.

Because we want to the create a pixel-perfect icon, let’s set up a “2 × 2” grid 
now. To do so, click on View → Grid Settings… in the toolbar and enter 
a Grid block size of “2px” (Fig. 10.2, right). Thick lines aren’t necessary 
(insert “0” here). This grid not only allows us to place all of the elements of 
the icon on full pixels, but helps us to avoid blurry lines if we stick to icon 
sizes that are multiples or halves of 64 pixels. To employ this grid to the 
fullest degree, always make sure that shapes align exactly to the grid lines 
when you add or modify them. It’s good to assess the quality of the icon 
occasionally without the grid lines: You can press Cmd + G to turn them off.

 

Fig. 10.2: The base for every icon is a circle, which also acts as a mask. A 2-pixel grid makes sure that all 
elements are placed on full pixels.
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A BETTER VIEW

To get a better view for what we’ll be doing, zoom in to about 800%. While 
it’s much easier to work on the details of the icon in this zoomed state, 
there is also the danger of losing a view of the overall quality. Luckily, 
Sketch Mirror helps here, especially if you have a second computer screen 
on hand. You can work on the first display in this zoomed-in state in 
Sketch, while the second display shows the original size.

Click on Mirror in the toolbar and the URL at the bottom-right of the dia-
log to open the design in the browser. There, select the “Icons” page at the 
top, and pick the icon or search for its name with the search function in the 
top-right corner to open it in a single view. Whenever you change some-
thing in Sketch now, it will immediately be reflected here. You can even 
set the currently selected artboard to automatically show in Mirror: Just 
enable Show current Artboard in the General tab of the Preferences.

The Tree

To gain some inspiration, I gave the icon search on The Noun Project77 a 
shot and browsed for some terms that I associate with the “seaside” theme. 
I landed on a boat floating on some waves and a tree representing the 
nature around the lake. This is the element we will begin with: It consists 
of three basic triangles for the branches and a rectangle for the trunk (Fig. 
10.3). While Sketch offers a distinct triangle shape for the former, I much 
prefer to use a rectangle instead, because I’m more free to pick the align-
ment. Furthermore, it’s accessible with a keyboard shortcut.

For the treetop, press R and add a first rectangle with a size of “12 × 6,” 
aligned to the grid. Make sure that this applies to all shapes that you add 

77	 https://thenounproject.com

https://thenounproject.com
https://thenounproject.com
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from now on. Go into the vector point mode, hold Cmd and click on the 
upper line to add a point in the exact middle. After that, select the points 
to the left and right with a Shift-click. You can also drag a selection to each 
point, instead of Shift-clicking, if it’s hard to catch. 

Now, delete these points, which will give us the desired triangle, and exit 
vector point mode. After that, duplicate the shape, either with Cmd + D or 
by holding Alt and dragging it down. In case you prefer the first method, 
make sure that Offset duplicated layers is switched off in the Layers 
tab of the Preferences, so that the duplicate stays at the same position as 
the original. After that, move the triangle down by 4 pixels. Either use the 
down arrow key or add “+4” to the Y field in the inspector. If the latter, press 
Esc to leave the input field.

This second triangle should be wider by 4 pixels and higher by 2 pixels. The 
fastest way to resize it is to hold Cmd and press the right arrow key until 
you’ve added 4 pixels. Keep holding Cmd and use the down arrow key in 
the same manner to make it 2 pixels higher. All of that can be done in the 
inspector, too.

Also create a duplicate of this second triangle, and modify it in the same 
manner: “4px” wider, “2px” higher, moved down by “4px.” Repeat the exact 
same steps for the fourth triangle. The last part of the tree, the trunk at the 
bottom, is a simple square, 4 × 4. After you have added all of the required 
shapes for the tree, select them and center them relative to each other with 
a right-click and then Align Center.

With all the parts still selected, make a Boolean operation of the type 
Union by pressing Alt + Cmd + U. This will add all of the shapes to a single 
layer and let you change the color at once to the same as the artboard’s 
background. Lastly, rename it to “Tree,” and move it to an X position of “4” 
and a Y position of “10” to leave room for the other parts.
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Fig. 10.3: The first element of the seaside icon: a tree.

THE BOAT

All right, let’s float over to the boat. It might not be obvious at first, but it 
also consists of three modified rectangles (Fig. 10.4). First, create a rect-
angle with the dimensions of “14 × 20” in the free space on the right side 
of the icon, for the larger sail. Enter vector point mode like before, which 
will select the top-left point, the starting point of the shape. However, the 
literal point of interest at the moment is the one in the top-right. Press Tab 
to jump to it, followed by Delete to remove it. Leave the vector point mode. 
Piece of cake.

Believe it or not, the second smaller sail is even easier. Duplicate the big 
sail, right-click and select Transform → Flip Horizontal. Jump to the 
inspector with Alt + Tab, move to the Width field with subsequent Tab 
presses, enter “8,” continue to the Height, and enter “12.” Press Esc to exit 
the field. Now, hit the left arrow key until the smart guides show that there 
is a gap of 2 pixels from the other sail. Also, move the smaller sail down 
with the down arrow key until both sails are on the same baseline. In the 
end, select both shapes to create another Union Boolean operation.
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For the boat hull, add yet another rectangle of 38 × 12 pixels below the sails 
and a spacing of 2 pixels. After entering vector point mode, hold Cmd and 
click on the lower line to add a point in the middle. Press Tab to jump to 
the lower-left point, hit Delete to delete it, press Tab again, but this time in 
combination with Shift to go in the reverse direction until you reach the 
bottom-right point. Also delete it.

A triangular boat looks quite dull, so let’s fix that with a double-click on 
the lower point, which will change the type from a Straight to a Mirrored 
point. This action gives us not only a round shape but also two vector 
control points that define the curve. Drag either of them out to increase the 
roundness of it. Looks good.

Leave vector point mode and select the boat hull together with the group 
of sails. Center them horizontally, but then move the sails one pixel to 
the right so that they are aligned to the grid again. Finally, select them all 
together and add them to the same group with another Union operation. 
Change the color to match the other parts of the icon. Rename this group 
to “Boat,” and change the position to “22” (X) and “18” (Y). Now let’s hide it 
with Shift + Cmd + H, so that we have an unobstructed view for the last part 
of the icon.

 

Fig. 10.4: The boat marks the second element of the icon. I’ve temporarily reduced the opacity of the tree to 
highlight the boat shape.
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THE WAVES

A boat can’t float in the air; we need some water to carry it. The waves 
increase the difficulty level slightly, but with a few cleverly placed shapes, 
they’re easy to do. The waves are formed by a row of ovals with a border, 
which forms the actual wave line.

The starting point is a single oval. Draw one with dimensions of “16 × 12.” 
Add it at the left edge of the icon, below the tree, so that you have room for 
the subsequent copies. Hold Alt and drag a copy to the right until both of 
the elements touch and are on the same line. Now, press Cmd + D to add 
elements with the same spacing until you have a total of four ovals. Still 
doesn’t look like waves. A step in the right direction is to select all of these 
shapes so that you are able to form a Union Boolean operation. Make sure 
that this group is centered to the artboard horizontally.

One element is still missing, a rectangle of “64 × 28” pixels, where we can 
carve the ovals out to form the final waves. Move it vertically until its 
upper side is centered to the ovals; also, center it horizontally to the art-
board (Fig. 10.5, 1). Now, drag the rectangle into the Boolean group in the 
layers list, but ensure that it is in the bottommost position. Finally, select 
all of the ovals again and change their Boolean type with a click on Sub-
tract, the small icon next to the layers in the layers list (Fig. 10.5, 2). Now 
we’re getting serious.
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Fig. 10.5: The waves are formed by four ovals that are subtracted from a rectangle (1). Change the Bool-
ean type with the little icons in the layers list (2).

Complete the waves by adding an Inside border with a Thickness of “2px” 
to the combined shape, and assign it the same color as everything else. 
Just like with the fill color, you can use the color picker with Ctrl + C to do 
this, but you’ll need to remove the fill with F first (we won’t need it any-
way). Finally, name this Boolean group “Waves top,” and move it to a Y 
position of “42.”

To create some movement, add a second line of waves, offset to the right by 
“8px,” half the width of an oval. The final Y position for this second line of 
waves is “52,” and the name should be “Waves bottom” (Fig. 10.6). 

If you select the “Boat” group in the layers list now and unhide it, it will 
float nicely on the upper water line.
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Fig. 10.6: The finished waves: two wave lines, offset by 8 pixels, create some movement. 

To finish it up, combine everything into an “Icon” group so that it’s easier 
to grab the whole package at once. Also, change the white circle in the back 
to a mask with Ctrl + Cmd + M, so that everything outside of this shape is 
clipped; it needs to be in the bottommost position for this to work. For the 
finished icon, have a look at Fig. 10.1.

Pixel Preview

Before moving on to the next icon, let’s have a look at how the current one 
might look in the browser. Because Sketch is based on vectors instead of 
bitmaps, you can get fooled pretty quickly by everything looking sharp and 
clean no matter how much you zoom in. The reality, once the assets land in 
the browser, is different.

While this isn’t much of a problem for SVGs, because they are also vec-
tor-based, PNGs and JPGs often don’t look nearly as good as they do in 
Sketch. To remedy this, at least to a certain degree, have a look at the pixel 
preview regularly, with Ctrl + P. It’s not 100% accurate, especially with text, 
but it gives you a good idea of how your assets will look when exported.

Because we’ve adhered to a strict grid for the icon, we can expect nothing 
less than a perfect result once the pixel preview is switched on. However, 
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always give this mode a look occasionally. For the most accurate result, use 
it at a zoom level of 100% and switch off the grid.

The Mountainside Category

More and more, you are becoming an icon master. Let’s ride this wave of 
success and take on the second icon. This one’s for the “mountainside” 
category, so mountains will play a big role here. We don’t need to redo all 
the groundwork again; we can take the “seaside” icon as a base. Duplicate 
it, rename it to “Mountainside,” and remove all elements except the circle. 
Change the background color of the artboard to the orange that you saved 
to the Document Colors earlier (#F5A623).

Now for the content. The first and easiest element is the sun in the top-
left, a colored circle, “12 × 12,” placed at a position of “40” (X) and “10” (Y). Be 
sure that it is within the “Icon” group (like all of the other elements we will 
create) and rename it to “Sun.”

With this easy win under our belt, let’s tackle the first mountain, which is 
based on a rectangle again. Create it in the same manner as the branches of 
the tree before: Add a rectangle, sized “40 × 30,” activate vector point mode, 
and create a new point in the middle of the upper side with a click. Alt 
ensures that it is added in the exact center. Press Shift + Tab to jump to the 
previous point, delete it, press Tab again to select the top-right point, and 
remove it, too. Name this shape “Base.”
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LET IT SNOW

Summer hasn’t reached the top of the mountain yet, so there’s still some 
snow remaining at its peak. We will add it with the help of another much 
smaller triangle that is separate from the bigger shape. Duplicate the 
triangle and resize it on the canvas. Hold Shift (to maintain the aspect 
ratio) and drag the bottom-middle handle up until it has a size of “8 × 6.” 
Name it “Snow.” 

With both shapes selected, perform a Subtract Boolean operation with 
Alt + Cmd + S, which will cut the smaller shape out from the bigger. Enter 
this new group with a double-click on the canvas and select the small tri-
angle; move it down by “4” pixels (Fig. 10.7). It has snowed! Leave the group 
again, bring it to a position of “–6/30” in the inspector, assign it the same 
color as the background of the artboard, and name it “Mountain left.”

 

Fig. 10.7: The initial elements of the mountainside icon: a sun and the first mountain. Please note that 
the mountain isn’t on its final position yet, to show the full shape.
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BIG AND SMALL

The second mountain on the right is just a copy, but in a different position. 
Duplicate the Boolean group, rename it to “Mountain right,” and set its 
position to “30” (X) and “34” (Y). For the third bigger mountain in the mid-
dle, we need another copy. Move it to the middle of the artboard so that we 
can better see what we are doing. Now, double-click on the Boolean group 
on the canvas, which will select the big triangle. Like before, the easiest 
way to retain the position and just make the shape higher is to use the mid-
dle handle at the bottom. Hold Shift to retain the ratio, and drag the handle 
down until the shape is 48 pixels high. Leave the Boolean group, center it 
horizontally, and rename it to “Mountain center.”

Everything looks fine — well, except for the fact that it’s quite hard to 
distinguish between the mountains. A separation line for each would help. 
Actually, we’ll be taking the outer shape of one mountain and inserting 
it in the Boolean group of another to subtract it. First, make sure that the 
rightmost mountain is on top in the hierarchy of the layers list (bring it up 
with Ctrl + Alt + Cmd + Up), followed by the middle mountain and the small 
one. The white circle should still be at the bottom.

To create the separation line, select the big shape of the middle moun-
tain with a double-click on the canvas, copy it, enter the group of the left 
mountain with another double-click, and paste this shape here. This will 
insert the shapes at the same position as before but automatically applies a 
Subtract Boolean operation. Now, move this triangle up by “4” pixels until 
there is clear separation between the mountains (fig. 10.8); this should be at 
a Y position of “16.” Rename it to “Separation.”
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Fig. 10.8: The three mountains are completed. To differentiate them, a copy of the big mountain’s shape 
(red line) is inserted and subtracted from the left mountain (and subsequently also from the rightmost 
mountain, not depicted. See Fig. 10.1 for the finished icon).

Do the same for the big mountain. Enter the Boolean group of the right-
most mountain with a double-click, copy the “Base,” switch to the group of 
the middle mountain, insert the separation shape with Cmd + V, and move 
it up by “4” pixels (to a Y position of “30”). Also, rename it to “Separation.” 
Goal achieved!

The Cityscape Icon

That was fun! The third icon, for the “cityscape” category, is quite different 
from the other two because it consists solely of unmodified rectangles, but 
plenty of them. They form three skyscrapers with a bunch of windows. 
As before, duplicate one of the other two icons to get a solid base, remove 
all redundant shapes (everything except the white circle in the back), and 
rename the artboard to “Cityscape.” After that, change the background to 
the third bright color we used for the category lines of the responsive arti-
cle: the purple (#E01081).
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THE FOUNDATION

To start, create a rectangle with a size of “14 × 38,” which will form the 
leftmost skyscraper. Assign it an inside border of the icon’s color, with a 
Thickness of “2,” but switch off its fill with F first. Move it to a position of 
“10” (X) and “30” (Y), and name it “Base.” This building will be inhabited by 
a huge number of people: Each of them needs a window for some fresh air 
and light. Create the first window in the top-left with a rectangle sized “2 × 
2.” Move it away “2” pixels from the border, both horizontally and vertically, 
name it “Window,” assign the icon color, and drag it into the “Icon” group 
together with the base shape of the building.

The easiest way to get the remaining windows is to the Make Grid func-
tion that you got to know earlier: Select it from Arrange in the menu bar. 
We need “8” rows with a Margin of “2px” and “2” columns with the same 
spacing. A click on Make Grid automagically adds the missing versions 
(Fig. 10.9). Select all of them in the layers list and create a “Windows” group, 
in which you should add to a “Skyscraper left” group in turn, together with 
the building’s shape.

 

Fig. 10.9: Create the first window, and add the remaining with the Make Grid function. Please note 
that they are depicted in the screenshot, but with reduced opacity.
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IN DEMAND

The city is big; it needs more room for people to live. To do this, duplicate 
this first skyscraper and rename it to “Skyscraper right.” Press Alt + Tab to 
jump into the X field of the inspector, enter “42,” use Tab again to cycle to 
the following Y field, fill it with a value of “38,” and end with a press on 
Enter and Esc.

We’re still not finished; people keep moving into the city, so we need to 
construct another building. Luckily, we already have the blueprints, which 
will make its creation a snap. Add another rectangle, and drag it to a size 
of “22 × 44” (or set these dimensions in the inspector). The name should be 
“Base,” like before. Instead of a border, we need a fill with the same color as 
the remaining elements. Use the color picker, with Ctrl + C, to take it over 
from the other shapes.

To let some sunlight into the building, we will create some windows in the 
same manner as above: Add a first white rectangle with a size of “2 × 2,” 
“4” pixels away from the top-left corner of the building; name it “Window.” 
Select both of these shapes, and set up a Subtract Boolean operation with 
Alt + Cmd + S to remove the window from the skyscraper and make the 
background visible.

Just like before, use the Make Grid function to create the remaining win-
dows. This time we need “10” rows and “4” columns, with a Margin of “2px” 
each. Because this duplication is supposed to happen in the Boolean group, 
these new versions will get removed from the base shape of the building 
(Fig. 10.10). Press Esc to leave the Boolean group, hit Cmd + R to rename it 
to “Skyscraper middle,” and move the skyscraper between the other two 
buildings, at a position of “22” (X) and “20” (Y).
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Fig. 10.10: In contrast with the other buildings, the skyscraper in the middle consists of a shape with a 
fill, where the windows are carved out with a Subtract Boolean operation.

FINISH IT UP

The last two elements we need are a rectangle with a size of “10 × 10” for 
the upper part of the building (Y: “10”) and another one sized “2 × 8” (Y: 
“2”) to form the stylized antenna. They should sit on top of each other and 
be centered to the building. Select them together with the skyscraper and 
perform a Union operation, which will add the new shapes to the existing 
Boolean group. We’ve just made so many people happy by giving them a 
new home. Good job!

The Countryside Icon

If you look at all of the icons we have designed so far, you may notice a 
common theme: In each icon there is at least one element that has a border 
of “2px,” while other parts are filled shapes. This makes for a kind of famil-
iarity and brings the icons together as a family. This is especially important 
if you design icons that are part of a set or need to be used in the same 
place. Furthermore, this mix of styles creates some variety: On one side, 
there are the “heavy” shapes with a fill; on the other side, you have these 
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“light” elements to balance them off. For more tips on icon design, have a 
look at this brilliant article by Scott Lewis on Smashing Magazine.78

Of course, we will continue in the same fashion for the last icon: the one 
for “countryside,” which represents destinations in rural nature, out-
side the hustle of the city. For this reason, it contains some gentle hills, 
a cosy cabin and some trees that represent the green of nature. How-
ever, life’s not all sunshine, so we have a cloud instead of the sun from 
the “mountainside” icon.

Like before, duplicate one of the other icons, delete everything except the 
encompassing circle in the back, rename the artboard to “Countryside,” and 
change the color of the background to last remaining color that we’ve saved 
to the Document Colors in the course of the responsive article. Which hue 
other than green (#79C03D) could better fit this feeling we’re after?

A GOOD START

Let’s start with the hills for a solid base. The first one is an oval of “60 × 
36,” placed at “16” (X) and “51” (Y). Press O to create this oval, but instead of 
drawing it exactly with these properties, choose a random size at first. And 
then jump immediately into the inspector with Alt + Tab to enter these X 
and Y positions as well as the width and height.

Changing these properties afterwards is always easier than fiddling 
around on the canvas to catch the right measurements. Once I have placed 
shapes on the canvas, I also prefer to move and modify them with the key-
board instead of the mouse, because this is much more precise and easier 
to handle. Remember that you can use the arrow keys to move a shape and 
also hold Cmd to resize it. For bigger distances, add Shift to the mix.

78	 http://smashed.by/sketch-icondesign

http://smashed.by/sketch-icondesign
http://smashed.by/sketch
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Continue by giving the hill a white fill; for the border, choose the back-
ground color of the artboard. The thickness should be “2px”; for the posi-
tion, select “Center.” This is also the reason why I chose an odd Y position 
earlier, because the border itself would be at an odd position otherwise (Fig 
10.11, red lines). 

To create some perspective, add another hill in the back. The first one can 
act as a model, so duplicate it and move it one step back in the layer hierar-
chy with Alt + Cmd + down arrow. The only thing we need to change with it 
is the position: move it to “–24” (X) and “43” (Y). The white background will 
ensure that they cover each other (Fig. 10.11). 

Name this one “Hill back” with Cmd + R. Press Shift + Tab to jump to the 
other hill, but remain in renaming mode, and enter “Hill front” for this 
layer. Finally, make sure that both of these shapes reside in the “Icon” 
group so that they are masked by the circle.

 

Fig. 10.11: Some gentle hills. The white fill color ensures that they cover each other. They both have an 
odd Y position, but due to the centered border, the shapes are aligned to the grid lines again (red lines).
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LUXURIANT VEGETATION

Time to plant some trees in this newly created soil. Icons in a set should 
not only be coherent with each other, but also coherent individually. In the 
“seaside” icon, the pointy tree and the boat have a similar style; the “moun-
tainside” icon has three equal mountains; and in the “cityscape” icon, we 
have these rectangular buildings with similar windows. The theme for the 
current icon is ovals, which are also the base for the trees.

I continue to emphasize that the easiest way to create icons or parts 
thereof is to use basic shapes and then combine them into entirely new 
forms. Of course, you could also draw a vector by hand with V for the plant, 
but two ovals do a better job because they are easier to create and their 
curves look way smoother. Draw a first oval with a size of “6 × 8” in the 
free space above the hills. Duplicate it and use Alt + Down and Alt + Right to 
resize it to “10 × 12.” Now, move it down by 4 pixels and select it together 
with the upper smaller oval, and center them horizontally by right-clicking 
and selecting Align Center.

The last element of the tree is the trunk, a rectangle that’s “2 × 8.” Place it 
at the bottom of the bigger oval so that they overlap by 2 pixels vertically. 
Also, center it horizontally relative to the other two shapes. After that, 
select all of them and perform a Union operation. This allows you to match 
the color of all of the layers to the artboard’s background at once. The name 
of this Boolean group should be “Tree.” Lastly, plant it into the leftmost 
hill at a position of “6” (X) and “22” (Y). In nature, it takes years for a tree 
to grow to a mature size; in Sketch, it’s a matter of seconds to get a second 
tree: press Cmd + D and change the position to “20” (X) and “26” (Y).
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A CABIN IN THE WOODS

The left hill is taken care of now, so let’s turn our attention to the right part. 
It should also be populated, but with a different kind of element: a small 
cosy cabin. Some basic shapes are enough to suggest this type of building: 
first, a rectangle with a size of “14 × 12,” duplicated and placed above to 
form the roof. Use a value of “18c” in the width field to change its size, from 
the center. For the height, enter “6b,” resized from the bottom to keep its 
position at the top of the cabin. Like before, modify it in the vector point 
mode to create a triangle. Enter vector point mode, insert a new point at 
the top side while holding Cmd, press Alt + Tab to jump to the point before, 
delete it, press Tab to jump to the point after, and delete it also. Lastly, com-
bine these two shapes with Union.

People should be able to enter the building; so, we’ll need a door. Draw a 
new rectangle at the bottom of the cabin, with a size of “4 × 8,” but change 
its fill to a lighter color (not white), so that you are able to place it properly. 
Select it together with the Boolean group and center them horizontally. 
Don’t worry that neither the rooftop nor the door align exactly to the grid; 
it’s OK to make exceptions from time to time.

Now, drag the door into the Boolean group in the layers list. You may need 
to change the order for the door to be above the other shapes so that you 
can change the Boolean type from Union to Subtract using the small icon 
next to the layer’s name. Remember that big shapes should always be at 
the bottom. The further up a shape is in the layer hierarchy, the smaller it 
should be.

We’ve already enabled people to enter the cabin with a door, but they 
should also be able to spark a fire to create a cosy atmosphere. A chimney 
will help to draw the smoke away. Create it with a size of “2 × 4” pixels and 
align it to the top of the rest of the building. Use the arrow keys to position 
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it 4 pixels from the left edge of the roof. Remember that you can press Alt 
and point there to show the distance.

Fig. 10.12: The cabin consists of three rectangles and a triangle, combined in a Boolean group. Please 
note that I have reduced the opacity of the tree to highlight the house.

To finish the cabin, move the chimney to the Boolean group, at the topmost 
position, name it “Cabin,” position the group at “36” (X) and “34” (Y) in the 
inspector so that it sits nicely on the hill, and change the color to match the 
rest of the icon.

CLOUDY SKY

There’s quite a bit of room above the existing elements now. I did it on 
purpose to leave some space for one last element. There’s already a sun 
in the mountainside icon, so I decided to have a try at a cloud instead. 
Add a circle with a diameter of “8px” first. Remember to hold Shift to lock 
the ratio and create a uniform shape instead of an ellipse. Duplicate this 
circle and offset it to the right by “14px” with the right arrow key and the 
one-time help of Shift.
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Now, add a rectangle that not only connects these two ovals but also forms 
the bottom of the cloud. It should be “12 × 4” and should start at the center 
of the left circle. The smart guides show you exactly this position when 
you add the rectangle. Combine all of the elements so far with a Union 
Boolean operation (press Alt + Cmd + U).

Now for the upper part of the cloud, which is formed by another oval sized 
“12 × 10.” Center it to the Boolean group horizontally, but let it stick out 
“4px” upwards. Finally, move it into this group in the layers list, change the 
group’s position to “32” (X) and “10” (Y), change the name to “Cloud,” and 
change the color to that of the other elements in the icon. Be sure that all 
elements are in the “Icon” group, so that they are masked properly. Con-
gratulations, you’ve just finished the last category icon.

 Fig. 10.13: The shapes that form the cloud are all combined with a Union operation.

With all of this design work behind us, we can a look at how to export the 
icons in the next chapter.
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Exporting Category Icons

Now that we have finished all of the icons for the different catego-
ries of sights, we can shift our focus to something else: preparing 
them to be used in production. In an ideal world, you should 

always aim for SVG format, because it’s resolution independent and only 
one size is needed. However, I still want to say a few words about PNG.

Border or No Border?

One thing we need to decide on before the icons can be exported is 
whether they should have a border. On the “Article” page, we’ve used a bor-
der so far, but there are occasions when no border would be appropriate; 
for example, when putting an icon on a dark background or when setting 
the border directly in the CSS. In this case, we can leave everything as is.

However, to include the border in the exported icons (because they are 
used in the article), we have to prepare a few things (Fig. 11.1). First, remove 
the background color of the artboard, because it was just for presentational 
purposes and doesn’t need to be in the final export: Select with a click the 
title on the canvas, and deselect Background Color in the inspector. Now, 
enlarge it by “8px” on each side. To do so, hold Shift to keep the ratio, as well 
as Alt to resize from the center, and drag one of the corner handles until a 
size of “80 × 80” is shown in the tooltip.

Now, set the actual border of the icon: Select the white circle in the back-
ground with a Cmd-click, and add an Outside border with a thickness of 
“8px.” For the color, pick the same as the other elements in the icon. To get 
a transparent background, you can also remove the white fill of the circle.
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Fig. 11.1: The cityscape icon with the added border, so that it’s ready for the article.

Optimizations

Everything is set now, but one icon has a minor flaw. You may remember 
that we used a white background for the hills in the “countryside” icon, so 
that one covers the other. Unfortunately, this fill would also be exported 
and prevents a fully transparent result. To remedy this, we need to make a 
few modifications. First, select the artboard and press Cmd + 2 to zoom all 
the way in. This gives us a better view of the work to be done.

Now, select the hill in the front, so that you can remove its fill with F. This 
reveals the overlapping lines that we want to hide. After that, jump to the 
other hill with Tab, and go into the vector point mode with Enter to add two 
points: one a little to the left where the shape touches the edge of the white 
circle, and one at the intersection of the two ovals of the hills (Fig. 11.2).
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Now you can use the Scissors tool from Layer → Paths in the menu bar: 
Cut away the superfluous parts on the left and right of these new points 
with a click, so that only the relevant part of the hill remains. This almost 
gives us the desired result. In case the line doesn’t fully touch the adjacent 
parts, change the border options with a click on the little gear icon in the 
Borders area of the inspector. There, set the Ends to the third icon, which 
ensures that the ends of the line are extended by half of the border width. 
Finally, remove the fill of this segment.

Fig. 11.2: Add two points to the hill in the back, and cut the rest (marked with red) with the Scissors tool. 

Export as PNG

Time to set the sizes for exporting. Suppose we want to use the icons not 
only at their original size, but also at half size in a different place on the 
website. Furthermore, they should be sharp on high-resolution displays, 
which requires us to export at double size.



Exporting Category Icons

319

First, select all artboards at the same with Shift + Cmd + A, so that you don’t 
need to make the following settings individually. Now, click on Make 
Exportable at the bottom of the inspector. The original sizes for the export 
of the icons are already handled this way. This also gives you a preview of 
the assets right above. In case you removed the white fill from the circles, 
transparent areas will be shown with a checkerboard pattern here.

For the halved size, click on the + icon. Select “0.5x” as the Size; for the 
Suffix, choose something appropriate, like “-sm.” It will automatically be 
added to the file name; in the case of the “seaside” icon, this would make 
“seaside-sm.png.” Perform another click on + to define the last required 
size: the one for high-resolution variants. Without any modifications, this 
should give you a “2x” size and a “@2x” suffix (Fig 11.4).

A final click on Export Artboards lets you choose the directory to export 
the icons to. Alternatively, you would press Shift + Cmd + E to get a handy 
overview of all assets due to be exported (along with any elements you may 
have set up this way earlier).

Export as SVG

Whenever you create an image with the intent to export it as an SVG later, 
use borders instead of shapes as often as possible. Borders are easier to 
draw in an SVG and, thus, drive the file size down. That’s exactly what we 
did for the outer two skyscrapers in the “cityscape” icon and for the hills 
in “countryside.” However, there is still some potential for optimization 
with the waves in the “seaside” icon. They consist of shapes with a Boolean 
operation at the moment, which we could use as a reference point to make 
a vector instead.

http://seaside-sm.png
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After you have clicked on the artboard of the icon in the layers list, press 
Cmd + 3 to center the canvas to it; you may also want to zoom in with 
Cmd + 2. Now, select the “Boat” group with a Cmd-click and hide it to get an 
unobstructed view of the waves.

The first task is to draw the new vector. Press V for the respective tool, and 
make a first click at the left edge of the artboard, at about the height of the 
peaks of the waves. Hold Shift to get a straight line, and make another click 
at the right edge of the artboard. Before you continue, change the border 
thickness to “2” so that you can better match the new wave line to the 
old. Now, add a point for every tip of the wave with a click at the relevant 
position. Don’t let the line that extends from the end of the line to your 
cursor position distract you; it just allows you to continue the vector at a 
later time.

To form the actual waves, add points in between the peaks, but hold Cmd 
while you click in order to snap to the exact center. Select all four of these 
middle points with a Shift-click, and move them down with the down arrow 
key until they are at about the same height as the lower parts of the old 
waves. Unfortunately, these new waves are a tad too angular, so we need 
to change their points from Straight to Mirrored with 2. Looks way 
better, but we want more. Jump to the first of these lower points with Tab, 
and drag its vector point handles out to enlarge the curves, so that they 
have about the same form as the old wave line. Repeat that for the other 
three points.
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After you have clicked on the artboard of the icon in the layers list, press 
Cmd + 3 to center the canvas to it; you may also want to zoom in with 
Cmd + 2. Now, select the “Boat” group with a Cmd-click and hide it to get an 
unobstructed view of the waves.

The first task is to draw the new vector. Press V for the respective tool, and 
make a first click at the left edge of the artboard, at about the height of the 
peaks of the waves. Hold Shift to get a straight line, and make another click 
at the right edge of the artboard. Before you continue, change the border 
thickness to “2” so that you can better match the new wave line to the 
old. Now, add a point for every tip of the wave with a click at the relevant 
position. Don’t let the line that extends from the end of the line to your 
cursor position distract you; it just allows you to continue the vector at a 
later time.

To form the actual waves, add points in between the peaks, but hold Cmd 
while you click in order to snap to the exact center. Select all four of these 
middle points with a Shift-click, and move them down with the down arrow 
key until they are at about the same height as the lower parts of the old 
waves. Unfortunately, these new waves are a tad too angular, so we need 
to change their points from Straight to Mirrored with 2. Looks way 
better, but we want more. Jump to the first of these lower points with Tab, 
and drag its vector point handles out to enlarge the curves, so that they 
have about the same form as the old wave line. Repeat that for the other 
three points.

Fig. 11.3: Create a vector with several points, and match it to the old wave line gradually. The marked 
icon in the inspector allows you to drag a selection while in vector point mode.

You may also need to move the peak points a little bit down to get the same 
shape as the old waves. Unfortunately, you can’t drag a selection to catch all 
of them in their current state, because this would extend the line instead. 
To do this, you need to click on the icon next to the Round drop-down in 
the inspector (Fig. 11.3, red border). This allows you to drag a selection now.

After you have matched the wave line, make sure that all points of the wave 
are aligned to full pixels: Leave vector point mode and select Round to Pixel 
from Layer in the menu bar. Furthermore, the layer needs to be at an odd Y 
position due to the Center position of the border. About “0” (X) and “45” (Y) 
should do the job. Finally, change the border to the main color of the icon.

The first wave line is finished. For the second line, you just need to make 
a duplicate and move it down by 12 pixels. Also, offset it to the left by 10 
pixels. Now you can match the names to the old shapes — “Waves top” and 
“Waves bottom” — and delete the old layer groups. The position should also 
be the same: in the “Icon” group, below the “Boat” group, which you can 
show again now.
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This optimization alone has brought the file size down by about 35%: a per-
fect opportunity to finally export the SVGs. As before, select all artboards 
with Shift + Cmd + A, but unlike for the PNGs, we only need one size now, so 
remove the other ones with the x buttons on the right, and set up an SVG 
format instead. That’s all we need to do here — no sizes needed, no suffixes 
(Fig. 11.4).

With this last step, we have completed the main projects of this book. 
You’ve learned about most of the functions of Sketch and how to apply 
them. This knowledge should enable you to build anything you can imag-
ine. In the next chapter, I will talk about some special use cases and how to 
employ the remaining features of Sketch, and we’ll revisit some important 
concepts via some unrelated mini projects.

Fig. 11.4: The final icons with borders and a transparent background, set for exporting. Please note that 
both PNG and SVG versions will be created.
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Mini Projects
ver the course of using Sketch in recent years, I’ve discovered 
several different things that either are not immediately obvious 
or make use of a certain feature of Sketch in a special way. I’d like 

to present a good deal of these techniques here. We will also take a deeper 
look at some topics we have already touched on, but in a less formal way. 
Consider these as design snacks, fun projects that let you play around in 
Sketch. You can find the Sketch files for all of the projects at  
http://smashed.by/sketch-files2.

Creating a Clock

This might not sound exciting at first, 
but we’ll discover how easy it is to 
recreate real-world objects in an amaz-
ingly accurate way. You’ll learn how to 
apply different layers of borders and 
shadows, we’ll take a deeper look at 
gradients and how to rotate and dupli-
cate elements in a special way.

The first step is to create a totally 
separate document, named “mini-proj-
ects.” Each project will happen on a different page, the initial one being 
reserved for the clock; rename it to “Clock” with a double-click. Now, 
create a new artboard with the same name, 600 pixels in both dimen-
sions and positioned “0” (X) and “0” (Y). For the background color, choose 
a toned-down blue; I picked the one from the Global Colors in the color 
dialog (#4A90E2). Center the artboard to the canvas with Cmd + 3, and let’s 
get started.

Fig. 12.1: The clock we are going to create.

O

http://smashed.by/sketch-files2
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SHADOWS AND BORDERS

The base of the clock is a simple white circle with a diameter of “480px.” 
Align it to the center of the artboard, and name it “Face.” For the bezel, add 
a first Inside border with a Thickness of “16.” With just a single solid 
color, it would look quite dull; to give it a metallic appearance, we will add 
an angular gradient instead. After you have picked this fill type for the bor-
der in the color dialog (last icon), click on the first color stop on the left of 
this dialog. Move it a bit to the right with the arrow key (press it about four 
times), and enter “#484848” for the color.Jump to the other color stop with 
Tab, and use the arrow key again to slightly move its position, but this time 
to the left (about six times). Change the color to “#BFBEAC”; I’ve mixed in a 
small amount of yellow to give it a more natural look, which also applies to 
some of the other light colors in the gradient. Now go back to the first stop 
and assign the color “#484848”.

Fig. 12.2: Assign an angular gradient to the border with several color stops. The red point marks the 
start color stop.
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Add six more color stops with a double-click each, their colors being (from 
left to right): “#BDBDBD”, “#A1A091”, “#C9C9C9”, “#575757”, “#C9C8B5”, 
“#555555.” For the positions, please refer to the Fig. 12.2. It looks way better 
now, but it is still not the result I had in mind. I also want the frame to have 
a 3D feeling, which is achieved with two additional borders: one below, 
with an Inside position and a thickness of “21.” Because it is placed below, 
it will be covered partly, but due to its increased size, it can still be seen a 
little. Keep this in mind when you stack borders.

Assign the second border a linear gradient (the second icon in the color 
dialog), going from the top-left of the clock face to the bottom-right. For 
the start color at the top, choose “#929292”; for the one at the bottom, 
“#D6D6D6” (Fig. 12.3). This alone gives the clock much more depth, but 
another border should give us the final look. This time, add one with an 
Outside border, stacked between the other two and with a thickness of 5 
pixels. This one also needs a linear gradient in the same direction, but from 
light to dark, with a color of “#BDBDBD” at the beginning and “#676767” 
at the end.

 

Fig. 12.3: Add two more borders, each with a linear gradient going from the top-left to the bottom-right.
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Now that we have taken care of the frame itself, we also want it to look 
slightly raised from the clock face. This is accomplished with a light inner 
shadow. Because the borders already cover a certain part of the clock, the 
shadow needs to be quite big so that it can be seen. To counteract this, 
increase the Spread of the shadow to a relatively large value of “26,” which 
will pull the shadow in. Setting the Blur to “10” now gives us a nice cen-
tered shadow; however, that doesn’t respect the lightning of the scene. The 
light is supposed to come from the top-left, so we need to correct both the 
X and Y positions to “3.” To echo the theme of the artboard’s background, I 
have chosen a darker shade of the blue, with “#162A40” at “23%” alpha. Save 
this color to the Document Colors for later reference.

This is not the only shadow we will use. Another one on the outside will 
make sure that the clock contrasts with the background and looks as if it 
would hang on a wall. The shadow should be black, with an alpha value 
of “23%” and the remaining properties “6/6/14.” This time, we don’t need 
to increase the Spread because we’ve only set a slight outside border for 
the circle. The raised effect is even reinforced with a slight gradient on the 
background itself. Because we have set it directly on the artboard, we need 
to overlay a rectangle for this purpose.

Add one that covers the whole artboard (name it “Background shadow”) 
but that is behind the clock face, and change the fill to a radial gradient. 
Move its center to the bottom-right third of the artboard (Fig. 12.4, 1); to 
change the size, drag the indicator on the circle line to the top-left third of 
the artboard (Fig. 12.4, 2). Be sure to use the point that is connected to the 
center with a line (the other point would change the gradient’s shape to an 
ellipse). Set both color stops to black in the inspector: the one at the cen-
ter should have full opacity (100%), and the one on the outside none at all 
(0%). The shadow would be way too strong like this, so decrease the gen-
eral opacity of this layer to 24% (close the color dialog and press 2, rapidly 
followed by 4).
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Fig. 12.4: A rectangle in the background with a radial gradient adds depth to the scene. Set the center 
point (1) to the bottom-right of the artboard, and drag the indicator on the circle line (2) to the top-left, 
to change its size.

THE CLOCK FACE

With the last step we finished the casing of the clock, so let’s take care of 
the clock face itself now. To make the alignment for all of the elements 
easier, let’s add some custom guides first: show the rulers with Ctrl + R, 
and make sure that the circle is selected. Now, add a vertical guide at its 
center with a click on the upper ruler. As a guide hover over the ruler until 
the red line is directly above the middle handles of the shape on the can-
vas. Do the same for the horizontal guide on the left ruler. For the correct 
placement, you could also have a look at the positions of the guides when 
you hover over the rulers: with an artboard size of 600 pixels, this would be 
300 pixels for both.
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To break the ground, we’ll add the scale for the hours. Create a rectangle at 
the top of the clock face, above the circle, for the mark of the twelfth hour. 
The easiest way is to add a rectangle with a random size first and then 
change it in the inspector. It should have the dimensions “6” (width) and 
“18” (height), with a black fill. Move it “31px” away from the outer edge of 
the circle: Hold Alt to show the smart guides, including the distance; point 
to the circle with the mouse; leave it there; and use the arrow keys to repo-
sition the shape until the spacing is correct (while still holding Alt). Also, 
center it to the clock face horizontally. But what about the remaining hour 
marks? It would be quite tedious to create and rotate them by hand.

FROM HOURS TO MINUTES

Luckily, Sketch offers a handy feature that can do both at the same time: 
Rotate Copies. Select it from Layer → Paths in the menu bar. The fol-
lowing dialog lets you define how many additional copies of the selected 
element to make. With a total of twelve hours, we require eleven more 
marks. After you have entered this value and confirmed the dialog, you 
will be presented with all of the lines and a circular indicator in the middle. 
You can drag this circle around at will; based on the position, it gives you a 
wealth of different patterns. Try to move it around! Also, give some other 
shapes a shot as a starting point to see what can be done with this option.

However, for the correct placement of the hour marks, move the indicator 
down until it is at the intersection of the guides that we added earlier (Fig. 
12.5). That was easy! Please note that you won’t be able to alter this position 
anymore as soon as you click anywhere else on the canvas. But you will still 
be able to change the individual elements after accessing the related Bool-
ean group with a double-click on the canvas. Rename it to “Hour marks.” 
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To break the ground, we’ll add the scale for the hours. Create a rectangle at 
the top of the clock face, above the circle, for the mark of the twelfth hour. 
The easiest way is to add a rectangle with a random size first and then 
change it in the inspector. It should have the dimensions “6” (width) and 
“18” (height), with a black fill. Move it “31px” away from the outer edge of 
the circle: Hold Alt to show the smart guides, including the distance; point 
to the circle with the mouse; leave it there; and use the arrow keys to repo-
sition the shape until the spacing is correct (while still holding Alt). Also, 
center it to the clock face horizontally. But what about the remaining hour 
marks? It would be quite tedious to create and rotate them by hand.

FROM HOURS TO MINUTES

Luckily, Sketch offers a handy feature that can do both at the same time: 
Rotate Copies. Select it from Layer → Paths in the menu bar. The fol-
lowing dialog lets you define how many additional copies of the selected 
element to make. With a total of twelve hours, we require eleven more 
marks. After you have entered this value and confirmed the dialog, you 
will be presented with all of the lines and a circular indicator in the middle. 
You can drag this circle around at will; based on the position, it gives you a 
wealth of different patterns. Try to move it around! Also, give some other 
shapes a shot as a starting point to see what can be done with this option.

However, for the correct placement of the hour marks, move the indicator 
down until it is at the intersection of the guides that we added earlier (Fig. 
12.5). That was easy! Please note that you won’t be able to alter this position 
anymore as soon as you click anywhere else on the canvas. But you will still 
be able to change the individual elements after accessing the related Bool-
ean group with a double-click on the canvas. Rename it to “Hour marks.” 

Fig. 12.5: Create the rectangle for the twelfth hour, and add the remaining marks with the Rotate Copies 
function. Drag the indicator (red circle) to the intersection of the guides.

For the minutes, we can take a similar approach, but instead of lines, we 
will create circles for these marks. To make that easier, set the hours to 
“20%” opacity first with 2. Now, draw a circle with a diameter of “8px” at the 
same position as the current mark on the twelfth hour, which you should 
move “40px” from the outer edge of the clock. Also, set its color to black. 

The Rotate Copies option comes into play again. This time we need “59” 
additional copies. Like before, align the circular indicator to the intersec-
tion of the guides. At once, we’ve added all of the marks for the minutes. 
Rename the new Boolean group to “Minute marks,” and access it with a 
double-click. However, we don’t need the marks at the same positions as 
the hours, so we will delete them now: Click on the mark at “12” on the 
canvas, hold Shift, click on the other round marks that overlap, and delete 
all twelve of them. You can now set the hours to full opacity again and hide 
the custom guides with Ctrl + R.
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FROM ONE TO TWELVE

This brings us a huge step closer to the final clock face. However, we have 
still some work to do. First, the digits. To give the clock a modern appear-
ance I have chosen the futuristic Exo 2 family from Google.79 Unfortu-
nately, you can’t use Rotate Copies to distribute text layers, but we would 
need to align them manually anyway due to the different shapes of the 
numbers, so let’s go for it.

To make the alignment easier, create a circle with a diameter of “360” at the 
center of the clock, and assign it a thin gray border (no fill). Add the “12” at 
the top, with a font size of “52,” a “Bold” weight and a black fill: Align it with 
the arrow keys, so that its topside touches the helper circle (Fig. 12.6). The 
number should also be centered to the corresponding hour mark. Continue 
in the same manner for the remaining hours. Always make sure that they 
touch the circle on the inside. The easiest way is to drag the preceding 
number out while holding Alt, move it to the new place, change the con-
tent, and set the final position with the arrow keys. When you are finished, 
delete this helper shape. Also, create a “Digits” group for all of the numbers.

Fig. 12.6: Use a helper circle with a gray outline to align all of the digits properly.

79	 http://smashed.by/sketch-exo2

http://smashed.by/sketch-exo2
http://smashed.by/sketch
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TICK-TOCK

The remaining elements to take care of are the watch hands. Zoom in a bit 
to start with the second hand. It’s made of a simple red (#DF321E) rectangle 
with dimensions of “4” (width) and “200” (height), and whose lower two 
vector points are moved in “1px” each to form a slight trapezoid. To achieve 
this, press Enter to go into vector point mode, hit Tab two times to go to the 
lower-right point, and press the left arrow key on the keyboard to move it 
1 pixel to the left. Hit Tab again to continue to the lower-left point, which 
you’ll move in with the right arrow key. Leave this mode again by pressing 
Esc two times, zoom back to 100% with Cmd + 0, and center the hand to the 
artboard horizontally. On the Y axis, it should be “192px” away from the 
top of the watch. Because it is supposed to point to the “6,” we don’t need to 
rotate it, but make sure that it is above the “Digits” group. Finally, name it 
“Second,” but hide it for now.

You can create the minute hand in the same fashion: Add a black rectangle 
with the dimensions “10” (width) and “210” (height), and zoom into it with 
Cmd + 2. For this shape, we’ll add some points at the top and bottom. Like 
before, enter vector point mode, but move the lower points in “2px” each. 
Now hold Cmd and click on the top segment to add a point in the exact 
middle. Push this point up by 3 pixels. Do the same for the lower segment, 
but move it down by 4 pixels (Fig. 12.7).
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Fig. 12.7: The minute hand is made of a simple rectangle, with additional points that are slightly moved.

Finally, give the pointer a three-dimensional appearance with a crest (Fig. 
12.8). One way to achieve this is to add a gradient with a hard stop in the 
middle, consisting of two stops at the same position. Add a gradient fill on 
top of the existing fill, assigned black with “100%” alpha for the first color 
stop and white with “0%” for the last stop. Bring the gradient to a horizon-
tal position with the left-pointing arrow in the color dialog.

Now add another point with a double-click on the gradient axis in the 
color dialog, moved to the exact middle with 5 on the keyboard. Give it 
100% alpha, and make sure it is black. Add another one to the right, and 
also move it to the center with 5, but then press the right arrow key once to 
offset it slightly to the right. After you have changed it to white with “30%” 
alpha, you’ll see that this has resulted in a hard edge, thanks to the same 
position of the color stops. To conclude, leave the color dialog by clicking 
anywhere on the canvas, and name this shape “Minute.” Place it 188 pixels 
away from the top of the clock, centered horizontally on the artboard.

It’s quite an easy task to get to the hour hand from here. Duplicate its 
minute counterpart, but hide the original layer, name the new one “Hour,” 
and change the dimensions to “12” (width) and “162” (height). That already 

Fig. 12.8: A linear gradient with a hard color 
stop in the middle gives the minute hand a 
three-dimensional appearance with a crest. It is 
achieved with two stops at the same position.
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Fig. 12.7: The minute hand is made of a simple rectangle, with additional points that are slightly moved.

Finally, give the pointer a three-dimensional appearance with a crest (Fig. 
12.8). One way to achieve this is to add a gradient with a hard stop in the 
middle, consisting of two stops at the same position. Add a gradient fill on 
top of the existing fill, assigned black with “100%” alpha for the first color 
stop and white with “0%” for the last stop. Bring the gradient to a horizon-
tal position with the left-pointing arrow in the color dialog.

Now add another point with a double-click on the gradient axis in the 
color dialog, moved to the exact middle with 5 on the keyboard. Give it 
100% alpha, and make sure it is black. Add another one to the right, and 
also move it to the center with 5, but then press the right arrow key once to 
offset it slightly to the right. After you have changed it to white with “30%” 
alpha, you’ll see that this has resulted in a hard edge, thanks to the same 
position of the color stops. To conclude, leave the color dialog by clicking 
anywhere on the canvas, and name this shape “Minute.” Place it 188 pixels 
away from the top of the clock, centered horizontally on the artboard.

It’s quite an easy task to get to the hour hand from here. Duplicate its 
minute counterpart, but hide the original layer, name the new one “Hour,” 
and change the dimensions to “12” (width) and “162” (height). That already 

Fig. 12.8: A linear gradient with a hard color 
stop in the middle gives the minute hand a 
three-dimensional appearance with a crest. It is 
achieved with two stops at the same position.

gives us the final shape. However we 
need to mirror it horizontally to 
bring the gradient to the opposite 
side: Right-click on the shape, and 
select Flip Horizontal from the 
Transform menu. After that, 
position it “202px” from the top of 
the clock face, and center it. Be sure 
that the order of the hands is 
second, hour, minute in the layers 
list, and combine all of them into the 
new group, “Hands.” It should be 
above the “Digits” group.

GO AROUND THE CIRCLE

Time to set the clock. The second hand, which you can show again now, 
already points in the right direction, but the other two hands should read 
10:07. Rotating the hour pointer in the default way doesn’t give us the cor-
rect result because it alters the position we’ve already set. You may remem-
ber that it’s possible to adjust the point around which an element rotates. 
For this to work, we need to use the Rotate icon in the toolbar (Fig. 12.9, 1), 
which gives us a little indicator at the center of the object (Fig. 12.9, 2).

Drag it to the intersection of the custom guides defined earlier, and try to 
perform the rotation now: The hand will move like on a real clock. Take 
this opportunity to set the hour hand to a little after 10:00, at about “233” 
degrees. Show the minute hand again, and proceed in the same manner, 
but rotate it until it is at the seventh minute of the hour (“–137” degrees). 
Please note that you need to perform the rotation on the canvas; the input 
field in the inspector won’t respect the altered rotation point.
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Fig. 12.9: Use the Rotate icon on the toolbar (1), which lets you alter the rotation point (2). Set it to the 
intersection of the custom guides, so that you can turn the minute hand like on a real watch. Rotate it by 
233 degrees. 

For the final touch and to further strengthen the 3D effect of the watch, 
add some shadows to the hands. Start with the second hand: To respect 
that the light comes from the top-left, we need to set the properties to 
“2/5/4/0” with the dark blue that we saved to the Document Colors 
(#162A40), but at “30%” opacity. The same blur and color can be used for the 
shadow of the hour hand, but the X and Y positions need to be changed to 
“–3” and “–2.” The same goes for the minute hand, but with values of “–4” 
and “–2.”

To top everything off, we will add one last element: a small red circle with a 
diameter of 12 pixels at the center of the clock that will hold all of the hands 
at their positions, and named “Cover” (Fig. 12.10). Take over the color from 
the second hand with the color picker and add a second fill on top of it: a 
radial gradient that has the same size and position as the circle, starting 
with 0% black at the center and going to 20% black on the outline. Also, add 
a shadow to raise it slightly from the hands. Give it the properties “0/0/5/0” 
with 50% black.
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Fig. 12.10: As a final touch, add a circle on top of the hands, with a radial gradient and a shadow. In the 
screenshot, you can also see the shadows of the hands.

The result is a realistic wall clock. You’ve learned not only how to stack 
multiple borders, but also how to apply gradients to create distinctive 
effects. You’ve also learned more about rotations and how to use the 
Rotate Copies function to add multiple copies of the same object in a very 
special way. On to another challenge: textured type.

Creating Textured Type

In the course of this book, you’ve learned a few ways to employ images in 
your designs, both as dedicated layers and pattern fills. The latter can also 
be used in a very special way to apply an image fill to text. It’s midsummer 
as I write this, so I decided to use an appropriate theme for this project, 
both for the text and the image. To strengthen the summer feeling, we will 
sprinkle in some blend modes.
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Fig. 12.11: We will create three different versions of textured type.

SUMMERTIME

Let’s start with the image. Like always, I landed at unsplash.com to find 
a suitable asset. After a bit of browsing, I decided on a picture with palm 
trees,80 which perfectly matched my summer mood at the time. Set up a 
new page named “Textured type” in Sketch, and create a new artboard, 
named “Pattern image,” with dimensions of “650 × 530” at “0” (X) and “0” 
(Y), and drag the image in. Resize and reposition it to show the preferred 
part. You can always adjust it later, because we will create a different art-
board on which we will combine it with the text.

To set a special mood, we will overlay the image with a gradient and adjust 
its blend mode (Fig. 12.12). Add a new fill with a linear gradient, going all 
the way from the top-left to bottom-right of the image (not the artboard). 
For the colors, I used a bright orange (#FF9500) at the start, and a blue with 
a hint of red at the end (#391CF7), with full opacity. By default, this gradient 
covers the image now, but if you start to alter its Blending, you can mix it 
and create very distinctive effects. Give all of the filters a try. I landed on 
Color Dodge in the end.

80	 http://smashed.by/sketch-unsplash

http://unsplash.com
http://smashed.by/sketch-unsplash
http://smashed.by/sketch-unsplash
http://smashed.by/sketch
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Fig. 12.12: Overlay a linear gradient to the image, and change the Blending to give it a special feel.

TEXT ME

Now, duplicate the artboard at the bottom by holding Alt and dragging it 
there on the canvas; rename it to “Pattern.” Hide the image temporarily 
with Shift + Cmd + H, as we will apply it in a different way later. This is 
the perfect opportunity to add the text layer with the content “SUMMER 
TIME.” For the font, I had a very bold weight in mind, which “Passion 
One”81 from Google Fonts fits perfectly.

After you have altered the typeface, change the Alignment to Center, add 
a break between the words and resize them, so that they have the same 
width and a very tight line spacing. “TIME” should be about 180% bigger 
than the other word, so select this part and add “* 1.8” to the font size field. 
Lower the line spacing of the whole text layer until the words almost 
touch. Leave text edit mode with Esc, and bring the text to a width of about 
590 pixels with the Scale dialog (Fig. 12.13).

81	 http://smashed.by/sketch-passionone

http://smashed.by/sketch-passionone
http://smashed.by/sketch-passionone
http://smashed.by/sketch
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This is a great way to resize text after you have altered the line spacing 
and want to keep it proportional to the font size. (If you had just resized 
the text layer in the inspector, the line height would have remained fixed.) 
Finally, center the text in both dimensions, but mind that the altered line 
spacing will make manual alignment in the vertical direction necessary. 
Horizontally, you can use the alignment icons in the inspector.

Fig. 12.13: Create the text on a different artboard, bring the words close together, and match their width. 

MARRY ME!

Now’s the time to marry the image with the text. Select the other artboard 
and copy the image, but go back to the text layer afterwards. Usually, a 
text layer doesn’t need a separate fill in order for its color to be defined; to 
overlay the image, though, we need to add a dedicated pattern fill. It’s the 
type second from the right in the fill dialog. The reason why we set up the 
image in a separate artboard is that it’s way easier to define the desired part 
of the image there. Unfortunately, the possibilities for doing that right in 
the fill itself are rather limited.



Mini Projects

339

Fig. 12.14: Overlay the text layer with a pattern fill from the image that you set up in the other artboard. 
A dark version of the image in the background provides enough contrast.

A neat way to insert the image in the fill dialog is to focus the preview area 
on the left with a click and then paste the image there with Cmd + V. Make 
sure that the drop-down beside it is set to Fill (Fig. 12.14). If you are not satis-
fied with the result, just adapt the image in the separate artboard and copy it 
again. That way, both the text and the image remain very flexible. For some 
final polish, show the image in the background again, but change from the 
gradient to a black fill with 80% opacity and a Normal blending. This will 
bring the text to the foreground. You might also want to alter its position and 
size so that it differs from the fill.

MASQUERADE

An alternate method of overlaying text with an image is to employ a mask. 
Duplicate both artboards to the right, but rename them to “Mask image” 
and “Mask.” Be sure to change size and position of the image to show a 
different section. For a distinct effect, we will not only alter the blending to 
another mode — try Lighten — but also use a distinct typeface with “Anto-
nio Bold” in the lower artboard. This time, I didn’t find it on Google Fonts 
but on Font Squirrel, which is also a great source for high-quality fonts.

http://smashed.by/sketch-antonio
http://smashed.by/sketch-antonio
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You can leave the general font size as is, but adapt “TIME” to be about 
190% bigger than the other word; adapt it in the same way as for the other 
artboard. The line spacing also needs an update so that the words almost 
touch again. Make sure to center the text vertically again. Now, duplicate 
the text layer as a backup — but hide it — because we will outline it with 
Shift + Cmd + O. This will create individual shapes for each letter and is 
required so that it can act as a mask. Press Ctrl + Cmd + M for that. Unfor-
tunately, this prevents modification of the text, but with a backup, this 
doesn’t matter too much. The big advantage of this approach is that you are 
much more free to adapt the image fill directly in the same artboard and 
don’t need to separate the two steps.

When you are satisfied with both the image on the upper artboard and the 
text on the lower artboard, copy the former, but be sure to pick the image 
itself. Paste it above the text on the other artboard, which will immediately 
clips it to the shapes. We just set up the image in the other artboard for 
illustration purposes. To make the adaptation easier, lock the outlined text 
layer in the background, so that you can change the image unhindered. If 
you want to see it in its full glory temporarily, right-click and select Ignore 
Underlying Mask. Lastly, delete the image in the background of the art-
board because we don’t need it anymore for this iteration.

 
 

Fig. 12.15: Create a mask from the text after you have outlined it, so that the image can clip to it.
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PATTERN LIBRARY

In a third iteration, I’d like to show you how to employ a repeating pat-
tern as a fill for text, instead of an image. We will use the artboard on the 
left, where the text is still editable as a base with Cmd + D, but rename it 
to “Repeating pattern.” Delete the image in the background as well as the 
pattern fill. For the font, I’ve chosen yet another style with “Oleo Script,”82 
but this time I relied on Google’s font service again. Select the text layer to 
change its content to “never settle” and make a break between the words 
like before. Now adapt the font size to “230px” (for both words) and the line 
spacing to “190.” Give the letters room to breath, with a character spacing 
of 4. Center it in both dimensions.

For the first layer, apply a linear gradient fill, going from the top-left to the 
bottom-right of the text layer. For a summery look, inspired by the colors of 
the ocean, I’ve used “#2FA3D8” and “#59CBC2,” with full opacity. The actual 
pattern fill will be applied in a separate fill layer, above the other one. Have 
a look at this collection of over 70 tileable patterns,83 made specifically for 
Sketch, to find a suitable match. After you have chosen a pattern, copy its 
artboard and apply the fill in the same way as above: Change to a pattern 
fill, click on the preview area, and paste the pattern. I’ve picked one from 
the “Dots” page. Set the fill type to “Tile” in the nearby drop-down, because 
it is supposed to be repeated. Change the slider below until you are satis-
fied with the size of the tile and, hence, the look of the text layer (fig. 12.16). 
Unfortunately, you are not able to change the position of the pattern, but 
this doesn’t matter so much with a simple repeating pattern.

82	 http://smashed.by/sketch-oleoscript
83	 http://smashed.by/sketch-patterns

http://smashed.by/sketch-oleoscript
http://smashed.by/sketch-patterns
http://smashed.by/sketch
http://smashed.by/sketch
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Because the effect is much too strong now, we will tone down the opacity 
of the fill (not the whole layer) to 90%, as well as change the blending to 
Overlay so that it blends in with the gradient. To give the text a stronger 
appearance, we will add some nice shadows as a last step; first, a white one 
with full opacity for the seam, with the properties “3/3/0”; for the actual 
shadow, set the properties to “14/14/0” and use the color “#196675.” Change 
it to 100% opacity and make sure that it is below the other shadow.

Fig. 12.16: Add two fills to the text: a linear gradient and a repeating pattern. Also, apply two shadows to 
give it a stronger appearance.

Having done such a relaxed theme, we will dig into a more serious topic 
again with the creation of pie charts. In this course of this, I will not only 
describe the already-mentioned Scissors tool in more detail, but also show 
a few other approaches.



Mini Projects

343

Creating Pie Charts

To start, create yet another page, named “Pie charts.” This time, we don’t 
need a separate artboard, but will work directly on the canvas for the first 
time. Whenever you don’t need a certain dimension for your creation, this 
is the best approach. You can convert everything to an artboard easily later 
anyway. The base for all of the pie charts is a gray (#DEDEDE) circle with 
a diameter of 200 pixels; move the first one to “0” (X) and “0” (Y). Overlay a 
slight radial gradient, going from 15% black in the middle to 0% at the out-
side. Move the center of the gradient to the lower-right third of the circle, 
and resize it so that both circles touch the top-left side.

 

Fig. 12.17: The different kinds of pie charts we will create. In the following section, the number in paren-
theses at the end of each heading corresponds to the number in this figure.
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METHOD ONE

For the first “slice,” duplicate the circle, remove the gradient, and switch to 
a bright color, like the orange from the Global Colors. To continue, enter 
the vector point mode. The goal is to create a pie with about 37% of the 
whole amount, so add a new point around the middle of the bottom-right 
segment of the circle with a click. For now, we have to approximate this 
value, but I will show you a method later that marks the exact position.

To get the actual pie shape, we will use the Scissors tool from Layer → 
Paths → Scissors in the menu bar. Start in the top-left segment and cut 
all of the segments counterclockwise down to the point we just created 
(Fig. 12.18, left). However, this doesn’t produce the desired result: We need 
to add another point to “blow up” the segment to a pie shape. For this, 
leave the Scissors tool with Esc, but re-enter vector point mode and click 
on the straight part for a new point (Fig. 12.18, middle). Drag this point to 
the center of the circle with the help of the smart guides. Now we’re on the 
right track!

Fig. 12.18: Left: Create a point, and then cut all segments with the Scissors tool. Middle: Add a new 
point in the straight segment that you drag to the middle of the circle. Right: The finished segment, with 
a slight shadow applied.
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Finally, click on Close Path at the top-right of the inspector to create a 
closed shape. This doesn’t matter so much if a fill is set for the shape, but 
it becomes apparent when only a border is applied. Try to add a border 
before and after you have closed the shape. Give the segment a slight black 
shadow (20% opacity), with just a Blur of “7,” and set the other properties to 
zero for a raised appearance (Fig. 12.18, right). 

For the keys, “63%” and “37%,” I’ve used “League Gothic” from Font Squirrel. 
The bigger slice got a font size of “64px” and a black color; for the smaller 
part, I chose “50px” with a white fill. Both should be set to a centered 
Alignment. To give the keys a distinct look, I’ve set the percent sign to a 
“50%” font size for both: Enter the text-edit mode with Enter, select the “%” 
and append “/2” to the Size field in the inspector. Align the text layers and 
place them above the shapes in the layer hierarchy. To conclude, select all 
present layers and create a new “Single” group.

FROM ONE TO MANY

Most of the time, a pie chart needs not two but multiple segments. Dupli-
cate the group you just created to the right and rename it to “Multiple.” 
Now disable the shadow of the first pie, make a copy of it, and assign it 
another bright color — let’s take one of the greens from the Global Col-
ors. To rotate the segment properly, we will adjust the rotation point, like 
I showed you when creating the clock: Click on Rotate in the toolbar, and 
drag the point to the position where the two straight lines meet, at the 
center of the circle (Fig. 12.19, left).

To make the alignment easier, you can add a vertical and horizontal guide 
at the center of the circle, as I showed you before. Now, rotate the shape 
until the two segments touch. Adjust the second slice by adding a new 
point and cutting away the superfluous segments with the Scissors again, 

http://smashed.by/sketch-leaguegothic
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starting with the top-left segment and going counterclockwise from there 
(Fig. 12.19, middle). Close it after you are finished with Close Path from 
Layer → Paths in the menu bar. You may need to reposition the new seg-
ment after that. Also, add another key for it, and adapt the other one in the 
gray segment. 

Do the same for more segments. Instead of rotating a previous segment, 
you can create it anew as described in method one, but insert two new 
points at the exact positions where the segment should start and end.

Fig. 12.19: Left: Create another segment that you rotate with the Rotate icon in the toolbar. Set the 
rotation point to the center of the circle. Middle: Add a new point that determines the size of the pie, and 
cut all segments up to that point. Right: To highlight a certain segment, enlarge it with the handle on 
the canvas on the opposite side of the circle’s center.

Sometimes you might even want to highlight a certain slice by enlarging it, 
let’s say the orange one. This is not that difficult: Select it with a Cmd-click 
and use the handle on the canvas (that is, on the opposite side of the circle’s 
center) to resize it — in this case, the one on the right (Fig. 12.19, right). Be 
sure to hold Shift so that the ratio is maintained. After you have resized it, 
move the segment down to the center of the circle again. To finish, move it 
above the other segment in the layers list and show the shadow again.
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AN ALTERED APPEARANCE

I want to show you different approaches to making pie charts, and also 
how to create a different appearance. Duplicate the first chart (Fig. 12.17, 1) 
to the right, name it “Progress,” and change the color of the segment (say, to 
the purple from the Global Colors). Also, remove the shadow. Now, dupli-
cate the grey base circle, but move it above the segment with Alt + Cmd + up 
arrow key. The text should still be seen. Assign it a white fill, remove the 
gradient, and resize it on the canvas until it has a size of “164 × 164.” Be sure 
to hold Alt while resizing so that it happens from the center. Instead of a 
pie chart, we’ve got some kind of progress indicator now. To strengthen 
this appearance, you can give the colored segment a white outside border, 
with a thickness of “6.”

Now, grab the black key (you can delete the other), center it to the circle 
horizontally, and move it to the lower half of it. After that, duplicate this 
key, but relocate this copy to the upper half. You can leave the lower text 
layer black (or another shade of gray to reflect the gray segment), the upper 
one should be colored in the same way as the other segment. Also, change 
its value to represent the size of the responding segment. The last element 
to add is a gray (#D8D8D8) rectangle with “130 × 2” (or a line with a corre-
sponding border), which separates these values. Center it both horizontally 
and vertically to the circle. The result can be seen in Fig. 12.17, 3.

METHOD TWO

There are still more ways to create pie charts. The following approach is 
especially suitable if you need multiple segments that have to be easily 
adjustable. Duplicate the initial pie (Fig 12.17, 1) to the bottom, and name it 
“Multiple v2.” Remove the orange segment and both keys. Then, select the 
base circle and set it up as a mask with Ctrl + Cmd + M (Fig. 12.20, left). You 
can also remove its radial gradient fill.
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Now, create a new colored rectangle in the same group, that has the same 
height as the circle and half of its width (100 × 200). Align the rectangle so 
that it exactly fills the right half of the circle (Fig. 12.20, left, red rectangle). 
Duplicate it, assign another color, and rotate it with the Rotate icon in 
the toolbar, but set the rotation point to the center of the circle (Fig. 12.20, 
middle, orange rectangle). If you need just one segment, assign this second 
rectangle the same color as the base circle and be done with it.

In case you want multiple segments, continue to duplicate and rotate the 
rectangle until you’re satisfied. Please note that you don’t have to reset the 
rotation point for each shape, because it is remembered for subsequent 
shapes if you duplicate them with Cmd + D (but don’t leave Rotate mode).

 
Fig. 12.20: Left: Set the gray base circle to a mask, and add a colored rectangle (purple) for the first segment. 
It clips to the circle’s shape. Middle: Duplicate the rectangle and rotate it, with the rotation point set to the 
center of the circle, to create the second segment (orange rectangle). Continue until you have all segments. 
Right: The moment the new segments (blue) begin to cover the first (purple) rectangle, set a mask for it 
(gray border) that only shows the part that doesn’t overlap.

As soon as the duplicated segment begins to cover the first segment, you 
need to take a different approach: Copy the first rectangle and move it to 
the opposite side of the circle (subtract 100 pixels, half the width of the cir-
cle, from the X position). Remove its fill with F and select it together with 
the latest segment. Click on the Mask icon in the toolbar, which hides the 
part that overlaps with the initial segment (Fig. 12.20, right, gray border). 
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METHOD THREE

The final method for creating a pie chart in Sketch is with an angular 
gradient. For a fresh start, create a new circle with a diameter of “150” in 
the bottom-right, and assign it a gradient of this type. For the start point, 
choose the color that you want the first segment to have (be sure to copy 
it); the end color should be same gray as for the base circles before. Now 
add a new color stop with a double-click, and assign it the same color 
as the first stop (you can paste it now), followed by another stop that 
you move to the same position, either in the color dialog or on the can-
vas (Fig. 12.21, left).

This will create a hard color stop and, thus, the first segment (Fig. 12.21, 
middle). For the ultimate precision, use the arrow keys on the keyboard, 
and Tab to jump from one point to another. You can also employ the 
numerical keys to move the stop to a certain position: 4 to 40% on the 
gradient axis, 8 for 80% and so on. To indicate that the color stops are in the 
same position, they are shown next to each other on the canvas. The color 
of the last stop will depend on the pie chart you have in mind: If you need 
just two segments, use the same color as for the end stop (the gray), which 
will finish the chart for now.

In case you want multiple slices, pick yet another color (copy it again). To 
finish this third segment, add another two colors to the right. The first, to 
the left of it, should have the same color that you picked for the second seg-
ment (paste it now); for the second, to the right, use the same color as the 
end stop of the gradient (the gray). Now, bring these two stops to the same 
position again (Fig. 12.21, right). Continue in the same manner for addi-
tional segments. To finish the chart, no matter whether you choose two or 
five segments, rotate it by –90 degrees, because an angular gradient always 
starts at the right of a shape by default.
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Fig. 12.21: Left: Set an angular gradient fill for the circle, and add color stops. Bring these stops to the 
same position. Middle: This adds a hard color stop and, thus, the first segment. Right: Continue in the 
same fashion to add more segments. 

Now for the keys. Instead of overlaying them on the chart, add them 
outside and connect them to the segments with vectors. Duplicate one of 
the black keys from another chart, and shrink it by “80%” with the Scale 
function (Cmd + K). After that, move it to top-right of the current chart to 
correspond with the first slice, and match the color as well as the value to 
it. To keep track of all of the layers, select both, the key and the chart, and 
create a new “Gradient” group, and put all other elements that we will cre-
ate into it. Make sure that it is in the main hierarchy of the layers list.

Let’s continue with the vector. Press V to enter the relevant tool; click below 
the text layer, on the right side, for the first point; hold Shift to restrict the 
movement to the horizontal axis, and make another click on the left side of 
the key. Keep holding Shift and continue the line diagonally to the segment 
itself. Give it a black border with a thickness of “3,” which finishes the first 
key. Continue in the same way for the other keys. You just need to adapt 
the individual segments of the line or mirror it as a whole and change the 
text layer to match value and color to the respective segment.

An automatic way to create pie charts and segmented circles is with the 
eponymous plugin.84 The next project we will tackle, a round progress 

84	 http://smashed.by/sketch-segmentcircle

http://smashed.by/sketch-segmentcircle
http://smashed.by/sketch
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bar, is very similar in type, but totally different in execution to pie charts, 
because it uses borders and related options to get the result.

Creating a Round Progress Bar

One graphical element that has gained quite some popularity lately due 
to the introduction of the Apple Watch is the so-called round progress bar 
(have a look at Fig. 12.23 for the result). We’ve already learned about a way 
to create a similar element in the previous chapter (Fig. 12.17, 3), but there’s 
an even simpler method. Like before, create a new page, named “Round 
progress bar,” and add a circle with a diameter of “200px” to it. It will be the 
base of our progress bar, but instead of a fill, we’ll use a centered border 
with “20px” thickness. Change the color to light gray (#E3E3E3) and dupli-
cate it. After you have picked a bright color for the copy, enter its border 
options with a click on the gear icon. 

Bring your attention to the Dash and Gap input fields. Instead of differ-
ent types of dashed or dotted lines, these fields can be used to create circle 
lines of any length. The starting point is the Gap value: Enter the diame-
ter of the circle and multiply it with the mathematical constant Pi: “200 * 
3.14159265359” (Fig. 12.22, 1). 

You can enter this calculation right in the input field, which results in 
“628.32.” If you adjust the Dash value now, you can watch the line grow 
(Fig. 12.22, 2). Use the arrow keys in combination with Shift to increase the 
value rapidly. To get to a certain amount, let’s say “70%,” just copy the value 
from Gap to Dash and multiply it with a hundredth of it — in this case, 
“0.7.” For the final appearance, set the Ends to rounded with the middle 
icon (Fig. 12.23, 1), add both circles to an “Ring” group, and flip it vertically.

http://length.The
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Fig. 12.22: Create a circle with a light-gray centered border, and duplicate and change it to a bright color. 
Enter its border options with a click on the gear icon and set the Gap (2) to the diameter of the circle, 
multiplied by the mathematical constant Pi (3.14159265359). When you start to increase the value of 
Dash (1), you will see the ring grow. 

To create multiple nested bars, like on the Apple Watch, duplicate this 
group and shrink it. Hold Alt to resize it from the center, together with Shift 
to maintain its ratio, and decrease the diameter on the canvas by 44 pixels. 
This gives you a new size of 156 pixels for the circles. All you need to do 
now is change the color of the top ring and adapt both the Dash and Gap 
fields to respect the new diameter (Fig. 12.23). Continue in the same man-
ner for more nested bars. Finally, put all of the rings in a dedicated group, 
like “Progress bar border.” Special thanks to Meng To for discovering 
this technique.

http://smashed.by/sketch-techniques
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Fig. 12.23: Flip the ring vertically and set the Ends to rounded (middle icon). Create more rings and 
adapt the Gap to the new diameter. For the orange ring and its diameter of “156,” this would mean a 
value of “490.09” (156 × 3.14159265359). 

Now that you have learned how to divide a circle into exact segments, you 
can apply this knowledge in the pie charts from the other page to create 
slices of a certain size. You just have to duplicate the gray base circle of the 
chart, bring it to the front and change it from a fill to a centered border 
(press F and B). Adjust the Gap of this border according to the diameter 
of the circle (diameter × Pi), and set the Dash to the percentage you need 
(diameter × Pi × (percentage/100)). For example, to set exactly “37%” for 
the first pie chart, enter “200 * 3.14159265359” in the gap, copy this value to 
Dash, and multiply it by 0.37 (37/100). Flip it vertically, and adjust the slice 
to the border length you see now.
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A DIFFERENT APPROACH

An even simpler method for the round progress bar is to use the Scissors 
tool again. Duplicate the the first gray ring from the other progress bar, 
and put it in a new “Progress bar segments” group, in the main hierarchy 
of the layers list, to distinguish this from the other method. Create a col-
ored copy again, but instead of using the border options, enter vector point 
mode for it. Add a new point at the position where the progress bar should 
end, and select the Scissors tool. Cut the segments you don’t need: Start at 
the topmost point of the circle, and go counterclockwise to the point you 
just added (Fig. 12.24). Finally, set the Ends to Rounded again. 

 

Fig. 12.24: Insert a new point, and use the Scissors tool to the cut the redundant segments. Start from 
the top point and go counter-clockwise.

For more bars, proceed in exactly the same manner: Duplicate the gray 
ring and shrink it, create a colored copy, insert a new point, and delete the 
redundant segments. While the rings are easier to create with this method, 
they have the disadvantage that you can’t adjust them easily, only if you 
need to make them shorter. Otherwise, you’ll need to start afresh. Having 
taken this side trip to the world of charts, bars and numbers, we will turn 
to a more relaxed topic, with the creation of a few so-called “hipster” logos. 
We’ll continue learning how to set text to a path.
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Creating Hipster Logos

Although the term “hipster” can have a negative connotation in some cir-
cles, it’s a prime style for a certain type of logo. It has a special appearance, 
and it can feature rounded or slanted text and can contain certain graph-
ical elements. This is the perfect opportunity to introduce one of the last 
remaining topics of Sketch: Text on Path.

Fig. 12.25: The two logos we are going to create, partly with the help of the Text on Path feature. 

BAKERY

Let’s start with the logo of the imaginary “Eastend Bakery.” Set up the new 
page “Hipster logos,” and add the base shape, a square with a side length 
of “206” pixels. Rotate it by 45 degrees to get a rhombus, and flatten it with 
Layer → Paths → Flatten from the menu bar. This will clear the rotation, 
which makes it easier to edit the shape. Grab the middle handle on the side, 
hold Alt to resize it from the center, and drag it out until it has width of 
“390px.” Be sure to unlock the ratio in the inspector first so that the height 
remains constant. Now, add a dark-green inside border (I chose “#417505”), 
with a thickness of 6px. You can leave the fill color, but set its opacity to 
0, so that it is easier to select the frame. To finish it, enter vector point 
mode, select all points, and assign rounded corners with a radius of “16.” 
Name it “Border.”
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ALL OF THE ELEMENTS

The logo contains three text elements, all set in “Montserrat Bold”85 from 
Google Fonts, with the same color as the frame: first, “EASTEND” with a 
“Bold” weight, a size of “46px” and a character spacing of “0.8.” After that, 
“BAKERY”: “Regular” weight, “30px” size, “1” character spacing. The third 
of the bunch is “SINCE 1932,” with the same weight, but a font size of “13” 
and spacing of “0.2.” Place the text layers below each other, and center them 
horizontally to the border.

Furthermore, add two rectangles with the same color and the dimensions 
“20 × 2,” placing them to the left and right of the date, so that these three 
elements together have the same width as “BAKERY” above. Put them in 
a “Date” group, and center them vertically to each other. Place this group 
at the bottom of the rhombus, so that it almost touches the edges. Directly 
above it, with just a slight gap, put the “BAKERY” layer. “EASTEND” should 
be slightly below the vertical center of the base shape for now.

The last elements we need are two crossed wheat ears at the top. As 
mentioned earlier, my trusted source for all kinds of icons and assets is 
the Noun Project, which has a Mac app.86 An great alternative is the free 
Iconjar application,87 which lets you import, store and categorize icon sets 
with ease. After you have found a suitable graphic for the grain, drag it 
into Sketch, and then adjust, duplicate and mirror it. Set up a new group, 
“Wheat,” and center it horizontally and place it at the top of the logo. It 
should have just a small spacing to the border. Make sure that all of the 
elements in the logo have the same color (see Fig. 12.26, left, for the position 
of elements).

85	 http://smashed.by/sketch-montserrat
86	 https://thenounproject.com/for-mac
87	 http://geticonjar.com/

http://smashed.by/sketch-montserrat
https://thenounproject.com/for-mac/
http://geticonjar.com/
http://smashed.by/sketch
https://thenounproject.com/for
http://geticonjar.com
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TEXT ON PATH

Now on to the actual topic of this chapter: placing text on a path. It doesn’t 
matter here whether you use a closed shape or an open path like a vector. 
We will go for the former: Create a new oval with a size of about “400 × 
190,” and place it directly below the “EASTEND” text (also in the layers list), 
and name it “Path.” You can switch from the fill to a border with F and B to 
make the placement easier. Combine them to a new “Eastend” group. After 
that, select the text and choose Text on Path from the Type menu in the 
menu bar. This ties the text to the shape of the ellipse.

Unfortunately, this feature needs a lot of trial and error, so move around 
both elements, the text and its path, independent of each other until you 
land at the desired result: The text should bend so that it follows the oval in 
the middle and is above the path (Fig. 12.26, right). This might also require 
you to flip the path in the other direction; just fiddle around a bit. In case 
the text seems to disappear or is cut off, certainly zoom in and out of the 
canvas to get the correct look. Sometimes it also helps if you slightly move 
the text or path. Next, grab the group and move it to the final position, 
above the “BAKERY” layer. 

You can hide the path now. Finally, put all of the content so far into a “Bak-
ery” group to finish the logo. Although Text on Path is buggy, it can still be 
a huge help for creating certain graphical assets.
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Fig. 12.26: Left: All of the elements of the logo, correctly placed. Right: Tie the “EASTEND” text layer to the 
path (red) with Text on Path from Type in the menu bar, so that it follows its shape. Please note that I 
have reduced the opacity of the remaining elements to highlight the transformed text layer.

Before you can export the logo, you’ll need to create outlines for the text. 
This can be a little tricky due to the text’s alignment to the path, so if 
Shift + Cmd + O doesn’t create the desired result, flatten the path first. After 
that, you might need to flip the converted outlines once again. This prepa-
ration is especially important if you want to create an SVG. Otherwise, you 
can export the logo without any modifications.

CAR SHOP

The second logo we’ll tackle is for a fictional car shop named “The 
Garage.” In contrast to the other logo, we will use a circle as the base 
structure. Add one with a diameter of “276px” to the right, and assign it 
an inside border with a thickness of “16” and named “Border.” I’ve used 
“#9D6B37” for its color. You can set the fill to 0% opacity again to make the 
selection easier, but make sure that it’s always behind all of the other lay-
ers to come. This frame will not go all around the logo, but will have a gap 
at the bottom where the text layer “CAR SHOP” sits. It’s based on the font 
“Chivo Black,”88 with a font size of 26 pixels and “1.75” character spacing. 
Assign it the same color as the frame.

88	 http://smashed.by/sketch-chivo

http://smashed.by/sketch-chivo
http://smashed.by/sketch
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FOLLOW ME

Before cutting away a part of the circle, we will set up the text to follow its 
contours, so that we have a better feeling for the hole. To make the place-
ment easier, you can reduce the opacity of the shape to about 20%. Now, 
duplicate the circle to act as the path (Fig. 12.27, left), group it with the text 
“CAR SHOP,” and select Text on Path again for the text layer. Make sure 
that the path is below the text. Like before, reposition both elements indi-
vidually until you are satisfied with the outcome. You might need to flip 
the path to get there. Move the group to the final position at the bottom of 
the circle, and hide the path.

Now, cut away the redundant part of the frame to make room for the text. 
Enter its vector point mode, add a point both to the left and the right of the 
text (use a custom guide to get the same heights), and use the Scissors tool 
to remove the segments at the position of the text. Proceed as in the second 
method of the round progress bar (Fig. 12.24). After that, you can bring back 
the border to full opacity.

ALL OVER AGAIN

The second element that will be applied to a path is “Garage.” To get a 
certain look, I’ve used the font “Lobster”89 at a size of “70” and “1.20” char-
acter spacing. Instead of a shape, we will use a vector for the path. Create a 
straight horizontal line below the text layer, and make it one fourth longer, 
about 260 pixels.

Enter vector point mode to move the second point up by about 40 pixels, 
jump back to the first point with Tab, and change to a Mirrored type 
with 2. Drag it to get vector point handles, and move them to the bot-

89	 http://smashed.by/sketch-lobster

http://smashed.by/sketch-lobster
http://smashed.by/sketch
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tom-left until you get a nice curve. The line that connects the two handles 
should have about the same length as the path. See Fig. 12.27, right, for 
the correct path.

Fig. 12.27: The two paths for the text layers. 

Leave vector point mode, select the path together with the text layer, and 
set up a new “Garage” group. Now, apply Text on Path to the text again, 
but make sure that it is above the path in the layers list. Follow the proce-
dure from above to align it properly to the path. You can always modify the 
vector, even in this state, if you are not satisfied. This also goes for the text 
layer — for example, to optimize the kerning. Move the group to the center 
of the circle after this procedure and hide the vector. There’s still plenty of 
free room in the logo that we want to fill with elements.

 For the upper half, add the text layer “The,” with a font size of “48,” set in 
the familiar “Playfair Display Italic,” with default character spacing. Center 
it to the logo horizontally.
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Missing Fonts

With all of these different fonts, some of them can be easily missed if you 
pass on the Sketch file to a fellow designer. Sketch will warn you that cer-
tain fonts are missing, but avoid opening the file in this case, because the 
text layers will revert to the default fonts.

Fig. 12.28: Sketch warns you if you attempt to open a file with a missing font. Don't do that; try to 
install the font first.

Instead create a backup of the file for the worst case scenario, and attempt 
to install the missing fonts first. The app RightFont,90 which I mentioned 
earlier, can be a huge help here, because it tries to activate missing fonts if 
you open the file with it from the Finder with a right-click (Open with → 
RightFont).

90	 http://rightfontapp.com

http://rightfontapp.com
http://rightfontapp.com
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For the lower half of the logo, add two crossed wrenches. Again, you can 
have a look at The Noun Project91 for a suitable asset — or for some inspi-
ration to create it yourself. To make them contrast with each other, dupli-
cate the wrench on top, select it with other below (that points in the other 
direction), and create a Subtract Boolean operation. Enlarge the shape on 
top in this group from the center by holding Alt and Shift, until there is a 
gap between the wrenches (Fig. 12.29). 

When you are finished, put them in a new “Wrenches” group, and ensure 
that they are centered relative to the logo. Make sure that all elements 
we’ve added recently share the same color, and create a new “Garage” 
group from all of them.

Fig. 12.29: Duplicate the top wrench, subtract it from the other (selected in the layers list), and enlarge it 
(to the size of the blue border) to create a gap between the shapes.

With this last step, you’ve finished the mini projects and learned a lot 
of practical tips that you can immediately apply in your daily work with 
Sketch. This also completes the practical part of the book. Now you know 
about every aspect of the design app and should be able to build anything 
you can imagine. The rest of the book covers topics related to the app in 
other ways.

91	 https://thenounproject.com/

https://thenounproject.com/
https://thenounproject.com
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Plugins

Basically, Sketch gives you everything you need to approach a broad range 
of projects. But there are still parts that either are totally missing in the app 
or that work in an unexpected manner. To account for this, the community 
has created countless plugins that enhance Sketch in very different ways.

Besides the ones already mentioned throughout the book (and that are 
also listed below for the sake of completeness), this appendix gives you an 
overview of the most recommended plugins. They are arranged in useful 
categories for easier recognition, but in no particular order. Most of them 
can be installed with Sketch Toolbox; however, the official websites are also 
mentioned for your reference. Read more about their usage and application 
on page 58ff. Please note that some plugins may stop working with newer 
versions of Sketch, so there's no guarantee for their correct functionality.

Up for more? Besides the official plugin directory92 there’s a huge collection 
of these little helpers to choose from on GitHub.93

RESPONSIVE DESIGN

•	 Fluid: Before Sketch offered native group-resizing possibilities, this 
was the best way to achieve the same functionality. It’s a bit more 
complicated to use, but it gives many more options for pinning ele-
ments to certain positions and resizing whole layouts at once. Sketch 
Constraints94 falls in the same category. 

92	 http://smashed.by/sketch-plugins
93	 http://smashed.by/sketch-plugins2
94	 http://smashed.by/sketch-constraints

http://smashed.by/sketch-plugins
http://smashed.by/sketch-plugins2
http://smashed.by/sketch-fluid
http://smashed.by/sketch-constraints
http://smashed.by/sketch-constraints
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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PRODUCTIVITY

•	 Sketch Runner:95 Like Spotlight search but in Sketch. Search through 
plugins and menu commands, jump to groups or layers, insert sym-
bols, or create and apply styles, all in a simple interface.

•	 Rename it:96 Rename multiple layers at once based on different 
parameters, like a numerical sequence, with a prefix or by adding 
dimensions to the name.

•	 Find and Replace:97 Finds text either in selected layers or the whole 
document and replaces it with different content.

•	 Dynamic button:98 Create buttons with fixed padding no matter what 
text you add. The button shape automatically snaps to the new dimen-
sions once you press a shortcut.

•	 Compo:99 Kind of an advancement of Dynamic button. Turn a text 
layer into a button, or put an existing component in order with the 
correct margins, all with a simple keystroke.

•	 Sort me:100 Allows you to arrange layers alphabetically or numerically 
in the layers list, or in the reverse order. 

COLORS AND PALETTES

•	 My Sketch Colors:101 By default, Sketch offers just a handful of preset col-
ors, but with this replacement you get a lot more options to choose from. 

95	 http://sketchrunner.com
96	 http://smashed.by/sketch-renameit
97	 http://smashed.by/sketch-findreplace
98	 http://smashed.by/sketch-dynamicbuttons
99	 http://smashed.by/sketch-compo
100	http://smashed.by/sketch-sortlayers
101	 http://smashed.by/sketch-mycolors

http://sketchrunner.com
http://smashed.by/sketch-renameit
http://smashed.by/sketch-findreplace
http://smashed.by/sketch-dynamicbuttons
http://smashed.by/sketch-compo
http://smashed.by/sketch-sortlayers
http://smashed.by/sketch-mycolors
http://sketchrunner.com
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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•	 Sketch Palettes:102 Lets you save and load colors in the color dialog so 
that you can distribute them across different computers or to your 
whole team.

•	 Prism:103 Creates an artboard with all of the colors in your Document 
Colors with the corresponding color labels, in a variety of formats. 
Think of it as a mini-style guide.

•	 Contrast Color Analyser:104 Calculates the color contrast of two 
layers and evaluates it against the Web Content Accessibility Guide-
lines.

IMAGES AND PATTERNS

•	 Sketch Subtle Patterns:105 Import all patterns from this well-known 
pattern library into Sketch. A paid but more comfortable alternative 
can be found directly on the website of the library.106

•	 Unsplash it:107 If you need a simple way to add an occasional place-
holder image from the famous Unsplash collection, this is the perfect 
place.

•	 Sharpen images:108 Apply a sharpen filter (unsharp mask) to your 
layers in Sketch in a non-destructive way. This is especially important 
if you flatten parts of your designs to a bitmap.

•	 sketch-uifaces:109 Easily load avatar images from the uiFaces110 website, 
so that you don’t have to insert profile pictures manually.

102	http://smashed.by/sketch-palettes
103	https://github.com/ment-mx/Prism
104	http://smashed.by/sketch-contrast
105	http://smashed.by/sketch-subtle
106	http://subtlepatterns.com
107	http://smashed.by/sketch-unsplashit
108	http://smashed.by/sketch-sharpen
109	http://smashed.by/sketch-uifacesplugin
110	 http://uifaces.com/

http://smashed.by/sketch-palettes
https://github.com/ment-mx/Prism
http://smashed.by/sketch-contrast
http://smashed.by/sketch-subtle
http://smashed.by/sketch-unsplashit
http://smashed.by/sketch-sharpen
http://smashed.by/sketch-uifacesplugin
http://uifaces.com/
http://smashed.by/sketch
https://github.com/ment-mx/Prism
http://smashed.by/sketch
http://smashed.by/sketch
http://subtlepatterns.com
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://uifaces.com
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DEVELOPMENT

•	 Git Sketch:111 The functionality of Git, built right into Sketch. No more 
“v1,” “v1.1,” “v2” for your files, but a clearly documented design process.

•	 CSSketch:112 Modify designs quickly by attaching a CSS file to it. It 
supports Sass and LESS style sheets so that you can use functions and 
variables which makes your workflow more efficient.

•	 Code generator:113 A paid plugin that allows you to convert parts of 
your Sketch document into Swift or Objective-C to ease the build 
process of an iOS app.

•	 Marketch:114 Creates an HTML page in which you can read all of the 
information to code your design, such as colors, font sizes and mea-
surements.

•	 Sketch Measure:115 Does the same plus adding measurements, dimen-
sions, color codes etc. as separate layer groups. 

STATES

•	 Checkpoints:116 Save important stages of your artboards so that you 
can easily compare and revert to them. States117 falls into the same 
category. 
 
 
 

111	 http://smashed.by/sketch-git
112	 http://smashed.by/sketch-css
113	 http://smashed.by/sketch-codegen
114	 http://smashed.by/sketch-marketch
115	 https://github.com/utom/sketch-measure
116	 http://smashed.by/sketch-checkpoint
117	 http://states.design

http://smashed.by/sketch-git
http://smashed.by/sketch-css
http://smashed.by/sketch-codegen
http://smashed.by/sketch-marketch
https://github.com/utom/sketch-measure
http://smashed.by/sketch-checkpoints
http://states.design
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
https://github.com/utom/sketch
http://smashed.by/sketch
http://states.design
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ASSET GENERATION AND EXPORTING

•	 AEIconizer:118 Make it easier to resize artwork for the iOS app icon: 
Select any layer and generate all of the required sizes.

•	 Iconboard:119 A paid plugin for creating optimized icons with multiple 
sizes from artboards in Sketch. Both Windows and Mac icon formats 
are supported.

•	 Sketch Export Assets:120 Export assets for Android, iOS and Windows 
Phone: Select the element and choose which platform you want to serve. 

STYLE GUIDES

•	 Style Inventory:121 The bigger your project grows, the more important 
it is to keep everything consistent. This plugin can help because it col-
lects all colors, text styles and symbols of a document in a dedicated 
artboard. Craft122 can help you do the same, but also syncs the styles. 

TEXT

•	 Comma:123 Easily access text modifications such as uppercase or title 
case, add ellipses, or change to single or double line breaks.  

•	 Sketch Iconfont124: Insert and manage icons from icon fonts with ease. 
Also needs the font bundles125 installed, which gives you access to four 
different fonts.

118	 http://smashed.by/sketch-aeiconizer
119	 http://smashed.by/sketch-iconboard
120	http://smashed.by/sketch-exportassets
121	 http://smashed.by/sketch-styleinv
122	http://smashed.by/sketch-craft
123	http://smashed.by/sketch-comma
124	http://smashed.by/sketch-iconfont
125	http://smashed.by/sketch-fontbundle

http://smashed.by/sketch-aeiconizer
http://smashed.by/sketch-iconboard
http://smashed.by/sketch-exportassets
http://smashed.by/sketch-styleinv
http://smashed.by/sketch-craft
http://smashed.by/sketch-comma
http://smashed.by/sketch-iconfont
http://smashed.by/sketch-fontbundle
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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IMAGE OPTIMIZATION

•	 Sketch Image Compressor:126 This official plugin takes care that your 
bitmap assets (PNG and JPG) are automatically optimized for a small 
file size when they are exported. 

•	 SVGO Compressor:127 The same, but for SVGs. Lets you tailor the opti-
mization settings to your needs. 

VARIOUS

•	 Split/Divide:128 Split overlaying shapes and create separate layers for 
the overlapping parts. 

•	 Animateme:129 Create animations right in Sketch: Define keyframes, set 
easing functions, and export as an animated GIF or separate PNG files.

•	 Segment Circle:130 Make circular graphics for diagrams and analytics, 
including as a segmented circle, tickmarks circle or dashed circle.

•	 Magic Mirror:131 Kind of a supercharged version of the native transfor-
mation tool, allowing you to create hip perspective mockups directly 
in Sketch. 

•	 Arrowfy:132 Let’s be serious, the default arrows of Sketch are somewhat 
less than perfect. This plugin eases the pain a bit by adding simple 
arrowheads to any line, sized and colored to match its properties. 

•	 Paparazzi!:133 A little utility app that lets you make screenshots of web-
sites, which you can import into Sketch as editable layers.

126	http://smashed.by/sketch-compress1
127	http://smashed.by/sketch-compress2
128	http://smashed.by/sketch-split
129	http://animatemate.com
130	http://smashed.by/sketch-segmentcircle
131	 http://magicsketch.io/mirror
132	 http://smashed.by/sketch-arrowfy
133	 http://derailer.org/paparazzi/

http://smashed.by/sketch-compress1
http://smashed.by/sketch-compress2
http://smashed.by/sketch-split
http://animatemate.com
http://smashed.by/sketch-segmentcircle
http://magicsketch.io/mirror
http://smashed.by/sketch-arrowfy
http://derailer.org/paparazzi/
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://animatemate.com
http://smashed.by/sketch
http://magicsketch.io/mirror
http://smashed.by/sketch
http://derailer.org/paparazzi
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CONTENT GENERATORS

These basically all do the same: provide real content for your design in an 
easy-to-use manner. There’s a whole paragraph dedicated to them in Design 
With Real Data on page 170, which you should check out to learn more about 
these helpers. Here’s just a list for reference.

•	 Craft134

•	 Sketch Data Populator135

•	 Content Generator136

•	 Day Player137

 
COLLECTIONS

Most plugins serve a single function, but some collections combine vari-
ous little helpers into a comprehensive package.

•	 Sketch-Mate:138 A collection of useful plugins that let you manipulate 
artboards, align layers in smart ways and sort them.

•	 Utility Belt139: An always-expanding collection of small, simple, 
focused plugins.

•	 Sandros Sketch Plugins:140 Another library of plugins aimed at work-
ing with horizontal and vertical grid layouts and typography.

134	http://smashed.by/sketch-craft
135	 http://smashed.by/sketch-datapopulator
136	http://smashed.by/sketch-contentgenerator
137	 http://smashed.by/sketch-dayplayer 
138	http://smashed.by/sketch-mate
139	http://smashed.by/sketch-utilitybelt
140	http://smashed.by/sketch-sandros

http://smashed.by/sketch-craft
http://smashed.by/sketch-datapopulator
http://smashed.by/sketch-contentgenerator
http://smashed.by/sketch-dayplayer
http://smashed.by/sketch-mate
http://smashed.by/sketch-utilitybelt
http://smashed.by/sketch-sandros
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
http://smashed.by/sketch
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Resources

Sketch not only has a vivid plugin ecosystem, but is also surrounded by a 
vibrant community that provides helpful resources about the design app 
on a regular basis. Let me give you a list of the best places out there.

•	 SketchTips:141 My website about Sketch, where I’ve provided countless 
tips and tricks about the design app for over two years now. Please sub-
scribe to my newsletter142 to get the occasional email about Sketch-re-
lated topics. As a bonus for signing up, I will send you my Sketch 
keyboard cheat sheet, with the most important keyboard shortcuts.

•	 Personal coaching:143 if you or your company are interested in a Sketch 
training, please fill out the contact form and I’ll get back to you in no time. 

•	 Visit the website of the book144 to get updates and to subscribe to the 
official newsletter. 

•	 You can also contact me145 there or ping me on Twitter  
@SketchTips whenever you have a question about Sketch or about 
design in general. I’d be glad to help in any possible way.

•	 My Skillshare courses:146 In my beginner’s video course, I show the 
basics of Sketch based on a beautiful Twitter profile card. If you are 
up for more of a challenge, watch my advanced class, where we design 
a gorgeous water-consumption app from start to finish.

•	 Sketch App Sources:147 A collection of useful resources about Sketch.
They also have a publication on Medium.148

141	 http://sketchtips.info
142	http://sketchtips.info/newsletter
143	http://www.sketch-handbook.com/contact
144	http://www.sketch-handbook.com/
145	https://twitter.com/sketchtips
146	https://www.skillshare.com/chris_krammer
147	http://www.sketchappsources.com
148	https://medium.com/sketch-app-sources

http://sketchtips.info
http://www.sketch-handbook.com/contact
http://www.sketch-handbook.com/
http://www.sketch-handbook.com/contact
https://www.skillshare.com/chris_krammer
http://Sketch.They
http://Sketch.They
https://medium.com/sketch-app-sources
http://sketchtips.info
http://sketchtips.info/newsletter
http://www.sketch-handbook.com/contact
http://www.sketch-handbook.com
https://twitter.com/sketchtips
https://www.skillshare.com/chris_krammer
http://www.sketchappsources.com
https://medium.com/sketch
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•	 Sketch Tricks:149 Get bite-sized Sketch tricks, tips and techniques in 
this weekly newsletter.

•	 SketchTalk:150 The friendly community where everything related to 
Sketch is discussed.

•	 Sketch Hunt151 and Sketch App Rocks:152 A collection of the best 
resources for the design app.

•	 The official Sketch documentation153

•	 The official Sketch Facebook group154

•	 Official Sketch support:155 Whenever you have a question about 
Sketch, want to report a bug or request a feature, the Sketch team is 
there to help.

•	 Sketch Beta:156 Get a look at the future of Sketch. This beta can be 
installed independent of the normal version and lets you see the next 
iteration of the design app. Use at your own risk, and be sure not to 
employ it for production work.

•	 Project files: The Sketch files of all projects built throughout this book 
are available for you to see how certain parts are constructed or to 
grab some of the assets. Here’s everything related to Visit Austria157, 
and here you can find the Mini Projects.158

149	http://sketchtricks.com
150	http://sketchtalk.io
151	 http://sketchhunt.com
152	http://sketchapp.rocks
153	 http://smashed.by/sketch-doc
154	http://smashed.by/sketch-group
155	 https://www.sketchapp.com/support
156	http://www.sketchapp.com/beta/
157	 http://smashed.by/sketch-files1
158	http://smashed.by/sketch-files2

http://smashed.by/sketch-doc
http://smashed.by/sketch-group
http://www.sketchapp.com/beta/
http://smashed.by/sketch-files1
http://smashed.by/sketch-files2
http://sketchtricks.com
http://sketchtalk.io
http://sketchhunt.com
http://sketchapp.rocks
http://smashed.by/sketch-doc
http://smashed.by/sketch-group
https://www.sketchapp.com/support
http://www.sketchapp.com/beta
http://smashed.by/sketch-files1
http://smashed.by/sketch-files2
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The Most Important Keyboard Shortcuts

The true power of Sketch lies in the keyboard shortcuts. Although I have 
named and used most of them throughout the book, I’d like to give you a 
condensed overview of the most important ones:

•	 Cmd + Click: No matter how deep within a group a layer is nested, you 
can select it if you click on it while holding Cmd.

•	 Alt + hover: Hold and hover over another layer to measure the distance 
to the currently selected layer (hold Cmd to drill into layer groups).

•	 Alt + drag: Hold and drag a layer to duplicate it.

•	 R: Add a rectangle (hold Shift to make a square).

•	 O: Add an ellipse (hold Shift to make a circle).

•	 A: Add an artboard.

•	 T: Add a text layer.

•	 Cmd + D: Duplicate a layer.

•	 ↑/↓/←/→: Move a layer in the corresponding direction on the canvas 
(hold Shift for 10-pixel steps).

•	 Cmd + →/↓: Enlarge a layer (hold Shift for 10-pixel steps).

•	 Cmd + ←/↑: Shrink a layer (hold Shift for 10-pixel steps).

•	 Tab: Cycle through the layers in the layers list (hold Shift to go in the 
opposite direction).

•	 Alt + Tab: Jump to the first input field in the inspector (Position → X). 
Press Tab to jump from one field to the next.

•	 Cmd + R: Rename a layer.



373

•	 Alt + Cmd + ↓/↑: Move a layer one step to the back or front.

•	 Cmd + G: Group multiple layers into a group (add Shift to ungroup 
them).

•	 Enter/Return: Access a layer group or the vector point mode of a layer.

•	 Esc: Sequentially go out of nested layer groups. Or stop editing the 
vector points of a layer. In case no point is selected, the vector point 
mode is left; otherwise, the currently selected point gets deselected.

•	 Shift + Cmd + L: Lock a layer.

•	 Shift + Cmd + H: Hide a layer.

•	 Alt + Cmd + =: Make text bigger.

•	 Alt + Cmd + –: Make text smaller.

•	 Cmd + B: Make text bold.

•	 Cmd + U: Underline text.

•	 F: Toggle the fill(s) of a layer.

•	 B: Toggle the border(s) of a layer.

•	 1 to 0: Change the opacity of a layer or group.

•	 Cmd + +: Zoom into the canvas.

•	 Cmd + –: Zoom out of the canvas.

•	 Cmd + 0: Show the actual size of the canvas (100%).

•	 Cmd + 2: Zoom all the way into the currently selected layer.

•	 Cmd + 3: Center the currently selected layer.

•	 Cmd + K: Scale an object by a certain ratio or a defined width or height.
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•	 Cmd + {/|/}: Align the content of text layer to the left, center or right.

•	 Ctrl + ↓/↑: Jump to next or previous page.

•	 Ctrl + R: Toggle rulers and guides.

•	 Ctrl + G: Toggle the layout grid.

•	 Ctrl + P: Toggle the pixel grid.

•	 Alt + Cmd + 3: Toggle the layers list and inspector (to maximize the 
canvas).

•	 Cmd + Esc: Return back to the instance from the master symbol.

•	 Alt + Cmd + U: Perform a Union Boolean operation.

•	 Alt + Cmd + S: Perform a Subtract Boolean operation.

•	 Ctrl + 1/2/3/4: Set the resizing behavior of a layer.

Besides the default keyboard shortcuts, it’s also possible to define your own 
combinations or alter the existing ones. Read more about that in info box 
Custom Shortcuts on page 73.
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Copyright Information

•	 Fig. 1.1 (left), 1.2, 1.3, 1.4, 2.19, 2.20, 2.21, 2.23, 2.26, 2.28, 2.37, 2.39, 3.2, 3.5, 
3.10, 3.12, 3.17, 3.20, 3.21, 3.22, 3.26, 3.27, 3.30, 3.32, 3.36, 3.37, 3.38, 3.42, 
3.47, 4.2, 4.16, 6.5, 6.6, 6.7, 6.8, 6.9, 6.10, 6.11, 6.14, 6.16 (bottom left), 7.1, 
7.4, 7.5, 7.7, 7.9, 7.13, 8.3, 9.2, 9.5  
© Österreich Werbung, Fotograf: Popp Hackner.

•	 Fig. 3.1, 3.4, 3.34, 6.10, 6.14 by Haitao Zeng  
(https://unsplash.com/photos/rU2-7y7_dbo).

•	 Fig. 3.19, 12.11 (left, middle), 12.12, 12.14, 12.15 by Thomas Lefebvre 
(unsplash.com/photos/V63oM8OPJSo).

•	 Fig. 5.14, 5.15, 5.18, 5.19, 5.20, 5.21, 6.13 by Joshua Hibbert  
(unsplash.com/photos/utjhJQPD2xw).

•	 Fig. 5.19, 6.13 (unsplash.com/photos/TI-B-TNYJMU).

•	 Fig. 6.21 (top right) by pokedstudio (www.pokedstudio.com).

•	 Fig. 1.1 (right), 12.25, 12.26 by Marco Galtarossa  
(thenounproject.com/marcogaltarossa), IT.

•	 Fig. 12.25, 12.29 by Nesdon Booth (thenounproject.com/nesdon.booth).

•	 Fig. 4.14, 4.15 by David Courey  
(thenounproject.com/term/bycicle/274110), USA. 

•	 Fig. 3.44 inspired by Creative Stall  
(thenounproject.com/creativestall), PK.

•	 Texts on details page from smashed.by/sketch-tannheim and  
en.wikipedia.org/wiki/Hallstatt.

Everything else: trademark of their respective owners. Please don’t copy any 
of the material without asking for permission. 

http://unsplash.com/photos/rU2-7y7_dbo
https://unsplash.com/photos/V63oM8OPJSo
https://unsplash.com/photos/utjhJQPD2xw
https://unsplash.com/photos/TI-B-TNYJMU
http://www.pokedstudio.com
http://thenounproject.com/marcogaltarossa
https://thenounproject.com/nesdon.booth/
http://thenounproject.com/term/bycicle
http://thenounproject.com/creativestall
http://smashed.by/sketch-tannheim
https://en.wikipedia.org/wiki/Hallstatt
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8-pixel grid (see Grid)
Alignment 34, 69
Alternatives 213
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Artboards 14, 29, 58
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        Manipulation 248
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Boolean operations 108
Border radius (see Rounded corners) 
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Device preview 202
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Exporting 185, 314
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Fill types 38, 93
Float in place (see Resizing)
Font size 35, 162, 224, 235, 272, 283
Fonts 27, 229, 359
Gradients 92, 93, 322, 334, 340, 348
Grid 41ff, 54,
        Baseline 224, 272
        Column (see Grid → Layout)
        Layout 221ff., 265, 282
        Responsive 267
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Group resizing (see Resizing) 
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Gutters (see Grid → Layout) 
Icons 86, 110, 149ff., 178ff., 292ff.
Image optimization 190
Import PDFs 189
Inspector 11, 251
Intersect (see Boolean operations) 
Kerning 133ff., 238
Layers 11, 29, 100, 140, 263,
        Hide 40, 251
        Lock/unlock 40, 69, 168
Layers list 11, 18, 30, 140ff., 251, 263
Ligatures 238
Line (see Shapes) 
Lines, dashed, dotted 53
Line height (see Line spacing) 
Line lenght 239
Line spacing 34, 54, 56, 240
Lock dimensions 33, 40
Make grid (see Grid → Tool) 
Masking 75, 95, 337,
        Alpha mask 95, 96
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222, 226,
Maximize available space 251
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Measure distance 22, 40, 87
Menu bar 11, 12
Merge shapes (see Boolean operations) 
Multiple properties 26
Oval (see Shapes) 
Pages 10, 119
Paste 169
Pattern fills 38
Pie charts 341
Pin to corner (see Resizing)
Pixel
        density 17
        grid (see Pixel fitting)
        precision (see Pixel fitting)
        preview (see Pixel fitting)
Pixel fitting 116, 136, 208
Plugins 83, 361
Polygons (see Shapes) 
Preferences 59, 78, 112, 116, 136, 137, 188, 
189, 294, 295
Print 208
Prototyping 217
Pullquotes 248, 277
Real data (see Content generators) 
Rectangle (see Shapes), 
        Rounded (see Shapes)
Resize object (see Resizing)
Resizing 266ff., 271, 289ff.
Responsive 221, 265
RGB to CMYK 211
Rotate 47, 153ff.,
        Copies 326ff., 343ff.,
Round progress bar 349
Rounded corners 44
Round
        pixels 112, 116, 117
        to pixel 67, 97, 117, 319
 

Rulers 164
Scale 57, 118, 137, 273, 284, 335, 348
Scissors 49, 316, 342, 352, 357
Shadows 26, 89, 322
Shapes 19, 49, 104
Shared styles 80, 149, 159, 170, 181
Shortcuts 71, 370
Slices 194, 199
Smart guides 22, 164
Star (see Shapes) 
Stretch (see Resizing)
Styles, set to default 18 
Subtract (see Boolean operations) 
SVG 188, 317,
       Copy SVG code 206
Symbols 63ff., 79, 88, 98, 119, 144, 166, 177, 
227, 247, 281, 291
Templates 14
Text borders 231
Text on path 353, 356
Text styles 79, 247
Toolbar 11, 251,
        Customize 67
Tracking 45, 135, 238
Transform 156
Triangle (see Shapes) 
Undo 24, 81
Union (see Boolean operations) 
Vector(s) 9, 21, 49, 130
        control points 124, 125, 128
        points 70, 100, 108, 117, 123ff.
        point mode 44, 49, 70, 106ff., 111, 114, 
123, 125, 129, 130
        Join 131
Windows support 204
Zooming 78
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